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= CHAPTER

Alarm Troubleshooting

This chapter gives a description, severity, and troubleshooting procedure for each commonly
encountered Cisco DWDM alarm and condition. Tables 2-1 through 2-5 provide lists of DWDM alarms
organized by severity. Table 2-6 on page 2-8 provides a list of alarms organized alphabetically. Table 2-7
gives definitions of all DWDM alarm logical objects, which are the basis of the alarm profile list in
Table 2-8 on page 2-17. For a comprehensive list of all conditions and instructions for using TL1
commands, refer to the Cisco ONS SONET TL1 Command Guide.

An alarm’s troubleshooting procedure applies to both the Cisco Transport Controller (CTC) and TL1
version of that alarm. If the troubleshooting procedure does not clear the alarm, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or call the Cisco Technical
Assistance Center (1-800-553-2447).

Alarms can occur even in those cards that are not explicitly mentioned in the Alarm sections. When an
alarm is raised, refer to its clearing procedure.

For more information about alarm profiles, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Unless otherwise noted, ONS 15454 refers to the ANSI and ETSI versions of the platform.

2.1 Alarm Indexes

The following tables group alarms and conditions by their default severities in the ONS DWDM system.
These severities are the same whether they are reported in the CTC Alarms window severity (SEV)
column or in TL1.

The CTC default alarm profile contains some alarms or conditions that are not currently implemented
but are reserved for future use.

The CTC default alarm profile in some cases contains two severities for one alarm (for example,
MIJ/MN). The platform default severity comes first (in this example, MJ), but the alarm can be demoted
to the second severity in the presence of a higher-ranking alarm. This is in accordance with

Telcordia GR-474.
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W Alarm Indexes

2.1.1 Critical Alarms (CR)

Table 2-1 alphabetically lists Critical (CR) DWDM alarms.

Table 2-1 Critical DWDM Alarm List

— HP-UNEQ (VCMON-HP) OPWR-HFAIL (AOTS)
— HP-UNEQ (VCTRM-HP) OPWR-HFAIL (OCH)
AU-LOP (VCMON-HP) I-HITEMP (NE) OPWR-HFAIL (OMS)
AU-LOP (VCTRM-HP) ILK-FAIL (TRUNK) OPWR-HFAIL (OTS)
AUTOLSROFF (OCN) IMPROPRMVL (EQPT) OPWR-LFAIL (AOTS)
AWG-FAIL (OTS) IMPROPRMVL (PPM) OPWR-LFAIL (OCH-TERM)
AWG-OVERTEMP (OTS) LOF (TRUNK) OPWR-LFAIL (OCH)
BKUPMEMP (EQPT) LOM (TRUNK) OPWR-LFAIL (OMS)
CONTBUS-DISABLED (EQPT) LOP-P (STSMON) OPWR-LFAIL (OTS)
ENCAP-MISMATCH-P (POS) LOP-P (STSTRM) OTUK-LOF (TRUNK)
ENCAP-MISMATCH-P (STSTRM) LOS (2R) OTUK-TIM (TRUNK)
EQPT (AICI-AEP) LOS (ESCON) PORT-FAIL (OCH)
EQPT (AICI-AIE) LOS (ISC) RS-TIM (STMN)
EQPT-DIAG (EQPT) LOS (0OTS) TIM (TRUNK)

EQPT (EQPT) LOS (TRUNK) TIM-P (STSTRM)
EQPT (PPM) LOS-P (OCH) TIM-S (OCN)
EQPT-MISS (FAN) LOS-P (OMS) UNEQ-P (STSMON)
FAN (FAN) LOS-P (OTS) UNEQ-P (STSTRM)
GAIN-HFAIL (AOTS) LOS-P (TRUNK) VOA-DISABLED (EQPT)
GAIN-LFAIL (AOTS) LOS-RAMAN (OTS) VOA-HFAIL (AOTS)
GE-OOSYNC (FC) MEA (AIP) VOA-HFAIL (OCH)
GE-OOSYNC (GE) MEA (EQPT) VOA-HFAIL (OMS)
GE-OOSYNC (ISC) MEA (FAN) VOA-HFAIL (OTS)
GE-OOSYNC (TRUNK) MEA (PPM) VOA-LFAIL (AOTS)
HITEMP (NE) MFGMEM (AICI-AEP) VOA-LFAIL (OCH)
HP-ENCAP-MISMATCH (VCTRM-HP) |MFGMEM (AICI-AIE) VOA-LFAIL (OMS)
HP-PLM (VCMON-HP) MFGMEM (BPLANE) VOA-LFAIL (OTS)
HP-PLM (VCTRM-HP) MFGMEM (FAN) —

HP-TIM (VCMON-HP) MFGMEM (PPM) —

2.1.2 Major Alarms (MJ)

Table 2-2 alphabetically lists Major (MJ) DWDM alarms.
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Table 2-2

Major DWDM Alarm List

Alarm Indexes

APSCNMIS (OCN)

GFP-LFD (CE100T)

ODUK-TIM-PM (TRUNK)

BAT-FAIL (PWR)

GFP-LFD (CE1000)

OUT-OF-SYNC (FC)

CARLOSS (EQPT)

GFP-LFD (CEMR)

OUT-OF-SYNC (GE)

CARLOSS (FC)

GFP-LFD (FCMR)

OUT-OF-SYNC (TRUNK)

CARLOSS (GE)

GFP-LFD (GFP-FAC)

PEER-NORESPONSE (EQPT)

CARLOSS (ISC)

GFP-LFD (ML100T)

PROV-MISMATCH (TRUNK)

CARLOSS (TRUNK)

GFP-LFD (ML1000)

PTIM (TRUNK)

DBOSYNC (NE)

GFP-LFD (MLMR)

PWR-PROT-ON (OTS)

DSP-COMM-FAIL (TRUNK)

GFP-LFD (POS)

RING-ID-MIS (OSC-RING)

DSP-FAIL (TRUNK)

GFP-UP-MISMATCH (CE100T)

SHELF-COMM-FAIL (SHELF)

DUP-SHELF-ID (SHELF)

GFP-UP-MISMATCH (CE1000)

SIGLOSS (ESCON)

EHIBATVG (PWR)

GFP-UP-MISMATCH (CEMR)

SIGLOSS (FC)

ELWBATVG (PWR)

GFP-UP-MISMATCH (FCMR)

SIGLOSS (GE)

FC-NO-CREDITS (FC)

GFP-UP-MISMATCH (GFP-FAC)

SIGLOSS (ISC)

FC-NO-CREDITS (TRUNK)

GFP-UP-MISMATCH (ML100T)

SIGLOSS (TRUNK)

FEC-MISM (TRUNK)

GFP-UP-MISMATCH (ML1000)

SYNCLOSS (FC)

GFP-CSF (CE100T)

GFP-UP-MISMATCH (MLMR)

SYNCLOSS (GE)

GFP-CSF (CE1000)

GFP-UP-MISMATCH (POS)

SYNCLOSS (ISC)

GFP-CSF (CEMR)

HIBATVG (PWR)

SYNCLOSS (TRUNK)

GFP-CSF (FCMR)

INVMACADR (AIP)

SYNCPRI (NE-SREF)

GFP-CSF (GFP-FAC)

LASERBIAS-FAIL (AOTS)

SYSBOOT (NE)

GFP-CSF (ML100T)

LWBATVG (PWR)

UT-COMM-FAIL (TRUNK)

GFP-CSF (ML1000)

MEA (SHELF)

UT-FAIL (TRUNK)

GFP-CSF (MLMR)

MEM-GONE (EQPT)

WVL-MISMATCH (TRUNK)

2.1.3 Minor Alarms (MN)

Table 2-3 alphabetically lists Minor (MN) DWDM alarms.

Table 2-3

Minor DWDM Alarm List

HI-LASERBIAS (OCN)

LO-TXPOWER (ESCON)

HI-LASERBIAS (PPM)

LO-TXPOWER (FC)

AMPLI-INIT (AOTS)

HI-LASERBIAS (TRUNK)

LO-TXPOWER (GE)

APC-CORR-SKIPPED (AOTS)

HI-LASERTEMP (EQPT)

LO-TXPOWER (ISC)

APC-CORR-SKIPPED (OCH)

HI-LASERTEMP (OCN)

LO-TXPOWER (OCN)

APC-CORR-SKIPPED (OMS)

HI-LASERTEMP (PPM)

LO-TXPOWER (PPM)

APC-CORR-SKIPPED (OTS)

HI-RXPOWER (2R)

LO-TXPOWER (TRUNK)

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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Table 2-3

Minor DWDM Alarm List (continued)

APC-OUT-OF-RANGE (AOTS)

HI-RXPOWER (ESCON)

MEM-LOW (EQPT)

APC-OUT-OF-RANGE (OCH)

HI-RXPOWER (FC)

MS-EOC (STMN)

APC-OUT-OF-RANGE (OMS)

HI-RXPOWER (GE)

NON-CISCO-PPM (PPM)

APC-OUT-OF-RANGE (OTS)

HI-RXPOWER (ISC)

OPWR-HDEG (AOTS)

APS-INV-PRIM (OCN)

HI-RXPOWER (OCN)

OPWR-HDEG (OCH-TERM)

APS-PRIM-FAC (OCN)

HI-RXPOWER (TRUNK)

OPWR-HDEG (OCH)

APS-PRIM-SEC-MISM (OCN)

HITEMP (EQPT)

OPWR-HDEG (OMS)

APSB (OCN)

HI-TXPOWER (2R)

OPWR-HDEG (OTS)

APSC-IMP (OCN)

HI-TXPOWER (EQPT)

OPWR-LDEG (AOTS)

APSCDFLTK (OCN)

HI-TXPOWER (ESCON)

OPWR-LDEG (OCH-TERM)

APSCINCON (OCN)

HI-TXPOWER (FC)

OPWR-LDEG (OCH)

APSCM (OCN)

HI-TXPOWER (GE)

OPWR-LDEG (OMS)

APSIMP (OCN)

HI-TXPOWER (ISC)

OPWR-LDEG (OTS)

APSMM (OCN)

HI-TXPOWER (OCN)

OTUK-IAE (TRUNK)

AUTORESET (EQPT)

HI-TXPOWER (PPM)

PROTNA (EQPT)

AWG-DEG (OTS)

HI-TXPOWER (TRUNK)

PROV-MISMATCH (PPM)

BPV (BITS)

HP-TIM (VCMON-HP)

PWR-FAIL-A (EQPT)

CASETEMP-DEG (AOTS)

IS-ADJ-FAIL (OCN)

PWR-FAIL-B (EQPT)

CONTBUS-IO-A (CONTBUS-A)
(EQPT)

IS-ADJ-FAIL (TRUNK)

PWR-FAIL-RET-A (EQPT)

CONTBUS-IO-B (CONTBUS-B)
(EQPT)

LASERBIAS-DEG (AOTS)

PWR-FAIL-RET-B (EQPT)

DATAFLT (NE)

LASERBIAS-DEG (OTS)

RS-EOC (STMN)

DCU-LOSS-FAIL (OTS)

LASERTEMP-DEG (AOTS)

SFTWDOWN (EQPT)

DUP-IPADDR (NE)

LMP-FAIL (GE)

SH-IL-VAR-DEG-HIGH (OTS)

DUP-NODENAME (NE) LMP-SD (GE) SH-IL-VAR-DEG-LOW (OTS)
EOC (OCN) LMP-SF (GE) SNTP-HOST (NE)

EOC (TRUNK) LOF (BITS) SPANLEN-OUT-OF-RANGE (OTS)
EOC-L (OCN) LO-LASERBIAS (EQPT) SSM-FAIL (BITS)

EOC-L (TRUNK)

LO-LASERBIAS (OCN)

SSM-FAIL (TRUNK)

EXCCOL (EQPT)

LO-LASERBIAS (PPM)

SYNCPRI (EXT-SREF)

EXT (ENVALRM)

LO-LASERTEMP (EQPT)

SYNCSEC (EXT-SREF)

FAPS-CONFIG-MISMATCH (EQPT)

LO-LASERTEMP (OCN)

SYNCSEC (NE-SREF)

FEPRLF (OCN)

LO-LASERTEMP (PPM)

SYNCTHIRD (EXT-SREF)

FIBERTEMP-DEG (AOTS)

LO-RXPOWER (2R)

SYNCTHIRD (NE-SREF)

FP-LINK-LOSS (EQPT)

LO-RXPOWER (ESCON)

TIM-MON (TRUNK)

GAIN-HDEG (AOTS)

LO-RXPOWER (FC)

TIM-P (STSMON)

GAIN-LDEG (AOTS)

LO-RXPOWER (GE)

VOA-HDEG (AOTS)
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Table 2-3

Minor DWDM Alarm List (continued)

Alarm Indexes

GCC-EOC (TRUNK)

LO-RXPOWER (ISC)

VOA-HDEG (OCH)

HELLO (OCN)

LO-RXPOWER (OCN)

VOA-HDEG (OMS)

HELLO (TRUNK)

LO-RXPOWER (TRUNK)

VOA-HDEG (OTS)

HI-LASERBIAS (2R)

LOS (BITS)

VOA-LDEG (AOTS)

HI-LASERBIAS (EQPT) LOS-O (OCH) VOA-LDEG (OCH)
HI-LASERBIAS (ESCON) LOS-0 (OMS) VOA-LDEG (OMS)
HI-LASERBIAS (FC) LOS-O (OTS) VOA-LDEG (OTS)

HI-LASERBIAS (GE)

LO-TXPOWER (2R)

HI-LASERBIAS (ISC)

LO-TXPOWER (EQPT)

2.1.4 NA Conditions

Table 2-4 alphabetically lists Not Alarmed (NA) DWDM conditions.

Table 2-4

NA DWDM Conditions List

APC-DISABLED (OCH)

FORCED-REQ-SPAN (ISC)

SD-L (TRUNK)

APC-DISABLED (OMS)

FORCED-REQ-SPAN (OCN)

SD-P (STSMON)

APC-DISABLED (OTS)

FORCED-REQ-SPAN (OTS)

SD-P (STSTRM)

APC-DISABLED (SHELF) FORCED-REQ-SPAN (TRUNK) SF (TRUNK)

APC-END (NE) FRCDSWTOINT (NE-SREF) SFBER-EXCEED-HO
(VCMON-HP)

APC-WRONG-GAIN (AOTS) FRNGSYNC (NE-SREF) SFBER-EXCEED-HO
(VCTRM-HP)

ALS (2R) FRCDSWTOPRI (EXT-SREF) SFBER-EXCEED-HO
(VCTRM-LP)

ALS (AOTS) FRCDSWTOPRI (NE-SREF) SF-L (TRUNK)

ALS (ESCON) FRCDSWTOSEC (EXT-SREF) SF-P (STSMON)

ALS (FC) FRCDSWTOSEC (NE-SREF) SF-P (STSTRM)

ALS (GE) FRCDSWTOTHIRD (EXT-SREF) SHUTTER-OPEN (OTS)

ALS (ISC) FRCDSWTOTHIRD (NE-SREF) SPAN-NOT-MEASURED (OTS)

ALS (OCN) FSTSYNC (NE-SREF) SQUELCHED (2R)

ALS (TRUNK)

FTA-MISMATCH (EQPT)

SQUELCHED (ESCON)

ALS-DISABLED (EQPT)

HI-CCVOLT (BITS)

SQUELCHED (FC)

APC-DISABLED (AOTS)

HLDOVRSYNC (NE-SREF)

WKSWPR (FC)

APC-DISABLED (EQPT)

HP-DEG (VCMON-HP)

WKSWPR (GE)

APC-DISABLED (NE)

HP-DEG (VCTRM-HP)

WKSWPR (ISC)

APS-PRIM-FAC (OCN)

HP-EXC (VCMON-HP)

WKSWPR (OTS)

AS-CMD (2R)

HP-EXC (VCTRM-HP)

WTR (2R)
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Table 2-4 NA DWDM Conditions List (continued)

AS-CMD (AOTS) INHSWPR (EQPT) WTR (EQPT)
AS-CMD (BPLANE) INHSWWKG (EQPT) WTR (ESCON)
AS-CMD (EQPT) INTRUSION-PSWD (NE) WTR (FC)

AS-CMD (ESCON) LAN-POL-REV (NE) WTR (GE)

AS-CMD (FC) LASER-APR (AOTS) WTR (ISC)

AS-CMD (GE) LASER-APR (OTS) WTR (TRUNK)
AS-CMD (ISC) LMP-UNALLOC (GE) SSM-LNC (BITS)
AS-CMD (NE) LOCKOUT-REQ (2R) SSM-LNC (NE-SREF)

AS-CMD (OCH)

LOCKOUT-REQ (EQPT)

SSM-LNC (TRUNK)

AS-CMD (OCN)

LOCKOUT-REQ (ESCON)

SSM-OFF (BITS)

AS-CMD (OMS)

LOCKOUT-REQ (FC)

SSM-OFF (TRUNK)

AS-CMD (OTS)

LOCKOUT-REQ (GE)

SSM-PRC (BITS)

AS-CMD (PPM)

LOCKOUT-REQ (ISC)

SQUELCHED (GE)

AS-CMD (PWR)

LOCKOUT-REQ (OCN)

SQUELCHED (ISC)

AS-CMD (SHELF)

LOCKOUT-REQ (OTS)

SQUELCHED (OCN)

AS-CMD (TRUNK)

LOCKOUT-REQ (STSMON)

SQUELCHED (TRUNK)

AS-MT (2R)

LOCKOUT-REQ (TRUNK)

SSM-DUS (BITS)

AS-MT (AOTS)

LPBKCRS (STSMON)

SSM-DUS (TRUNK)

AS-MT (EQPT)

LPBKFACILITY (ESCON)

SSM-PRC (NE-SREF)

AS-MT (ESCON)

LPBKFACILITY (FC)

SSM-PRC (TRUNK)

AS-MT (FC) LPBKFACILITY (GE) SSM-PRS (BITS)

AS-MT (GE) LPBKFACILITY (ISC) SSM-PRS (NE-SREF)
AS-MT (ISC) LPBKFACILITY (TRUNK) SSM-PRS (TRUNK)
AS-MT (OCH) LPBKTERMINAL (ESCON) SSM-RES (BITS)

AS-MT (OCN) LPBKTERMINAL (FC) SSM-RES (NE-SREF)
AS-MT (OMS) LPBKTERMINAL (GE) SSM-RES (TRUNK)
AS-MT (OTS) LPBKTERMINAL (ISC) SSM-SDH-TN (BITS)
AS-MT (PPM) LPBKTERMINAL (TRUNK) SSM-SDH-TN (NE-SREF)

AS-MT (SHELF)

MAN-REQ (EQPT)

SSM-SDH-TN (TRUNK)

AS-MT (TRUNK)

MANRESET (EQPT)

SSM-SETS (BITS)

AS-MT-O0G (STSTRM)

MANSWTOINT (NE-SREF)

SSM-SETS (NE-SREF)

AUD-LOG-LOSS (NE)

MANSWTOPRI (EXT-SREF)

SSM-SETS (TRUNK)

AUD-LOG-LOW (NE)

MANSWTOPRI (NE-SREF)

SSM-SMC (BITS)

AUTOSW-LOP (STSMON)

MANSWTOSEC (EXT-SREF)

SSM-SMC (NE-SREF)

AUTOSW-LOP-SNCP (VCMON-HP)

MANSWTOSEC (NE-SREF)

SSM-SMC (TRUNK)

AUTOSW-LOP-SNCP (VCMON-LP)

MANSWTOTHIRD (EXT-SREF)

SSM-ST2 (BITS)

AUTOSW-PDI-SNCP (VCMON-HP)

MANSWTOTHIRD (NE-SREF)

SSM-ST2 (NE-SREF)
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Alarm Indexes

Table 2-4 NA DWDM Conditions List (continued)

AUTOSW-PDI (STSMON)

MANUAL-REQ-SPAN (2R)

SSM-ST2 (TRUNK)

AUTOSW-SDBER (STSMON)

MANUAL-REQ-SPAN (ESCON)

SSM-ST3 (BITS)

AUTOSW-SFBER (STSMON)

MANUAL-REQ-SPAN (FC)

SSM-ST3 (NE-SREF)

AUTOSW-SDBER-SNCP (VCMON-HP)

MANUAL-REQ-SPAN (GE)

SSM-ST3 (TRUNK)

AUTOSW-SFBER-SNCP (STSMON)

MANUAL-REQ-SPAN (ISC)

SSM-ST3E (BITS)

AUTOSW-UNEQ (STSMON)

MANUAL-REQ-SPAN (OCN)

SSM-ST3E (NE-SREF)

AUTOSW-UNEQ-SNCP (VCMON-HP)

MANUAL-REQ-SPAN (OTS)

SSM-ST3E (TRUNK)

AUTOSW-UNEQ-SNCP (VCMON-LP)

MANUAL-REQ-SPAN (TRUNK)

SSM-ST4 (BITS)

AWG-WARM-UP (OTS)

MS-DEG (STMIE)

SSM-ST4 (NE-SREF)

CHANLOSS (OCN)

MS-DEG (STMN)

SSM-ST4 (TRUNK)

CLDRESTART (EQPT)

MS-EOC (STMN)

SSM-STU (BITS)

CTNEQPT-MISMATCH (EQPT)

MS-EXC (STMIE)

SSM-STU (NE-SREF)

ETH-LINKLOSS (NE)

MS-EXC (STMN)

SSM-STU (TRUNK)

FAILTOSW (2R)

MT-OCHNC (OTS)

SSM-TNC (BITS)

FAILTOSW (EQPT)

OCHNC-INC (OCHNC-CONN)

SSM-TNC (NE-SREF)

FAILTOSW (ESCON)

OCHTERM-INC (OCH-TERM)

SSM-TNC (TRUNK)

FAILTOSW (GE)

ODUK-SD-PM (TRUNK)

SW-MISMATCH (EQPT)

FAILTOSW (FC)

ODUK-SF-PM (TRUNK)

SWTOPRI (EXT-SREF)

FAILTOSW (ISC)

OPEN-SLOT (EQPT)

SWTOPRI (NE-SREF)

FAILTOSW (OCN)

OSRION (AOTS)

SWTOSEC (EXT-SREF)

FAILTOSW (OTS)

OSRION (OTS)

SWTOSEC (NE-SREF)

FAILTOSW (TRUNK)

OTUK-SD (TRUNK)

SWTOTHIRD (EXT-SREF)

FAILTOSW-HO (VCMON-HP)

OTUK-SF (TRUNK)

TRAIL-SIGNAL-FAIL (OCH)

FAILTOSW-PATH (STSMON)

OUT-OF-SYNC (ISC)

SWTOTHIRD (NE-SREF)

FAPS (TRUNK)

PARAM-MISM (AOTS)

SYNC-FREQ (BITS)

FDI (OCH-TERM)

PARAM-MISM (OCH)

SYNC-FREQ (TRUNK)

FDI (OCH)

PARAM-MISM (OCH-TERM)

TEMP-MISM (NE)

FE-FRCDWKSWBK-SPAN (OCN)

PARAM-MISM (OMS)

TRAIL-SIGNAL-FAIL (TRUNK)

FORCED-REQ (STSMON)

PARAM-MISM (OTS)

UNC-WORD (TRUNK)

FE-FRCDWKSWPR-SPAN (OCN)

PDI-P (STSMON)

VOLT-MISM (PWR)

FE-MANWKSWBK-SPAN (OCN)

PDI-P (STSTRM)

WKSWPR (2R)

FE-MANWKSWPR-SPAN (OCN) PMI (OMS) WKSWPR (EQPT)
FORCED-REQ (EQPT) PMI (OTS) WKSWPR (ESCON)
FORCED-REQ (POS) RLS (OTS) WKSWPR (FC)
FORCED-REQ-SPAN (2R) RUNCFG-SAVENEED (EQPT) WKSWPR (GE)
FORCED-REQ-SPAN (ESCON) SD (TRUNK) WKSWPR (ISC)
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Table 2-4 NA DWDM Conditions List (continued)
FORCED-REQ-SPAN (FC) SD-L (OCN) WKSWPR (OTS)
FORCED-REQ-SPAN (GE) SD-L (OCN) —

2.1.5 NR Conditions

Table 2-5 alphabetically lists Not Reported (NR) DWDM conditions.

Table 2-5 NR DWDM Conditions List

AIS (BITS)

ERFI-P-CONN (STSTRM)

ODUK-AIS-PM (TRUNK)

AIS (TRUNK)

ERFI-P-SRVR (STSMON)

ODUK-BDI-PM (TRUNK)

AIS-L (OCN)

ERFI-P-SRVR (STSTRM)

ODUK-LCK-PM (TRUNK)

AIS-L (TRUNK)

HP-RFI (VCMON-HP)

ODUK-OCI-PM (TRUNK)

AIS-P (STSMON)

MS-AIS (STMN)

OTUK-AIS (TRUNK)

AIS-P (STSTRM)

MS-AIS (STMIE)

OTUK-BDI (TRUNK)

AU-AIS (VCTRM-HP)

MS-RFI (STMN)

RFI (TRUNK)

AU-AIS (VCMON-HP)

MS-RFI (STMIE)

RFI-L (OCN)

AUTOSW-AIS (STSMON)

ODUK-1-AIS-PM (TRUNK)

RFI-L (TRUNK)

AUTOSW-AIS-SNCP (VCMON-HP)

ODUK-2-AIS-PM (TRUNK)

RFI-P (STSMON)

AUTOSW-AIS-SNCP (VCMON-LP)

ODUK-3-AIS-PM (TRUNK)

RFI-P (STSTRM)

ERFI-P-CONN (STSMON)

ODUK-4-AIS-PM (TRUNK)

UNQUAL-PPM

2.1.6 Alarms and Conditions Listed By Alphabetical Entry

Table 2-6 alphabetically lists all DWDM alarms and conditions.

Table 2-6 Alphabetical DWDM Alarm and Condition List

GFP-CSF (CE1000)

ODUK-TIM-PM (TRUNK)

GFP-CSF (CEMR)

OPEN-SLOT (EQPT)

GFP-CSF (FCMR)

OPWR-HDEG (AOTS)

GFP-CSF (GFP-FAC)

OPWR-HDEG (OCH)

AIS (BITS) GFP-CSF (ML100T) OPWR-HDEG (OCH-TERM)
AIS (TRUNK) GFP-CSF (ML1000) OPWR-HDEG (OMS)
AIS-L (OCN) GFP-CSF (MLMR) OPWR-HDEG (OTS)

AIS-L (TRUNK)

GFP-LFD (CE100T)

OPWR-HFAIL (AOTS)

AIS-P (STSMON)

GFP-LFD (CE1000)

OPWR-HFAIL (OCH)

AIS-P (STSTRM)

GFP-LFD (CEMR)

OPWR-HFAIL (OMS)

ALS (2R)

GFP-LFD (FCMR)

OPWR-HFAIL (OTS)

ALS (AOTS)

GFP-LFD (GFP-FAC)

OPWR-LDEG (AOTS)
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Table 2-6

Alphabetical DWDM Alarm and Condition List (continued)

Alarm Indexes

ALS (ESCON)

GFP-LFD (ML100T)

OPWR-LDEG (OCH)

ALS (FC) GFP-LFD (ML1000) OPWR-LDEG (OCH-TERM)
ALS (GE) GFP-LFD (MLMR) OPWR-LDEG (OMS)

ALS (ISC) GFP-LFD (POS) OPWR-LDEG (OTS)

ALS (OCN) GFP-UP-MISMATCH (CE100T) OPWR-LFAIL (AOTS)

ALS (TRUNK)

GFP-UP-MISMATCH (CE1000)

OPWR-LFAIL (OCH)

ALS-DISABLED (EQPT)

GFP-UP-MISMATCH (CEMR)

OPWR-LFAIL (OCH-TERM)

AMPLI-INIT (AOTS)

GFP-UP-MISMATCH (FCMR)

OPWR-LFAIL (OMS)

APC-CORR-SKIPPED (AOTS)

GFP-UP-MISMATCH (GFP-FAC)

OPWR-LFAIL (OTS)

APC-CORR-SKIPPED (OCH)

GFP-UP-MISMATCH (ML100T)

OSRION (AOTS)

APC-CORR-SKIPPED (OMS)

GFP-UP-MISMATCH (ML1000)

OSRION (OTS)

APC-CORR-SKIPPED (OTS)

GFP-UP-MISMATCH (MLMR)

OTUK-AIS (TRUNK)

APC-DISABLED (AOTS)

GFP-UP-MISMATCH (POS)

OTUK-BDI (TRUNK)

APC-DISABLED (EQPT)

HELLO (TRUNK)

OTUK-IAE (TRUNK)

APC-DISABLED (NE)

HIBATVG (PWR)

OTUK-LOF (TRUNK)

APC-DISABLED (OCH)

HI-CCVOLT (BITS)

OTUK-SD (TRUNK)

APC-DISABLED (OMS)

HI-LASERBIAS (2R)

OTUK-SF (TRUNK)

APC-DISABLED (OTS)

HI-LASERBIAS (EQPT)

OTUK-TIM (TRUNK)

APC-DISABLED (SHELF)

HI-LASERBIAS (ESCON)

OUT-OF-SYNC (FC)

APC-END (NE)

HI-LASERBIAS (FC)

OUT-OF-SYNC (GE)

APC-OUT-OF-RANGE (AOTS)

HI-LASERBIAS (GE)

OUT-OF-SYNC (ISC)

APC-OUT-OF-RANGE (OCH)

HI-LASERBIAS (ISC)

OUT-OF-SYNC (TRUNK)

APC-OUT-OF-RANGE (OMS)

HI-LASERBIAS (OCN)

PARAM-MISM (AOTS)

APC-OUT-OF-RANGE (OTS)

HI-LASERBIAS (PPM)

PARAM-MISM (OCH)

APC-WRONG-GAIN (AOTS)

HI-LASERBIAS (TRUNK)

PARAM-MISM (OCH-TERM)

APS-INV-PRIM (OCN)

HI-LASERTEMP (EQPT)

PARAM-MISM (OMS)

APS-PRIM-FAC (OCN)

HI-LASERTEMP (OCN)

PARAM-MISM (OTS)

APS-PRIM-SEC-MISM (OCN)

HI-LASERTEMP (PPM)

PDI-P (STSMON)

APSB (OCN)

HI-RXPOWER (2R)

PDI-P (STSTRM)

APSC-IMP (OCN)

HI-RXPOWER (ESCON)

PEER-NORESPONSE (EQPT)

APSCDFLTK (OCN)

HI-RXPOWER (FC)

PM-TCA

APSCINCON (OCN) HI-RXPOWER (GE) PMI (OMS)
APSCM (OCN) HI-RXPOWER (ISC) PMI (OTS)
APSCNMIS (OCN) HI-RXPOWER (OCN) PORT-FAIL (OCH)

APSIMP (OCN)

HI-RXPOWER (TRUNK)

PROTNA (EQPT)

APSMM (OCN)

HITEMP (EQPT)

PROV-MISMATCH (PPM)

AS-CMD (2R)

HITEMP (NE)

PROV-MISMATCH (TRUNK)
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Table 2-6 Alphabetical DWDM Alarm and Condition List (continued)

AS-CMD (AOTS)

HI-TXPOWER (2R)

PTIM (TRUNK)

AS-CMD (BPLANE)

HI-TXPOWER (EQPT)

PWR-FAIL-A (EQPT)

AS-CMD (EQPT)

HI-TXPOWER (ESCON)

PWR-FAIL-B (EQPT)

AS-CMD (ESCON)

HI-TXPOWER (FC)

PWR-FAIL-RET-A (EQPT)

AS-CMD (FC) HI-TXPOWER (GE) PWR-FAIL-RET-B (EQPT)
AS-CMD (GE) HI-TXPOWER (ISC) PWR-PROT-ON (OTS)
AS-CMD (ISC) HI-TXPOWER (OCN) RFI (TRUNK)

AS-CMD (NE) HI-TXPOWER (PPM) RFI-L (OCN)

AS-CMD (OCH)

HI-TXPOWER (TRUNK)

RFI-P (STSMON)

AS-CMD (OCN)

HLDOVRSYNC (NE-SREF)

RFI-P (STSTRM)

AS-CMD (OMS) HP-DEG (VCMON-HP) RLS (OTS)
AS-CMD (OTS) HP-DEG (VCTRM-HP) RMON-ALARM
AS-CMD (PPM) HP-ENCAP-MISMATCH (VCTRM-HP) [RMON-RESET

AS-CMD (PWR)

HP-EXC (VCMON-HP)

RING-ID-MIS (OSC-RING)

AS-CMD (SHELF)

HP-EXC (VCTRM-HP)

RS-EOC (STMN)

AS-CMD (TRUNK)

HP-PLM (VCMON-HP)

RS-TIM (STMN)

AS-MT-O0G (STSTRM)

HP-PLM (VCTRM-HP)

RUNCFG-SAVENEED (EQPT)

AS-MT (2R)

HP-RFI (VCMON-HP)

SD (TRUNK)

AS-MT (AOTS)

HP-TIM (VCMON-HP)

SD-L (OCN)

AS-MT (EQPT)

HP-UNEQ (VCMON-HP)

SD-P (STSMON)

AS-MT (ESCON)

HP-UNEQ (VCTRM-HP)

SD-P (STSTRM)

AS-MT (FC) I-HITEMP (NE) SF (TRUNK)

AS-MT (GE) ILK-FAIL (TRUNK) SF-L (TRUNK)

AS-MT (ISC) IMPROPRMVL (EQPT) SF-P (STSMON)

AS-MT (OCH) IMPROPRMVL (PPM) SF-P (STSTRM)

AS-MT (OCN) INTRUSION-PSWD (NE) SFBER-EXCEED-HO (VCMON-HP)
AS-MT (OMS) INVMACADR (AIP) SFBER-EXCEED-HO (VCTRM-HP)
AS-MT (OTS) INHSWPR (EQPT) SFBER-EXCEED-HO (VCTRM-LP)
AS-MT (PPM) INHSWWKG (EQPT) SFTWDOWN (EQPT)

AS-MT (SHELF)

ISIS-ADIJ-FAIL (OCN)

SHELF-COMM-FAIL (SHELF)

AS-MT (TRUNK)

ISIS-ADIJ-FAIL (TRUNK)

SH-IL-VAR-DEG-HIGH (OTS)

AU-AIS (VCTRM-HP)

LAN-POL-REV (NE)

SH-IL-VAR-DEG-LOW (OTS)

AU-AIS (VCMON-HP)

LASEREOL (OCN)

SHUTTER-OPEN (OTS)

AU-LOP (VCTRM-HP)

LASER-APR (AOTS)

SIGLOSS (ESCON)

AU-LOP (VCMON-HP)

LASER-APR (OTS)

SIGLOSS (FC)

AUD-LOG-LOSS (NE)

LASERBIAS-DEG (AOTS)

SIGLOSS (GE)

AUD-LOG-LOW (NE)

LASERBIAS-DEG (OTS)

SIGLOSS (ISC)
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Table 2-6

Alphabetical DWDM Alarm and Condition List (continued)

Alarm Indexes

AUTORESET (EQPT)

LASERBIAS-FAIL (AOTS)

SIGLOSS (TRUNK)

AUTOLSROFF (OCN)

LASERTEMP-DEG (AOTS)

SNTP-HOST (NE)

AUTOSW-AIS (STSMON)

LMP-FAIL (GE)

SPANLEN-OUT-OF-RANGE (OTS)

AUTOSW-AIS-SNCP (VCMON-HP)

LMP-SD (GE)

SPAN-NOT-MEASURED (OTS)

AUTOSW-AIS-SNCP (VCMON-LP)

LMP-SF (GE)

SQUELCHED (2R)

AUTOSW-LOP (STSMON)

LMP-UNALLOC (GE)

SQUELCHED (ESCON)

AUTOSW-LOP-SNCP (VCMON-HP)

LOCKOUT-REQ (2R)

SQUELCHED (FC)

AUTOSW-LOP-SNCP (VCMON-LP)

LOCKOUT-REQ (EQPT)

SQUELCHED (GE)

AUTOSW-PDI (STSMON)

LOCKOUT-REQ (ESCON)

SQUELCHED (ISC)

AUTOSW-PDI-SNCP (VCMON-HP)

LOCKOUT-REQ (FC)

SQUELCHED (OCN)

AUTOSW-SDBER (STSMON)

LOCKOUT-REQ (GE)

SQUELCHED (TRUNK)

AUTOSW-SDBER-SNCP (VCMON-HP)

LOCKOUT-REQ (ISC)

SSM-DUS (BITS)

AUTOSW-SFBER (STSMON)

LOCKOUT-REQ (OTS)

SSM-DUS (TRUNK)

AUTOSW-SFBER-SNCP (STSMON)

LOCKOUT-REQ (TRUNK)

SSM-FAIL (BITS)

AUTOSW-UNEQ (STSMON)

LOF (BITS)

SSM-FAIL (TRUNK)

AUTOSW-UNEQ-SNCP (VCMON-HP)

LOF (TRUNK)

SSM-LNC (BITS)

AUTOSW-UNEQ-SNCP (VCMON-LP)

LO-LASERBIAS (EQPT)

SSM-LNC (NE-SREF)

AWG-DEG (OTS)

LO-LASERBIAS (OCN)

SSM-LNC (TRUNK)

AWG-FAIL (OTS)

LO-LASERBIAS (PPM)

SSM-OFF (BITS)

AWG-OVERTEMP (OTS)

LO-LASERTEMP (EQPT)

SSM-OFF (TRUNK)

AWG-WARM-UP (OTS)

LO-LASERTEMP (OCN)

SSM-PRC (BITS)

BAT-FAIL (PWR)

LO-LASERTEMP (PPM)

SSM-PRC (NE-SREF)

BKUPMEMP (EQPT)

LOM (TRUNK)

SSM-PRC (TRUNK)

BPV (BITS)

LOP-P (TRUNK)

SSM-PRS (BITS)

CARLOSS (EQPT) LOP-P (OCH) SSM-PRS (NE-SREF)
CARLOSS (FC) LOP-P (OMS) SSM-PRS (TRUNK)
CARLOSS (GE) LOP-P (OTS) SSM-RES (BITS)

CARLOSS (ISC)

LO-RXPOWER (2R)

SSM-RES (NE-SREF)

CARLOSS (TRUNK)

LO-RXPOWER (ESCON)

SSM-RES (TRUNK)

CASETEMP-DEG (AOTS)

LO-RXPOWER (FC)

SSM-SDH-TN (BITS)

CHANLOSS (OCN)

LO-RXPOWER (GE)

SSM-SDH-TN (NE-SREF)

CLDRESTART (EQPT)

LO-RXPOWER (ISC)

SSM-SDH-TN (TRUNK)

CONTBUS-DISABLED (EQPT)

LO-RXPOWER (OCN)

SSM-SETS (BITS)

CONTBUS-IO-A (CONTBUS-A)
(EQPT)

LO-RXPOWER (TRUNK)

SSM-SETS (NE-SREF)

CONTBUS-IO-B (CONTBUS-B) LOS (2R) SSM-SETS (TRUNK)
(EQPT)
CTNEQPT-MISMATCH (EQPT) LOS (BITS) SSM-SMC (BITS)
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Alphabetical DWDM Alarm and Condition List (continued)

DATAFLT (NE)

LOS (ESCON)

SSM-SMC (NE-SREF)

DBOSYNC (NE) LOS (ISC) SSM-SMC (TRUNK)
DCU-LOSS-FAIL (OTS) LOS (OTS) SSM-ST2 (BITS)
DSP-COMM-FAIL (TRUNK) LOS (TRUNK) SSM-ST?2 (NE-SREF)
DSP-FAIL (TRUNK) LOS-O (OCH) SSM-ST2 (TRUNK)
DUP-IPADDR (NE) LOS-O (OMS) SSM-ST3 (BITS)
DUP-NODENAME (NE) LOS-O (OTS) SSM-ST3 (NE-SREF)
DUP-SHELF-ID (SHELF) LOS-P (OCH) SSM-ST3 (TRUNK)
EHIBATVG (PWR) LOS-P (OMS) SSM-ST3E (BITS)
ELWBATVG (PWR) LOS-P (OTS) SSM-ST3E (NE-SREF)

ENCAP-MISMATCH-P (STSTRM)

LOS-P (TRUNK)

SSM-ST3E (TRUNK)

ENCAP-MISMATCH-P (POS)

LOS-RAMAN (OTS)

SSM-ST4 (BITS)

EOC (OCN) LO-TXPOWER (2R) SSM-ST4 (NE-SREF)
EOC (TRUNK) LO-TXPOWER (EQPT) SSM-ST4 (TRUNK)
EOC-L (OCN) LO-TXPOWER (ESCON) SSM-STU (BITS)

EOC-L (TRUNK)

LO-TXPOWER (FC)

SSM-STU (NE-SREF)

ERFI-P-CONN (STSMON)

LO-TXPOWER (GE)

SSM-STU (TRUNK)

ERFI-P-CONN (STSTRM)

LO-TXPOWER (ISC)

SSM-TNC (BITS)

ERFI-P-SRVR (STSMON)

LO-TXPOWER (OCN)

SSM-TNC (NE-SREF)

ERFI-P-SRVR (STSTRM)

LO-TXPOWER (PPM)

SSM-TNC (TRUNK)

EQPT (AICI-AEP)

LO-TXPOWER (TRUNK)

SW-MISMATCH (EQPT)

EQPT (AICI-AIE)

LPBKCRS (STSMON)

SWTOPRI (EXT-SREF)

EQPT (EQPT)

LPBKFACILITY (ESCON)

SWTOPRI (NE-SREF)

EQPT (PPM)

LPBKFACILITY (FC)

SWTOSEC (EXT-SREF)

EQPT-DIAG (EQPT)

LPBKFACILITY (GE)

SWTOSEC (NE-SREF)

EQPT-MISS (FAN)

LPBKFACILITY (ISC)

SWTOTHIRD (EXT-SREF)

ETH-LINKLOSS (NE)

LPBKFACILITY (TRUNK)

SWTOTHIRD (NE-SREF)

EXCCOL (EQPT)

LPBKTERMINAL (ESCON)

SYNC-FREQ (BITS)

EXT (ENVALRM)

LPBKTERMINAL (FC)

SYNC-FREQ (TRUNK)

FAILTOSW (2R)

LPBKTERMINAL (GE)

SYNCLOSS (FC)

FAILTOSW (EQPT)

LPBKTERMINAL (ISC)

SYNCLOSS (GE)

FAILTOSW (ESCON)

LPBKTERMINAL (TRUNK)

SYNCLOSS (ISC)

FAILTOSW (FC)

LWBATVG (PWR)

SYNCLOSS (TRUNK)

FAILTOSW (GE)

MAN-REQ (EQPT)

SYNCPRI (EXT-SREF)

FAILTOSW (ISC)

MANRESET (EQPT)

SYNCPRI (NE-SREF)

FAILTOSW (OCN)

MANSWTOINT (NE-SREF)

SYNCSEC (EXT-SREF)

FAILTOSW (OTS)

MANSWTOPRI (EXT-SREF)

SYNCSEC (NE-SREF)
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Alphabetical DWDM Alarm and Condition List (continued)

Alarm Indexes

FAILTOSW (TRUNK)

MANSWTOPRI (NE-SREF)

SYNCTHIRD (EXT-SREF)

FAILTOSW-HO (STSMON)

MANSWTOSEC (EXT-SREF)

SYNCTHIRD (NE-SREF)

FAILTOSW-PATH (STSMON)

MANSWTOSEC (NE-SREF)

SYSBOOT (NE)

FAN (FAN)

MANSWTOTHIRD (EXT-SREF)

TEMP-MISM (NE)

FAPS (TRUNK)

MANSWTOTHIRD (NE-SREF)

TIM (TRUNK)

FAPS-CONFIG-MISMATCH (EQPT)

MANUAL-REQ-SPAN (2R)

TIM-MON (TRUNK)

FC-NO-CREDITS (FC)

MANUAL-REQ-SPAN (ESCON)

TIM-P (TRUNK)

FC-NO-CREDITS (TRUNK)

MANUAL-REQ-SPAN (FC)

TIM-S (TRUNK)

FDI (OCH)

MANUAL-REQ-SPAN (GE)

TRAIL-SIGNAL-FAIL (OCH)

FDI (OCH-TERM)

MANUAL-REQ-SPAN (ISC)

TRAIL-SIGNAL-FAIL (TRUNK)

FE-FRCDWKSWBK-SPAN (OCN)

MANUAL-REQ-SPAN (OCN)

UNC-WORD (TRUNK)

FE-FRCDWKSWPR-SPAN (OCN)

MANUAL-REQ-SPAN (OTS)

UNEQ-P (STSMON, STSTRM)

FE-MANWKSWBK-SPAN (OCN)

MANUAL-REQ-SPAN (TRUNK)

UNQUAL-PPM (PPM)

FE-MANWKSWPR-SPAN (OCN)

MANWKSWBK-NO-TRFSW (OCN)

UT-COMM-FAIL (TRUNK)

FEC-MISM (TRUNK)

MANWKSWPR-NO-TRFSW (OCN)

UT-FAIL (TRUNK)

FEPRLF (OCN)

MEA (AIP)

VOA-DISABLED (EQPT)

FIBERTEMP-DEG (AOTS) MEA (EQPT) VOA-HDEG (AOTS)
FORCED-REQ (EQPT) MEA (FAN) VOA-HDEG (OCH)
FORCED-REQ (STSMON) MEA (PPM) VOA-HDEG (OMS)

FORCED-REQ (POS)

MEA (SHELF)

VOA-HDEG (OTS)

FORCED-REQ-SPAN (2R)

MEM-GONE (EQPT)

VOA-HFAIL (AOTS)

FORCED-REQ-SPAN (ESCON)

MEM-LOW (EQPT)

VOA-HFAIL (OCH)

FORCED-REQ-SPAN (FC)

MFGMEM (AICI-AEP)

VOA-HFAIL (OMS)

FORCED-REQ-SPAN (GE)

MFGMEM (AICI-AIE)

VOA-HFAIL (OTS)

FORCED-REQ-SPAN (ISC)

MFGMEM (AIP)

VOA-LDEG (AOTS)

FORCED-REQ-SPAN (OCN)

MFGMEM (BPLANE)

VOA-LDEG (OCH)

FORCED-REQ-SPAN (OTS)

MFGMEM (FAN)

VOA-LDEG (OMS)

FORCED-REQ-SPAN (TRUNK)

MFGMEM (PPM)

VOA-LDEG (OTS)

FP-LINK-LOSS (EQPT)

MS-AIS (STMN)

VOA-LFAIL (AOTS)

FRCDSWTOINT (NE-SREF)

MS-AIS (STMIE)

VOA-LFAIL (OCH)

FRCDSWTOPRI (EXT-SREF)

MS-DEG (STMN)

VOA-LFAIL (OMS)

FRCDSWTOPRI (NE-SREF)

MS-DEG (STMIE)

VOA-LFAIL (OTS)

FRCDSWTOSEC (EXT-SREF)

MS-EOC (STMN)

VOLT-MISM (PWR)

FRCDSWTOSEC (NE-SREF) MS-EXC (STMN) WKSWBK (EQPT)
FRCDSWTOTHIRD (EXT-SREF) MS-EXC (STMIE) WKSWBK (OCN)
FRCDSWTOTHIRD (NE-SREF) MS-RFI (STMN) WKSWBK (OTS)
FRCDWKSWBK-NO-TRFSW (OCN)  |MS-RFI (STMIE) WKSWPR (2R)
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Alphabetical DWDM Alarm and Condition List (continued)

FRCDWKSWPR-NO-TRFSW (OCN)

MT-OCHNC (OTS)

WKSWPR (EQPT)

FRNGSYNC (NE-SREF)

NON-CISCO-PPM (PPM)

WKSWPR (ESCON)

FSTSYNC (NE-SREF)

OCHNC-INC (OCHNC-CONN)

WKSWPR (FC)

FTA-MISMATCH (EQPT)

OCHTERM-INC (OCH-TERM)

WKSWPR (GE)

GAIN-HDEG (AOTS)

ODUK-1-AIS-PM (TRUNK)

WKSWPR (ISC)

GAIN-HFAIL (AOTS)

ODUK-2-AIS-PM (TRUNK)

WKSWPR (OTS)

GAIN-LDEG (AOTS)

ODUK-3-AIS-PM (TRUNK)

WORK-QUEUE-FULL (EQPT)

GAIN-LFAIL (AOTS)

ODUK-4-AIS-PM (TRUNK)

WTR (2R)

GCC-EOC (TRUNK) ODUK-AIS-PM (TRUNK) WTR (EQPT)
GE-OOSYNC (FC) ODUK-BDI-PM (TRUNK) WTR (ESCON)
GE-OOSYNC (GE) ODUK-LCK-PM (TRUNK) WTR (FC)
GE-OOSYNC (ISC) ODUK-OCI-PM (TRUNK) WTR (GE)
GE-OOSYNC (TRUNK) ODUK-SD-PM (TRUNK) WTR (ISC)
GFP-CSF (CE100T) ODUK-SF-PM (TRUNK) WTR (TRUNK)

2.2 Logical Objects

The CTC alarm profile list organizes all alarms and conditions according to the logical objects they are
raised against. These logical objects represent physical objects such as cards, logical objects such as

circuits, or transport and signal monitoring entities such as the SONET or ITU-T G.709 optical overhead
bits. One alarm can appear in multiple entries. It can be raised against multiple objects. For example, the
loss of signal (LOS) alarm can be raised against the optical signal (OC-N) or the optical transport layer
overhead (OTN) as well as other objects. Therefore, both OCN: LOS and OTN: LOS appear in the list
(as well as the other objects).

Alarm profile list objects are defined in Table 2-7.

Note  Alarm logical object names can appear as abbreviated versions of standard terms used in the system and
the documentation. For example, the “OCN” logical object refers to the OC-N signal. Logical object
names or industry-standard terms are used within the entries as appropriate.

2.2.1 Alarm Logical Objects

Table 2-7 lists all logical alarm objects used in this chapter.

Table 2-7

Alarm Logical Object Type Definitions

Logical Object

Definition

2R

Reshape and retransmit (used for transponder [TXP] cards).

AICI-AEP

Alarm Interface Controller—International/alarm expansion panel. A combination
term that refers to this platform’s AIC-I card.
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Logical Objects

Table 2-7 Alarm Logical Object Type Definitions (continued)

Logical Object Definition

AICI-AIE Alarm Interface Controller-International/Alarm Interface Extension. A
combination term that refers to this platform's AIC-I card.

AIP Alarm Interface Panel.

AOTS Amplified optical transport section.

BITS Building integrated timing supply incoming references (BITS-1, BITS-2).

BPLANE The backplane.

ENVALRM An environmental alarm port.

EQPT A card, its physical objects, and its logical objects as they are located in any of the
eight noncommon card slots. The EQPT object is used for alarms that refer to the
card itself and all other objects on the card including ports, lines, synchronous
transport signals (STS), and virtual tributaries (VT).

ESCON Enterprise System Connection fiber optic technology, referring to the following
TXP cards: TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G,
MXPP_MR_2.5G.

EXT-SREF BITS outgoing references (SYNC-BITS1, SYNC-BITS2).

FAN Fan-tray assembly.

FC Fibre channel data transfer architecture, referring to the following muxponder
(MXP) or TXP cards: MXP_MR_2.5G, MXPP_MR_2.5G, MXP_MR_10DME_C,
MXP_MR_10DME_L, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, GE_XP, 10GE_XP, ADM-10G, and
OTU2_XP.

GE Gigabit Ethernet, referring to the following MXP or TXP cards: MXP_MR_2.5G,
MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10G,
TXP_MR_10E,TXP_MR_10E_C, TXP_MR_10E_L, MXP_MR_10DME_C,
MXP_MR_10DME_L, GE-XP, 10GE-XP, ADM-10G, and OTU2_XP.

ISC Inter-service channel, referring to TXPP_MR_2.5G or TXP_MR_2.5G cards.

NE The entire network element.

NE-SREF The timing status of the NE.

OCH The optical channel, referring to dense wavelength division multiplexing (DWDM)
cards.

OCH-TERM The optical channel termination node, referring to DWDM cards.

The network element reports alarms or conditions on ingress ports of the card.
Alarms detected at the internal ports (TERM side) will be ingress mapped to the
MON side. The alarm profile entities of OCH-TERM, if available, should be
changed to the same severity as the customized severity for a specific OCH-TERM
alarm.

OCHNC-CONN The optical channel network connection, referring to DWDM cards.

oMs Optical multiplex section.

0SC-RING Optical service channel ring.

0TS Optical transport section.

PPM Pluggable port module (PPM, also called SFP), referring to MXP and TXP cards.
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Table 2-7 Alarm Logical Object Type Definitions (continued)

Logical Object Definition

PWR Power equipment.
SHELF The shelf assembly.
STSMON STS alarm detection at the monitor point (upstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of STSMON, if
available, should be changed to the same severity as the customized severity
for a specific STS alarm.

STSTRM STS alarm detection at termination (downstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of STSTRM, if
available, should be changed to the same severity as the customized severity
for a specific STS alarm.

TRUNK The optical or DWDM card carrying the high-speed signal; referring to MXP or
TXP cards.
VT-MON VT1 alarm detection at the monitor point (upstream from the cross-connect).

Note The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of VI-MON, if
available, should be changed to the same severity as the customized severity
for a specific VT alarm.

2.2.2 Alarm List by Logical Object Type

Note

Note

Table 2-8 lists all Release 8.5 DWDM alarms and logical objects as they are given in the system alarm
profile. The list entries are organized by logical object name and then by alarm or condition name. Where
appropriate, the alarm entries also contain troubleshooting procedures.

In a mixed network containing different types of nodes (for example, ONS 15310-CL, ONS 15454, and
ONS 15600), the initially displayed alarm list in the node view (single-shelf mode) or shelf view
(multishelf mode) Provisioning > Alarm Profiles tabs > Alarm Profile Editor tab lists all conditions that
are applicable to all nodes in the network. However, when you load the default severity profile from a
node, only applicable alarms will display severity levels. Nonapplicable alarms can display “use default”
or “unset.”

In some cases this list does not follow alphabetical order, but it does reflect the order shown in CTC.
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Table 2-8 Alarm List by Logical Object in Alarm Profile

2R: ALS (NA) GE: SQUELCHED (NA) POS: ENCAP-MISMATCH-P (CR)
2R: AS-CMD (NA) GE: SYNCLOSS (MJ) POS: FORCED-REQ (NA)

2R: AS-MT (NA) GE: WKSWPR (NA) POS: GFP-CSF (MJ)

2R: FAILTOSW (NA) GE: WTR (NA) POS: GFP-LFD (MJ)

2R: FORCED-REQ-SPAN (NA) GFP-FAC: GFP-CSF (MJ) PPM: AS-CMD (NA)

2R: HI-LASERBIAS (MN) GFP-FAC: GFP-LFD (MJ) PPM: AS-MT (NA)

2R: HI-RXPOWER (MN) GFP-FAC: GFP-UP-MISMATCH (MJ) |PPM: EQPT (CR)

2R: HI-TXPOWER (MN) ISC: ALS (NA) PPM: HI-LASERBIAS (MN)
2R: LO-RXPOWER (MN) ISC: AS-CMD (NA) PPM: HI-LASERTEMP (MN)
2R: LO-TXPOWER (MN) ISC: AS-MT (NA) PPM: HI-TXPOWER (MN)

2R: LOCKOUT-REQ (NA) ISC: CARLOSS (MJ) PPM: IMPROPRMVL (CR)

2R: LOS (CR) ISC: FAILTOSW (NA) PPM: LO-LASERBIAS (MN)
2R: MANUAL-REQ-SPAN (NA) ISC: FORCED-REQ-SPAN (NA) PPM: LO-LASERTEMP (MN)
2R: SQUELCHED (NA) ISC: GE-OOSYNC (CR) PPM: LO-TXPOWER (MN)
2R: WKSWPR (NA) ISC: HI-LASERBIAS (MN) PPM: MEA (CR)

2R: WTR (NA) ISC: HI-RXPOWER (MN) PPM: MFGMEM (CR)
AICI-AEP: EQPT (CR) ISC: HI-TXPOWER (MN) PPM: NON-CISCO-PPM (MN)
AICI-AEP: MFGMEM (CR) ISC: LO-RXPOWER (MN) PPM: PROV-MISMATCH (MN)
AICI-AIE: EQPT (CR) ISC: LO-TXPOWER (MN) PPM: UNQUAL-PPM (NR)
AICI-AIE: MFGMEM (CR) ISC: LOCKOUT-REQ (NA) PWR: AS-CMD (NA)

AIP: INVMACADR (MJ) ISC: LOS (CR) PWR: BAT-FAIL (MJ)

AIP: MEA (CR) ISC: LPBKFACILITY (NA) PWR: EHIBATVG (MJ)

AIP: MFGMEM (CR) ISC: LPBKTERMINAL (NA) PWR: ELWBATVG (MJ)
AOTS: ALS (NA) ISC: MANUAL-REQ-SPAN (NA) PWR: HIBATVG (MJ)

AOTS: AMPLI-INIT (NA) ISC: OUT-OF-SYNC (NA) PWR: LWBATVG (MJ)

AOTS: APC-CORR-SKIPPED (MN) ISC: SIGLOSS (MJ) PWR: VOLT-MISM (NA)
AOTS: APC-DISABLED (MN) ISC: SQUELCHED (NA) SHELF: APC-DISABLED (MN)
AOTS: APC-OUT-OF-RANGE (MN) ISC: SYNCLOSS (MJ) SHELF: AS-CMD (NA)

AOTS: APC-WRONG-GAIN (NA) ISC: WKSWPR (NA) SHELF: AS-MT (NA)

AOTS: AS-CMD (NA) ISC: WTR (NA) SHELF: DUP-SHELF-ID (MJ)
AOTS: AS-MT (NA) ML100T: GFP-CSF (MJ) SHELF: MEA (MJ)

AOTS: CASETEMP-DEG (MN) ML100T: GFP-LFD (MJ) SHELF: SHELF-COMM-FAIL (MJ)
AOTS: FIBERTEMP-DEG (MN) ML100T: GFP-UP-MISMATCH (MJ) STMI1E: MS-AIS (NR)

AOTS: GAIN-HDEG (MN) ML1000: GFP-CSF (MJ) STMI1E: MS-DEG (NA)

AOTS: GAIN-HFAIL (CR) ML1000: GFP-LFD (MJ) STMI1E: MS-EXC (NA)

AOTS: GAIN-LDEG (MN) ML1000: GFP-UP-MISMATCH (MJ) STMI1E: MS-RFI (NR)

AOTS: GAIN-LFAIL (CR) MLMR: GFP-CSF (MJ) STMI1E: SD-L (NA)
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Table 2-8

Alarm List by Logical Object in Alarm Profile (continued)

AOTS: LASER-APR (NA)

MLMR: GFP-LFD (MJ)

STMIE: SF-L (NA)

AOTS: LASERBIAS-DEG (MN)

MLMR: GFP-UP-MISMATCH (MJ)

STMN:

APSB (MN)

AOTS: LASERBIAS-FAIL (MJ)

NE-SREF: FRCDSWTOINT (NA)

STMN:

APSC-IMP (MN)

AOTS: LASERTEMP-DEG (MN)

NE-SREF: FRCDSWTOPRI (NA)

STMN:

APSCDFLTK (MN)

AOTS: OPWR-HDEG (MN) NE-SREF: FRCDSWTOSEC (NA) STMN: APSCINCON (MN)

AOTS: OPWR-HFAIL (CR) NE-SREF: FRCDSWTOTHIRD (NA)  |STMN: APSCM (MN)

AOTS: OPWR-LDEG (MN) NE-SREF: FRNGSYNC (NA) STMN: APSCNMIS (MJ)

AOTS: OPWR-LFAIL (CR) NE-SREF: FSTSYNC (NA) STMN: APSMM (MN)

AOTS: OSRION (NA) NE-SREF: HLDOVRSYNC (NA) STMN: AUTOLSROFF (CR)

AOTS: PARAM-MISM (NA) NE-SREF: MANSWTOINT (NA) STMN: FE-FRCDWKSWBK-SPAN
(NA)

AOTS: VOA-HDEG (MN) NE-SREF: MANSWTOPRI (NA) STMN: FE-FRCDWKSWPR-SPAN
(NA)

AOTS: VOA-HFAIL (CR) NE-SREF: MANSWTOSEC (NA) STMN: FE-MANWKSWBK-SPAN
(NA)

AOTS: VOA-LDEG (MN) NE-SREF: MANSWTOTHIRD (NA) STMN: FE-MANWKSWPR-SPAN
(NA)

AOTS: VOA-LFAIL (CR) NE-SREF: SSM-LNC (NA) STMN: FEPRLF (MN)

BITS: AIS (NR) NE-SREF: SSM-PRC (NA) STMN: HELLO (MN)

BITS: BPV (MN) NE-SREF: SSM-PRS (NA) STMN: ISIS-ADJ-FAIL (MN)

BITS: HI-CCVOLT (NA) NE-SREF: SSM-RES (NA) STMN: LASEREOL (MN)

BITS: LOF (MN) NE-SREF: SSM-SDH-TN (NA) STMN: LOCKOUT-REQ (NA)

BITS: LOS (MN) NE-SREF: SSM-SETS (NA) STMN:

MANWKSWBK-NO-TRFSW (NA)

BITS: SSM-DUS (NA) NE-SREF: SSM-SMC (NA) STMN: MANWKSWPR-NO-TRESW
(NA)

BITS: SSM-FAIL (MN) NE-SREF: SSM-ST2 (NA) STMN: MS-AIS (NR)

BITS: SSM-LNC (NA) NE-SREF: SSM-ST3 (NA) STMN: MS-DEG (NA)

BITS: SSM-OFF (NA) NE-SREF: SSM-ST3E (NA) STMN: MS-EOC (MN)

BITS: SSM-PRC (NA) NE-SREF: SSM-ST4 (NA) STMN: MS-EXC (NA)

BITS: SSM-PRS (NA) NE-SREF: SSM-STU (NA) STMN: MS-RFI (NR)

BITS: SSM-RES (NA) NE-SREF: SSM-TNC (NA) STMN: RS-EOC

BITS: SSM-SDH-TN (NA) NE-SREF: SWTOPRI (NA) STMN: RS-TIM

BITS: SSM-SETS (NA)

NE-SREF: SWTOSEC (NA)

STSMON: AIS-P (NR)

BITS: SSM-SMC (NA)

NE-SREF: SWTOTHIRD (NA)

STSMON: AUTOSW-AIS (NR)

BITS: SSM-ST2 (NA)

NE-SREF: SYNCPRI (MJ)

STSMON: AUTOSW-LOP (NA)

BITS: SSM-ST3 (NA)

NE-SREF: SYNCSEC (MN)

STSMON: AUTOSW-PDI (NA)

BITS: SSM-ST3E (NA)

NE-SREF: SYNCTHIRD (MN)

STSMON: AUTOSW-SDBER (NA)

BITS: SSM-ST4 (NA)

NE: APC-DISABLED (MN)

STSMON: AUTOSW-SFBER (NA)
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

BITS: SSM-STU (NA) NE: APC-END (NA) STSMON: AUTOSW-UNEQ (NA)

BITS: SSM-TNC (NA) NE: AS-CMD (NA) STSMON: ERFI-P-CONN (NR)

BITS: SYNC-FREQ (NA) NE: AUD-LOG-LOSS (NA) STSMON: ERFI-P-SRVR (NR)

BPLANE: AS-CMD (NA) NE: AUD-LOG-LOW (NA) STSMON: FAILTOSW-PATH (NA)

BPLANE: MFGMEM (CR) NE: DATAFLT (MN) STSMON: FORCED-REQ (NA)

CE100T: GFP-CSF (MJ) NE: DBOSYNC (MJ) STSMON: LOCKOUT-REQ (NA)

CE100T: GFP-LFD (MJ) NE: DUP-IPADDR (MN) STSMON: LOP-P (CR)

CE100T: GFP-UP-MISMATCH (MJ) NE: DUP-NODENAME (MN) STSMON: LPBKCRS (NA)

CE1000: GFP-CSF (MJ) NE: ETH-LINKLOSS (NA) STSMON: PDI-P (NA)

CE1000: GFP-LFD (MJ) NE: HITEMP (CR) STSMON: RFI-P (NA)

CE1000: GFP-UP-MISMATCH (MJ) NE: I-HITEMP (CR) STSMON: SD-P (NA)

CEMR: GFP-CSF (MJ) NE: INTRUSION-PSWD (NA) STSMON: SF-P (NA)

CEMR: GFP-LFD (M1J) NE: LAN-POL-REV (NA) STSMON: TIM-P (NA)

CEMR: GFP-UP-MISMATCH (MJ) NE: SNTP-HOST (MN) STSMON: UNEQ-P (CR)

ENVALRM: EXT (MN) NE: SYSBOOT (MJ) STSTRM: AIS-P (NR)

EQPT: ALS-DISABLED (NA) NE: TEMP-MISM (NA) STSTRM: AS-MT-O0G (NA)

EQPT: APC-DISABLED (MN) OCH-TERM: FDI (NA) STSTRM: ENCAP-MISMATCH-P
(CR)

EQPT: AS-CMD (NA) OCH-TERM: OCHTERM-INC (NA) STSTRM: ERFI-P-CONN (NR)

EQPT: AS-MT (NA) OCH-TERM: OPWR-HDEG (MN) STSTRM: ERFI-P-SRVR (NR)

EQPT: AUTORESET (MN) OCH-TERM: OPWR-LDEG (MN) STSTRM: LOP-P (CR)

EQPT: BKUPMEMP (CR) OCH-TERM: OPWR-LFAIL (CR) STSTRM: PDI-P (NA)

EQPT: CARLOSS (MJ) OCH-TERM: PARAM-MISM (NA) STSTRM: RFI-P (NA)

EQPT: CLDRESTART (NA) STSTRM: SD-P (NA)

EQPT: CONTBUS-DISABLED (CR) STSTRM: SF-P (NA)

EQPT: CONTBUS-IO-A (CONTBUS-A) STSTRM: TIM-P (NA)

(MN)

EQPT: CONTBUS-IO-B (CONTBUS-B) STSTRM: UNEQ-P (CR)

(MN)

EQPT: CTNEQPT-MISMATCH (NA)  |OCH: APC-CORR-SKIPPED (MN) TRUNK: AIS (NR)
EQPT: DIAG (CR) OCH: APC-DISABLED (MN) TRUNK: AIS-L (NR)

EQPT: EQPT (CR) OCH: APC-OUT-OF-RANGE (MN) TRUNK: ALS (NA)

EQPT: EXCCOL (MN) OCH: AS-CMD (NA) TRUNK: AS-CMD (NA)

EQPT: FAILTOSW (NA) OCH: AS-MT (NA) TRUNK: AS-MT (NA)

EQPT: FAPS-CONFIG-MISMATCH OCH: FDI (NA) TRUNK: CARLOSS (MJ)

(MN)

EQPT: FORCED-REQ (NA) OCH: LOS-0O (MN) TRUNK: DSP-COMM-FAIL (MJ)
EQPT: FP-LINK-LOSS (MN) OCH: LOS-P (CR) TRUNK: DSP-FAIL (MJ)
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)

EQPT: FTA-MISMATCH (NA) OCH: OPWR-HDEG (MN) TRUNK: EOC (MN)

EQPT: HI-LASERBIAS (MN) OCH: OPWR-HFAIL (CR) TRUNK: EOC-L (MN)

EQPT: HI-LASERTEMP (MN) OCH: OPWR-LDEG (MN) TRUNK: FAILTOSW (NA)

EQPT: HI-TXPOWER (MN) OCH: OPWR-LFAIL (CR) TRUNK: FAPS (NA)

EQPT: HITEMP (MN) OCH: PARAM-MISM (NA) TRUNK: FC-NO-CREDITS (MJ)

EQPT: IMPROPRMVL (CR) OCH: PORT-FAIL (CR) TRUNK: FEC-MISM (MJ)

EQPT: INHSWPR (NA) OCH: TRAIL-SIGNAL-FAIL (NA) TRUNK: FORCED-REQ-SPAN (NA)

EQPT: INHSWWKG (NA) OCH: VOA-HDEG (MN) TRUNK: GCC-EOC (MN)

EQPT: LO-LASERBIAS (MN) OCH: VOA-HFAIL (CR) TRUNK: GE-OOSYNC (CR)

EQPT: LO-LASERTEMP (MN) OCH: VOA-LDEG (MN) TRUNK: HELLO (MN)

EQPT: LO-TXPOWER (MN) OCH: VOA-LFAIL (CR) TRUNK: HI-LASERBIAS (MN)

EQPT: LOCKOUT-REQ (NA) OCHNC-CONN: OCHNC-INC (NA) TRUNK: HI-RXPOWER (MN)

EQPT: MAN-REQ (NA) OCN: AIS-L (NR) TRUNK: HI-TXPOWER (MN)

EQPT: MANRESET (NA) OCN: ALS (NA) TRUNK: ILK-FAIL (CR)

EQPT: MEA (CR) OCN: APS-INV-PRIM (MN) TRUNK: ISIS-ADJ-FAIL (MN)

EQPT: MEM-GONE (M1J) OCN: APS-PRIM-FAC (NA) TRUNK: LO-RXPOWER (MN)

EQPT: MEM-LOW (MN) OCN: APS-PRIM-SEC-MISM (MN) TRUNK: LO-TXPOWER (MN)

EQPT: OPEN-SLOT (NA) OCN: APSB (MN) TRUNK: LOCKOUT-REQ (NA)

EQPT: PEER-NORESPONSE (MJ) OCN: APSC-IMP (MN) TRUNK: LOF (CR)

EQPT: PROTNA (MN) OCN: APSCDFLTK (MN) TRUNK: LOM (CR)

EQPT: PWR-FAIL-A (MN) OCN: APSCINCON (MN) TRUNK: LOS (CR)

EQPT: PWR-FAIL-B (MN) OCN: APSCM (MN) TRUNK: LOS-P (CR)

EQPT: PWR-FAIL-RET-A (MN) OCN: APSCNMIS (MJ) TRUNK: LPBKFACILITY (NA)

EQPT: PWR-FAIL-RET-B (MN) OCN: APSIMP (MN) TRUNK: LPBKTERMINAL (NA)

EQPT: RS-EOC (MN) OCN: APSMM (MN) TRUNK: MANUAL-REQ-SPAN
(NA)

EQPT: RS-TIM (CR) OCN: AS-CMD (NA) TRUNK: ODUK-1-AIS-PM (NR)

EQPT: RUNCFG-SAVENEED (NA) OCN: AS-MT (NA) TRUNK: ODUK-2-AIS-PM (NR)

EQPT: SFTWDOWN (MN) OCN: AUTOLSROFF (CR) TRUNK: ODUK-3-AIS-PM (NR)

EQPT: SW-MISMATCH (NA) OCN: CHANLOSS (NA) TRUNK: ODUK-4-AIS-PM (NR)

EQPT: UNEQ-P (CR) OCN: EOC (MN) TRUNK: ODUK-AIS-PM (NR)

EQPT: VOA-DISABLED (CR) OCN: EOC-L (MN) TRUNK: ODUK-BDI-PM (NR)

EQPT: WKSWBK (NA) OCN: FAILTOSW (NA) TRUNK: ODUK-LCK-PM (NR)

EQPT: WKSWPR (NA) OCN: FE-FRCDWKSWBK-SPAN (NA) |TRUNK: ODUK-OCI-PM (NR)

EQPT: WORK-QUEUE-FULL (NA) OCN: FE-FRCDWKSWPR-SPAN (NA) |TRUNK: ODUK-SD-PM (NA)

EQPT: WTR (NA) OCN: FE-MANWKSWBK-SPAN (NA) |TRUNK: ODUK-SF-PM (NA)

ESCON: ALS (NA)

OCN:

FE-MANWKSWPR-SPAN (NA)

TRUNK:

ODUK-TIM-PM (MJ)
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Table 2-8 Alarm List by Logical Object in Alarm Profile (continued)
ESCON: AS-CMD (NA) OCN: FEPRLF (MN) TRUNK: OTUK-AIS (NR)
ESCON: AS-MT (NA) OCN: FORCED-REQ-SPAN (NA) TRUNK: OTUK-BDI (NR)
ESCON: FAILTOSW (NA) OCN: FRCDWKSWBK-NO-TRFSW TRUNK: OTUK-IAE (MN)
(NA)
ESCON: FORCED-REQ-SPAN (NA) OCN: FRCDWKSWPR-NO-TRFSW TRUNK: OTUK-LOF (CR)
(NA)
ESCON: HI-LASERBIAS (MN) OCN: HELLO (MN) TRUNK: OTUK-SD (NA)
ESCON: HI-RXPOWER (MN) OCN: HI-LASERBIAS (MN) TRUNK: OTUK-SF (NA)
ESCON: HI-TXPOWER (MN) OCN: HI-LASERTEMP (MN) TRUNK: OTUK-TIM (CR)
ESCON: LO-RXPOWER (MN) OCN: HI-RXPOWER (MN) TRUNK: OUT-OF-SYNC (MJ)
ESCON: LO-TXPOWER (MN) OCN: HI-TXPOWER (MN) TRUNK: PROV-MISMATCH (MJ)
ESCON: LOCKOUT-REQ (NA) OCN: ISIS-ADJ-FAIL (MN) TRUNK: PTIM (MJ)
ESCON: LOS (CR) OCN: LASEREOL (MN) TRUNK: RFI (NR)
ESCON: LPBKFACILITY (NA) OCN: LOCKOUT-REQ (NA) TRUNK: RFI-L (NR)
ESCON: LPBKTERMINAL (NA) OCN: LO-LASERBIAS (MN) TRUNK: SD (NA)
ESCON: MANUAL-REQ-SPAN (NA) OCN: LO-LASERTEMP (MN) TRUNK: SD-L (NA)
ESCON: SIGLOSS (MJ) OCN: LO-RXPOWER (MN) TRUNK: SF (NA)
ESCON: SQUELCHED (NA) OCN: LO-TXPOWER (MN) TRUNK: SF-L (NA)
ESCON: WKSWPR (NA) OCN: MANUAL-REQ-SPAN (NA) TRUNK: SIGLOSS (MJ)
ESCON: WTR (NA) OCN: MANWKSWBK-NO-TRFSW TRUNK: SQUELCHED (NA)
(NA)
EXT-SREF: FRCDSWTOPRI (NA) OCN: MANWKSWPR-NO-TRFSW TRUNK: SSM-DUS (NA)
(NA)
EXT-SREF: FRCDSWTOSEC (NA) OCN: RFI-L (NA) TRUNK: SSM-FAIL (MN)
EXT-SREF: FRCDSWTOTHIRD (NA) |OCN: SD-L (NA) TRUNK: SSM-LNC (NA)
EXT-SREF: MANSWTOPRI (NA) OCN: SF-L (NA) TRUNK: SSM-OFF (NA)
EXT-SREF: MANSWTOSEC (NA) OCN: SQUELCHED (NA) TRUNK: SSM-PRC (NA)
EXT-SREF: MANSWTOTHIRD (NA) OCN: TIM-S (CR) TRUNK: SSM-PRS (NA)
EXT-SREF: SWTOPRI (NA) OMS: APC-DISABLED (MN) TRUNK: SSM-RES (NA)
EXT-SREF: SWTOSEC (NA) OMS: APC-CORR-SKIPPED (MN) TRUNK: SSM-SDH-TN (NA)
EXT-SREF: SWTOTHIRD (NA) OMS: APC-OUT-OF-RANGE (MN) TRUNK: SSM-SETS (NA)
EXT-SREF: SYNCPRI (MN) OMS: AS-CMD (NA) TRUNK: SSM-SMC (NA)
EXT-SREF: SYNCSEC (MN) OMS: AS-MT (NA) TRUNK: SSM-ST2 (NA)
EXT-SREF: SYNCTHIRD (MN) OMS: LOS-O (MN) TRUNK: SSM-ST3 (NA)
FAN: EQPT-MISS (CR) OMS: LOS-P (CR) TRUNK: SSM-ST3E (NA)
FAN: FAN (CR) OMS: OPWR-HDEG (MN) TRUNK: SSM-ST4 (NA)
FAN: MEA (CR) OMS: OPWR-HFAIL (CR) TRUNK: SSM-STU (NA)
FAN: MFGMEM (CR) OMS: OPWR-LDEG (MN) TRUNK: SSM-TNC (NA)
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Table 2-8

Alarm List by Logical Object in Alarm Profile (continued)

FC: ALS (NA)

OMS: OPWR-LFAIL (CR)

TRUNK: SYNC-FREQ (NA)

FC: AS-CMD (NA)

OMS: PARAM-MISM (NA)

TRUNK: SYNCLOSS (MJ)

FC: AS-MT (NA)

OMS: PMI (NA)

TRUNK: TIM (CR)

FC: CARLOSS (MJ)

OMS: VOA-HDEG (MN)

TRUNK: TIM-MON (MN)

FC: FAILTOSW (NA)

OMS: VOA-HFAIL (CR)

TRUNK: TRAIL-SIGNAL-FAIL
(NA)

FC: FC-NO-CREDITS (MJ)

OMS: VOA-LDEG (MN)

TRUNK: UNC-WORD (NA)

FC: FORCED-REQ-SPAN (NA)

OMS: VOA-LFAIL (CR)

TRUNK: UT-COMM-FAIL (MJ)

FC: GE-OOSYNC (CR)

OSC-RING: RING-ID-MIS (MJ)

TRUNK: UT-FAIL (MJ)

FC: HI-LASERBIAS (MN)

OTS: APC-CORR-SKIPPED (MN)

TRUNK: WTR (NA)

FC: HI-RXPOWER (MN)

OTS: APC-DISABLED (MN)

TRUNK: WVL-MISMATCH (MJ)

FC: HI-TXPOWER (MN)

OTS: APC-OUT-OF-RANGE (MN)

VCMON-HP: AU-AIS (NR)

FC: LO-RXPOWER (MN)

OTS: AS-CMD (NA)

VCMON-HP: AU-LOP (NA)

FC: LO-TXPOWER (MN)

OTS: AS-MT (NA)

VCMON-HP: AUTOSW-AIS-SNCP
(NR)

FC: LOCKOUT-REQ (NA)

OTS: AWG-DEG (MN)

VCMON-HP: AUTOSW-LOP-SNCP
(NA)

FC: LPBKFACILITY (NA)

OTS: AWG-FAIL (CR)

VCMON-HP: AUTOSW-PDI-SNCP
(NA)

FC: LPBKTERMINAL (NA) OTS: AWG-OVERTEMP (CR) VCMON-HP:
AUTOSW-SDBER-SNCP (NA)
FC: MANUAL-REQ-SPAN (NA) OTS: AWG-WARM-UP (NA) VCMON-HP:
AUTOSW-SFBER-SNCP (NA)
FC: OUT-OF-SYNC (MJ) OTS: DCU-LOSS-FAIL (MN) VCMON-HP:

AUTOSW-UNEQ-SNCP (NA)

FC: SIGLOSS (MJ)

OTS: FAILTOSW (NA)

VCMON-HP: FAILTOSW-HO (NA)

FC: SQUELCHED (NA)

OTS: FORCED-REQ-SPAN (NA)

VCMON-HP: FORCED-REQ (NA)

FC: SYNCLOSS (MJ)

OTS: LASERBIAS-DEG (MN)

VCMON-HP: HP-DEG (NA)

FC: WKSWPR (NA)

OTS: LOS (CR)

VCMON-HP: HP-EXC (NA)

FC: WTR (NA)

OTS: LOS-O (MN)

VCMON-HP: HP-PLM (CR)

FCMR: GFP-CSF (MJ)

OTS: LOS-P (CR)

VCMON-HP: HP-RFI (NR)

FCMR: GFP-LFD (MJ)

OTS: LOS-RAMAN (CR)

VCMON-HP: HP-TIM (MN)

FCMR: GFP-UP-MISMATCH (M1J)

OTS: LOCKOUT-REQ (NA)

VCMON-HP: HP-UNEQ (CR)

GE: ALS (NA)

OTS: MANUAL-REQ-SPAN (NA)

VCMON-HP: LOCKOUT-REQ (NA)

GE: AS-CMD (NA)

OTS: MT-OCHNC (NA)

VCMON-HP: LPBKCRS (NA)

GE: AS-MT (NA)

OTS: OPWR-HDEG (MN)

VCMON-HP: SFBER-EXCEED-HO
(NA)

GE: CARLOSS (MJ)

OTS: OPWR-HFAIL (CR)

VCMON-LP: AUTOSW-AIS-SNCP
(NR)
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Table 2-8

Alarm List by Logical Object in Alarm Profile (continued)

Trouble Characterizations

GE:

FAILTOSW (NA)

OTS: OPWR-LDEG (MN)

VCMON-LP: AUTOSW-LOP-SNCP
(NA)

GE:

FORCED-REQ-SPAN (NA)

OTS: OPWR-LFAIL (CR)

VCMON-LP:
AUTOSW-UNEQ-SNCP (NA)

GE: GE-OOSYNC (CR) OTS: OSRION (NA) VCMON-LP: FORCED-REQ (NA)

GE: HI-LASERBIAS (MN) OTS: PARAM-MISM (NA) VCMON-LP: LOCKOUT-REQ (NA)

GE: HI-RXPOWER (MN) OTS: PMI (NA) VCTRM-HP: AS-MT-00G (NA)

GE: HI-TXPOWER (MN) OTS: PWR-PROT-ON (MJ) VCTRM-HP: AU-AIS (NR)

GE: LMP-FAIL (MN) OTS: RLS (NA) VCTRM-HP: AU-LOP (CR)

GE: LMP-SD (MN) OTS: SH-IL-VAR-DEG-HIGH (MN) VCTRM-HP: HP-DEG (NA)

GE: LMP-SF (MN) OTS: SH-IL-VAR-DEG-LOW (MN) VCTRM-HP:
HP-ENCAP-MISMATCH (CR)

GE: LMP-UNALLOC (NA) OTS: SHUTTER-OPEN (NA) VCTRM-HP: HP-EXC (NA)

GE:

LO-RXPOWER (MN)

OTS: SPAN-NOT-MEASURED (NA)

VCTRM-HP: HP-PLM (CR)

GE:

LO-TXPOWER (MN)

OTS: SPANLEN-OUT-OF-RANGE
(MN)

VCTRM-HP: HP-TIM (CR)

GE:

LOCKOUT-REQ (NA)

OTS: VOA-HDEG (MN)

VCTRM-HP: HP-UNEQ (CR)

GE:

LPBKFACILITY (NA)

OTS: VOA-HFAIL (CR)

VCTRM-HP: SFBER-EXCEED-HO
(NA)

GE:

LPBKTERMINAL (NA)

OTS: VOA-LDEG (MN)

VCTRM-LP: AS-MT-O0G (NA)

GE:

MANUAL-REQ-SPAN (NA)

OTS: VOA-LFAIL (CR)

VCTRM-LP: SFBER-EXCEED-HO
(NA)

GE:

OUT-OF-SYNC (MJ)

OTS: WKSWBK (NA)

GE:

SIGLOSS (MJ)

OTS: WKSWPR (NA)

2.3 Trouble Characterizations

The ONS DWDM system reports trouble by utilizing standard alarm and condition characteristics,
standard severities following the rules in Telcordia GR-253-CORE, and graphical user interface (GUI)
state indicators.These notifications are described in the following paragraphs.

The ONS System uses standard Telcordia categories to characterize levels of trouble. The system reports
trouble notifications as alarms and status or descriptive notifications (if configured to do so) as
conditions in the CTC Alarms window. Alarms typically signify a problem that the user needs to remedy,
such as a loss of signal. Conditions do not necessarily require troubleshooting.

Note  Unless otherwise specified in this chapter, “ONS 15454 refers to both ANSI and ETSI versions of the

platform.

Note  For a description of CTC-view terminology, refer to the “Cisco Transport Controller Operation” chapter
in the Cisco ONS 15454 DWDM Reference Manual.
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2.3.1 Alarm Characteristics

The ONS DWDM system uses standard alarm entities to identify what is causing trouble. All alarms
stem from hardware, software, environment, or operator-originated problems whether or not they affect
service. Current alarms for the network, CTC session, node, or card are listed in the Alarms tab. (In
addition, cleared alarms are also found in the History tab.)

2.3.2 Condition Characteristics

Note

2.3.3 Severity

Conditions include any problem detected on an ONS DWDM shelf. They can include standing or
transient notifications. A snapshot of all current raised, standing conditions on the network, node, or card
can be retrieved in the CTC Conditions window or using TL1's set of RTRV-COND commands. (In
addition, some but not all cleared conditions are also found in the History tab.)

For a comprehensive list of all conditions, refer to the Cisco ONS SONET TL1 Command Guide. For
information about transients, see Chapter 3, “Transient Conditions.”

When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms
on that entity. You can retrieve alarms and events on the Conditions tab. You can change this behavior
for the LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set
the NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT to TRUE on the NE Defaults tab.

The ONS DWDM system uses Telcordia-devised standard severities for alarms and conditions:
Critical (CR), Major (MJ), Minor (MN), Not Alarmed (NA) and Not Reported (NR). These are
described below:

e A Critical (CR) alarm generally indicates severe, Service-Affecting (SA) trouble that needs
immediate correction. Loss of traffic on an STS-1, which can hold 28 DS-1 circuits, would be a
Critical (CR), Service-Affecting (SA) alarm.

e A Major (MJ) alarm is a serious alarm, but the trouble has less impact on the network. For example,
loss of traffic on more than five DS-1 circuits is Critical (CR), but loss of traffic on one to four DS-1
circuits is Major (MJ).

e Minor (MN) alarms generally are those that do not affect service. For example, the automatic
protection switching (APS) byte failure (APSB) alarm indicates that line terminating equipment
(LTE) detects a byte failure on the signal that could prevent traffic from properly executing a traffic
switch.

e Not Alarmed (NA) conditions are information indicators, such as for free-run synchronization state
(FRNGSYNC) or a forced-switch to primary (FRCSWTOPRI) timing event. They could or could
not require troubleshooting, as indicated in the entries.

¢ Not Reported (NR) conditions occur as a secondary result of another event. For example, the alarm
indication signal (AIS), with severity NR, is inserted by a downstream node when an LOS (CR or
MJ) alarm occurs upstream. These conditions do not in themselves require troubleshooting, but are
to be expected in the presence of primary alarms.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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Severities can be customized for an entire network or for single nodes, from the network level down to
the port level by changing or downloading customized alarm profiles. These custom severities are
subject to the standard severity-demoting rules given in Telcordia GR-474-CORE. Procedures for
customizing alarm severities are located in the “Manage Alarms” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

2.3.4 Service Effect

2.3.5 State

Service-Affecting (SA) alarms—those that interrupt service—could be Critical (CR), Major (MJ), or
Minor (MN) severity alarms. Service-Affecting (SA) alarms indicate service is affected.
Non-Service-Affecting (NSA) alarms always have a Minor (MN) default severity.

The Alarms or History tab State (ST) column indicate the disposition of the alarm or condition as
follows:

e A raised (R) event is one that is active.
e A cleared (C) event is one that is no longer active.

e A transient (T) event is one that is automatically raised and cleared in CTC during system changes
such as user login, logout, loss of connection to node/shelf view, etc. Transient events do not require
user action. These are listed in Chapter 3, “Transient Conditions.”

2.4 Safety Summary

A

This section covers safety considerations designed to ensure safe operation of the ONS DWDM system.
Personnel should not perform any procedures in this chapter unless they understand all safety
precautions, practices, and warnings for the system equipment. Some troubleshooting procedures
require installation or removal of cards; in these instances users should pay close attention to the
following caution.

Caution

>

Warning

>

Hazardous voltage or energy could be present on the backplane when the system is operating. Use
caution when removing or installing cards.

Some troubleshooting procedures require installation or removal of OC-192 cards; in these instances
users should pay close attention to the following warnings.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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A

Warning

A

Warning

A

Warning

A

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Class 1 laser product. Statement 1008

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Warning

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

2.5 Trouble-Clearing Procedures

Note

Note

25.1 AIS

This section list alarms alphabetically and includes some conditions commonly encountered when
troubleshooting alarms. The severity, description, and troubleshooting procedure accompany each alarm
and condition.

When you check the status of alarms for cards, ensure that the alarm filter icon in the lower right corner
of the GUI is not indented. If it is, click it to turn it off. When you are done checking for alarms, you can
click the alarm filter icon again to turn filtering back on. For more information about alarm filtering,
refer to the “Manage Alarms” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

When checking alarms, ensure that alarm suppression is not enabled on the card or port. For more
information about alarm suppression, refer to the “Manage Alarms” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms
on that entity. All alarms and events appear on the Conditions tab. You can change this behavior for the
LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set the
NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT to TRUE on the NE Defaults tab.

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Objects: BITS, FUDC, MSUDC
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The Alarm Indication Signal (AIS) condition indicates that this node is detecting an alarm indication
signal in the incoming signal SONET overhead.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AIS Condition
Step1  Determine whether there are alarms such as LOS on the upstream nodes and equipment or if there are
OOS,MT (or Locked,maintenance), or OOS,DSBLD (or Locked,disabled) ports.
Step2  Clear the upstream alarms using the applicable procedures in this chapter.
Step3  If the condition does not clear, log into the Technical Support Website at

252 AIS-L

Note

http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
logical Objects: OCN, TRUNK

The AIS Line condition indicates that this node is detecting line-level AIS in the incoming signal. This
alarm is secondary to another alarm occurring simultaneously in an upstream node.

This condition can also be raised in conjunction with the “TIM-S” alarm if AIS-L is enabled. (For more
information about the TIM-S alarm, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 Troubleshooting Guide.

ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.

Clear the AIS-L Condition

Step 1
Step 2

253 AIS-P

Complete the “Clear the AIS Condition” procedure on page 2-27.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM
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The AIS Path condition means that this node is detecting AIS in the incoming path. This alarm is
secondary to another alarm occurring simultaneously in an upstream node.

Clear the AIS-P Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-27.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

254 ALS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC, OCN, TRUNK

The Automatic Laser Shutdown (ALS) condition occurs when an amplifier card (OPT-BST, or
OPT-PRE, OPT-AMP-C, or OMP-AMP-17-C) is switched on. The turn-on process lasts approximately
nine seconds, and the condition clears after approximately 10 seconds.

~

Note  ALS is an informational condition and does not require troubleshooting.

255 ALS-DISABLED

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Automatic Laser Shutdown (ALS) condition occurs when a DWDM Optical Preamplifier or Optical
Booster (OPT-BST) Amplifier card’s ALS is changed to Disabled from any other state (such as Enabled)
by user command.

Clear the ALS-DISABLED Condition

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-BST, or OPT-PRE,
OPT-AMP-C, or OMP-AMP-17-C card to display the card view.

Step2  Click the Maintenance > ALS tabs.
Step3  In the ALS Mode column, change the entry from Disabled to your required state.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.6 AMPLI-INIT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Logical Object: AOTS

The Amplifier Initialized condition occurs when an amplifier card (OPT-BST or OPT-PRE) is not able
to calculate gain. This condition typically accompanies the “APC-DISABLED” alarm on page 2-29.

For basic information about amplifier cards, refer to the “Card Reference” chapter of the

Cisco ONS 15454 DWDM Reference Manual. For information abut gain, refer to the “Network
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AMPLI-INIT Condition

Step 1
Step 2

Step 3

Complete the “Delete a Circuit” procedure on page 2-245 on the most recently created circuit.

Recreate this circuit using the procedures in the “Create Channels and Circuits” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

If the condition does not clear, log onto http://www.cisco.com/tac for more information or call TAC
(1-800-553-2447).

2.5.7 APC-CORR-SKIPPED

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS

The Automatic Power Control (APC) Correction Skipped condition occurs when the actual power level
of a DWDM channel exceeds the expected setting by 3 dBm or more. APC compares actual power levels
with previous power levels every hour or after any channel allocation is performed. If the power
difference to be compensated by APC exceeds the range of + 3 dBm or -3 dBm compared with the
previous value set, APC is designed not to correct the level and the APC-CORR-SKIPPED condition is
raised.

For more information about APC, refer to the “Network Reference” chapter in the Cisco ONS 15454
DWDM Reference Manual, and the “1.12.2 System Restart after a Fiber Cut” section on page 1-70.

The APC Correction Skipped alarm strongly limits network management (for example, a new circuit
cannot be turned into IS). The Force APC Correction button helps to restore normal conditions by
clearing the APC Correction Skipped alarm. For more information about the Force APC Correction
button, refer to the “Managing APC” section in “Network Reference” chapter of the Cisco ONS 15454
DWDM Reference Manual.

2.5.8 APC-DISABLED

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: NE, SHELF, AOTS, OTS, OMS, OCH, EQPT

The APC Disabled alarm occurs when the information related to the number of DWDM channels is not
reliable. The condition can occur when any of the following related alarms also occur: the “EQPT” alarm
on page 2-72, the “IMPROPRMVL” alarm on page 2-109, or the “MEA (EQPT)” alarm on page 2-157.
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If the condition occurs with the creation of the first circuit, delete and recreate the circuit. (Refer to the
“Create Channels and Circuits” chapter of the Cisco ONS 15454 DWDM Procedure Guide for
information about this.) For more information about APC, refer to the “Network Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual.

APC Disabled alarm is raised in the following conditions:

e  When you manually disable APC in a given domain to prevent unexpected power regulations during
maintenance or troubleshooting.

e When an anomalous event impacting optical regulation occurs.
APC Disabled alarm is disabled in the following conditions:
e An EQPT alarm raised by any of the MSTP units in any of the domain nodes.
e A MEA alarm raised by any of the MSTP equipped cards in any of the domain nodes.
e An IMPROPRMVL alarm is raised by any of the equipped cards in any of the domain nodes.

e Gain Degrade, Power Degrade, Power Fail Alarm is raised by the output port of any Amplifier in
any of domain nodes.

e A VOA degrade or fail alarm is raised by any by any of the equipped cards in any of the domain
nodes.

¢ Signalling protocol detects that one of the APC instances in any of the domain nodes is no more
reachable

¢ Not all nodes belonging to domain are set in Metro-Core (e.g. one is configured as Not-DWDM).

~

Wte The MEA and IMPROPRMVL alarms does not disable APC when raised on OSCM, OSC-CSM, or
MXP/TXP cards.

Clear the APC-DISABLED Alarm

Step 1 Complete the appropriate procedure to clear the main alarm:
e (Clear the EQPT Alarm, page 2-73
e Clear the IMPROPRMVL Alarm, page 2-110
e Clear the MEA (EQPT) Alarm, page 2-158

Step2  If the condition does not clear, complete the “Delete a Circuit” procedure on page 2-245 and then
recreate it using procedures in the “Create Channels and Circuits” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

25.9 APC-END

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE
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The APC Terminated on Manual Request condition is raised when APC terminates after it is manually
launched from CTC or TL1. APC-END is an informational condition that is raised and cleared
spontaneously by the system and is not visible in the CTC Condition window. It is visible only by
retrieving it in the Conditions or History tabs. For more information about APC, refer to the “Network
Reference” chapter in the Cisco ONS 15454 DWDM Reference Manual.

APC-END is an informational condition and does not require troubleshooting.

25.10 APC-OUT-OF-RANGE

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS

The APC Out of Range condition is raised on amplifier cards (OPT-PRE BST , OPT-BST-L, OPT-PRE,
OPT-AMP-17-C, OPT-AMP-C, OPT-RAMP-C, OPT-AMP-L, and OPT-BST-E); demultiplexer cards
(32-DMX, 40-DMX-C, and 32-DMX-L) having a single variable optical attenuator (VOA); and optical
add/drop multiplexer cards (AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, and AD-4B-xx.x)
when the requested gain or attenuation setpoint cannot be set because it exceeds the port parameter
range. For example, this condition is raised when APC attempts to set the OPT-BST gain higher than
20 dBm (the card’s maximum setpoint) or to set the attenuation on the express VOA lower than 0 dBm
(its minimum setpoint).

A common cause of an amplifier trying to attain a value higher than the maximum setpoint or an
attenuator trying to attain a value lower than the minimum setpoint is the low input power.

For general information about DWDM cards, refer to the “Card Reference” chapter of the

Cisco ONS 15454 DWDM Reference Manual. For more information about APC, refer to the “Network
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the APC-OUT-OF-RANGE Alarm

Step 1

Step 2

There are various root causes for the APC-OUT-OF-RANGE condition. To determine the correct root
cause, complete the network-level troubleshooting procedures and node level problems located in
1.13 Node Level (Intranode) Problems of Chapter 1, “General Troubleshooting.”

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2511 APC-WRONG-GAIN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: AOTS
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The APC-WRONG-GALIN condition is raised on the amplifier card (OMP-AMP-17-C), when the actual
gain of the card (17dB) does not match the expected gain calculated by APC. There is a margin of +1 or
-1 dB before the condition is raised.

S

Note  The APC-WRONG-GAIN condition indicates a system issue and not the card problem.

Clear the APC-WRONG-GAIN Alarm

The condition can be cleared by recovering the power at the input port:

Step1  Check the incoming fiber connection and clean them.

Step2  Check the regulation points (VOA and amplifiers) along the optical path upstream of the
OMP-AMP-17-C card.

Step3  If the condition does not clear, log onto http://www.cisco.com/tac for more information or call TAC
(1-800-553-2447).

25.12 APSB

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN, STMN

The APS Channel Byte Failure alarm occurs when LTE detects protection switching byte failure or an
invalid switching code in the incoming APS signal. Some older SONET not manufactured by Cisco send
invalid APS codes if they are configured in a 1+1 protection group with newer SONET nodes, such as
the ONS 15454. These invalid codes cause an APSB alarm on an ONS 15454.

Clear the APSB Alarm

Step1  Use an optical test set to examine the incoming SONET overhead to confirm inconsistent or invalid
K bytes. For specific procedures to use the test set equipment, consult the manufacturer. If corrupted
K bytes are confirmed and the upstream equipment is functioning properly, the upstream equipment
might not interoperate effectively with the ONS 15454.

Step2  If the alarm does not clear and the overhead shows inconsistent or invalid K bytes, you could need to
replace the upstream cards for protection switching to operate properly. Complete the “Physically
Replace a Card” procedure on page 2-244.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.13 APSCM

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN, STMN
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The APS Channel Mismatch alarm occurs when the ONS 15454 expects a working channel but receives
a protect channel. In many cases, the working and protect channels are crossed and the protect channel
is active. If the fibers are crossed and the working line is active, the alarm does not occur. The APSCM
alarm occurs only on the ONS 15454 when bidirectional protection is used on OC-N cards in a 1+1
protection group configuration. The APSCM alarm does not occur in an optimized 1+1 protection
configuration.

On the ONS 15454 0C-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning  Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057
Clear the APSCM Alarm
Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.

Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1 Verify that the working-card channel fibers are physically connected directly to the adjoining node’s
working-card channel fibers.

Step2  If the fibers are correctly connected, verify that the protection-card channel fibers are physically
connected directly to the adjoining node’s protection-card channel fibers.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.14 APSIMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN, STMN

The APS Invalid Code alarm occurs if a 1+1 protection group is not properly configured at both nodes
to send or receive the correct APS byte. A node that is either configured for no protection or is configured
for path protection or BLSR protection does not send the right K2 APS byte anticipated by a system
configured for 1+1 protection. The 141 protect port monitors the incoming K2 APS byte and raises this
alarm if it does not receive the byte.
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The alarm is superseded by an APSCM or APSMM alarm, but not by an AIS condition. It clears when
the port receives a valid code for 10 ms.

Clear the APSIMP Alarm

Step1  Check the configuration of the other node in the 1+1 protection group. If the far end is not configured
for 1+1 protection, create the group. For procedures, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Step2  If the other end of the group is properly configured or the alarm does not clear after you have provisioned
the group correctly, verify that the working ports and protect ports are cabled correctly.

Step3  Ensure that both protect ports are configured for SONET.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.15 APS-INV-PRIM

Default Severity: Minor (MN), Non-Service Affecting (NSA)
Logical Object: OCN

The Optimized 1+1 APS Primary Facility condition occurs on OC-N cards in an optimized 1+1
protection system if the incoming primary section header does not indicate whether it is primary or
secondary.

Note  APS-INV-PRIM is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

25.16 APSMM

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: STMN

An APS Mode Mismatch failure alarm occurs on OC-N cards when there is a mismatch of the protection
switching schemes at the two ends of the span, such as being bidirectional at one end and unidirectional
at the other. Each end of a span must be provisioned the same way: bidirectional and bidirectional, or
unidirectional and unidirectional. APSMM can also occur if third-party equipment is provisioned as 1:N
and the ONS 15454 is provisioned as 1+1.

If one end is provisioned for 1+1 protection switching and the other is provisioned for path protection
protection switching, an APSMM alarm occurs in the ONS 15454 that is provisioned for 1+1 protection
switching.
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Clear the APSMM Alarm

Step1  For the reporting ONS 15454, display node view and verify the protection scheme provisioning:
a. Click the Provisioning > Protection tabs.
b. Click the 1+1 protection group configured for the OC-N cards.

The chosen protection group is the protection group optically connected (with data communications
channel, or DCC, connectivity) to the far end.

c. Click Edit.
d. Record whether the Bidirectional Switching check box is checked.
Step2  Click OK in the Edit Protection Group dialog box.
Step3  Log into the far-end node and verify that the OC-N 1+1 protection group is provisioned.

Step4  Verify that the Bidirectional Switching check box matches the checked or unchecked condition of the
box recorded in Step 1. If not, change it to match.

Step5  Click Apply.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.17 APS-PRIM-FAC

Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
Logical Object: OCN

The Optimized 1+1 APS Invalid Primary Section condition occurs on OC-N cards in an optimized 1+1
protection system if there is an APS status switch between the primary and secondary facilities to
identify which port is primary.

Note APS-PRIM-FAC is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

Clear the APS-PRIM-FAC Condition

Step 1 This condition clears when the card receives a valid primary section indication (1 or 2).

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.18 APS-PRIM-SEC-MISM

Default Severity: Minor (MN), Non-Service Affecting (NSA)
Logical Object: OCN
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The Optimized 1+1 APS Primary Section Mismatch condition occurs on OC-N cards in an optimized
1+1 protection system if there is a mismatch between the primary section of the local node facility and
the primary section of the remote-node facility.

Clear the APS-PRIM-SEC-MISM Alarm

Step1  Ensure that the local node and remote-node ports are correctly provisioned the same way. For more
information about optimized 1+1 configurations, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.19 AS-CMD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: 2R, AOTS, BPLANE, EQPT, ESCON, FC, GE, ISC, NE, OCH, OCN/STMN,
OMS, OTS, PPM, PWR, SHELF, TRUNK

The Alarms Suppressed by User Command condition applies to the network element (NE object),
backplane (BPLANE object), a single MXP or TXP card, or a port on one of these cards. It occurs when
alarms are suppressed for that object and its subordinate objects. For example, suppressing alarms on a
card also suppresses alarms on its ports.

Note  For more information about suppressing alarms, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Note  This condition is not raised for multiservice transport platform (MSTP) cards such as amplifiers,
multiplexers, or demultiplexers.

Clear the AS-CMD Condition

Step 1 For all nodes, in node view (single-shelf mode) or shelf view (multishelf mode), click the Conditions tab.

Step2  Click Retrieve. If you have already retrieved conditions, look under the Object column and Eqpt Type
column and note what entity the condition is reported against, such as a port, slot, or shelf.

e If the condition is reported against a slot and card, alarms were either suppressed for the entire card
or for one of the ports. Note the slot number and continue with Step 3.

e If the condition is reported against the backplane, go to Step 7.
e If the condition is reported against the NE object, go to Step 8.
Step3  Determine whether alarms are suppressed for a port and if so, raise the suppressed alarms:

a. Double-click the card to open the card view.
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b. Click the Provisioning > Alarm Profiles > Alarm Behavior tabs and complete one of the following
substeps:

e If the Suppress Alarms column check box is checked for a port row, deselect it and click Apply.

e If the Suppress Alarms column check box is not checked for a port row, from the View menu
choose Go to Previous View.

If the AS-CMD condition is reported for a card and not an individual port, in node view (single-shelf
mode) or shelf view (multishelf mode), click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

Locate the row number for the reported card slot.
Click the Suppress Alarms column check box to deselect the option for the card row.

If the condition is reported for the backplane, the alarms are suppressed for cards such as the ONS 15454
AIP that are not in the optical or electrical slots. To clear the alarm, complete the following steps:

a. Click the Provisioning > Alarm Profiles > Alarm Behavior tabs.
b. In the backplane row, uncheck the Suppress Alarms column check box.
¢. Click Apply.

If the condition is reported for the shelf, cards and other equipment are affected. To clear the alarm,
complete the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Alarm
Profiles > Alarm Behavior tabs if you have not already done so.

b. Click the Suppress Alarms check box located at the bottom of the window to deselect the option.
c. Click Apply.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)

Logical Objects: 2R, AOTS, EQPT, ESCON, FC, GE, ISC, OCH, OCN/STMN, OMS, OTS, PPM,
SHELF, TRUNK

The Alarms Suppressed for Maintenance Command condition applies to MXP or TXP cards and occurs
when a client or trunk port is placed in the Out-of-Service and Management,

Maintenance (OOS-MA,MT or Locked,enabled, loopback & maintenance) service state for loopback
testing operations.

While provisioning traffic between two MXP-MR-10DME, MXP-MR-2.5G, or MXPP-MR-2.5G cards,
putting the trunk port (09) of the card OOS-MT (initially IS) results in the AS-MT alarm being reported
on both trunk and client port. This is because all the GFP interfaces derive their state from the trunk state
if the trunk is not IS-NR. If the Trunk port state is [S-NR, then all the GFP interfaces derive their state
from the corresponding client port. When the trunk is moved to AS-MT, which is not IS, the GFP of the
client port also moves to the AS-MT state. The FAC of the client does not change state.
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Clear the AS-MT Condition

Step 1 Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2521 AU-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCTRM-HP

An AU AIS condition applies to the administration unit, which consists of the virtual container (VC)
capacity and pointer bytes (H1, H2, and H3) in the SDH frame.

Generally, any AIS is a special SDH signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AU-AIS Condition

Step1  Complete the “Clear the AIS Condition” procedure on page 2-27.
Step2  If the condition does not clear, complete the “Clear the APSB Alarm” procedure on page 2-32.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2522 AU-LOP

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: VCMON-HP, VCTRM-HP

An AU-LOP alarm indicates that the SDH high order path overhead section of the administration unit
has detected a loss of path. AU-LOP occurs when there is a mismatch between the expected and
provisioned circuit size. For the TXP card, an AU-LOP is raised if a port is configured for an SDH signal
but receives a SDH signal instead. (This information is contained in the H1 byte bits 5 and 6.)

>

Warning  Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about MXP and TXP cards, refer to the Cisco ONS 15454 SDH Reference Manual.

Clear the AU-LOP Alarm

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

In node view, click the Circuits tab and view the alarmed circuit.

Verify that the correct circuit size is listed in the Size column. If the size is different from what is
expected, such as a VC4-4c instead of a VC4, this causes the alarm.

If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned
circuit size and the size expected by the test set can cause this alarm. Ensure that the test set monitoring
is set up for the same size as the circuit provisioning. For specific procedures to use the test set
equipment, consult the manufacturer.

If you have not been using a test set, or if the test set is correctly set up, the error is in the provisioned
CTC circuit size. Complete the “Delete a Circuit” procedure on page 2-245.

Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits and Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country in order to report a
Service-Affecting (SA) problem.

2.5.23 AUTOLSROFF

>

Warning

>

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STMN

The Auto Laser Shutdown alarm occurs when the STM-64 card temperature exceeds 194 degrees F
(90 degrees C). The internal equipment automatically shuts down the STM-64 laser when the card
temperature rises to prevent the card from self-destructing.

On the 0C192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is
off when the safety key is off (labeled 0). Statement 293.

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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Warning  Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the AUTOLSROFF Alarm

Step 1 View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-2).
Figure 2-2 shows the shelf LCD panel.

Figure 2-1 Shelf LCD Panel
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Step2  If the temperature of the shelf exceeds 194 degrees F (90 degrees C), the alarm should clear if you solve
the ONS 15454 temperature problem. Complete the “Clear the HITEMP Alarm” procedure on
page 2-100.

Step3  If the temperature of the shelf is under 194 degrees F (90 degrees C), the HITEMP alarm is not the cause
of the AUTOLSROFF alarm. Complete the “Physically Replace a Card” procedure on page 2-244 for the
0OC-192 card.

~

Note  When you replace a card with the identical type of card, you do not need to make any changes
to the database.

Step4  If card replacement does not clear the alarm, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.

2.5.24 AUTORESET

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Automatic System Reset alarm occurs when you change an IP address or perform any other
operation that causes an automatic card-level reboot. AUTORESET typically clears after a card reboots
(up to ten minutes).

Resets performed during a software upgrade also prompt the condition. This condition clears
automatically when the card finishes resetting. If the alarm does not clear, complete the following
procedure.
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Clear the AUTORESET Alarm

Step1  Determine whether there are additional alarms that could have triggered an automatic reset. If there are,
troubleshoot these alarms using the applicable section of this chapter.

Step2  If the card automatically resets more than once a month with no apparent cause, complete the “Physically
Replace a Card” procedure on page 2-244.

Warning  Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.25 AUTOSW-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, VI-MON

The Automatic Path Protection Switch Caused by an AIS condition indicates that automatic path
protection switching occurred because of an AIS condition. If the path protection is configured for
revertive switching, it reverts to the working path after the fault clears. The AIS also clears when the
upstream trouble is cleared.

Note  This condition is only reported if the path protection is set up for revertive switching.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AUTOSW-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-27.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.26 AUTOSW-AIS-SNCP

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP
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The Automatic path protection Switch Caused by an AIS condition indicates that automatic path
protection protection switching occurred because of the TU-AIS condition. If the path protection ring is
configured for revertive switching, it switches back to the working path after the fault clears. The
AUTOSW-AIS-path protection clears when you clear the primary alarm on the upstream node.

Note  This condition is only reported if the SNCP is set up for revertive switching.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AUTOSW-AIS-path protection Condition

Step1  Complete the “Clear the AIS Condition” procedure on page 2-27.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.27 AUTOSW-LOP (STSMON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON

The Automatic Path Protection Switch Caused by LOP condition for the STS monitor (STSMON)
indicates that automatic path protection switching occurred because of the “LOP-P” alarm on

page 2-131. If the path protection is configured for revertive switching, it reverts to the working path
after the fault clears.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-LOP (STSMON) Condition

Step1  Complete the “Clear the LOP-P Alarm” procedure on page 2-131.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.28 AUTOSW-LOP-SNCP

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Logical Object: VCMON-HP, VCMON-LP

An Automatic path protection Switch Caused by LOP alarm indicates that an automatic path protection
protection switching occurred because of the “AU-LOP” alarm, page 2-38. If the path protection ring is
configured for revertive switching, it switches back to the working path after the fault clears.

~

Note  This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-LOP-SNCP Alarm

Step 1 Complete the “Clear the AU-LOP Alarm” procedure on page 2-39.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country.

2.5.29 AUTOSW-PDI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VI-MON

The Automatic Path Protection Switch Caused by Payload Defect Indication (PDI) condition indicates
that automatic path protection switching occurred because of a “PDI-P” alarm on page 2-186. If the path
protection is configured for revertive switching, it reverts to the working path after the fault clears.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-PDI Condition

Step 1 Complete the “Clear the PDI-P Condition” procedure on page 2-187.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.30 AUTOSW-PDI-SNCP

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP

The Automatic path protection Switch Caused by Payload Defect Indication (PDI) condition indicates
that automatic path protection protection switching occurred because of a PDI alarm. If the path
protection is configured for revertive switching, it reverts to the working path after the fault clears.
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Note  This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-PDI-SNCP Condition

Step 1 Complete the “Clear the PDI-P Condition” section on page 2-187.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.31 AUTOSW-SDBER

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VI-MON

The Automatic Path Protection Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition
indicates that a “SD-P” condition on page 2-202 caused automatic path protection switching to occur. If
the path protection is configured for revertive switching, the path protection reverts to the working path
when the SD-P is resolved.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-SDBER Condition

Step 1 Complete the “Clear the SD-P Condition” procedure on page 2-203.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.32 AUTOSW-SDBER-SNCP

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP

The Automatic path protection Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition
indicates that a signal degrade caused automatic path protection protection switching to occur. If the path
protection ring is configured for revertive switching, it reverts to the working path when the SD is
resolved.

Note  This condition is only reported if the SNCP is set up for revertive switching.
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Clear the AUTOSW-SDBER-SNCP Condition

Step 1 Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.33 AUTOSW-SFBER

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VI-MON

The Automatic USPR Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates that a
“SF-P” condition on page 2-206 caused automatic path protection switching to occur. If the path
protection is configured for revertive switching, the path protection reverts to the working path when the
SF-P is resolved.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-SFBER Condition

Step 1 Complete the “Clear the SF-P Condition” procedure on page 2-206.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.34 AUTOSW-SFBER-SNCP

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP

The Automatic path protection Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates
that a signal fail caused automatic path protection protection switching to occur. If the path protection
ring is configured for revertive switching, it reverts to the working path when the SF is resolved.

~

Note  This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-SFBER-SNCP Condition

Step 1 Complete the “Clear the SF (TRUNK) Condition” procedure on page 2-204.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
| 78-18378-02 .m



Chapter2  Alarm Troubleshooting |

W Trouble-Clearing Procedures

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.35 AUTOSW-UNEQ (STSMON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON

The Automatic Path Protection Switch Caused by Unequipped condition indicates that an “UNEQ-P”
alarm on page 2-226, caused automatic path protection switching to occur. If the path protection is
configured for revertive switching, it reverts to the working path after the fault clears.

~

Note  This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-UNEQ (STSMON) Condition

Step 1 Complete the “Clear the UNEQ-P Alarm” procedure on page 2-226.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.36 AUTOSW-UNEQ-SNCP (VCMON-HP)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP

The Automatic path protection Switch Caused by an Unequipped condition indicates that an HP-UNEQ
alarm caused automatic path protection protection switching to occur (see the “HP-UNEQ” alarm,
page 2-107). If the path protection ring is configured for revertive switching, it reverts to the working
path after the fault clears.

Warning  Class 1 laser product. Statement 1008

Warning Class 1M laser radiation when open. Do not view directly with optical instruments. Statement 1053

Warning  Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-UNEQ-SNCP (VCMON-HP) Condition

Step 1
Step 2

Complete the “Clear the HP-UNEQ Alarm” procedure on page 2-107.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country.

2.5.37 AWG-DEG

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS

The Arrayed Waveguide Gratings (AWG) Degrade alarm occurs when a 32MUX-0, 40MUX, 32WSS-O,
40WSSC-C, 32DMX-0, 32DMX, or 40DMX card heater-control circuit degrades. The heat variance can
cause slight wavelength drift. The card does not need to be replaced immediately, but it should be at the
next opportunity.

For General information about 32MUX-0, 40MUX, 32WSS-0O, 40WSSC-C, 32DMX-0, 32DMX, and
40DMX cards, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM Reference
Manual. For more information about changing their settings, refer to the “Change DWDM Card
Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AWG-DEG Alarm

Step 1

A

Warning

Step 2

For the alarmed 32MUX-0O, 40MUX, 32WSS-0, 40WSSC-C, 32DMX-0, 32DMX, or 40DMX card,
complete the “Physically Replace a Card” procedure on page 2-244 at the next opportunity.

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.38 AWG-FAIL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OTS

The AWG Failure alarm occurs when a 32MUX-0, 40MUX, 32WSS-0, 40WSSC-C, 32DMX-0,
32DMX, or 40DMX card heater-control circuit completely fails. The circuit failure disables wavelength
transmission. The card must be replaced to restore traffic.

Note For general information about 32MUX-0, 40MUX, 32WSS-0, 40WSSC-C, 32DMX-0, 32DMX, and
40DMX cards, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM Reference
Manual. For information about changing their settings, refer to the “Change DWDM Card Settings”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AWG-FAIL Alarm

Step 1 For the alarmed 32MUX-0O, 40MUX, 32WSS-0, 40WSSC-C, 32DMX-0, 32DMX, or 40DMX card,
complete the “Physically Replace a Card” procedure on page 2-244.

Warning  Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic hag. Statement 201

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.39 AWG-OVERTEMP

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OTS

The AWG Over Temperature alarm is raised if a 32MUX-0, 40MUX, 32WSS-0O, 40WSSC-C,
32DMX-0, 32DMX, or 40DMX card having an AWG-FAIL alarm is not replaced and its heater-control
circuit temperature exceeds 212 degrees F (100 degrees C). The card goes into protect mode and the
heater is disabled.

Note  For general information about these cards, refer to the “Card Reference” chapter in the Cisco ONS 15454
DWDM Reference Manual. For information about changing their settings, refer to the “Change DWDM
Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AWG-OVERTEMP Alarm

Step 1 Complete the “Clear the AWG-FAIL Alarm” procedure on page 2-48.
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Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2540 AWG-WARM-UP

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OTS

The AWG Warm-Up condition occurs when a 32MUX-0, 40MUX, 32WSS-0, 40WSSC-C, 32DMX-O,
32DMX, or 40DMX card heater-control circuit is attaining its operating temperature during startup. The
condition lasts approximately 10 minutes but can vary somewhat from this period due to environmental
temperature.

~

Note AWG-WARM-UP is an informational condition and does not require troubleshooting.

2.5.41 BAT-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR

The Battery Fail alarm occurs when one of the two power supplies (A or B) is not detected. This could
be because the supply is removed or is not operational. The alarm does not distinguish between the
individual power supplies, so onsite information about the conditions is necessary for troubleshooting.

Clear the BAT-FAIL Alarm

Step1 At the site, determine which battery is not present or operational.

Step2 Remove the power cable from the faulty supply. For procedures, refer to the “Install the Shelf and
Common Control Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide. Reverse the power
cable installation procedure.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.42 BKUPMEMP

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT

The Primary Nonvolatile Backup Memory Failure alarm refers to a problem with the TCC2/TCC2P card
flash memory. The alarm occurs when the TCC2/TCC2P card is in use and has one of four problems:

¢ Flash manager fails to format a flash partition.
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¢ Flash manager fails to write a file to a flash partition.

e Problem at the driver level.

e Code volume fails cyclic redundancy checking (CRC, which is a method to verify for errors in data
transmitted to the TCC2/TCC2P card).

The BKUPMEMP alarm can also cause the “EQPT” alarm, page 2-72. If the EQPT alarm is caused by
BKUPMEMP, complete the following procedure to clear the BRUPMEMP and the EQPT alarm.

A

Caution A software update on a standby TCC2/TCC2P card can take up to 30 minutes.

Clear the BKUPMEMP Alarm

Step1  Verify that both TCC2/TCC2P cards are powered and enabled by confirming lighted ACT/SBY LEDs
on the TCC2/TCC2P cards.

Step2  Determine whether the active or standby TCC2/TCC2P card has the alarm.

Step 3 If both TCC2/TCC2P cards are powered and enabled, reset the TCC2/TCC2P card where the alarm is
raised. If the card is the active TCC2/TCC2P card, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-241. If the card is the standby TCC2/TCC2P card:

a. Right-click the standby TCC2/TCC2P card in CTC.

b. Choose Reset Card from the shortcut menu.

c. Click Yes in the Are You Sure dialog box. The card resets, the FAIL LED blinks on the physical card.
d. Wait ten minutes to verify that the card you reset completely reboots.

Step 4 If the TCC2/TCC2P card you reset does not reboot successfully, or the alarm has not cleared, call
Cisco TAC (1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the
“Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-242. If the
Cisco TAC technician tells you to remove the card and reinstall a new one, follow the “Physically
Replace a Card” procedure on page 2-244.

A

Warning  Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool hefore touching any other part of it or
before placing it in an antistatic bag. Statement 201

25.43 BPV

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: BITS

The 64K Clock Bipolar Density Violation alarm is raised on the TCC2P card if there is a frequency
variation in the 8K BITS clock.

The TCC2P card contains an 8K clock and a 64K clock. Each has some bipolar variation, which is
normal. This alarm is raised on the 8K clock if that variation discontinues. The BPV alarm is demoted
by an LOF or LOS against the BITS clock.
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This alarm is not raised on the TCC2 card.
Clear the BPV Alarm
Step 1 Reestablish a normal BITS input signal to clear the alarm. Clear any alarms on the incoming signal or
against the BITS timing sources.
Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.44 CARLOSS (EQPT)

>

Warning

>

Warning

Note

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: EQPT

A Carrier Loss on the LAN Equipment alarm generally occurs on MXP, TXP, or ADM-10G cards when
the ONS system and the workstation hosting CTC do not have a TCP/IP connection. The problem
involves the LAN or data circuit used by the RJ-45 (LAN) connector on the TCC2/TCC2P card or the
LAN backplane pin connection. This CARLOSS alarm does not involve an Ethernet circuit connected
to an Ethernet port. The problem is in the connection and not CTC or the node.

On TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and MXP_2.5G_10G cards, CARLOSS is also
raised against trunk ports when ITU-T G.709 encapsulation is turned off.

A TXP_MR_2.5G card can raise a CARLOSS alarm when the payload is incorrectly configured for the
10 Gigabit Ethernet or 1 Gigabit Ethernet payload data types.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about provisioning MXP or TXP PPMs (also called SFPs), refer to the “Turn Up
a Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For PPM (SFP) specifications, refer
to the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM Reference Manual. For
more information about MRC-12 and OC192-XFP/STM64-XFP cards, refer to the “Optical Cards”
chapter in the Cisco ONS 15454 Reference Manual.
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~

Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (EQPT) Alarm

Step 1

Step 2

Step 3

Step 4

A

If the reporting card is an MXP or TXP card in an ONS 15454 node, verify the data rate configured on
the PPM (also called SFP):

a. In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting MXP or
TXP card.

b. Click the Provisioning > Pluggable Port Modules tabs.

c. View the Pluggable Port Modules area port listing in the Actual Equipment Type column and
compare this with the contents of the Selected PPM area Rate column for the MXP or TXP multirate
port.

d. If the rate does not match the actual equipment, you must delete and recreate the selected PPM.
Select the PPM (SFP), click Delete, then click Create and choose the correct rate for the port rate.

S

Note  For more information about provisioning PPMs (SFPs), refer to the “Turn Up a Node”
chapter of the Cisco ONS 15454 DWDM Procedure Guide. For PPM (SFP) specifications,
refer to the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM Reference
Manual.

If the reporting card is an OC-N/STM-N card, verify connectivity by pinging the ONS system that is
reporting the alarm by completing the “1.6.8 Verify PC Connection to the ONS 15454 (ping)” procedure
on page 1-42.

If the ping is successful, it demonstrates that an active TCP/IP connection exists. Restart CTC:
a. Exit from CTC.

b. Reopen the browser.

c¢. Log into CTC.

Using optical test equipment, verify that proper receive levels are achieved. (For instructions about using
optical test equipment, refer to the manufacturer documentation.)

Caution

Step 5

Step 6

Step 7

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify that the optical LAN cable is properly connected and attached to the correct port. For more
information about fiber connections and terminations, refer to the “Turn Up a Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

If the fiber cable is properly connected and attached to the port, verify that the cable connects the card
to another Ethernet device and is not misconnected to an OC-N/STM-N card.

If you are unable to establish connectivity, replace the fiber cable with a new known-good cable. To do
this, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
m. 78-18378-02 |



| Chapter2

Alarm Troubleshooting

Step 8

Step 9

Trouble-Clearing Procedures 1l

If you are unable to establish connectivity, perform standard network or LAN diagnostics. For example,
trace the IP route, verify cable continuity, and troubleshoot any routers between the node and CTC. To
verify cable continuity, follow site practices.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.45 CARLOSS (FC)

Note

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: FC

The Carrier Loss for Fibre Channel (FC) alarm occurs on the client port of a TXP_MR_10G,
TXP_MR_I0E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_2.5G, MXPP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, supporting 1-Gb
Fibre Channel (FC1G), 2-Gb FC (FC2G), or 10Gb Fiber Channel (10G Fiber Channel) traffic. The loss
can be due to a misconfiguration, fiber cut, or client equipment problem.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the CARLOSS (FC) Alarm

Step 1
Step 2

Complete the “Clear the CARLOSS (GE) Alarm” procedure on page 2-54.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.46 CARLOSS (GE)

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: GE

The Carrier Loss for Gigabit Ethernet (GE) alarm occurs on the client port of a TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_2.5G, MXPP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, GE-XP, 10GE-XP,
or ADM-10G cards supporting 1-Gbps or 10-Gbps traffic. The loss can be due to a misconfiguration,
fiber cut, or client equipment problem.
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Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the CARLOSS (GE) Alarm

Step 1 Ensure that the GE client is correctly configured:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. Click the Provisioning > Pluggable Port Modules tabs.

c. View the Pluggable Port Modules area port listing in the Actual Equipment Type column and
compare this with the client equipment. If no PPM (SFP) is provisioned, refer to the “Turn Up a
Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide. PPM (SFP) specifications are
listed in the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM Reference
Manual.

d. If a PPM (SFP) has been created, view the contents of the Selected PPM area Rate column for the
MXP or TXP MR card and compare this rate with the client equipment data rate. In this case, the
rate should be ONE_GE or 10G Ethernet. If the PPM (SFP) rate is differently provisioned, select
the PPM (SFP), click Delete, then click Create and choose the correct rate for the equipment type.

>
Note  For information about installing provisioning PPMs (SFPs), refer to the “Turn Up a Node”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step2  If there is no PPM (SFP) misprovisioning, check for a fiber cut. An LOS alarm would also be present.
If there is an alarm, complete the “Clear the LOS (OCN/STMN) Alarm” procedure located in Chapter 2,
“Alarm Troubleshooting,” of the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH
Troubleshooting Guide.

Step3  If there is no fiber cut or provisioning error, check the client-side equipment for any transmission errors
on the line.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.47 CARLOSS (ISC)

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: ISC

The Carrier Loss for Inter-Service Channel (ISC) alarm occurs on the client port of a TXP_MR_10G,
TXP_MR_I10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_2.5G, and MXPP_MR_2.5G supporting ISC traffic. The loss can be due to a
misconfiguration, fiber cut, or client equipment problem.
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Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the CARLOSS (ISC) Alarm

Step 1 Complete the “Clear the CARLOSS (GE) Alarm” procedure on page 2-54.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.48 CARLOSS (TRUNK)

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

A Carrier Loss alarm is raised on the optical Trunk-RX port of a TXP_MR_10G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, and
MXPP_MR_2.5G when the Ethernet payload is lost. This alarm only occurs when ITU-T G.709
encapsulation is disabled.

Note  For general information about TXP cards and their monitoring capabilities, refer to the “Card Reference”
chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them,
refer to the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Clear the CARLOSS (TRUNK) Alarm

Step 1 Check for any upstream equipment failures:
e Verify that the far-end TXP or MXP is generating the signal to be received by the alarmed card.
e Verify that the Trunk-Tx port is not reporting any performance monitoring (PM) problems.

e Verify that the Client-Rx port is not reporting any PM problems that could cause the CARLOSS in
this card.

~

Note  For more information about performance monitoring, refer to the “Performance Monitoring”
chapter of the Cisco ONS 15454 DWDM Reference Manual.

Step2  If there is no cause upstream, verify cabling continuity from the transmitting port of the DWDM card
(AD-xC-xx.x-xx.x, 32DMX-0, 32DMX, or 40DMX) connected to the TXP receiving port reporting this
alarm.
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Step 3

Step 4

Step 5

Step 6

Step 7

A

Warning

Step 8

If a patch panel is used, ensure that the LC-LC adapter managing the connection is in good working
order.

If the continuity is good, clean the fiber according to site practice. If none exists, complete the fiber
cleaning procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

If the signal is valid, ensure that the transmit and receive outputs from the patch panel to your equipment
are properly connected (that is, the correct wavelength is coming from the patch panel). For more
information about fiber connections and terminations, refer to the “Turn Up a Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

If the correct port is in service but the alarm has not cleared, use an optical test set to confirm that a valid
signal exists on the input port of the alarmed TXP. For specific procedures to use the test set equipment,
consult the manufacturer. Test the line as close to the receiving card as possible.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
reporting card.

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool hefore touching any other part of it or
hefore placing it in an antistatic bag. Statement 201

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.49 CASETEMP-DEG

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS

The Case Temperature Degrade alarm is raised when a DWDM card temperature sensor detects an
out-of-range external temperature at the shelf level. The working range for DWDM cards is from
23 degrees F (-5 degrees C) to 149 degrees F (65 degrees C).

For specific temperature and environmental information about each DWDM card, refer to the “Hardware
Specifications” appendix in the Cisco ONS 15454 DWDM Reference Manual.

Clear the CASETEMP-DEG Alarm

Step 1

Step 2

Step 3

Determine whether the air filter needs replacement. Complete the “Inspect, Clean, and Replace the
Reusable Air Filter” procedure on page 2-247.

If the filter is clean, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-248.

If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-249. The fan should run immediately when correctly inserted.
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Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2550 CHANLOSS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OCN

The SONET Section Layer DCC Termination Failure condition occurs when the ONS 15454 receives
unrecognized data in the section layer DCC bytes.

>

Warning  Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

A

Warning  Use of controls, adjustments, or performing procedures other than those specified may result in
hazardous radiation exposure. Statement 1057

Clear the CHANLOSS Condition

Step 1 In the absence of other alarms, determine whether the alarmed port is connected to another vendor’s
equipment. If so, you can mask the alarm on this path using a custom alarm profile. For more information
about custom profiles, refer to the “Manage Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

Step2  If alternate vendor equipment is not the cause of the alarm, complete the “Reset a Card in CTC”
procedure on page 2-241 for the traffic card.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step3  If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2551 CLDRESTART

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Cold Restart condition occurs when a card is physically removed and inserted, replaced, or when
the ONS 15454 power is initialized.
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Clear the CLDRESTART Condition

Step 1

Step 2

Step 3

Step 4

Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on
page 2-242.

If the condition fails to clear after the card reboots, complete the “Remove and Reinsert (Reseat) Any
Card” procedure on page 2-243.

If the condition does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for
the card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.52 COMM-FAIL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Plug-In Module (card) Communication Failure indicates that there is a communication failure
between the TCC2/TCC2P and the traffic card. The failure could indicate a broken card interface.

Clear the COMM-FAIL Alarm

Step 1

Step 2

Step 3

Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-243” for the reporting
card.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244” for the
card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.5.53 CONTBUS-DISABLED

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT

The CONTBUS-DISABLED alarm is a function of the enhanced cell bus verification feature. This alarm
occurs when a card is defective upon insertion into the chassis or when a card already present in the
chassis becomes defective. (That is, the card fails the enhanced cell bus verification test.) The alarm
persists as long as the defective card remains in the chassis. When the card is removed,
CONTBUS-DISABLED will remain raised for a one-minute wait time. This wait time is designed as a
guard period so that the system can distinguish this outage from a briefer card reset communication
outage.

If no card is reinserted into the original slot during the wait time, the alarm clears. After this time, a
different, nondefective card (not the original card) should be inserted.
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When CONTBUS-DISABLED is raised, no message-oriented communication is allowed to or from this
slot to the TCC2/TCC2P card (thus avoiding node communication failure).

Caution

CONTBUS-DISABLED clears only when the faulty card is removed for one minute. If any card at all is
reinserted before the one-minute guard period expires, the alarm does not clear.

CONTBUS-DISABLED overrides the IMPROPRMVL alarm during the one-minute wait period, but
afterward IMPROPRMVL can be raised because it is no longer suppressed. IMPROPRMVL is raised
after CONTBUS-DISABLED clears if the card is in the node database. If CONTBUS-DISABLED has
cleared but IMPROPRMVL is still active, inserting a card will clear the IMPROPRMVL alarm.

Clear the CONTBUS-DISABLED Alarm

Step 1

Step 2

If the IMPROPRMVL alarm is raised, complete the “Physically Replace a Card” procedure on
page 2-244. (For general information about card installation, refer to the “Install Cards and Fiber-Optic
Cable” chapter of the Cisco ONS 15454 Procedure Guide.)

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.54 CONTBUS-10-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

A TCCA to Shelf A Slot Communication Failure alarm occurs when the active Slot 7 TCC2/TCC2P card
(TCC A) has lost communication with another card in the shelf. The other card is identified by the Object
column in the CTC alarm window.

The CONTBUS-IO-A alarm can appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P card. In the case of a TCC2/TCC2P card protection switch, the alarm clears after the other
cards establish communication with the newly active TCC2/TCC2P card. If the alarm persists, the
problem lies with the physical path of communication from the TCC2/TCC2P card to the reporting card.
The physical path of communication includes the TCC2/TCC2P card, the other card, and the backplane.

Clear the CONTBUS-10-A Alarm

Step 1

Step 2

Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm,
page 2-157 for the reporting card.

If the alarm object is any single card slot other than the standby Slot 11 TCC2/TCC2P card, perform a
CTC reset of the object card. Complete the “Reset a Card in CTC” procedure on page 2-241. For the
LED behavior, see the “2.7.2 Typical Traffic Card LED Activity During Reset” section on page 2-235.
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Step 3

Step 4

Step 5

Step 6

A

If the alarm object is the standby Slot 11 TCC2/TCC2P card, complete the “Reset a Card in CTC”
procedure on page 2-241 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

If CONTBUS-IO-A is raised on several cards at once, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-241.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-243 for the reporting card.

Caution

Step 7

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the middle-right outside edge of the shelf
assembly.

If the reset card has not rebooted successfully, or the alarm has not cleared, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free TAC
numbers for your country. If the Technical Support technician tells you to reseat the card, complete the
“Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-242. If the
Technical Support technician tells you to remove the card and reinstall a new one, follow the “Physically
Replace a Card” procedure on page 2-244.

2555 CONTBUS-10-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

A TCC B to Shelf Communication Failure alarm occurs when the active Slot 11 TCC2/TCC2P card
(TCC B) has lost communication with another card in the shelf. The other card is identified by the Object
column in the CTC alarm window.

The CONTBUS-IO-B alarm could appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P card. In the case of a TCC2/TCC2P card protection switch, the alarm clears after the other
cards establish communication with the newly active TCC2/TCC2P card. If the alarm persists, the
problem lies with the physical path of communication from the TCC2/TCC2P card to the reporting card.
The physical path of communication includes the TCC2/TCC2P card, the other card, and the backplane.

Clear the CONTBUS-10-B Alarm

Step 1

Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.

If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm,
page 2-157 for the reporting card.
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If the alarm object is any single card slot other than the standby Slot 7 TCC2/TCC2P card, perform a
CTC reset of the object card. Complete the “Reset a Card in CTC” procedure on page 2-241. For the
LED behavior, see the “2.7.2 Typical Traffic Card LED Activity During Reset” section on page 2-235.

If the alarm object is the standby Slot 7 TCC2/TCC2P card, complete the “Reset a Card in CTC”
procedure on page 2-241 for it. The procedure is similar.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

If CONTBUS-IO-B is raised on several cards at once, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-241.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-243 for the reporting card.

Caution

Step 7

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located lower-right edge of the shelf assembly.

If the reset card has not rebooted successfully, or the alarm has not cleared, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free TAC
numbers for your country. If the Technical Support technician tells you to reseat the card, complete the
“Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-242. If the
Technical Support technician tells you to remove the card and reinstall a new one, follow the “Physically
Replace a Card” procedure on page 2-244.

2556 CTNEQPT-MISMATCH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Connection Equipment Mismatch condition is raised when there is a mismatch between the
cross-connect card preprovisioned in the slot and the card actually present in the shelf. For example, an
XC-VXL card could be preprovisioned in Slot 10, but another card could be physically installed.

~

Note  Cisco does not support configurations of unmatched cross-connect cards in Slot 8 and
Slot 10, although this situation could briefly occur during the upgrade process.

~

Note  The cross-connect card you are replacing should not be the active card. (It can be in SBY
state or otherwise not in use.)
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~

Note  During an upgrade, this condition occurs and is raised as its default severity, Not Alarmed (NA).
However, after the upgrade has occurred, if you wish to change the condition’s severity so that it is
Not Reported (NR), you can do this by modifying the alarm profile used at the node. For more
information about modifying alarm severities, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the CTNEQPT-MISMATCH Condition

Step 1 Determine what kind of card is preprovisioned in the slot by completing the following steps:
a. Innode view, click the Inventory tab.
b. View the slot’s row contents in the Eqpt Type and Actual Eqpt Type columns.

The Eqpt Type column contains the equipment that is provisioned in the slot. The Actual Eqpt Type
contains the equipment that is physically present in the slot. For example, Slot 8 could be
provisioned for an XCVT card, which is shown in the Eqpt Type column, but a different
cross-connect card could be physically present in the slot. (This card would be shown in the Actual
Eqpt Type column.)

Step2  Complete the “Physically Replace a Card” procedure on page 2-244 for the mismatched card.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.57 DATAFLT

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: NE

The Software Data Integrity Fault alarm occurs when the TCC2/TCC2P card exceeds its flash memory
capacity.

A

Caution  When the system reboots, the last configuration entered is not saved.

Clear the DATAFLT Alarm

Step 1 Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-241.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2558 DBOSYNC

A

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: NE

The Standby Database Out Of Synchronization alarm occurs when the standby TCC2/TCC2P card
database does not synchronize with the active database on the active TCC2/TCC2P card.

Caution  If you reset the active TCC2/TCC2P card while this alarm is raised, you lose current provisioning.
Clear the DBOSYNC Alarm
Step1  Save a backup copy of the active TCC2/TCC2P card database. Refer to the “Maintain the Node” chapter
in the Cisco ONS 15454 DWDM Procedure Guide.
Step2  Make a minor provisioning change to the active database to see if applying a provisioning change clears
the alarm:
a. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
General > General tabs.
b. In the Description field, make a small change such as adding a period to the existing entry.
The change causes a database write but does not affect the node state. The write could take up to a
minute.
Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1-800-553-2447).

2.5.59 DCU-LOSS-FAIL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS

The DCU-LOSS-FAIL condition occurs when the DCU loss monitored value exceeds the board's
maximum acceptable DCU loss.

Clear the DCU-LOSS-FAIL Condition

Step 1

Step 2

Step 3
Step 4

Verify that the optical fibers connecting the board (OPT-PRE, OPT-PRE-L, or OPT-AMP-L) and the
DCU unit are clean, correctly plugged in, and not damaged.

If the condition does not clear, verify that appropriate DCU unit, according to the installation
requirements, is connected to the board and is correctly working.

If the condition still does not clear, verify that the optical power signal is present on the DCU-TX port.

If the alarm is still present, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.60 DISCONNECTED

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM

The Disconnected alarm is raised when CTC has been disconnected from the node. The alarm is cleared
when CTC is reconnected to the node.

Clear the DISCONNECTED Alarm

Step 1 Restart the CTC application.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.61 DSP-COMM-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The Digital Signal Processor (DSP) Communication Failure alarm indicates that there is a
communication failure between an MXP or TXP card microprocessor and the on-board DSP chip that
controls the trunk (or DWDM) port. This alarm typically occurs after a DSP code upgrade.

The alarm is temporary and does not require user action. The MXP or TXP card microprocessor attempts
to restore communication with the DSP chip until the alarm is cleared. (For general information about
MXP and TXP cards, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM Reference
Manual.)

If the alarm is raised for an extended period, the MXP or TXP card raises the “DUP-IPADDR” alarm on
page 2-65 and could affect traffic.

~

Note DSP-COMM-FAIL is an informational alarm and does not require troubleshooting.

2.5.62 DSP-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The DSP Failure alarm indicates that a “DSP-COMM-FAIL” alarm, page 2-64, has persisted for an
extended period on an MXP or TXP card. It indicates that the card is faulty.

Clear the DSP-FAIL Alarm

Step1  Complete the “Physically Replace a Card” procedure on page 2-244 for the reporting MXP or TXP card.
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Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
hefore placing it in an antistatic bag. Statement 201

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.63 DUP-IPADDR

Default Severity: Minor (MN), Non-Service Affecting (NSA)
Logical Object: NE

The Duplicate IP Address alarm indicates that the alarmed node IP address is already in use within the
same data communications channel (DCC) area. When this happens, CTC no longer reliably connects to
either node. Depending on how the packets are routed, CTC could connect to either node (having the
same IP address). If CTC has connected to both nodes before they shared the same address, it has two
distinct NodeModel instances (keyed by the node ID portion of the MAC address).

Clear the DUP-IPADDR Alarm

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

Isolate the alarmed node from the other node having the same address:

a. Connect to the alarmed node using the Craft port on the TCC2/TCC2P card.
b. Begin a CTC session.

c. In the login dialog box, uncheck the Network Discovery check box.

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Network > General tabs.

In the IP Address field, change the IP address to a unique number.
Click Apply.

Restart any CTC sessions that are logged into either of the duplicate IP addresses. (For procedures to log
in or log out, refer to the “Connect the PC and Log Into the GUI” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.64 DUP-NODENAME

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: NE

The Duplicate Node Name alarm indicates that the alarmed node alphanumeric name is already being
used within the same DCC area.
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Clear the DUP-NODENAME Alarm

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > General >
General tabs.

Step 2 In the Node Name field, enter a unique name for the node.
Step3  Click Apply.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.65 DUP-SHELF-ID

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: SHELF

The Duplicated Shelf Identifier alarm applies to a shelf that has multishelf management enabled when
the TCC2/TCC2P detects that you have programmed an ID already in use by another shelf. For more
information about provisioning an NC shelf or SS shelf for multishelf configurations, refer to the “Turn
Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide and “Node Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual.

Clear the DUP-SHELF-ID Alarm

Step1  Unprovision the shelf ID of the duplicate shelf by completing the following steps:

a. In shelf view (multishelf mode) or multishelf view (multishelf mode), click the node controller
Provisioning > General > Multishelf Config tabs.

b. Enter a new value in the Shelf ID field.
c. Click Apply.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

25.66 EHIBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR

The Extreme High Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input
voltage exceeds the extreme high power threshold. This threshold, with a default value of —56.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains under the threshold for

120 seconds. (For information about changing this threshold, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.)
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Clear the EHIBATVG Alarm

Step1  The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.67 ELWBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR

The Extreme Low Voltage Battery alarm occurs in a =48 VDC environment when a battery lead input
voltage falls below the extreme low power threshold. This threshold, with a default value of —40.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains over the threshold for

120 seconds. (For information about changing this threshold, refer to the “Turn Up a Node” chapter in
the Cisco ONS 15454 DWDM Procedure Guide.

Clear the ELWBATVG Alarm

Step1  The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.68 ENCAP-MISMATCH-P

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STSTRM

The Encapsulation C2 Byte Mismatch Path alarm applies to ML-Series Ethernet cards or the CE-1000
card. It occurs when the first three following conditions are met and one of the last two is false:

e The received C2 byte is not 0x00 (unequipped).

e The received C2 byte is not a PDI value.

e The received C2 does not match the expected C2.

e The expected C2 byte is not 0x01 (equipped unspecified).
e The received C2 byte is not 0x01 (equipped unspecified).

For an ENCAP-MISMATCH-P to be raised, there is a mismatch between the received and expected C2
byte, with either the expected byte or received byte value being 0x01.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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Note

For example, an ENCAP-MISMATCH-P alarm is raised if a circuit created between two ML-Series or
two CE-1000 cards has generic framing procedure (GFP) framing provisioned on one end and HDLC
framing with LEX encapsulation provisioned on the other. The GFP framing card transmits and expects
a C2 byte of 0x1B, while the HDLC framing card transmits and expects a C2 byte of 0x01.

A mismatch between the transmit and receive cards on any of the following parameters can cause the
alarm:

e Mode (HDLC, GFP-F)

e Encapsulation (LEX, HDLC, PPP)
e CRC size (16 or 32)

e Scrambling state (on or off)

This alarm is demoted by a PLM-P condition or a PLM-V condition.

By default, an ENCAP-MISMATCH-P alarm causes an ML-Series or CE-1000 card data link to go
down. This behavior can be modified using the command line interface (CLI) command in interface
configuration mode: no pos trigger defect encap.

For more information about the ML-Series or CE-1000 Ethernet cards, refer to the Ethernet Card
Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327.

Clear the ENCAP-MISMATCH-P Alarm

Step 1

Step 2

Step 3

Ensure that the correct framing mode is in use on the receive card:
a. Innode view, double-click the receive ML-Series or CE-1000 card to open the card view.
b. Click the Provisioning > Card tabs.

¢. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.

Ensure that the correct framing mode is in use on the transmit card, and that it is identical to the receiving
card:

a. In node view, double-click the transmit ML-Series or CE-1000 card to open the card view.
b. Click the Provisioning > Card tabs.

c. In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.

If the alarm does not clear, use the CLI to ensure that the remaining settings are correctly configured on
the ML-Series or CE-1000 card:

¢ Encapsulation
e CRCsize

e Scrambling state
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2.5.69 EOC

>

Warning

Note

Note

Trouble-Clearing Procedures 1l

To open the interface, click the IOS tab and click Open IOS Command Line Interface (CLI). Refer to
the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454,

Cisco ONS 15454 SDH, and Cisco ONS 15327 entries on all three of these topics to obtain the full
configuration command sequences.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: OCN/STMN, TRUNK

The SONET DCC Termination Failure alarm occurs when the ONS system loses its DCC. Although this
alarm is primarily SONET, it can apply to DWDM. For example, the OSCM card can raise this alarm on
its OC-3 section overhead.

The SDCC consists of three bytes, D1 through D3, in the SONET overhead. The bytes convey
information about operation, administration, maintenance, and provisioning (OAM&P). The ONS
system uses the DCC on the SONET section layer to communicate network management information.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows a partial state when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

For general information about OSCM or other DWDM cards, refer to the “Card Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to
the “Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide. For
more information about the SONET (ANSI) or SDH (ETSI) overhead, refer to the “SONET Topologies
and Upgrades” chapter of the Cisco ONS 15454 Procedure Guide or the “SDH Topologies and
Upgrades” chapter of the Cisco ONS 15454 SDH Procedure Guide.

The EOC alarm is raised on the DWDM trunk in MSTP systems. Its SDH (ETSI) counterpart, MS-EOC,
is not raised against the trunk port.

| 78-18378-02
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Clear the EOC Alarm

Step 1

A

If the LOS (DS1) alarm or SF-L alarm is reported, complete the appropriate troubleshooting procedure
in the “Alarm Troubleshooting” chapter of the Cisco ONS 15454 Troubleshooting Guide.

Caution

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If the alarm does not clear on the reporting node, verify the physical connections between the cards and
that the fiber-optic cables are configured to carry SDCC traffic. For more information about fiber
connections and terminations, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the
fiber span have in-service (IS or Unlocked) ports. Verify that the ACT/SBY LED on each card is green.

When the LEDs on the cards are correctly illuminated, complete the “Verify or Create Node Section
DCC Terminations” procedure on page 2-245 to verify that the DCC is provisioned for the ports at both
ends of the fiber span.

Repeat Step 4 at the adjacent nodes.

If DCC is provisioned for the ends of the span, verify that the port is active and in service by completing
the following steps:

a. Confirm that the card shows a green LED in CTC or on the physical card. A green ACT/SBY LED
indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the port is in service, in node view (single-shelf mode) or shelf view (multishelf
mode), double-click the card in CTC to open the card view.

¢. In card view, click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS (or Unlocked).

e. If the Admin State column lists the port as OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the column and choose IS , or Unlocked. Click Apply.

For all nodes, if the card is in service, use an optical test set to determine whether signal failures are
present on fiber terminations. For specific procedures to use the test set equipment, consult the
manufacturer.

Caution

Step 8

Step 9

Step 10

Using an optical test set disrupts service on a card. It could be necessary to manually switch traffic
carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock Initiation, and
Clearing” section on page 2-237 for commonly used switching procedures.

If no signal failures exist on terminations, measure power levels to verify that the budget loss is within
the parameters of the receiver. Refer to the “Hardware Specifications” appendix in the Cisco ONS 15454
DWDM Reference Manual for card power levels.

If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly
terminated. For more information about cabling, refer to the “Turn Up a Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

If fiber connectors are properly fastened and terminated, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-241.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.
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Step 11

Step 12

Step 13
Step 14

>

Warning

25.70 EOC-L

>

Warning

>

Trouble-Clearing Procedures 1l

Resetting the active TCC2/TCC2P card switches control to the standby TCC2/TCC2P card. If the alarm
clears when the ONS system node switches to the standby TCC2/TCC2P card, the user can assume that
the previously active card is the cause of the alarm.

If the TCC2/TCC2P card reset does not clear the alarm, delete the problematic SDCC termination:
a. From the View menu in card view, choose Go to Previous View if you have not already done so.

b. In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Comm Channels > SDCC tabs.

c. Highlight the problematic DCC termination.
d. Click Delete.
e. Click Yes in the Confirmation Dialog box.

Recreate the SDCC termination. Refer to the “Turn Up a Node” chapter of the Cisco ONS 15454 DWDM
Procedure Guide for procedures.

Verify that both ends of the DCC have been recreated at the optical ports.

If the alarm has not cleared, call Cisco TAC (1-800-553-2447). If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-242. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Card” procedure on page 2-244.

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Default Severity: Minor (MN), Non-Service-Affecting (NSA) for OCN/STMN
Logical Object: TRUNK

The Line DCC (LDCC) Termination Failure alarm occurs when the ONS system loses its line data
communications channel (LDCC) termination. For example, the OSCM card can raise this alarm on its
OC-3 line overhead.

The LDCC consists of nine bytes, D4 through D12, in the SONET overhead. The bytes convey
information about OAM&P. The ONS system uses the LDCCs on the SONET line layer to communicate
network management information.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Warning Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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A

Warning

~

Note

Note

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows a partial status when the EOC or EOC-L alarm is raised, it occurs when the logical
circuit is in place. The circuit is able to carry traffic when the DCC termination issue is resolved. You
do not need to delete the circuit when troubleshooting this alarm.

For general information about OSCM or other DWDM cards, refer to the “Card Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to
the “Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide. For
more information about the SONET (ANSI) or SDH (ETSI) overhead, refer to the “SONET Topologies
and Upgrades” chapter of the Cisco ONS 15454 Procedure Guide or the “SDH Topologies and
Upgrades” chapter of the Cisco ONS 15454 SDH Procedure Guide.

Clear the EOC-L Alarm

Step 1
Step 2

A

Complete the “Clear the EOC Alarm” procedure on page 2-70.

If the alarm has not cleared, call Cisco TAC (1-800-553-2447). If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-242. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Card” procedure on page 2-244.

Warning

2571 EQPT

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool hefore touching any other part of it or
before placing it in an antistatic bag. Statement 201

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AICI-AEP, AICI-AIE, EQPT, PPM

An Equipment Failure alarm indicates that a hardware failure has occurred on the reporting card. If the
EQPT alarm occurs with a “BKUPMEMP” alarm, page 2-49, refer to the procedure to clear the alarm.
(Clearing a BKUPMEMP alarm also clears an EQPT alarm.)

This alarm is also invoked if a diagnostic circuit detects a card application-specific integrated circuit
(ASIC) failure. In this case, if the card is part of a protection group, an APS switch occurs. If the card is
the protect card, switching is inhibited and a “PROTNA” alarm, page 2-189, is raised. The standby path
generates a path-type alarm. For more information about provisioning PPMs (SFPs), refer to the “Turn
Up a Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.
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Clear the EQPT Alarm

Step 1

Step 2
Step 3

Step 4

A

Warning

Step 5

Step 6

If traffic is active on the alarmed port, you could need to switch traffic away from it. See the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-237 for commonly used
traffic-switching procedures.

Complete the “Reset a Card in CTC” procedure on page 2-241 for the reporting card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED status. A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a
standby card.

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-243 for the reporting card.

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

If the physical reseat of the card fails to clear the alarm, complete the “Physically Replace a Card”
procedure on page 2-244 for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.72 EQPT-DIAG

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT

An Equipment-Diagnostic Failure alarm indicates that a software or hardware failure has occurred on
the reporting card. This alarm can be raised against a traffic card or a cross-connect card.

Clear the EQPT-DIAG Alarm

Step 1

Step 2
Step 3

Step 4

If traffic is active on the alarmed card, you could need to switch traffic away from it. Refer to the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-237 for procedures.

Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-243 for the alarmed card

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 if it is
raised against a traffic card, or complete the “2.8.5 Generic Signal and Circuit Procedures” procedure
on page 2-244 if the alarm is raised against the cross-connect card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.73 EQPT-MISS

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: FAN

The Replaceable Equipment or Unit Missing alarm is reported against the fan-tray assembly unit. It
indicates that the replaceable fan-tray assembly is missing or is not fully inserted. It could also indicate
that the ribbon cable connecting the AIP to the system board is bad.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the EQPT-MISS Alarm

Step1  If the alarm is reported against the fan, verify that the fan-tray assembly is present.

Step2  If the fan-tray assembly is present, complete the “Replace the Fan-Tray Assembly” procedure on
page 2-249.

Step3  If no fan-tray assembly is present, obtain a fan-tray assembly and refer to the “Install the Fan-Tray
Assembly,” procedure in the “Install the Shelf and Common Control Cards” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Step4  If the alarm does not clear, replace the ribbon cable from the AIP to the system board with a known-good
ribbon cable.

Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.74 ERFI-P-CONN

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Objects: STSMON, STSTRM

The Three-Bit (Enhanced) Remote Failure Indication (ERFI) Path Connectivity condition is triggered on
DS-1, DS-3, or VT circuits when the “UNEQ-P” alarm on page 2-226 and the “TIM-P” alarm on
page 2-223 are raised on the transmission signal.

Clear the ERFI-P-CONN Condition

Step 1 Clear the UNEQ-P alarm. This should clear the ERFI condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.75 ERFI-P-SRVR

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM

The Three-Bit ERFI Path Server condition is triggered on DS-1, DS-3, or VT circuits when the “AIS-P”
condition, page 2-27 or the “LOP-P” alarm on page 2-131 is raised on the transmission signal.

Clear the ERFI-P-SRVR Condition

Step 1 Complete the “Clear the LOP-P Alarm” procedure on page 2-131. This should clear the ERFI condition.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.76 EXCCOL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Excess Collisions on the LAN alarm indicates that too many collisions are occurring between data
packets on the network management LAN, and communications between the ONS system and CTC
could be affected. The network management LAN is the data network connecting the workstation
running the CTC software to the TCC2/TCC2P card. The problem causing the alarm is external to the
ONS system.

Troubleshoot the network management LAN connected to the TCC2/TCC2P card for excess collisions.
You might need to contact the system administrator of the network management LAN to accomplish the
following steps.

Clear the EXCCOL Alarm

Step 1 Verify that the network device port connected to the TCC2/TCC2P card has a flow rate set to 10 Mb,
half-duplex.

Step2  If the port has the correct flow rate and duplex setting, troubleshoot the network device connected to the
TCC2/TCC2P card and the network management LAN.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.77 EXT

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: ENVALRM
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A Failure Detected External to the NE alarm occurs because an environmental alarm is present. For
example, a door could be open or flooding could have occurred.

Clear the EXT Alarm
Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the AIC-I card to open the
card view.
Step2  Double-click the Maintenance > External Alarms tabs.
Step3  Follow your standard operating procedure to remedy environmental conditions that cause alarms. The
alarm clears when the situation is remedied.
Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1-800-553-2447).

2.5.78 FAILTOSW (2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, TRUNK, OTS)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, TRUNK, OTS

The Failure to Switch to Protection Facility condition for MXP and TXP client ports occurs in a Y-cable
protection group when a working or protect facility switches to its companion port by using a MANUAL
command. For example, if you attempt to manually switch traffic from an unused protect port to an
in-service working port, the switch will fail (because traffic is already present on the working port) and
you will see the FAILTOSW condition.

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Clear the FAILTOSW (2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, TRUNK, OTS) Condition

Step 1

Step 2

Step 3

Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card
and clears the FAILTOSW.

If the condition does not clear, replace the working card that is reporting the higher-priority alarm by
following the “Physically Replace a Card” procedure on page 2-244. This card is the working facility
using the protect facility and not reporting FAILTOSW.

Replacing the working card that is reporting the higher-priority alarm allows traffic to revert to the
working slot and the card reporting the FAILTOSW to switch to the protect card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.79 FAILTOSW (TRUNK)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Failure to Switch to Protection Facility condition applies to MXP and TXP trunk ports in splitter
protection groups and occurs when a working or protect trunk port switches to its companion port by
using a MANUAL command.

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Clear the FAILTOSW (TRUNK) Condition

Step 1

Step 2

Step 3

Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card
and clears the FAILTOSW.

If the condition does not clear, replace the working card that is reporting the higher-priority alarm by
following the “Physically Replace a Card” procedure on page 2-244. This card is the working facility
using the protect facility and not reporting FAILTOSW.

Replacing the working card that is reporting the higher-priority alarm allows traffic to revert to the
working slot and the card reporting the FAILTOSW to switch to the protect card.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.80 FAILTOSW-HO

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP

The High-Order Path Failure to Switch to Protection condition occurs when a high-order path circuit
fails to switch to the working or protect electrical circuit using the MANUAL command.

Clear the FAILTOSW-HO Condition

Step 1

Step 2

Complete the “Clear the FAILTOSW (2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, TRUNK, OTS)
Condition” procedure on page 2-76.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.
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2.5.81 FAILTOSW-PATH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VI-MON

The Fail to Switch to Protection Path condition occurs when the working circuit does not switch to the
protection circuit on a path protection configuration. Common causes of the FAILTOSW-PATH alarm
include a missing or defective protect port, a lockout set on one of the path protection nodes, or
path-level alarms that would cause a path protection switch to fail including the “AIS-P” condition on
page 2-27, the “LOP-P” alarm on page 2-131, the “SD-P” condition, page 2-202, the “SF-P” condition
on page 2-206, and the “UNEQ-P” alarm on page 2-226.

The “SD-L” condition on page 2-201, or the “SF-L” condition on page 2-205 can also occur on the failed
path.

Clear the FAILTOSW-PATH Condition in a Path Protection Configuration

Step1  Look up and clear the higher-priority alarm. Clearing this alarm frees the standby card and clears the
FAILTOSW-PATH condition. If the “AIS-P” condition on page 2-27, the “LOP-P” alarm on page 2-131,
the “UNEQ-P” alarm on page 2-226, the “SF-P” condition on page 2-206, the “SD-P” condition,
page 2-202, the “SD-L” condition on page 2-201, or the “SF-L” condition on page 2-205 are also
occurring on the reporting port, complete the applicable alarm clearing procedure.

>
Note A higher-priority alarm is an alarm raised on the working electrical card using the 1:N card

protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW
condition.

Step2  If the condition does not clear, replace the active OC-N card that is reporting the higher-priority alarm.
Complete the “Physically Replace a Card” procedure on page 2-244. Replacing the active OC-N card
that is reporting the higher-priority alarm allows traffic to revert to the active slot. Reverting frees the
standby card, which can then take over traffic from the card reporting the lower-priority alarm and the
FAILTOSW-PATH condition.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

25.82 FAN

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: FAN

The Fan Failure alarm indicates a problem with the fan-tray assembly. When the fan-tray assembly is not
fully functional, the temperature of the ONS system can rise above its normal operating range.

The fan-tray assembly contains six fans and needs a minimum of five working fans to properly cool the
shelf. However, even with five working fans, the fan-tray assembly could need replacement because a
sixth working fan is required for extra protection against overheating.
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Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the FAN Alarm

Step 1 Determine whether the air filter needs replacement. Complete the “Inspect, Clean, and Replace the
Reusable Air Filter” procedure on page 2-247.

Step2  If the filter is clean, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-248.

Step3  If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-249. The fan should run immediately when correctly inserted.

Step4  If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447).

2.5.83 FAPS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: TRUNK

The Fast Automatic Protection Switching condition is applicable to GEXP/10GEXP cards. This
condition occurs when the protection port, on the master card, switches from blocking to forwarding
state.

Clear the FAPS Alarm

Step1  When the cause of switching disappears, the protection port switches from the forwarding to the
blocking state, and the FAPS alarm clears.

Step2  If the alarm does not clear even after the protection port switches back to the blocking state, log into the
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1 800 553-2447).

2.5.84 FAPS-CONFIG-MISMATCH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Fast Automatic Protection Switching (FAPS) Config Mismatch condition is raised when a GE-XP
or 10GE-XP card that is provisioned as a master card in a FAPS ring, resets or when one of the master
card’s trunk port is not set to Blocking.
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Clear the FAPS-CONFIG-MISMATCH Condition

Step 1

Step 2

Check the configuration of the master card. Ensure that at least one of the trunk ports of the master card
is in the blocking state and the FAPS ring is complete.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.85 FC-NO-CREDITS

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Objects: Client port

The Fibre Channel Distance Extension Credit Starvation alarm occurs on storage access networking
(SAN) Fibre Channel/Fiber Connectivity (FICON) DWDM cards when the congestion prevents the GFP
transmitter from sending frames to the DWDM card port. For example, the alarm can be raised when an
operator configures a card to autodetect framing credits but the card is not connected to an interoperable
FC-SW-standards-based Fibre Channel/FICON port.

FC-NO-CREDITS is raised only if transmission is completely prevented. (If traffic is slowed but still
passing, this alarm is not raised.)

Clear the FC-NO-CREDITS Alarm

Step 1

Step 2

Step 3

If the port is connected to a Fibre Channel/FICON switch, make sure it is configured for interoperation
mode using the manufacturer's instructions.

If the port is not connected to a switch, turn off Autodetect Credits by completing the following steps:
a. Double-click the DWDM card.
b. Click the Provisioning > Port > General tabs.
¢. Under Admin State, click the cell and choose OOS,MT (or Locked,maintenance).
d. Click Apply.
e. Click the Provisioning > Port > Distance Extension tabs.
f. Uncheck the Autodetect Credits column check box.
g. Click Apply.
h. Click the Provisioning > Port > General tabs.
i. Under Admin State, click the cell and choose IS , or Unlocked.
j. Click Apply.

Program the Credits Available value based on the buffers available on the connected equipment by
completing the following steps:
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Note  The NumCredits entry must be provisioned to a value smaller than or equal to the receive buffers
or credits available on the connected equipment.

a. Double-click the DWDM card.

b. Click the Provisioning > Port > Distance Extension tabs.
c. Enter a new value in the Credits Available column.

d. Click Apply.

Step4  If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447).

2.5.86 FDI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: OCH, OCH-TERM, OMS, OTS, EQPT

The Forward Defect Indication (FDI) condition is part of MSTP network-level alarm correlation in R7.0.
It is raised at the far end when the OCH optical payload is missing due to an optical channel signal
(LOS), light (LOS-P), or optical power (OPWR-LFAIL) alarm root cause.

An LOS, LOS-P, or OPWR-LFAIL alarm on an MSTP circuit causes multiple alarms for each channel.
Correlation simplifies troubleshooting by reporting a single alarm for multiple alarms having one root
cause, then demoting the root alarms so that they are only visible in the Conditions window (showing

their original severity.)

FDI clears when the optical channel is working on the aggregated or single-channel optical port.

Note  Network-level alarm correlation is only supported for MSTP communication alarms. It is not supported
for equipment alarms.

Clear the FDI Condition

Step 1 Clear the root-cause service-affecting alarm by using one of the following procedures, as appropriate:
e “Clear the LOS (OTS) Alarm” procedure on page 2-136
e “Clear the LOS (TRUNK) Alarm” procedure on page 2-137
e “Clear the LOS-P (OCH) Alarm” procedure on page 2-142
e “Clear the LOS-P (AOTS, OMS, OTS) Alarm” procedure on page 2-140
e “Clear the LOS-P (TRUNK) Alarm” procedure on page 2-146
e “Clear the OPWR-LFAIL Alarm” procedure on page 2-178

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.87 FE-FRCDWKSWBK-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN

The Far End Forced Switch Back to Working—Span condition is raised on a far-end 1+1 protect port when
it is Force switched to the working port.

~

Note = WKSWBK-type conditions apply only to nonrevertive circuits.

Clear the FE-FRCDWKSWBK-SPAN Condition

Step1  Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-238 for the far-end
port.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.88 FE-FRCDWKSWPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN

The Far End Working Facility Forced to Switch to Protection Span condition occurs from a far-end node
when a span on a four-fiber BLSR is forced from working to protect using the Force Span command.
This condition is only visible on the network view Conditions tab. The port where the Force Switch
occurred is indicated by an “F” on the network view detailed circuit map. This condition is accompanied
by WKSWPR.

Clear the FE-FRCDWKSWPR-SPAN Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step2  Log into the node that links directly to the card reporting the FE condition.
Step3  Clear the main alarm.

Step 4 If the FE-FRCDWKSWPR-SPAN condition does not clear, complete the “Clear a BLSR External
Switching Command” procedure on page 2-240.
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Step5  If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.89 FE-MANWKSWBK-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN

The Far End Manual Switch Back to Working—Span condition occurs when a far-end span is Manual
switches back to working.

~

Note = WKSWBK-type conditions apply only to nonrevertive circuits.

Clear the FE-EMANWKSWBK-SPAN Condition

Step1  To troubleshoot the FE condition, determine which node and card is linked directly to the card reporting
the FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main
alarm from a card in Slot 6 of Node 2.

Step2  Log into the node that is linked directly to the card reporting the FE condition.
Step3  Complete the “Clear a BLSR External Switching Command” procedure on page 2-240.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2590 FE-MANWKSWPR-SPAN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN

The Far-End Span Manual Switch Working Facility to Protect condition occurs when a four-fiber BLSR
span is switched from working to protect at the far-end node using the Manual Span command. This
condition is only visible on the network view Conditions tab and is accompanied by WKSWPR. The port
where the Manual Switch occurred is indicated by an “M” on the network view detailed circuit map.

Clear the FE-FMANWKSWPR-SPAN Condition

Step 1 To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE condition on a card in Slot 12 of Node 1 could link to the main condition
from a card in Slot 6 of Node 2.
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Step 2
Step 3
Step 4

Log into the node that links directly to the card reporting the FE condition.
Complete the “Clear a BLSR External Switching Command” alarm, page 2-240.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2591 FEC-MISM

Note

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The Forward Error Correction (FEC) Mismatch alarm applies to all cards featuring FEC/E-FEC
capability: TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_10G, MXP_MR_10E, ADM-10G, and OTU2_XP. FEC-MISMATCH is
reported only on the card configured in Standard FEC mode or with FEC disabled. A card configured in
enhanced FEC mode will report an “OTUK-LOF” alarm on page 2-181.

The alarm is related to ITU-T G.709 encapsulation and is only raised against a trunk port.

For general information about MXP and TXP cards and their monitoring capabilities, refer to the “Card
Reference” chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about
provisioning them, refer to the “Provision Transponder and Muxponder Cards” chapter in the

Cisco ONS 15454 DWDM Procedure Guide.

Clear the FEC-MISM Alarm

Step 1

Step 2
Step 3

Step 4
Step 5

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_10G, MXP_MR_10E, ADM-10G, and OTU2_XP card.

Click the Provisioning > OTN > OTN Lines tabs.

In the FEC column, click Enable to activate the FEC feature. This causes a different OTN frame to be
transmitted. Alternately, in the E-FEC column (TXP_MR_10E and MXP_MR_10E), click Enable to
activate the Enhanced FEC feature.

Verify that the far-end card is configured the same way by repeating Step 1 through Step 3.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.
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2.5.92 FEPRLF

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN

The Far-End Protection Line Failure alarm occurs when there was an “SF (TRUNK)” condition on
page 2-204 condition on the protect card’s APS channel coming into the node.

The FEPRLF alarm occurs on the ONS 15454 only when bidirectional protection is used on optical
(traffic) cards in a 1+1 protection group configuration.

Clear the FEPRLF Alarm on an BLSR

Step 1

Step 2
Step 3
Step 4

To troubleshoot the FE alarm, determine which node and card is linked directly to the card reporting the
FE alarm. For example, an FE alarm or condition on a card in Slot 16 of Node 1 could relate to a main
alarm from a card in Slot 16 in Node 2.

Log into the node that is linked directly to the card reporting the FE alarm.
Clear the main alarm. Refer to the appropriate alarm section in this chapter for procedures.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.93 FIBERTEMP-DEG

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS

The Fiber Temperature Degrade alarm occurs when a DWDM card internal heater-control circuit fails.
Degraded temperature can cause some signal drift. The card should be replaced at the next opportunity.

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the FIBERTEMP-DEG Alarm

Step 1

A

Warning

For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-244 at the next
opportunity.

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201
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Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.94 FORCED-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT, ML1000, ML100T, MLFX, STSMON, VT-MON

The Force Switch Request on Facility or Port condition occurs when you enter the Force command on a
port to force traffic from a working port to a protect port or protection span (or from a protect port to a
working port or span). You do not need to clear the condition if you want the Force switch to remain.

FORCED-REQ is raised for an IEEE 802.17b-based RPR span if the force was requested in the

Cisco IOS CLI using the “rpr-ieee protection request force-switch {east | west}” command. It clears
from the RPR-IEEE span when you remove the switch in the CLI. For the IEEE 802.17b-based RPR
interface, FORCED-REQ is suppressed by the RPR-PASSTHR alarm. It also suppresses the following
alarms:

e MAN-REQ (for an ML-Series object)
e RPR-SF

e RPR-SD

e WTR (for an ML-Series object)

Clear the FORCED-REQ Condition

Step 1
Step 2

Step 3

Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-238.
If the condition is raised on an IEEE 802.17b-based RPR span, enter the following command in the CLI
in RPR-IEEE interface configuration mode:

router (config-if)#no rpr-ieee protection request force-switch {east | west}

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.95 FORCED-REQ-SPAN (2R, ESCON, FC, GE, ISC, OCN/STMN, OTS)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, OTS

The Force Switch Request Span condition applies to Y-cable-protected TXP configurable clients (OC-3,
OC-12/STM-4,0C-48/STM-16, OC-192/STM-64, FC, ESCON, or FICON). If traffic is present on a
working port and you use the FORCE command to prevent it from switching to the protect port
(indicated by “FORCED TO WORKING”), FORCED-REQ-SPAN indicates this force switch. In this
case, the force is affecting not only the facility, but the span.
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Note  For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

2.5.96 FORCED-REQ-SPAN (TRUNK)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Force Switch Request Span condition applies to MXP and TXP trunk ports in splitter protection
groups. If traffic is present on a working port and you use the FORCE command to prevent it from
switching to the protect port (indicated by “FORCED TO WORKING”), FORCED-REQ-SPAN
indicates this force switch. In this case, the force is affecting not only the facility, but the span.

Note  For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

2.5.97 FP-LINK-LOSS

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Front Port Link Loss condition occurs when a LAN cable is not connected to the front port of the
TCC2/TCC2P card.

Clear the FP-LINK-LOSS Condition

Step 1 Connect a LAN cable to the front port of the TCC2/TCC2P card.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.98 FRCDSWTOINT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF

The Force Switch to Internal Timing condition occurs when the user issues a Force command to switch
to an internal timing source.

~

Note FRCDSWTOINT is an informational condition and does not require troubleshooting.
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2.5.99 FRCDSWTOPRI

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Primary Timing Source condition occurs when the user issues a Force command to
switch to the primary timing source.

FRCDSWTOPRI is an informational condition and does not require troubleshooting.

2.5.100 FRCDSWTOSEC

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Second Timing Source condition occurs when the user issues a Force command to
switch to the second timing source.

FRCDSWTOSEC is an informational condition and does not require troubleshooting.

2.5.101 FRCDSWTOTHIRD

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Force Switch to Third Timing Source condition occurs when the user issues a Force command to
switch to a third timing source.

FRCDSWTOTHIRD is an informational condition and does not require troubleshooting.

2.5.102 FRNGSYNC

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF

The Free Running Synchronization Mode condition occurs when the reporting ONS system is in free-run
synchronization mode. External timing sources have been disabled and the node is using its internal
clock, or the node has lost its designated building integrated timing supply (BITS) timing source. After
the 24-hour holdover period expires, timing slips could begin to occur on an ONS system node relying
on an internal clock.

If the ONS system is configured to operate from its internal clock, disregard the FRNGSYNC condition.
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Clear the FRNGSYNC Condition

Step 1

Step 2

Step 3

If the ONS system is configured to operate from an external timing source, verify that the BITS timing
source is valid. Common problems with a BITS timing source include reversed wiring and bad timing
cards. Refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual for more information.

If the BITS source is valid, clear alarms related to the failures of the primary and secondary reference
sources, such as the “SYNCPRI” alarm on page 2-219 and the “SYNCSEC” alarm on page 2-220.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.103 FSTSYNC

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF

A Fast Start Synchronization Mode condition occurs when the node is choosing a new timing reference.
The previous timing reference has failed.

The FSTSYNC alarm disappears after approximately 30 seconds. If the condition does not clear, log into
the Technical Support Website at http://www.cisco.com/techsupport for more information or call
Cisco TAC (1-800-553-2447).

FSTSYNC is an informational condition. It does not require troubleshooting.

25.104 FTA-MISMATCH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Fan Tray Mismatch condition is raised on the ADM-10G card and OTU2_XP. It indicates that an
unsupported version of the fan tray assembly (15454-FTA3 or 15454-FTA2) is installed in the shelf. The
ADM-10G and OTU2_XP card must be installed in a shelf that has FTA version 4 or higher.

Clear the FTA-MISMATCH Condition

Step 1

Step 2

Obtain the correct fan tray assembly (15454-FTA4 or higher), and replace the existing FTA with the new
one by following the “Replace the Fan-Tray Assembly” procedure on page 2-249.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

| 78-18378-02

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0 g



Chapter2  Alarm Troubleshooting |

W Trouble-Clearing Procedures

2.5.105 GAIN-HDEG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS

The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier reaches the Gain High Degrade Threshold. (This value is automatically provisioned
with the gain setpoint, but the alarm threshold is 2 dBm higher than the setpoint. The card should be
replaced at the first opportunity.

This alarm is applicable only when the amplifier working mode is set to Control Gain.

For general information about DWDM amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-HDEG Alarm

Step 1

Step 2
Step 3

A

Verify that the LED is correctly illuminated on the physical card. A green ACT/SBY LED indicates an
active card. A red ACT/SBY LED indicates a failed card.

Complete “Reset a Card in CTC” procedure on page 2-241 on the failing amplifier.

If the alarm does not clear, identify all the OCHNC circuits applying to the failing card. Force all the
protected circuits on the optical path that the faulty amplifier does not belong to. Switch the OCHNC
administrative state of all these circuits to OOS,DSBLD (or Locked,disabled).

Caution

Step 4

Step 5

Step 6

A

Warning

A

Warning

All remaining unprotected circuits will suffer for a traffic hit when you disable the circuits.

Switch the administrative state of only one of the OCHNC circuits to IS,AINS (or
Unlocked,automaticInService. This forces the amplifier to recalculate its gain setpoint and value.

If the alarm does not clear and no other alarms exist that could be the source of the GAIN-HDEG alarm,
or if clearing an alarm did not clear the GAIN-HDEG, place all of the card ports in OOS,DSBLD (or
Locked,disabled) administrative state.

Complete the “Physically Replace a Card” procedure on page 2-244 for the reporting card.

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool hefore touching any other part of it or
hefore placing it in an antistatic bag. Statement 201
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Note  Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.106 GAIN-HFAIL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: AOTS

The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier reaches the Gain High Degrade Threshold. (This value is automatically provisioned
with the gain setpoint, but the alarm threshold is 5 dBm higher than the setpoint.) If the alarm cannot be
cleared, the card must be replaced.

This alarm is applicable only when the amplifier working mode is set to Control Gain.

For general information about DWDM cards, refer to the “Card Reference” chapter in the

Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-HFAIL Alarm

Step 1
Step 2

For the alarmed card, complete the “Clear the GAIN-HDEG Alarm” procedure on page 2-90.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.107 GAIN-LDEG

~

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS

The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier does not reach Gain High Degrade Threshold. (This value is automatically
provisioned with the gain setpoint, but the alarm threshold is 2 dBm lower than the setpoint.) The card
should be replaced at the first opportunity.

This alarm is applicable only when the amplifier working mode is set to Control Gain.
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Note

For general information about DWDM amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-LDEG Alarm

Step 1
Step 2

For the alarmed card, complete the “Clear the GAIN-HDEG Alarm” procedure on page 2-90.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.108 GAIN-LFAIL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: AOTS

The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier does not reach Gain High Degrade Threshold. (This value is automatically
provisioned with the gain setpoint, but the alarm threshold is 5 dBm lower than the setpoint. If the alarm
cannot be cleared, the card must be replaced.

This alarm is applicable only when the amplifier working mode is set to Control Gain.

For general information about DWDM amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-LFAIL Alarm

Step 1
Step 2

For the alarmed card, complete the “Clear the GAIN-HDEG Alarm” procedure on page 2-90.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.109 GCC-EOC

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK, EQPT
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The GCC Embedded Operation Channel Failure alarm applies to the optical transport network (OTN)
communication channel for TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_I0E_C, TXP_MR_I10E_L, MXP_2.5G_10G, MXP_2.5G_10E, ADM-10G, and OTU2_XP
cards. The GCC-EOC alarm is raised when the channel cannot operate.

This alarm applies to trunk ports only when ITU-T G.709 encapsulation is enabled and a general
communication channel (GCC) has been provisioned between the two TXP/MXP cards.

For more information about GCC circuits, please refer to the “Create Channels and Circuits” chapter in
the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GCC-EOC Alarm

Step 1
Step 2

Complete the “Clear the EOC Alarm” procedure on page 2-70.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25110 GE-00SYNC (FC, GE, ISC)

Note

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: FC, GE, ISC

The Gigabit Ethernet Out of Synchronization alarm applies to TXP_MR_10G,TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G,TXPP_MR_2.5G,MXP_MR_2.5G,
MXPP_MR_2.5G, GE-XP, 10GE, and ADM-10G cards when the Ethernet signal incoming on the
Client-Rx port is out of synchronization.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the GE-OOSYNC (FC, GE, ISC) Alarm

Step 1

Step 2
Step 3

Ensure that the incoming signal from the Client-Rx port is provisioned with the correct physical-layer
protocol (Ethernet).

Ensure that the line is provisioned with the correct line speed (10G or 1G Ethernet).

Verify that the optical power and the optical signal-to-noise range (OSNR) of the incoming Client-Rx
port optical signal are within the accepted ranges. You can find XFP/SFP ranges in the “Hardware
Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.
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Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

25111 GE-00SYNC (TRUNK)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: TRUNK

The Gigabit Ethernet Out of Synchronization alarm applies to TXP_MR_10G,TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G,TXPP_MR_2.5G,MXP_MR_2.5G,
MXPP_MR_2.5G, GE-XP, 10GE, and ADM-10G cards only when the ITU-T G.709 encapsulation
framer is disabled.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the GE-00OSYNC (TRUNK) Alarm

Step 1 Verify that ITU-T G.709 encapsulation is disabled:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b. Click the Provisioning > OTN > OTN Lines tabs.
c. If the G.709 OTN column says Enable, choose Disable from the drop-down list.
d. Click Apply.

Step 2 For the TRUNK-RX port, double-click the card and click the Performance > OTN PM > FEC PM tabs.
If post-FEC errors are present, troubleshoot this problem first. If not, move to next step.

Step3  Verify the status of far-end TXP/MXP connected to the faulty near-end card. Look for any alarms
reported by the Client-Rx port of far-end card. If these alarms exist, troubleshoot them.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.112 GFP-CSF

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX
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The GFP Client Signal Fail Detected alarm is a secondary alarm raised on local GFP data ports when a
remote Service-Affecting (SA) alarm causes invalid data transmission. The alarm is raised locally on
CE-100T-8, CE-1000-4, CE-MR-10, FC_MR-4, ML100T, ML1000, ML100X-8, ML-MR-10,
MXP_MR_25G, and MXPP_MR_25G GFP data ports and does not indicate that a

Service-Affecting (SA) failure is occurring at the local site, but that a CARLOSS, LOS, or SYNCLOSS
alarm caused by an event such as a pulled receive cable is affecting a remote data port's transmission
capability. This alarm can be demoted when a facility loopback is placed on the FC_MR-4 port.

For more information about provisioning MXP or TXP cards, refer to the Cisco ONS 15454 DWDM
Reference Manual. For more information about Ethernet cards, refer to the Ethernet Card Software
Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and

Cisco ONS 15327.

Clear the GFP-CSF Alarm

Step 1
Step 2

Clear the Service-Affecting (SA) alarm at the remote data port.

If the GFP-CSF alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) to report
a Service-Affecting (SA) problem.

25.113 GFP-LFD

Note

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX

The GFP Loss of Frame Delineation alarm applies to Fibre Channel, FICON GFP, and Ethernet ports.
This alarm occurs if there is a faulty SONET connection, if SONET path errors cause GFP header errors
in the check sum calculated over payload length (PLI/cHEC) combination, or if the GFP source port
sends an invalid PLI/cHEC combination. This loss causes traffic stoppage.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-LFD Alarm

Step 1

Step 2

Look for and clear any associated SONET path errors such as LOS or the “AU-AIS” alarm on page 2-38
that originate at the transmit node.

If the GFP-LFD alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) to report
a Service-Affecting (SA) problem.

| 78-18378-02

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0 g



Chapter2  Alarm Troubleshooting |

W Trouble-Clearing Procedures

2.5.114 GFP-UP-MISMATCH

Note

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX

The GFP User Payload Mismatch is raised against Fibre Channel/FICON ports supporting GFP. It occurs
when the received frame user payload identifier (UPI) does not match the transmitted UPI and all frames
are dropped. The alarm is caused by a provisioning error, such as the port media type not matching the
remote port media type. For example, the local port media type could be set to Fibre Channel—1 Gbps
ISL or Fibre Channel—2 Gbps ISL and the remote port media type could be set to FICON—1 Gbps ISL
or FICON—2 Gbps ISL.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-UP-MISMATCH Alarm

Step 1

Step 2

Step 3

Ensure that the transmit port and receive port are identically provisioned for distance extension by
completing the following steps:

a. Double-click the card to open the card view.

b. Click the Provisioning > Port > Distance Extension tabs.

¢. Check the check box in the Enable Distance Extension column.

d. Click Apply.

Ensure that both ports are set for the correct media type. For each port, complete the following steps:
a. Double-click the card to open the card view (if you are not already in card view).

b. Click the Provisioning > Port > General tabs.

c. Choose the correct media type (Fibre Channel - 1Gbps ISL, Fibre Channel - 2 Gbps ISL,
FICON - 1 Gbps ISL, or FICON - 2 Gbps ISL) from the drop-down list.

d. Click Apply.

If the GFP-UP-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) to report
a Service-Affecting (SA) problem.

25.115 HELLO

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN

The Open Shortest Path First (OSPF) Hello alarm is raised when the two end nodes cannot bring an
OSPF neighbor up to the full state. Typically, this problem is caused by an area ID mismatch, and/or
OSPF HELLO packet loss over the DCC.
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Clear the HELLO Alarm

Step1  Ensure that the area ID is correct on the missing neighbor by completing the following steps:
a. In node view, click the Provisioning > Network > OSPF tabs.
b. Ensure that the IP address in the Area ID column matches the other nodes.
c. If the address does not match, click the incorrect cell and correct it.
d. Click Apply.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country.

2.5.116 HIBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR

The High Voltage Battery alarm occurs in a -48 VDC environment when a battery lead input voltage
exceeds the high power threshold. This threshold, with a default value of —-52 VDC, is
user-provisionable. The alarm remains raised until the voltage remains under the threshold for

120 seconds.

Clear the HIBATVG Alarm

Step 1 The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.117 HI-CCVOLT

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: BITS

The 64K Composite Clock High NE Voltage alarm occurs when the 64K signal peak voltage exceeds
1.1 VDC.

Clear the HI-CCVOLT Condition

Step 1 Lower the source voltage to the clock.

Step2  If the condition does not clear, add more cable length or add a 5 dBm attenuator to the cable.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.118 HI-LASERBIAS

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, PPM, TRUNK

The Equipment High Transmit Laser Bias Current alarm is raised against TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_I10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, OC192-XFP, ADM-10G, and OTU2_XP card laser performance. The alarm indicates
that the card laser has reached the maximum laser bias tolerance.

Laser bias typically starts at about 30 percent of the manufacturer maximum laser bias specification and
increases as the laser ages. If the HI-ILASERBIAS alarm threshold is set at 100 percent of the maximum,
the laser usability has ended. If the threshold is set at 90 percent of the maximum, the card is still usable
for several weeks or months before it needs to be replaced.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. Specific hardware values are listed in the “Hardware
Specifications” appendix of the same manual.

Clear the HI-LASERBIAS Alarm

Step 1 Complete the “Physically Replace a Card” procedure on page 2-244. Replacement is not urgent and can
be scheduled during a maintenance window.

A

Warning  Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

A

Caution  Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has
not already occurred. See the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-237 for commonly used traffic-switching procedures.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.119 HI-LASERTEMP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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Logical Objects: EQPT, OCN/STMN, PPM

The Equipment High Laser Optical Transceiver Temperature alarm applies to the TXP, MXP, and
ADM-10G cards. HI-LASERTEMP occurs when the internally measured transceiver temperature
exceeds the card setting by 35.6 degrees F (2 degrees C). A laser temperature change affects the
transmitted wavelength.

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The LOS (OCN/STMN)
alarm is raised at the far-end node and the “DUP-IPADDR” alarm, page 2-65, is raised at the near end.
(For instructions to clear either of these alarms, you can also refer to the “Alarm Troubleshooting”
chapter in the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting
Guide.)

For information about MXP and TXP cards and PPMs (SFPs), refer to the “Card Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the HI-LASERTEMP Alarm

Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP or MXP card to
open the card view.

Click the Performance > Optics PM > Current Values tabs.

Verify the card laser temperature levels. Maximum, minimum, and average laser temperatures are shown
in the Current column entries in the Laser Temp rows.

Complete the “Reset a Card in CTC” procedure on page 2-241 for the MXP or TXP card.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
reporting MXP or TXP card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.120 HI-RXPOWER

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, TRUNK, EQPT

The Equipment High Receive Power alarm is an indicator of the optical signal power that is transmitted
to the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_I10E, TXP_MR_10E_C,
TXP_MR_10E_L, MXP_2.5G_10G, OC192-XFP, GE-XP, 10GE-XP, ADM-10G, or OTU2_XP card.
HI-RXPOWER occurs when the measured optical power of the received signal exceeds the threshold.
The threshold value is user-provisionable.

For general information about MXP and TXP cards and their power levels, refer to the “Card Reference”
chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them,
refer to the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.
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Clear the HI-RXPOWER Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Check the PM of the TRUNK-RX port. Verify that received power is above the optics threshold:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b. For the TRUNK-RX port, double-click the card and click the Performance > Optics PM >
Historical PM tabs, choose the port in the Port drop-down list, and click Refresh.

¢. Compare the refreshed PM values with the threshold (ensuring that it is above the threshold value)
by clicking the Performance > Optics PM > Current Values tabs.

d. Ensure that a proper threshold has been provisioned for the receive value. (Refer to the “Provision
Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If
an incorrect threshold has been set, adjust it to a value within the allowed limits. If instead the alarm
condition does not clear, move to next step.

Verify that the Trunk-Rx port is cabled correctly, and clean the fiber connecting the faulty TXP/MXP to
the Drop port of the DWDM card (32DMX, 32DMX-0, 40DMX, or AD-xC-xx.x). If no site cleaning
practices are available, refer to the fiber cleaning procedure in the “Maintain the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Determine whether a bulk attenuator is specified by the Cisco TransportPlanner (MP) design. If so,
verify that the proper fixed attenuation value has been used.

Using a test set, check the optical power value of the Drop port of the DWDM card (32DMX, 32DMX-O,
40DMX, or AD-xC-xx.x) connected to the faulty TXP/MXP. If the read value is different (+1 dBm or
—1 dBm) from the ANS setpoint for “Padd&drop-Drop power,” move to next step.

Look for and troubleshoot any alarm reported by the DWDM cards belonging to the OCHNC circuit
destinating at the faulty TXP/MXP. Possible alarms include amplifier Gain alarms (the “GAIN-HDEG”
alarm on page 2-90, the “GAIN-HFAIL” alarm on page 2-91, the “GAIN-LDEG” alarm on page 2-91,
or “GAIN-LFAIL” alarm on page 2-92); APC alarms (“APC-CORR-SKIPPED” alarm on page 2-29 or
“APC-OUT-OF-RANGE” alarm on page 2-31), or LOS-P alarms on the Add or Drop ports involved in
the OCHNC circuit.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.121 HITEMP

Default Severity: Critical (CR), Service-Affecting (SA) for NE; Default Severity: Minor (MN),
Non-Service-Affecting (NSA) for EQPT

Logical Objects: EQPT, NE

The High Temperature alarm occurs when the temperature of the ONS system is above 122 degrees F
(50 degrees C).

Clear the HITEMP Alarm

Step 1

View the temperature displayed on the ONS system LCD front panel. For example, the ONS 15454 front
panel is illustrated in Figure 2-2.
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Figure 2-2 Shelf LCD Panel
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Verify that the environmental temperature of the room is not abnormally high.

If the room temperature is not abnormal, physically ensure that nothing prevents the fan-tray assembly
from passing air through the ONS system shelf.

If airflow is not blocked, physically ensure that blank faceplates fill the ONS system shelf empty slots.
Blank faceplates help airflow.

If faceplates fill the empty slots, determine whether the air filter needs replacement. Refer to the
“Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-247.

If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-249.

~

Note  The fan should run immediately when correctly inserted.

If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447) if it applies to the NE, or a

Non-Service-Affecting (NSA) problem if it applies to equipment.

2.5.122 HI-TXPOWER

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, PPM, TRUNK

The Equipment High Transmit Power alarm is an indicator on the TXP_MR_E, TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, OC192-XFP, ADM-10G, or OTU2_XP card
transmitted optical signal power. HI-TXPOWER occurs when the measured optical power of the
transmitted signal exceeds the threshold.

For general information about MXP and TXP cards and power levels, refer to the “Card Reference”
chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them,
refer to the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.
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Clear the HI-TXPOWER Alarm

Step1  Check the PM of the Trunk-Tx port. Verify that received power is above the optics threshold:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b. For the Trunk-Tx port, double-click the card and click the Performance > Optics PM >
Historical PM tabs, choose the port in the Port drop-down list, and click Refresh.

¢. Compare the refreshed PM values with the threshold (ensuring that it is above the threshold value)
by clicking the Performance > Optics PM > Current Values tabs.

d. Ensure that a proper threshold has been provisioned for the receive value. (Refer to the “Provision
Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If
an incorrect threshold has been set, adjust it to a value within the allowed limits. If instead the alarm
condition does not clear, move to next step.

Step2  Physically verify, by using a standard power meter that the optical output power is overcoming the
expected power threshold. If so, the card should be replaced at first opportunity

~

Note  The higher power level is not a major issue for the DWDM card (32MUX-0O, 40MUX,
32WSS-0, 40WSS-C, or AD-xC-xx.x) connected to the faulty TXP/MXP, because an
internal VOA can automatically decrease the optical power to the expected level.

Step3  Complete the “Physically Replace a Card” procedure on page 2-244.

Step4  If the alarm does not clear after the replacement, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a Service-Affecting (SA) problem. If the alarm does not clear, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

2.5.123 HLDOVRSYNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF

The Holdover Synchronization Mode condition is caused by loss of the primary and second timing
references in the node. Timing reference loss occurs when line coding on the timing input is different
from the configuration on the node, and it often occurs during the selection of a new node reference
clock. The condition clears when primary or second timing is reestablished. After the 24-hour holdover
period expires, timing slips could begin to occur on an ONS system relying on an internal clock.

Clear the HLDOVRSYNC Condition

Step 1 Clear additional alarms that relate to timing, such as:
e 2.5.102 FRNGSYNC, page 2-88
e 2.5.103 FSTSYNC, page 2-89
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e 2.5.153 LOF (BITS), page 2-126

e 25.163 LOS (BITS), page 2-134

e 2.5.188 MANSWTOINT, page 2-156
e 2.5.189 MANSWTOPRI, page 2-156
e 2.5.190 MANSWTOSEC, page 2-156
e 2.5.191 MANSWTOTHIRD, page 2-156
e 25.292 SWTOPRI, page 2-217

e 2.5.293 SWTOSEC, page 2-217

e 2.5.294 SWTOTHIRD, page 2-217

e 2.5.295 SYNC-FREQ, page 2-218

e 2.5.297 SYNCPRI, page 2-219

e 2.5.298 SYNCSEC, page 2-220

e 2.5.299 SYNCTHIRD, page 2-220

Reestablish a primary and secondary timing source according to local site practice. If none exists, refer
to the “Turn Up the Network™ chapter in the Cisco ONS 15454 DWDM Procedure Guide.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) in order to
report a Service-Affecting (SA) problem.

2.5.124 HP-DEG

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VMMON-HP, VCTRM-HP

An HP-DEG condition is similar to the “SD (TRUNK)” condition, page 2-201, but it applies to the HP
layer of the SDH overhead. A HP-DEG alarm travels on the B3 byte of the SDH overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for
HP-DEG from 1E-9 dBm to 1E-5 dBm. For MS-SPRing 1+1 and unprotected circuits, the BER
threshold value is not user-provisionable and the error rate is hard-coded to 1E-6 dBm.

On path protection configurations, an HP-DEG condition causes a switch from the working card to the
protect card at the path level. On MS-SPRing, 1+1, and on unprotected circuits, an HP-DEG condition
does not cause switching.

The BER increase that causes the condition is sometimes caused by a physical fiber problem such as a
poor fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

HP-DEG clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the HP-DEG Condition

Step 1

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.125 HP-ENCAP-MISMATCH

Note

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: VCTRM-HP

The High-Order Path Encapsulation C2 Byte Mismatch alarm applies to ML-Series Ethernet cards. It
occurs when the first three following conditions are met and one of the last two is false:

e The received C2 byte is not 0x00 (unequipped).

e The received C2 byte is not a PDI value.

e The received C2 does not match the expected C2.

e The expected C2 byte is not 0x01 (equipped unspecified).
e The received C2 byte is not 0x01 (equipped unspecified).

(This is in contrast to LP-PLM, which must meet all five criteria.) For an HP-ENCAP-MISMATCH to
be raised, there is a mismatch between the received and expected C2 byte, with either the expected byte
or received byte value being 0x01.

An example situation that would raise an HP-ENCAP-MISMATCH alarm is if a circuit created between
two ML-Series cards has GFP framing provisioned on one end and high-level data link control (HDLC)
framing with LEX encapsulation provisioned on the other. The GFP framing card transmits and expects
a C2 byte of Ox1B, while the HDLC framing card transmits and expects a C2 byte of 0x01.

A mismatch between the transmit and receive cards on any of the following parameters can cause the
alarm:

e Mode (HDLC, GFP-F)

e Encapsulation (LEX, HDLC, PPP)
e CRCsize (16 or 32)

e Scrambling state (on or off)

This alarm is demoted by a path label mismatch (PLM) such as LP-PLM.

By default, an HP-ENCAP-MISMATCH alarm causes an ML-Series card data link to go down. This
behavior can be modified using the command-line interface (CLI) command no pos trigger defect
encap.

For more information about the ML-Series Ethernet card, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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Clear the HP-ENCAP-MISMATCH Alarm

Step 1

Step 2

Step 3

Step 4

Ensure that the correct framing mode is in use on the receiving card by completing the following steps:
a. Innode view, double-click the ML-Series card to display the card view.
b. Click the Provisioning > Card tabs.

¢. In the Mode drop-down list, ensure that the correct mode (GFP-F or HDLC) is selected. If it is not,
choose it and click Apply.

Ensure that the correct framing mode is in use on the transmit card, and that it is identical to the framing
mode used on the receiving card by completing the following steps:

a. Innode view, double-click the ML-Series card to display the card view.
b. Click the Provisioning > Card tabs.

¢. In the Mode drop-down list, ensure that the same mode (GFP-F or HDLC) is selected. If it is not,
choose it and click Apply.

If the alarm does not clear, use the ML-Series card CLI to ensure that the remaining settings are correctly
configured:

e Encapsulation
e CRCsize
e Scrambling state

To open the interface, click the card view 1OS tab and click Open IOS Connection. Refer to the
Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454
SDH, and Cisco ONS 15327 entries on all three of these topics to obtain the full configuration command
sequences.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.126 HP-EXC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: VCMON-HP, VCTRM-HP

An HP-EXC condition is similar to the “SF (TRUNK)” condition, page 2-204, but it applies to the path
layer B3 byte of the SONET overhead. It can trigger a protection switch.

The HP-EXC condition clears when the BER level falls to one-tenth of the threshold level that triggered
the condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

Clear the HP-EXC Condition

Step 1

Complete the “Clear the SF (TRUNK) Condition” procedure on page 2-204.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

25127 HP-PLM

The HP-PLM condition is not used in this platform in this release. It is reserved for development.

2.5.128 HP-RFI

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP

The High-Order Remote Failure Indication (RFI) condition indicates that there is a remote failure
indication in the high-order (VC-4 or VC-3) path, and that the failure has persisted beyond the maximum
time allotted for transmission system protection. The HP-RFI is sent as the protection switch is initiated.
Resolving the fault in the adjoining node clears the HP-RFI condition in the reporting node.

Clear the HP-RFI Condition

Step1  Log into the node at the far end of the reporting ONS 15454.
Step2  Determine whether there are any related alarms, especially the LOS(STMI1E, STMN).
Step3  Clear the main alarm. See the appropriate alarm section in this chapter for procedures.

Step4  If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

25129 HP-TIM

Default Severities: Critical (CR), Service-Affecting (SA) for VCTRM-HP; Minor (MN),
Non-Service-Affecting (NSA) for VCMON-HP

Logical Objects: VCMON-HP, VCTRM-HP

The TIM High-Order TIM Failure alarm indicates that the trace identifier J1 byte of the high-order
(VC-4 or VC-3) overhead is faulty. HP-TIM occurs when there is a mismatch between the transmitted
and received J1 identifier byte in the SONET path overhead. The error can originate at the transmit end
or the receive end.
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Clear the HP-TIM Alarm

Step 1

Step 2
Step 3

Use an optical test set capable of viewing SONET path overhead to determine the validity of the J1 byte.
For specific procedures to use the test set equipment, consult the manufacturer. Examine the signal as
near to the reporting card as possible.

e Examine the signal as close as possible to the output card.
If the output card signal is valid, complete the “Clear the SYNCPRI Alarm” procedure on page 2-219.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country. If the alarm applies to
VCTRM-HP, it is a service-affecting problem.

2.5.130 HP-UNEQ

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: VCMON-HP, VCTRM-HP

The signal label mismatch fault (SLMF) Unequipped High-Order Path alarm applies to the C2 path
signal label byte in the high-order (VC-4) path overhead. HP-UNEQ occurs when no C2 byte is received
in the SONET path overhead.

Clear the HP-UNEQ Alarm

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7

From the View menu, choose Go to Network View.

Right-click the alarm to display the Select Affected Circuits shortcut menu.

Click Select Affected Circuits.

When the affected circuits appear, look in the Type column for a virtual circuit (VC).

If the Type column does not contain a VC, there are no VCs. Go to Step 7.

If the Type column does contain a VC, attempt to delete these row(s) by completing the following steps:

~

Note  The node does not allow you to delete a valid VC.

a. Click the VC row to highlight it. Complete the “Delete a Circuit” procedure on page 2-245.
b. If an error message dialog box appears, the VC is valid and not the cause of the alarm.
c. If any other rows contain VT, repeat Steps a through b.

If all ONS nodes in the ring appear in the CTC network view, verify that the circuits are all complete by
completing the following steps:

a. Click the Circuits tab.
b. Verify that INCOMPLETE is not listed in the Status column of any circuits.
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Step 8

Step 9

Step 10

Step 11

Step 12

A

Warning

A

Warning

>

Warning

Step 13

If you find circuits listed as incomplete, verify that these circuits are not working circuits that continue
to pass traffic, using an appropriate optical test set and site-specific procedures. For specific procedures
to use the test set equipment, consult the manufacturer.

If the incomplete circuits are not needed or are not passing traffic, delete the incomplete circuits.
Complete the “Delete a Circuit” procedure on page 2-245.

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and Tunnels” chapter in
the Cisco ONS 15454 Procedure Guide for circuit procedures.

Log back in and verify that all circuits terminating in the reporting card are active by completing the
following steps:

a. Click the Circuits tab.
b. Verify that the Status column lists all circuits as active.

If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure
Guide.

On the 0C192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is
off when the safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
optical and/or electrical cards.

Caution

Step 14

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the “Maintain the Node” chapter
in the Cisco ONS 15454 Procedure Guide for information.

~

Note  When you replace a card with the identical type of card, you do not need to make any changes
to the database.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.
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25.131 I-HITEMP

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: NE

The Industrial High Temperature alarm occurs when the temperature of the ONS system is above

149 degrees F (65 degrees C) or below —40 degrees F (40 degrees C). This alarm is similar to the
HITEMP alarm but is used for the industrial environment. If this alarm is used, you can customize your
alarm profile to ignore the lower-temperature HITEMP alarm.

Clear the I-HITEMP Alarm

Step 1 Complete the “Clear the HITEMP Alarm” procedure on page 2-100.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

2.5.132 ILK-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The ADM Peer Group Interlink Failure condition is raised on the ADM-10G card. This condition occurs
when one of the following SONET/OTN alarms is detected on the interlink ports of the ADM-10G card.

e “LOS (TRUNK)” alarm, page 2-137
e “LOF (TRUNK)” alarm, page 2-127
e “SF (TRUNK)” alarm, page 2-204

Clear the ILK-FAIL Alarm

Step1  Clear the root-cause service-affecting alarm by using one of the following procedures, as appropriate:
e “Clear the LOS (TRUNK) Alarm” procedure on page 2-137
e “Clear the LOF (TRUNK) Alarm” procedure on page 2-127
e “Clear the SF (TRUNK) Condition” procedure on page 2-204

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

2.5.133 IMPROPRMVL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: EQPT, PPM
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The Improper Removal IMPROPRMVL) alarm occurs under the following conditions:

e A card is removed when the card was rebooting. It is recommended that after the card completely
reboots, delete the card in CTC and only then remove the card physically. When you delete the card,
CTC loses connection with the node view (single-shelf mode) or shelf view (multishelf mode), and
goes to network view.

e When a card is deleted from CTC before physically removing the card from its slot. It is
recommended that the card be physically removed from its slot before deleting it from CTC.

>
Note  CTC provides the user approximately 15 seconds to physically remove the card before it begins

rebooting the card.
It can take up to 30 minutes for software to be updated on a standby TCC2/TCC2P card.

e A card is inserted into a slot but is not fully plugged into the backplane.
e A PPM (SFP) is provisioned but the physical module is not inserted into the port.

e Removal of an SFP from the client ports of a Y-cable protection group card causes an
IMPROPRMVL (PPM) alarm.

The working port raises the CR,IMPROPRMVL,SA alarm and the protected port raises the
MN,IMPROPRMVL,NSA alarm. The severity on the client ports is changed according to the
protection switch state.

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

For more information about provisioning PPMs (SFPs), refer to the “Turn Up a Node” chapter of
the Cisco ONS 15454 DWDM Procedure Guide. For specific PPM (SFP) values, refer to the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.

e Electrical issues such as short circuit or failure of DC-DC conversion.

Clear the IMPROPRMVL Alarm

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), right-click the card reporting the
IMPROPRMVL.

Step2  Choose Delete from the shortcut menu.

~

Note  CTC does not allow you to delete the reporting card if the card is in service, does have circuits
mapped to it, is paired in a working protection scheme, has DCC enabled, or is used as a timing
reference.

Step 3 If any ports on the card are in service, place them out of service (OOS,MT or Locked,maintenance):

A

Caution Before placing a port out of service (OOS,MT or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), ensure that no live traffic is present.

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b. Click the Provisioning > Line tabs.
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¢. Click the Admin State column of any in-service (IS or Unlocked) ports.
d. Choose OOS,MT (or Locked,maintenance) to take the ports out of service.

If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-245.

Caution

Step 5

Step 6

Step 7

Step 8

Before deleting the circuit, ensure that the circuit does not carry live traffic.

If the card is paired in a protection scheme, delete the protection group by completing the following
steps:

a. Click View > Go to Previous View to return to node view (single-shelf mode) or shelf view (multishelf
mode).

b. If you are already in node view (single-shelf mode) or shelf view (multishelf mode), click the
Provisioning > Protection tab.

c. Click the protection group of the reporting card.
d. Click Delete.
If the card is provisioned for DCC, delete the DCC provisioning by completing the following steps:

a. In node view (single-shelf mode) or multishelf view (multishelf mode), click the ONS system
Provisioning > Comm Channels > SDCC (or Provisioning > Comm Channels > MS DCC) tabs.

b. Click the slots and ports listed in DCC terminations.
c. Click Delete and click Yes in the dialog box that appears.
If the card is used as a timing reference, change the timing reference by completing the following steps:

a. In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.

b. Under NE Reference, click the drop-down arrow for Ref-1.
c. Change Ref-1 from the listed OC-N/STM-N card to Internal Clock.
d. Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.134 INHSWPR

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Inhibit Switch To Protect Request on Equipment condition occurs on traffic cards when the ability
to switch to protect has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the working system. If the card is part of a 1:N protection scheme, traffic can be
switched between working cards when the switch to protect is disabled.
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Clear the INHSWPR Condition

Step 1

Step 2

Step 3

If the condition is raised against a 1+1 port, complete the “Initiate a 14+1 Manual Switch Command”
procedure on page 2-237.

If it is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” procedure on
page 2-238 to switch it back.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.135 INHSWWKG

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Inhibit Switch To Working Request on Equipment condition occurs on traffic cards when the ability
to switch to working has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the protect system. If the card is part of a 1:N protection scheme, traffic can be
switched between protect cards when the switch to working is disabled.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the INHSWWHKG Condition

Step 1

Step 2

Step 3

If the condition is raised against a 1+1 port, complete the “Initiate a 14+1 Manual Switch Command”
procedure on page 2-237.

If it is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” procedure on
page 2-238 to switch it back.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.136 INCOMPATIBLE-SEND-PDIP

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM

The Incompatible Software alarm is raised when CTC’S send PDI-P provisioning differs from the host
node's provisioning.
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Clear the INCOMPATIBLE-SEND-PDIP Alarm

Step1  Reconfigure CTC’s send PDI-P alarm capability to align with the host node settings.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.137 INCOMPATIBLE-SW

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM

The Incompatible Software alarm is raised when CTC cannot connect to the NE due to differing,
incompatible versions of software between CTC and the NE. The alarm is cleared by restarting CTC in
order to redownload the CTC JAR files from the NE.

Clear the INCOMPATIBLE-SW Alarm

Step1  Restart the CTC application.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.138 INTRUSION-PSWD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE

The Security Intrusion Incorrect Password condition occurs after a user attempts a provisionable (by
Superuser) number of unsuccessful logins, a login with an expired password, or an invalid password. The
alarmed user is locked out of the system, and INTRUSION-PSWD condition is raised. This condition is
only shown in Superuser login sessions, not in login sessions for lower-level users. The
INTRUSION-PSWD condition is automatically cleared when a provisionable lockout timeout expires,
or it can be manually cleared in CTC by the Superuser if the lockout is permanent.

Clear the INTRUSION-PSWD Condition

Step1  Login as a user ID with superuser rights. (For more information about this, refer to the “Connect the PC
and Log Into the GUI” chapter in the Cisco ONS 15454 DWDM Procedure Guide.)

Step2  Innode view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > Security >
Users tabs.

Step3  Click Clear Security Intrusion Alarm.
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Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.139 INVMACADR

Default Severity: Major (MJ), Non-Service Affecting (NSA)
Logical Object: AIP

The Equipment Failure Invalid MAC Address alarm occurs when the ONS system MAC address is
invalid. Each ONS system has a unique, permanently assigned MAC address. The address resides on an
AIP EEPROM. The TCC2/TCC2P card reads the address value from the AIP chip during boot-up and
keeps this value in its synchronous dynamic RAM (SDRAM).

Under normal circumstances, the read-only MAC address can be viewed in the node view (single-shelf
mode) or multishelf view (multishelf mode) Provisioning > Network tab in CTC.

The ONS system uses both IP and MAC addresses for circuit routing. When an INVMACADR alarm
exists on a node, you see a PARTIAL circuit in the CTC circuit status column. The circuit works and is
able to carry traffic, but CTC cannot logically display the circuit end-to-end information.

An invalid MAC address can be caused when:

e There is a read error from the AIP during boot-up; in this case, the reading TCC2/TCC2P card uses
the default MAC address (00-10-cf-ff-ff-ff).

e There is a read error occurring on one of the redundant TCC2/TCC2P cards that read the address
from the AIP; these cards read the address independently and could therefore each read different
address values.

e An AIP component failure causes a read error.

e The ribbon cable connecting the AIP card to the backplane is bad.
Clear the INVMACADR Alarm

Step 1 Check for any outstanding alarms that were raised against the active and standby TCC2/TCC2P card and
resolve them.

Step2  If the alarm does not clear, determine whether the LCD display on the fan tray (Figure 2-2 on
page 2-101) is blank or if the text is garbled. If so, proceed to Step 8. If not, continue with Step 3.

Step3 At the earliest maintenance window, reset the standby TCC2/TCC2P card:
>

Note  The reset requires approximately five minutes. Do not perform any other step until the reset is
complete.

a. Log into a node on the network. If you are already logged in, continue with Step b.
b. Identify the active TCC2/TCC2P card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

¢. Innode view (single-shelf mode) or shelf view (multishelf mode), right-click the standby
TCC2/TCC2P card in CTC.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
m. 78-18378-02 |



| Chapter2

Alarm Troubleshooting

Step 4

Step 5
Step 6

Step 7

Step 8

Step 9
Step 10

Trouble-Clearing Procedures 1l

d. Choose Reset Card from the shortcut menu.
e. Click Yes in the Are You Sure dialog box.

The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.

f. Verify that the reset is complete and error-free, and that no new related alarms appear in CTC. A
green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

g. Double-click the node and ensure that the reset TCC2/TCC2P card is still in standby mode and that
the other TCC2/TCC2P card is active.

A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
h. Ensure that no new alarms associated with this reset appear in the CTC Alarms window.

If the standby TCC2/TCC2P card fails to boot into standby mode and reloads continuously, the AIP is
probably defective. In this case, the standby TCC2/TCC2P card is unsuccessfully attempting to read the
EEPROM located on the AIP. The TCC2/TCC2P card reloads until it reads the EEPROM. Proceed to
Step 8.

If the standby TCC2/TCC2P card rebooted successfully into standby mode, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-242.

Resetting the active TCC2/TCC2P card causes the standby TCC2/TCC2P card to become active. The
standby TCC2/TCC2P card keeps a copy of the chassis MAC address. If its stored MAC address is valid,
the alarm should clear.

After the reset, note whether or not the INVMACADR alarm has cleared or is still present.

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-241 again to place the standby TCC2/TCC2P card back into active mode.

After the reset, note whether or not the INVMACADR alarm has cleared or is still present. If the
INVMACADR alarm remains standing through both TCC2/TCC2P card resets, this indicates that the
AIP is probably defective. Proceed to Step 8.

If the INVMACADR was raised during one TCC2/TCC2P card reset and cleared during the other, the
TCC2/TCC2P card that was active while the alarm was raised needs to be replaced. Continue with
Step 7.

If the faulty TCC2/TCC2P card is currently in standby mode, complete the “Physically Replace a Card”
procedure on page 2-244 for this card. If the faulty TCC2/TCC2P card is currently active, during the next
available maintenance window complete the “Reset an Active TCC2/TCC2P Card and Activate the
Standby Card” procedure on page 2-241 and then complete the “Physically Replace a Card” procedure
on page 2-244.

Y

Note  If the replacement TCC2/TCC2P card is loaded with a different software version from the
current TCC2/TCC2P card, the card boot-up could take up to 30 minutes. During this time, the
card LEDs flicker between Fail and Act/Sby as the active TCC2/TCC2P card version software
is copied to the new standby card.

Open a case with Cisco TAC (1 800 553-2447) for assistance with determining the node’s previous MAC
address.

Replace the ribbon cable between the system board and the AIP with a known-good cable.

If the alarm persists, complete the “Replace an Alarm Interface Panel” procedure located in the “Alarm
Troubleshooting” chapter of the Cisco ONS 15454 Troubleshooting Guide.
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Step 11

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.140 ISIS-ADJ-FAIL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN

The Open System Interconnection (OSI) Intermediate System to Intermediate-System (IS-IS) Adjacency
Failure alarm is raised by an intermediate system (node routing IS Level 1 or Level 1 and 2) when no IS
or end system (ES) adjacency is established on a point-to-point subnet. The Intermediate-System
Adjacency Failure alarm is not supported by ES. It is also not raised by IS for disabled routers.

The alarm is typically caused by a misconfigured router manual area adjacency (MAA) address. For
more information about IS-IS OSI routing and MAA configuration, refer to the “Management Network
Connectivity” chapter in the Cisco ONS 15454 SDH Reference Manual. For more information about
configuring OSI, refer to the “Turn Up Node” chapter in the Cisco ONS 15454 Procedure Guide for
procedures.

Clear the ISIS-ADJ-FAIL Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Ensure that both ends of the communication channel are using the correct Layer 2 protocol and settings
(LAPD or PPP). To do this, complete the following steps:

a. At the local node, in node view, click the Provisioning > Comm Channels >SMSDCC tabs.
b. Click the row of the circuit. Click Edit.

c. In the Edit MSDCC termination dialog box, view and record the following selections: Layer 2
protocol (LAPD or PPP); Mode radio button selection (AITS or UITS); Role radio button selection
(Network or User); MTU value; T200 value, and T203 selections.

d. Click Cancel.

e. Log in to the remote node and follow the same steps, also recording the same information for this
node.

If both nodes do not use the same Layer 2 settings, you will have to delete the incorrect termination and
recreate it. To delete it, click the termination and click Delete. To recreate it, refer to the “Turn Up Node”
chapter in the Cisco ONS 15454 Procedure Guide for the procedure.

If the nodes use PPP Layer 2, complete the “Clear the RS-EOC Alarm” procedure on page 2-199. If the
alarm does not clear, go to Step 7.

If both nodes use the LAPD Layer 2 protocol but have different Mode settings, change the incorrect
node’s entry by clicking the correct setting radio button in the Edit MSDCC termination dialog box and
clicking OK.

If the Layer 2 protocol and Mode settings are correct, ensure that one node is using the Network role and
the other has the User role. If not (that is, if both have the same mode settings), correct the incorrect one
by clicking the correct radio button in the Edit MSDCC termination dialog box and clicking OK.

If the Layer 2, Mode, and Role settings are correct, compare the MTU settings for each node. If one is
incorrect, choose the correct value in the Edit MSDCC dialog box and click OK.
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If all of the preceding settings are correct, ensure that OSI routers are enabled for the communications
channels at both ends by completing the following steps:

a. Click Provisioning > OSI > Routers > Setup.

b. View the router entry under the Status column. If the status is Enabled, check the other end.
c. If the Status is Disabled, click the router entry and click Edit.

d. Check the Enabled check box and click OK.

If the routers on both ends are enabled and the alarm still has not cleared, ensure that both ends of the
communications channel have a common MAA by completing the following steps:

a. Click the Provisioning > OSI > Routers > Setup tabs.

b. Record the primary MAA and secondary MAAs, if configured.

You can record long strings of information such as the MAA address by using the CTC export and print
functions. Export it by choosing File > Export > html. Print it by choosing File > Print.

c. Log into the other node and record the primary MAA and secondary MAAs, if configured.

d. Compare this information. There should be at least one common primary or secondary MAA in
order to establish an adjacency.

e. If there is no common MAA, one must be added to establish an adjacency. Refer to the “Turn Up
Node” chapter of the Cisco ONS 15454 Procedure Guide for procedures to do this.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.141 LASER-APR

>

Warning

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: AOTS

The Laser Automatic Power Reduction (APR) alarm condition is raised by OSC-CSM, OSCM,
OPT-BST, OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C cards when the laser is working in power
reduction mode. The condition clears as soon as safety conditions are released and the power value
reaches the normal setpoint.

Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into
beams or view directly with optical instruments. Statement 1051.

Only inactivate the APR function temporarily for installation or maintenance reasons. Activate APR
immediately after maintenance or installation.
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Note

LASER-APR is an informational condition and does not require troubleshooting. For more information
about optical amplifier APR, refer to the “Card Reference” chapter in the Cisco ONS 15454 DWDM
Reference Manual.

2.5.142 LASERBIAS-DEG

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OTS

The Laser Bias Current Degrade alarm occurs on an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C,
or OPT-AMP-17-C) when laser aging causes a degrade, but not failure, of laser transmission. The card
should be replaced at the next opportunity.

For general information about optical amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LASERBIAS-DEG Alarm

Step 1

A

Warning

Step 2

For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-244 at the next
opportunity.

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

~

Note  Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.143 LASERBIAS-FAIL

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: AOTS

The Laser Bias Current Failure alarm occurs on an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C,
and OPT-AMP-17-C) when the laser control circuit fails or if the laser itself fails service. The card must
be replaced to restore traffic.
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Note  For general information about optical amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LASERBIAS-FAIL Alarm

Step 1 For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-244.

A

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

~

Note  Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.144 LASEREOL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN

The Laser Approaching End of Life alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G,
TXP_MR_I0E, and MXP_2.5G_10G cards. It is typically accompanied by the “HI-LASERBIAS” alarm
on page 2-98. It is an indicator that the laser in the card must be replaced. How soon the replacement
must happen depends upon the HI-LASERBIAS alarm’s threshold. If the threshold is set under 100
percent, the laser replacement can usually be done during a maintenance window. But if the
HI-LASERBIAS threshold is set at 100 percent and is accompanied by data errors, LASEREOL
indicates the card must be replaced sooner.

Note For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.

Clear the LASEREOL Alarm

Step 1 Complete the “Physically Replace a Card” procedure on page 2-244.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.145 LASERTEMP-DEG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS

The Laser Temperature Degrade alarm occurs when the Peltier control circuit fails on an amplifier card
(OPT-BST, OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C). The Peltier control provides cooling for the
amplifier. The card should be replaced at the next opportunity.

Note  For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LASERTEMP-DEG Alarm

Step 1 For the alarmed DWDM card, complete the “Physically Replace a Card” procedure on page 2-244 at the
next opportunity.

A

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

~

Note  Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.146 LMP-FAIL

Default Severity:Minor (MN), Non-Service-Affecting (NSA)
Logical Object: GE

The Link Management Protocol Fail alarm is raised by the TCC2/TCC2P card when an LMP control
channel fails or when there is a traffic engineering (TE) link correlation error. When the alarm is raised
against a control channel, it uses a control channel (CTRLx) AID. When the alarm is raised against a TE
link, a TE link AID (TLINKX) is used.

The alarm clears when the control channel or TE link is restored.

Note  LMP-FAIL occurs independently of the condition hierarchy between LMP-SD, page 122, LMP-SF,
page 122, or LMP-UNALLOC, page 124.
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When the LMP-FAIL alarm is reported against a control channel (CTRLx) AID, it only refers to control
channel failure. It does not directly indicate data link or traffic engineering link status.

When the LMP-FAIL alarm is reported against a TE link AID (TLINKX), it refers only to TE link status,
not to control channel or data link status.

Clear the LMP-FAIL Alarm

Step 1
Step 2

Step 3

Step 4

Verify the AID (CTRLx or TLINKX) of the alarm.

If the alarm is against the control channel AID, this is caused by mismatched control channel parameters
between the near-end ONS 15454 and the far-end node (which may be another vendor’s equipment).
Complete the following steps:

a. Determine whether both near-end and far-end sides of the control channel are in the IS or Unlocked
administrative state:

¢ Click the Provisioning > Comm Channels > LMP > Control Channels tabs and view the
Admin State column content for the channel.

e If the status does not say IS or Unlocked, change it and click Apply.

b. Determine whether the near-end node LMP configuration contains the far-end node’s IP address as
its remote node IP. Also verify that the near-end node’s LMP configuration uses the LMP node 1D
as its own remote node ID. If one or more of these values is incorrect, enter it correctly.

c¢. Determine whether the far-end node LMP configuration contains the near-end node's IP address as
its remote node IP. Also verify that the far-end node’s LMP configuration uses the LMP node ID as
its own remote node ID. If one or more of these values is incorrect, enter it correctly.

d. Verify that the far-end node is using the near-end node’s IP address as its remote node IP address,
and that the far end is also using the LMP node ID as its remote node ID. Update the far end’s values
if they are incorrect.

If instead the alarm is raised against the TE link AID, complete the following steps:

a. Determine whether both near-end and far-end sides of the TE link are in the IS or Unlocked
administrative state. If either end is currently down, update its administrative state to IS or
Unlocked:

¢ Click the Provisioning > Comm Channels > LMP > TE links tab.
e If the status does not say IS or Unlocked, change it and click Apply.

b. Determine whether the near-end node’s remote TE link ID matches the far-end node’s local TE link
ID. If the near-end node’s remote value is incorrect, enter it correctly.

c¢. Determine whether the far-end node’s remote TE link ID corresponds to the near-end node’s local
TE link ID. If the far-end node’s remote value is incorrect, enter it correctly.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.147 LMP-SD

Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE

The LMP Data Link Signal Degrade condition occurs for when the TCC2/TCC2P receives an LMP link
summary or channel status message that the control channel is not available from the far end, so the data
link level of service is not guaranteed. The degrade range is provisionable.

LMP-SD clears when the TCC2/TCC2P receives a link summary or channel status message reporting
that the data link is in the Signal Okay (OK) state.

LMP-SD is part of an alarm hierarchy that includes LMP-SF, page 122, and LMP-UNALLOC, page 124.
The hierarchy is as follows: If LMP-UNALLOC is raised, LMP-SF and LMP-SD are suppressed. If
LMP-SF is raised, it suppresses LMP-SD. LMP-SF and LMP-UNALLOC both suppress near-end
LOS-type alarms for DWDM clients. LMP-SD, however, does not suppress LOS alarms.

This condition clears when the far-end trouble has been cleared.

Clear the LMP-SD Condition

Step1  Look for and clear any of the following alarms in Table 2-9 and Table 2-10 occurring on the far-end port.
Table 2-9 Transponder Trunk Alarms that Cause LMP-SD
Trunk Port Alarm LMP Failure Direction
SD SD Tx
OTUK-SD SD Tx
ODUK-SD-PM SD Tx
ODUK-SD-TCM1 SD Tx
ODUK-SD-TCM2 SD Tx
Table 2-10 Transponder Client Alarm that Causes LMP-SD
Client Port Alarm LMP Failure Direction
SD SD Rx

Step2  If the LMP-SD condition does not clear, log into the Technical Support Website at

http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.148 LMP-SF

Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE

l_ Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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NSA for the near end). The near-end’s TCC2/TCC2P receives an LMP link summary or channel status
message that the data link service has failed. The signal fail threshold provisionable.

LMP-SF clears when the TCC2/TCC2P receives a link summary or channel status message reporting that
the data link is in the Signal Okay (OK) state.

LMP-SF is part of an alarm hierarchy that includes LMP-SD, page 122, and LMP-UNALLOC, page 124.

The hierarchy is as follows: If LMP-UNALLOC is raised, LMP-SF and LMP-SD are suppressed. If

LMP-SF is raised, it suppresses LMP-SD. LMP-SF and LMP-UNALLOC both suppress near-end
LOS-type alarms for DWDM clients, but LMP-SD does not suppress LOS-type alarms.

This condition clears when the far-end trouble has been cleared.

Clear the LMP-SF Condition

Step 1

Look for and clear any of the following alarms in Table 2-11, Table 2-12, or Table 2-13 occurring on the

far-end port.

Table 2-11 Transponder Card Alarms that Cause LMP-SF

Card Alarm LMP Failure Direction
EQPT SF Tx
IMPROPRMVL SF Tx
Table 2-12 Transponder Trunk Alarms that Cause LMP-SF

Trunk Port Alarm LMP Failure Direction
LOS SF Tx
OTUK-LOF SF Tx
OTUK-AIS SF Tx

LOM SF Tx
OTUK-SF SF Tx
ODUK-SF-PM SF Tx
ODUK-SF-TCM1 SF Tx
ODUK-SF-TCM2 SF SF Tx
FEC-MISM SF Tx
Table 2-13 Transponder Client Alarms that Cause LMP-SF

Client Alarm LMP Failure Direction
LOS SF Rx
SIGLOSS SF Rx
SYNCLOSS SF Rx
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Table 2-13 Transponder Client Alarms that Cause LMP-SF (continued)
Client Alarm LMP Failure Direction
CARLOSS SF Rx

LOF SF Rx

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.149 LMP-UNALLOC

Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE

The LMP Data Link Unallocated condition is raised when the TCC2/TCC2P receives an LMP link
summary or channel status message reporting that the data link as unallocated for data traffic. The
condition clears when the data link is allocated and sends an LMP link summary or channel status
message to this effect. If a data link has the LMP-UNALLOC alarm raised against it, this should suppress
all other alarms on the client port, since the far-end node is not using the errored port. (Consequently
you do not have to clear any alarms on the far-end node’s unused port.)

LMP-UNALLOC is part of an alarm hierarchy that includes LMP-SD, page 122, and LMP-SF, page 122.
The hierarchy is as follows: If LMP-UNALLOC is raised, LMP-SF and LMP-SD are suppressed. If
LMP-SF is raised, it suppresses LMP-SD. LMP-SF and LMP-UNALLOC both suppress near-end
LOS-type DWDM client alarms, but LMP-SD does not.

In most cases, this condition is an informational notice at the near-end node that the far-end port is not
being utilized. If, however, the far-end port should be allocated for traffic, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

2.5.150 LOCKOUT-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OTS, TRUNK

The Lockout Switch Request on Facility or Equipment condition occurs when a user initiates a lockout
switch request for an OC-N port in a 1+1 facility protection group. This can be accomplished by locking
traffic onto the working port with the LOCK ON command (thus locking it off the protect port), or
locking it off the protect port with the LOCK OUT command. In either case, the protect port will show
“Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ condition.

A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.
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Clear the LOCKOUT-REQ Condition

Step 1
Step 2

Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-240.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.151 LOCKOUT-REQ (2R, EQPT, ESCON, FC, GE, ISC)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC

The Lockout Switch Request on Facility or Equipment condition occurs in a Y-cable MXP or TXP client
protection group for the above-listed clients when a user initiates a lockout switch request. The condition
is raised when you lock traffic onto the working port with the Lock On command (thus locking it off the
protect port), or you lock it off the protect port with the Lock Out command. In either case, the protect
port will show “Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ
condition.

A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.

Clear the LOCKOUT-REQ (2R, EQPT, ESCON, FC, GE, ISC) Condition

Step 1

Step 2

Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-240.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.152 LOCKOUT-REQ (TRUNK)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Lockout Switch Request on Facility or Equipment condition occurs in an MXP or TXP trunk port
splitter protection group when you lock traffic onto the working port with the Lock On command (thus
locking it off the protect port), or lock it off the protect port with the Lock Out command. In either case,
the protect port will show “Lockout of Protection,” and the Conditions window will show the
LOCKOUT-REQ condition.

A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.
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Clear the LOCKOUT-REQ (TRUNK) Condition

Step 1 Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-240.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.153 LOF (BITS)

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: BITS

The Loss of Frame (LOF) BITS alarm occurs when a port on theTCC2/TCC2P card BITS input detects
an LOF on the incoming BITS timing reference signal. LOF indicates that the receiving ONS system has
lost frame delineation in the incoming data.

Note  The procedure assumes that the BITS timing reference signal is functioning properly. It also assumes the
alarm is not appearing during node turn-up.

Clear the LOF (BITS) Alarm

Step1  Verify that the line framing and line coding match between the BITS input and the TCC2/TCC2P card:
a. Innode or card view, note the slot and port reporting the alarm.

b. Find the coding and framing formats of the external BITS timing source. The formats should be in
the user documentation for the external BITS timing source or on the timing source itself.

¢. In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
BITS Facilities tabs.

d. Verify that the Coding setting matches the coding of the BITS timing source, either B§ZS or AMI.

e. If the coding does not match, click Coding and choose the appropriate coding from the drop-down
list.

f. Verify that Framing matches the framing of the BITS timing source, either ESF or SF (D4).

g. If the framing does not match, click Framing and choose the appropriate framing from the
drop-down list.

>
Note  On the timing subtab, the BS§ZS coding field is normally paired with ESF in the Framing
field and the AMI coding field is normally paired with SF (D4) in the Framing field.

Step2  If the alarm does not clear when the line framing and line coding match between the BITS input and the
TCC2/TCC2P card, complete the “Physically Replace a Card” procedure on page 2-244 for the
TCC2/TCC2P card.
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If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.154 LOF (TRUNK)

Note

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK, OCN

The Loss of Frame for the DWDM trunk applies to the trunk optical or electrical signal that is carried to
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, MXP_2.5G_10G, ADM-10G and OTU2_XP cards. It indicates that the receiving
ONS system has lost frame delineation in the incoming data from trunk that serves the cards. LOF occurs
when the SONET overhead loses a valid framing pattern for 3 milliseconds. Receiving two consecutive
valid A1/A2 framing patterns clears the alarm.

InR7.01, when an LOF alarm occurs on TXP or MXP trunks, G709/SONET/SDH TCAs are suppressed.
For details, see the “Alarm and TCA Monitoring and Management” chapter in the Cisco ONS 15454
DWDM Reference Manual.

Clear the LOF (TRUNK) Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Using site practices, verify fiber continuity to the port. Refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

If the cabling is good, verify that the correct port is in service by completing the following steps:

a. Confirm that the LED is correctly illuminated on the physical card. A green ACT/SBY LED
indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the port is in service, in node view (single-shelf mode) or shelf view (multishelf
mode), double-click the card in CTC to open the card view.

¢. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS (or Unlocked).

e. If the Admin State column lists the port as OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the column and choose IS , or Unlocked.

f. Click Apply.

If the correct port is in service, clean the fiber according to site practice. If no site practice exists,
complete the fiber cleaning procedure in the “Maintain the Node” chapter of the Cisco ONS 15454
DWDM Procedure Guide.

If the alarm does not clear, verify that the power level of the optical signal is within the TXP or MXP
card receiver specifications. (These specifications are listed in the “Hardware Specifications” appendix
of the Cisco ONS 15454 DWDM Reference Manual.)

If the optical power level is within specifications, use an optical test set to verify that a valid signal exists
on the line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line
as close to the receiving card as possible.
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Step6  If a valid signal exists, replace the connector on the backplane.
Step7  Repeat Steps 1 to 6 for any other port on the card reporting the LOF.

Step8  If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

Step 9 If no other alarms exist that could be the source of the LOF, or if clearing an alarm did not clear the LOF,
complete the “Physically Replace a Card” procedure on page 2-244 for the reporting card.

Step10 If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.155 LOGBUFR90

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM

The Log Buffer Over 90 alarm indicates that the per-NE queue of incoming alarm, event, or update
capacity of 5000 entries is over 90 percent full. LOGBUFR90 will clear if CTC recovers. If it does not
clear, LOGBUFROVFL occurs.

~

Note LOGBUFRYO0 is an informational alarm and does not require troubleshooting.

2.5.156 LOGBUFROVFL

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM

The Log Buffer Overflow alarm indicates that the CTC per-NE queue of incoming alarm, event, or
updates, which has a capacity of 5,000 entries, has overflowed. This happens only very rarely. However
if it does, you must restart the CTC session. It is likely that some updates will have been missed if this
alarm occurs.

Clear the LOGBUFROVFL Alarm

Step 1 Restart the CTC session.s

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.157 LO-LASERBIAS

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EQPT, OCN/STMN, PPM
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The Equipment Low Transmit Laser Bias Current alarm is raised against the TXP and MXP card laser
performance. The alarm indicates that the card laser has reached the minimum laser bias tolerance.

If the LO-LASERBIAS alarm threshold is set at O percent (the default), the laser's usability has ended.
If the threshold is set at 5 percent to 10 percent, the card is still usable for several weeks or months before
you need to replace it.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LO-LASERBIAS Alarm

Step 1
Step 2

Complete the “Physically Replace a Card” procedure on page 2-244.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.158 LO-LASERTEMP

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EQPT, OCN/STMN, PPM

The Equipment Low Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards.
LO-LASERTEMP occurs when the internally measured transceiver temperature falls below the card
setting by35.6 degrees F or 2 degrees C. A laser temperature change affects the transmitted wavelength.
(This temperature is equivalent to about 200 picometers of wavelength.)

When the TXP or MXP card raises this alarm, the laser is automatically shut off. The An LOS for
OCN/STMN is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-65 is raised at the
near end. (Both of these alarms are described in the “Alarm Troubleshooting” chapter of the

Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide). To
verify the card laser temperature level, double-click the card in node view (single-shelf mode) or shelf
view (multishelf mode) and click the Performance > Optics PM > Current Values tabs. Maximum,
minimum, and average laser temperatures are shown in the Current column entries in the Laser Temp
rows.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LO-LASERTEMP Alarm

Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), complete the “Reset a Card in CTC”
procedure on page 2-241 for the reporting MXP or TXP card.
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Step 2

Step 3

2.5.159 LOM

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
reporting MXP or TXP card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK, EQPT

The Optical Transport Unit (OTU) Loss of Multiframe alarm is an OTN alarm for the trunk port and
occurs when the Multi Frame Alignment Signal (MFAS) is corrupted. The alarm applies to
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_I10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, ADM-10G, and OTU2_XP cards when the MFAS) overhead field
is errored for more than five frames and persists for more than 3 milliseconds.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LOM Alarm

Step 1 Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Step2  If the bit error rate (BER) threshold is correct and at the expected level, use an optical test set to measure
the power level of the line to ensure it is within guidelines. For specific procedures to use the test set
equipment, consult the manufacturer.

Step3  If the optical power level is good, verify that optical receive levels are within the acceptable range.
Ranges for ONS 15454 DWDM cards are located in the “Hardware Specifications” appendix of the
Cisco ONS 15454 DWDM Reference Manual.

Step4  Ifreceive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the fiber cleaning procedure in the “Maintain the Node” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

Step5  If the condition does not clear, verify that single-mode fiber is used.

Step6  If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.

Step7  Clean the fiber connectors at both ends for a signal degrade according to site practice.

Step8  Verify that a single-mode laser is used at the far end.

Step9  If the problem does not clear, the transmitter at the other end of the optical line could be failing and

require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-242.
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If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STSMON, STSTRM

A Loss of Pointer Path alarm indicates that the SONET path pointer in the overhead has been lost. LOP
occurs when valid H1/H2 pointer bytes are missing from the overhead. Receiving equipment monitors
the H1/H2 pointer bytes to locate the SONET payload. An LOP-P alarm occurs when eight, nine, or ten
consecutive frames do not have valid pointer values. The alarm clears when three consecutive valid
pointers are received.

The LOP-P alarm can occur when the received payload does not match the provisioned payload. The
alarm is caused by a circuit type mismatch on the concatenation facility. For example, if an STS-1 is sent
across a circuit provisioned for STS-3c, an LOP-P alarm occurs.

For the FC_MR-4 card, an LOP-P is raised if a port is configured for a SONET signal but receives an
SONET signal instead. (This information is contained in the H1 byte bits 5 and 6.)

Clear the LOP-P Alarm

A

Caution

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

In node view, click the Circuits tab and view the alarmed circuit.

Verify the circuit size listed in the Size column. If the size is different from what is expected, such as an
STS3c instead of an STS1, this causes the alarm.

If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned
circuit size and the size expected by the test set can cause this alarm. For specific procedures to use the
test set equipment, consult the manufacturer. Ensure that the test set monitoring is set up for the same
size as the circuit provisioning.

Refer to the manufacturer’s instructions for test-set use.

If the error is not due to an incorrectly configured test set, the error is in the provisioned CTC circuit
size. Complete the “Delete a Circuit” procedure on page 2-245.

Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits and VT Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.
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2.5.161 LO-RXPOWER

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, TRUNK

The Equipment Low Receive Power alarm is an indicator for TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_I10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
0C192-XFP, ADM-10G, and OTU2_XP card received optical signal power. LO-RXPOWER occurs
when the measured optical power of the received signal falls below the threshold value, which is
user-provisionable.

For general information about MXP and TXP cards and their necessary levels, refer to the “Card
Reference” chapter and the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM
Reference Manual.

Clear the LO-RXPOWER Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Check the PM of the TRUNK-RX port. Verify that received power is above the optics threshold:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b. For the TRUNK-RX port, double-click the card and click the Performance > Optics PM >
Historical PM tabs, choose the port in the Port drop-down list, and click Refresh.

c¢. Compare the refreshed PM values with the threshold (ensuring that they are above the threshold
value) by clicking the Performance > Optics PM > Current Values tabs.

d. Ensure that a proper threshold has been provisioned for the receive value. (Refer to the “Provision
Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If
an incorrect threshold has been set, adjust it to a value within the allowed limits. If instead the alarm
condition does not clear, move to next step.

Verify that the Trunk-Rx port is cabled correctly, and clean the fiber connecting the faulty TXP/MXP to
the Drop port of the DWDM card (32DMX, 32DMX-0, 40DMX, or AD-xC-xx.x). If no site cleaning
practices are available, refer to the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM
Procedure Guide.

Determine whether a bulk attenuator is specified by the Cisco TransportPlanner design. If so, verify that
the proper fixed attenuation value has been used.

Using a test set, check the optical power value of the Drop port of the DWDM card (32DMX, 32DMX-O,
40DMX, or AD-xC-xx.x) connected to the faulty TXP/MXP. If the read value is different (+1 dBm or

—1 dBm) from the ANS setpoint for “Padd&drop-Drop power,” move to next step. If not, complete the
“Physically Replace a Card” section on page 2-244.

Look for any alarm reported by the DWDM cards belonging to the OCHNC circuit whose destination is
the faulty TXP/MXP and first troubleshoot that alarm. Possible alarm related include: amplifier Gain
alarms (the “GAIN-HDEG” alarm on page 2-90, the “GAIN-HFAIL” alarm on page 2-91, the
“GAIN-LDEG” alarm on page 2-91, or “GAIN-LFAIL” alarm on page 2-92); APC alarms (the
“APC-CORR-SKIPPED” alarm on page 2-29 or “APC-OUT-OF-RANGE” alarm on page 2-31), and
LOS-P alarms on the Add or Drop ports belonging to the OCHNC circuit.
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If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.162 LOS (2R)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: 2R

The Loss of Signal for a 2R client applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and MXP_2.5G_10G cards. The alarm is raised
when the card port is not receiving input. An AIS is sent upstream.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. To
verify cable continuity, follow site practices.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual.
Clear the LOS (2R) Alarm

Step1  Ensure that the signal entering the Client-Rx port is provisioned with the correct physical-layer protocol.

Step2  Ensure that the signal feeding the Client-Rx port is provisioned with the correct line speed.

Step3  Check the PM of the Client-Rx port.

Step4  Verify that received power is above the optics threshold.

Step5  Ensure that a proper threshold has been provisioned. (Refer to the “Provision Transponder and
Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide. Refer to the SFP/XFP
plug-in specifications located in the “Hardware Specifications” appendix of the Cisco ONS 15454
DWDM Reference Manual.) If an incorrect threshold has been set, adjust it to a value within the allowed
limits.

Step6  Verify the proper cabling and clean the fibers according with the site practice. Cabling procedures are
located in the “Turn Up a Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide, and a
fiber-cleaning procedure is located in the “Maintain the Node” chapter of the same guide.

Step7  Verify using an optical test set that a valid signal exists on the line and feeds the Client-Rx port. (For
specific procedures to use the test set equipment, consult the manufacturer.) Test the line as close to the
receiving card as possible. If the alarm condition does not clear, move to next step.

Step8  Complete the “Install an SFP or XFP Connector” procedure on page 1-59 or the “Physically Replace a
Card” procedure on page 2-244 as appropriate for your purposes.

Step9  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport

for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.
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2.5.163 LOS (BITS)

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: BITS

The LOS (BITS) alarm indicates that the TCC2/TCC2P card has an LOS from the BITS timing source.
LOS for BITS means the BITS clock or the connection to it failed.

Clear the LOS (BITS) Alarm
A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step1  Verify the wiring connection from the BITS clock pin fields on the ONS system backplane to the timing
source.

Step2  If wiring is good, verify that the BITS clock is operating properly.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.164 LOS (ESCON)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: ESCON

The ESCON LOS alarm occurs on the TXP_MR_2.5G or TXPP_MR_2.5G card when there is a loss of
signal for this payload, usually due to a physical error such as incorrect cabling connections, faulty
cabling, or a break. It can also be caused by an incorrectly configured SFP.

Clear the LOS (ESCON) Alarm

Step 1 Check for any upstream equipment failures that could cause the ESCON LOS alarm in this node.

Step2  If there is no cause upstream, verify cabling continuity from the transmitting port to the receiving port
reporting this LOS. To verify cable continuity, follow site practices.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step3  If the continuity is good, clean the fiber according to site practice. If none exists, complete the
fiber-cleaning procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.
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Step 10

Step 11
Step 12
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Ensure that the PPM (SFP) is correctly configured for this payload:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. Click the Provisioning > Pluggable Port Modules tabs.

c. Check the Pluggable Port Modules area for the PPM (SFP) associated with the port.

d. In the Pluggable Ports area, ensure that the rate for the errored PPM (SFP) is ESCON.
A
Note  For information about provisioning PPMs (SFPs), refer to the “Turn Up a Node” chapter in

the Cisco ONS 15454 DWDM Procedure Guide. PPM (SFP) specifications are listed in the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.

If the physical cabling and PPM (SFP) are good but the alarm does not clear, verify that the correct port
is actually in service:

a. Confirm that the LED is correctly lit on the physical TXP card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
b. To determine whether the port is in service, double-click the card in CTC to open the card view.
¢. Click the Provisioning > Line tabs.
d. Verify that the Admin State column lists the port as IS (or Unlocked).

e. If the Admin State column lists the port as OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the column and choose IS , or Unlocked. Click Apply.

If the correct port is in service but the alarm has not cleared, use an optical test set to confirm that a valid
signal exists on the line. For specific procedures to use the test set equipment, consult the manufacturer.
Test the line as close to the receiving card as possible.

If the signal is valid, ensure that the transmit and receive outputs from the patch panel to your equipment
are properly connected. For more information about fiber connections and terminations, refer to the
“Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

If a valid signal exists but the alarm does not clear, replace the cable connector on the ONS system.
Repeat Steps 2 through 6 for any other port on the card that reports the LOS (ESCON).

If the alarm does not clear, the cabling could still be faulty despite correct attachments. Use the test set
to locate the bad cable and replace it using the procedures in the “Manage the Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

If the alarm does not clear, look for any card-level alarm that could cause this port alarm.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.165 LOS (ISC)

Default Severity: Critical (CR), Service-Affecting (SA)
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Note

Logical Object: ISC

The LOS alarm for the ISC port applies to TXPP_MR_2.5G or TXP_MR_2.5G client PPMs (SFPs)
provisioned at the ISC port rate. Troubleshooting is similar to the LOS (2R) alarm.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LOS (ISC) Alarm

A

Caution

Step 1
Step 2

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Complete the “Clear the LOS (2R) Alarm” procedure on page 2-133.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.166 LOS (OTS)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OTS

The Loss of Signal for the OTS applies to the OSC-3-RX port of the OPT-BST or OPT-AMP-x-C
amplifier cards and the LINE-2-RX port of the OSCM or OSC-CSM card. It indicates that a fiber cut has
occurred and no power is being received from the span. The alarm is raised when both LOS-P and LOS-O
alarms occur, and demotes them.

Clear the LOS (OTS) Alarm

Step 1
Step 2

To troubleshoot this alarm, see the “1.12.1 Fiber Cut Detection” section on page 1-61.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.167 LOS (TRUNK)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK
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The Loss of Signal (LOS) for a TRUNK applies to GE-XP, 10GE-XP, TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, ADM-10G,
and OTU2_XP cards.

The MXP_2.5G_10E card has no LOS (TRUNK) option, because G.709 cannot be disabled on the card.

The alarm is raised when the card port is not receiving input. An AIS is sent upstream.

The purpose of the LOS (TRUNK) alarm is to alert the user that no optical power is being received from
the fiber. A typical fault condition signalled by the LOS (TRUNK) alarm is a fiber cut. In this case,
neither the payload nor the overhead signals are being received.

With G.709 off, the alarm coming from the trunk is LOS (TRUNK) in accordance with SONET
standards.

In R7.01, when an LOS (TRUNK) alarm occurs on TXP and MXP trunks, G709/SONET/SDH TCAs are
suppressed. For details, see the “Alarm and TCA Monitoring and Management” chapter in the
Cisco ONS 15454 DWDM Reference Manual.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide

Clear the LOS (TRUNK) Alarm

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Check the PMs of the TRUNK-RX port and verify that the received power is above the optics threshold.

Check that a proper threshold has been provisioned. (For procedures, refer to the “Provision Transponder
and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If an incorrect
threshold has been set, adjust it to a value within the allowed limits. If the alarm condition does not clear,
move to next step.

Verify the cabling of the Trunk-Rx port and clean the fiber connecting the faulty TXP/MXP to the Drop
port of the DWDM card (32DMX, 32DMX-0, 40DMX, or AD-xC-xx.x). For fiber cleaning procedures,
refer to the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Using an optical test set, verify that a valid signal exists on the line and feeds the TRUNK-RX port.(For
specific procedures to use the test set equipment, consult the manufacturer.) Test the line as close to the
receiving card as possible. If the alarm condition does not clear, move to next step.

Verify whether a bulk attenuator is specified in the Cisco TransportPlanner design. If so, verify that the
proper fixed attenuation value has been used.

Check the Drop port optical power value of the DWDM card (32DMX, 32DMX-0, 40DMX, or
AD-xC-xx.x) connected to the faulty TXP/MXP. If the read value is different (+1 dBm or —1 dBm)
compared to the ANS setpoint “Padd&drop-Drop power,” move to next step. If not, complete the
“Physically Replace a Card” procedure on page 2-244.
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Step 7

Step 8

Step 9

2.5.168 LOS-0

If the alarm does not clear after the replacement, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a Service-Affecting (SA) problem.

Look for and troubleshoot any alarms reported by the DWDM cards belonging to the OCHNC circuit
whose destination is the faulty TXP/MXP. Possible alarms include: amplifier gain alarms (the
“GAIN-HDEG” alarm on page 2-90, the “GAIN-HFAIL” alarm on page 2-91, the “GAIN-LDEG” alarm
on page 2-91 or “GAIN-LFAIL” alarm on page 2-92); APC alarms (the “APC-CORR-SKIPPED” alarm
on page 2-29 and “APC-OUT-OF-RANGE” alarm on page 2-31), OR LOS-P alarms on the Add or Drop
ports belonging to the OCHNC circuit.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: OCH, OMS, OTS

The Incoming Overhead Loss of Signal alarm applies to the OSC-TX port of OPT-BST or
OPT-AMP-x-C cards (LINE-1-RX), the OSC-RX internal optical port of OSC-CSM card (LINE-3-RX
Port 3). It is raised when the monitored input power crosses the FAIL-LOW threshold associated to the
OSC Power received. The is alarm is demoted if another LOS alarm is also present.

Clear the LOS-0 Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Verify fiber continuity to the port by following site practices. Refer to the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

If the cabling is good, confirm that the LED is correctly illuminated on the physical card. A green
ACT/SBY LED indicates an active card. A red ACT/SBY LED indicates a failed card.

Display the optical thresholds by clicking one of the following tabs:

e Forthe OPT-BST or OPT-AMP-x-C cards, click the Provisioning > Opt. Ampli. Line > Optics
Thresholds tabs and click the Alarm checkbox in the Type panel.

e For the OSC-CSM cards, click the Provisioning > Optical Line > Optics Thresholds tabs.

Verify that OSC Fail Low thresholds are correct according with Cisco TransportPlanner configuration
file. To identify the MP value:

a. In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning >
WDM-ANS > Provisioning tabs.

b. Identify the following parameter: east or west side Rx channel OSC LOS threshold.

If the port power is below the threshold, verify that OSC connections have been created on the other side
of the span. If the connections are not present, refer to the “Provision Channels and Circuits” chapter of
the Cisco ONS 15454 DWDM Procedure Guide for procedures.

If OSC connections are present, check the OSC transmitted power using CTC on the far-end node. Refer
to the “TurnUp Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide for the proper
procedure.
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If the transmitted OSC value is out of range, troubleshoot that problem first.

If the OSC value is within range, come back to the port reporting the LOS-O alarm and clean the fiber
according to site practice. If no site practice exists, complete the fiber-cleaning procedure in the
“Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

If no other alarms exist that could be the source of the LOS-O, place all of the card ports in OOS,DSBLD
(or Locked,disabled) administrative state.

Complete the “Physically Replace a Card” procedure on page 2-244 for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.169 LOS-P (AOTS, OMS, 0TS)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OMS, OTS

The Loss of Signal for Optical Channel alarm (OMS and OTS layer) applies to all input ports of the
following DWDM cards: AD-1B-xx.x, AD-4B-xx.x, 32DMX, 32DMX-0O, 40DMX-C, 40DMX-CE,
OPT-PRE, OPT-BST, OPT-AMP-C, OPT-AMP-17-C, and OSC-CSM.

For AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, 32MUX-0, 32WSS, 40WSS-C, and WXC cards, this alarm
applies only to the input ports where an aggregate signal is managed, such as the COM-RX, EXP-RX,
or xxBAND-RX ports). These ports are solely used for the AOTS, OMS, and OTS layers.

LOS-P (AOTS, OMS, or OTS) indicates a loss of receive signal, which means that the monitored input
power value has crossed the Power Failure Low Threshold associated to the port.

When the LOS-P alarm is raised on the LINE-RX port of the OPT-BST, OPT-AMP-x-C, or OSC-CSM
card, it can indicate a fiber cut. Refer to the “Network Reference” chapter of the Cisco ONS 15454
DWDM Reference Manual for a fiber cut detection procedure.

When the LOS-P alarm is raised on the COM-RX port of the 32DMX-C, 32DMX-L, 40DMX-C,
40-DMX-CE, or WXC cards, it can indicate the presence of undesirable counter-propagating light
entering the card from the drop ports. The counter-propagating light can be inserted into these cards as
a result of incorrect cabling of transponder or line cards to the fiber patch-panel (in particular, swapping
RX with TX patchcords). This behavior is only applicable to optical modules with vendor IDs 2049,
2050, 2304, and 2306. You can view the vendor IDs at CTC > Card View > Inventory tab.

Clear the LOS-P (AOTS, OMS, OTS) Alarm

Step 1

Verify that the card has the correct physical behavior by checking the LED on the physical card. A green
ACT/SBY LED indicates an active card, and a red ACT/SBY LED indicates a failed card. If the LED is
red, complete the “Physically Replace a Card” procedure on page 2-244 and continue to Step 8.
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~

Note  When you replace a card with an identical type of card, you do not need to make any changes to
the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.

Step2  Verify that there truly is a loss of input signal by completing the following steps:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. Verify the proper input power values by clicking one of the following tabs as appropriate:

e For the OPT-BST, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Parameters tabs.

e For the OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Parameters tabs.

e For the AD-xC-xx.x card, click the Provisioning > Optical Line > Parameters tabs.
e For the AD-xB-xx.x card, click the Provisioning > Optical Band > Parameters tabs.

e For the 32MUX-0 and 40MUX cards, click the Provisioning > Optical Line > Parameters
tabs.

e For the 32WSS and 40WSS-C cards, click the Provisioning > Optical Line > Parameters tabs.
e For the 32DMX-O card, click the Provisioning > Optical Line > Parameters tabs.
e For the 32DMX and 40DMX cards, click the Provisioning > Optical Line > Parameters tabs.
e For the OSC-CSM card, click the Provisioning > Optical Line > Parameters tabs.

c¢. Display the proper Power Failure Low threshold by clicking one of the following tabs as appropriate:

e For the OPT-BST, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Optics Thresholds tabs.

e For the OPT-BST, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Optics Thresholds tabs.

e For the AD-xC-xx.x card, click the Provisioning > Optical Line > Optics Thresholds tabs.
e For the AD-xB-xx.x card, click the Provisioning > Optical Band > Optics Thresholds tabs.
e For the AD-xB-xx.x card, click the Provisioning > Optical Line > Optics Thresholds tabs.

e For the 32MUX-0 and 40MUX cards, click the Provisioning > Optical Line > Optics
Thresholds tabs.

e For the 32WSS and 40WSS-C cards, click the Provisioning > Optical Line > Optics
Thresholds tabs.

e For the 32DMX-O card, click the Provisioning > Optical Line > Optics Thresholds tabs.
e For the 32DMX and 40DMX, click the Provisioning > Optical Line > Optics Thresholds tabs.
e For the OSC-CSM card, click the Provisioning > Optical Line > Optics Thresholds tabs.

Tip To view the alarm thresholds (as opposed to the warning thresholds), check the Alarm check box on the
bottom-left of the Optics Thresholds tab and click Reset.

d. Compare the actual Power value with the Alarm Threshold value and complete one of the following
actions:
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e If the Power value is less than the Fail Low threshold, go to Step 3.

e If the Power value is greater than the Fail Low threshold plus the alarm hysteresis (allowance
value) default of 1 dBm, complete the “Reset a Card in CTC” procedure on page 2-241 for the
card.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 and
continue to Step 8.

S
Note  When you replace a card with an identical type of card, you do not need to make any changes

to the database other than restoring the card’s port to the IS,AINS or
Unlocked,automaticInService administrative state.

Verify the fiber continuity to the port by following site practices. Refer to the “Network Reference”
chapter of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Check the “Internal Connections” file generated by Cisco Transport Planner for the node where the
errored card is located. If necessary, recable the node cabling in accordance with the MP file connections
list. To cable a DWDM node, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

If the cabling is good, use an optical test set to measure the power value on the output port connected to
the alarmed card. For specific procedures to use the test set equipment, consult the manufacturer. If the
power difference reported is greater than 1 dBm (standard fiber jumper insertion loss is 0.3 dBm), clean
the fiber according to site practice. If no site practice exists, complete the fiber-cleaning procedure in
the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Unplugging the fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer to
the “Manage the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide for detailed
information.

If the port on which the alarm is raised is connected to a remote CRS-1 or ASR 9000 series router, verify
that the wavelength configured on the router interface is the same as that configured for the port. Check
the router configuration by using these steps:

a. Enter the following command on the router to validate the remote node configuration.

Router> show controllers dwdm interface id x/x/X/x

b. Check the information displayed under Optics Status to verify the configured wavelength.

c. If the wavelength is different from that configured for the port, reset it by entering the following
command on the router in global configuration mode.

Router (config)# controller dwdm interface id x/x/x/x wavelength channel number

~

Note The wavelength configured for the port can be checked in CTC card view.

If the alarm does not clear, follow the general troubleshooting rules in the “Network Reference” chapter
in the Cisco ONS 15454 DWDM Reference Manual for identifying any other upstream alarm in the
logical signal flow that could be the root cause of the outstanding alarm.
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Step8  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.170 LOS-P (OCH)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OCH

The Loss of Signal for Optical Channel alarm on the OCH layer applies to the channel Add or
pass-through ports on the AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, 32MUX-0, 40MUX, 32WSS-O,
40WSS-C, GE-XP, 10GE-XP, and ADM-10G DWDM cards.

For the 32WSS-0 and 40WSS-C, the LOS-P alarm can be associated with Add ports as well as
pass-through internal ports. If the LOS-P (OCH) alarm is raised against this kind of port a different
troubleshooting procedure is needed because the port does not have an optical power source directly
connected to it. In this case, follow the general troubleshooting rules for network-level (inter-node)
troubleshooting in Chapter 1, “General Troubleshooting,” to identify upstream alarms in the logical
signal flow that could cause an LOS-P.

LOS-P (OCH) indicates a loss of received signal, which means the monitored input power value has
crossed the Power Failure Low threshold associated with the port in accordance with the specific VOA
power reference setpoint provisioned on VOA along the path.

Note  For more information about provisioning VOA setpoints, refer to the “Network Reference” chapters of
the Cisco ONS 15454 DWDM Reference Manual.

Clear the LOS-P (OCH) Alarm

Step 1 Verify that the card is exhibiting correct behavior by checking the LED behavior on the physical card. A
green ACT/SBY LED indicates an active card, and a red ACT/SBY LED indicates a failed card. If the
LED is red, complete the “Physically Replace a Card” procedure on page 2-244 and continue to Step 9.

~

Note  When you replace a card with an identical type of card, you do not need to make any changes to
the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.

Step2  Verify that there truly is a loss of received signal by completing the following steps:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. View the proper input power values by clicking one of the following tabs as appropriate:
e For the AD-xC-xx.x card, click the Provisioning > Optical Chn > Parameters tabs.
e For the ADM-10G card, click Performance > Optics PM > Current Values tabs.

e For the 32MUX-0 and 40MUX cards, click the Provisioning > Optical Chn > Parameters
tabs.
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e For the 32WSS-0 and 40WSS-C cards, click the Provisioning > Optical Chn: Optical
Connector x > Parameters tabs.

c¢. Display the proper Power Failure Low threshold by clicking one of the following tabs as appropriate:
e For the AD-xC-xx.x card, click the Provisioning > Optical Chn > Optics Thresholds tabs.
e For the ADM-10G card, click Provisioning > Optics Thresholds tabs.

e For the 32MUX-0O and 40MUX cards, click the Provisioning > Optical Chn > Optics
Thresholds tabs.

e For the 32WSS-0 and 40WSS-C cards, click the Provisioning > Optical Chn: Optical
Connector x > Optics Thresholds tabs.

pe

Tip To view the alarm thresholds (as opposed to the warning thresholds), check the Alarm check box on the
bottom-left of the Optics Thresholds tab and click Reset.

d. Compare the actual assigned Power value with the Alarm Threshold value and complete one of the
following actions:

e If the Power value is less than the Fail Low threshold, go to Step 3.

e [f the Power value is greater than the Fail Low threshold plus the alarm hysteresis (or allowance
value) default of 1 dBm, complete the “Reset a Card in CTC” procedure on page 2-241 for the
card.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 and
continue to Step 9.

~

Note  When you replace a card with an identical type of card, you do not need to make any changes
to the database other than restoring the card’s port to the IS,AINS or
Unlocked,automaticInService administrative state.

Step3  Verify the fiber continuity to the port using site practices. Refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step4  Check the “Internal Connections” file generated by Cisco TransportPlanner for the node where the card
is located. If necessary, recable the node in accordance with the MP file connections list. For procedures
to cable a DWDM node, refer to the “Turn Up a Node” chapter of the Cisco ONS 15454 DWDM
Procedure Guide.

Step5  If the cabling is good, verify that each involved optical signal source, including TXP, MXP or ITU-T line
card trunk transmit ports, is in the IS (or Unlocked) administrative state. To do this, click the following
tabs as appropriate:

e For the ADM-10G card, click the Provisioning > Line > Ports tabs.

e For the TXP_MR_10G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

e For the TXP_MR_10E card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

e For the TXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

e For the TXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.
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e For the MXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

e For the MXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

e For the MXP_2.5G_10E card, click the Provisioning > Line > Trunk tabs.

e For the MXP_2.5G_10G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

If the port administrative state is not IS (or Unlocked), choose IS , or Unlocked, from the Admin state
drop-down list. If the alarm does not clear, continue with Step 9.

If the LOS-P (OCH) alarm applies to a 32WSS-O passthrough port, it means that a single optical source
is not directly connected to the port. In this case, follow the general troubleshooting rules given in
“Network Level (Internode) Troubleshooting” to identify any other alarm upstream to the logical signal
flow that could be the root cause for the outstanding alarm.

If the signal source is in IS (or Unlocked) administrative state, use an optical test set to verify that the
transmit laser is active. For specific procedures to use the test set equipment, consult the manufacturer.

If the laser is active, compare the card’s provisioned transmit optical power value with the expected
range in the “Provision Transponder and Muxponder Cards” chapter of the Cisco ONS 15454 DWDM
Procedure Guide. To display the provisioned transmit optical power values, click the following tabs as
appropriate:

e For the ADM-10G card, click Performance > Optics PM > Current Values tabs.

e For the TXP_MR_10G card, click the Performance > Optics PM > Current Values > Trunk Port
tabs.

e For the TXP_MR_10E card, click the Performance > Optics PM > Current Values > Trunk Port
tabs.

e For the MXP_2.5G_10E card, click the Performance > Optics PM > Current Values >
Trunk Port tabs.

e For the MXP_2.5G_10G card, click the Performance > Optics PM > Current Values >
Trunk Port tabs.

Use a standard power meter to measure actual transmit optical power for the following cards as
applicable:

e GE-XP

e 10GE-XP

e ADM-10G

e TXP_MR_2.5G

e TXPP_MR_2.5G

¢ MXP_MR_2.5G

e MXPP_MR_2.5G

e Every ITU-T line card
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If the tested optical transmit optical power is within the expected range, go to Step 9. If the actual power
value is outside the specification range, complete the “Physically Replace a Card” procedure on

page 2-244. (These are listed in the “Hardware Specifications” appendix of the Cisco ONS 15454
DWDM Reference Manual.) When the newly installed card becomes active, verify that the LOS-P (OCH)
alarm clears. If it does not, continue with Step 9.

If a spare card is unavailable and the transmit power still functions, you can temporarily clear the LOS-P
alarm by following the general procedure to add path VOAs during startup failure as noted in the
“Perform Node Acceptance Tests” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more
information about provisioning VOA setpoints, refer to the “Network Reference” chapter of the

Cisco ONS 15454 DWDM Reference Manual.

If the power is within the expected range, return to the port that reported LOS-P and clean the alarmed
port’s fiber according to site practice. If no site practice exists, complete the procedure in the “Maintain
the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Unplugging the fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer to
the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-237 for basic
instructions, or refer to the “Manage the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide for more detailed information.

If the alarm does not clear, add path VOAs during startup failure as noted in the “Perform Node
Acceptance Tests” chapter of the Cisco ONS 15454 DWDM Procedure Guide to remedy the problem.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.171 LOS-P (TRUNK)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK

The Loss of Signal Payload (LOS-P) alarm for the trunk layer indicates that the incoming payload signal
is absent at the input trunk port. There still may be optical power on the fiber, but the payload data is
missing. This alarm applies to the following cards: TXP_MR_10G, TXP_MR_10E, MXP_2.5G_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, GE-XP, 10GE-XP, ADM-10G,
OTU2_XP and every ITU-T line card.

The MXP_2.5G_10E has no LOS-P (TRUNK) option, because ITU-T G.709 encapsulation on the card
cannot be disabled.

With ITU-T G.709 encapsulation on, the alarm coming from the trunk is LOS-P (TRUNK) in accordance
with the OTN standards.
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Note In R7.01, when an LOS-P (TRUNK) alarm occurs on TXP and MXP trunks, G709/SONET/SDH TCAs
are suppressed. For details, see “Alarm and TCA Monitoring and Management” chapter in the
Cisco ONS 15454 DWDM Reference Manual.

Clear the LOS-P (TRUNK) Alarm

Step 1 Verify that the card behaves correctly by checking the LED behavior on the physical card. A green
ACT/SBY LED indicates an active card, and a red ACT/SBY LED indicates a failed card. If the LED is
red, complete the “Physically Replace a Card” procedure on page 2-244 and continue to Step 8.

>
Note = When you replace a card with an identical type of card, you do not need to make any changes to

the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.

Step2  Verify that there truly is a loss of received optical power by completing the following steps:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the alarmed card to
open the card view.

b. Click the Performance > Optics PM > Current Values > Trunk Port tabs and view the RX Optical
Pwr value.

¢. Compare the actual power levels with the expected power range given in the “Hardware
Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual. Complete one of the
following actions:

e If power is higher than —40 dBm (that is, =20 dBm, —1 dBm, O dBm or 10 dBm) and within the
accepted range go to Step 4.

e or if the power is lower than —40 dBm (that is, —40 dBm, —45 dBm or —50 dBm) complete the
“Reset a Card in CTC” procedure on page 2-241 for the card.

Step3  If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
reporting card and then go to Step 9.

>
Note = When you replace a card with an identical type of card, you do not need to make any changes to

the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.

Stepd  Verify the fiber continuity to the port by following site practices. Refer to the “Network Reference”
chapter of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step5  Check the “Internal Connections” file generated by Cisco TransportPlanner for the node containing the
alarmed card. If necessary, recable the node in accordance with the MP file connections list. For
procedures to cable a DWDM node, refer to the “Turn Up a Node” chapter of the Cisco ONS 15454
DWDM Procedure Guide.

Step6  If the cabling is good, use a test set to verify the power value on the DWDM CH_DROP-TX port on the
AD-xC-xx.x, 32DMX-0, 32DMX, or 40DMX. For specific procedures to use the test set equipment,
consult the manufacturer.
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If the power difference reported is greater than 1 dBm (standard fiber jumper insertion loss is 0.3 dBm),
clean the fiber according to site practice. If no site practice exists, complete the procedure in the
“Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Unplugging the fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer to
the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-237 for basic
instructions, or to the “Manage the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide for
more detailed information.

If the alarm does not clear, follow the general troubleshooting rules stated in the “Network Reference”
chapter of the Cisco ONS 15454 DWDM Reference Manual to identify upstream alarms in the logical
signal flow that could cause an LOS-P.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.172 LOS-RAMAN (0TS)

Default Severity: Critical (CR), Service-Affecting (SA)
SONET Logical Objects: OTS

The Loss of Raman signal alarm indicates that the Raman signal has not received by the RX RAMAN
port on the OPT-RAMP-C card.

Clear the LOS-RAMAN Condition

Step 1

A

Verify that the fiber cable is properly connected and attached to the correct port. For more information
about fiber connections and terminations, refer to the “Install Cards and Fiber-Optic Cables” chapter in
the Cisco ONS 15454 Procedure Guide.

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located lower-right edge of the shelf assembly.
Step2  Consult site records to determine whether the port raising the alarm has been assigned.
Step3  If the port is assigned, verify that the correct port is in service by completing the following steps:
a. To confirm this physically, confirm that the card shows a green LED on the physical card.
A green LED indicates an active card. An amber LED indicates a standby card.
b. To determine this virtually, double-click the card in CTC to display the card view and complete the
following substeps:
e Click the Provisioning > Line tabs.
e Verify that the Admin State column lists the port as IS or Unlocked.
c. If the Admin State column lists the port as OOS,MT or Locked,maintenance or Locked,disabled,
click the column and choose IS or Unlocked.
Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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Step 4

Step 5

Step 6
Step 7

Step 8

S

Note If a port in the OOS or Unlocked administrative state does not receive a signal, the LOS
alarm is raised and the port service state transitions to Locked-disabled, automaticInService
& failed.

d. Click Apply.

Use a test set to confirm that a valid signal exists on the line. Test the line as close to the receiving card
as possible. For specific procedures to use the test set equipment, consult the manufacturer.

If a valid signal is not present and the transmitting device is operational, replace the cable connecting
the transmitting device to the port. To do this, refer to the “Install Hardware” chapter in the
Cisco ONS 15454 Procedure Guide.

Repeat Steps 1 to 5 for any other port on the card that reports the LOS-RAMAN condition.

If no other alarms are present that could be the source of the LOS-RAMAN condition, or if clearing an
alarm did not clear the LOS-RAMAN condition, complete the “Physically Replace a Card” procedure
on page 2-244 for the reporting card.

~

Note  When you replace a card with the identical type of card, you do not need to make any changes
to the database.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.

2.5.173 LO-TXPOWER

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, PPM, TRUNK

The Equipment Low Transmit Power alarm is an indicator for the TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_I10E, TXP_MR_I10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
0C192-XFP, ADM-10G, and OTU2_XP card transmitted optical signal power. LO-TXPOWER occurs
when the measured optical power of the transmitted signal falls under the threshold. The threshold value
is user-provisionable.

For more information about MXP and TXP cards and their power levels, refer to the “Card Reference”
in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to
the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.
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Clear the LO-TXPOWER Alarm

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6

In node view (single-shelf mode) or single-shelf view (multishelf mode), display the TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, OC192-XFP, ADM-10G, or OTU2_XP card view.

Click the Provisioning > Optics Thresholds > Current Values tabs.
For the ADM-10G card, click the Performance > Optics PM > Current Values tabs.
Increase the TX Power Low column value by 0.5 dBm.

If the card transmit power setting cannot be increased without affecting the signal, complete the
“Physically Replace a Card” procedure on page 2-244.

If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.174 LPBKCRS

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: STSMON, STSTRM

The Loopback Cross-Connect condition indicates that there is a software cross-connect loopback active
between an optical card and an OC-192 card. A cross-connect loopback test occurs below line speed and
does not affect traffic.

Cross-connect loopbacks occur below line speed. They do not affect traffic.

Clear the Condition

Step 1

Step 2
Step 3

To remove the loopback cross-connect condition, double-click the optical card in CTC to display the
card view.

Complete the “Clear an STM-N Card XC Loopback Circuit” procedure on page 2-246.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.175 LPBKFACILITY (ESCON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: ESCON
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The LPBKFACILITY (ESCON) condition occurs on a TXP_MR_2.5G or TXPP_MR_2.5G card PPM
(SFP) provisioned for FICON1G or FICON 2G line speed when there is a facility loopback active on the
card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Clear the LPBKFACILITY (ESCON) Condition

Step 1 Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

Step2  If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem (1-800-553-2447).

2.5.176 LPBKFACILITY (FC)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: FC

A Loopback Facility condition for the FC payload occurs on a fibre channel (FC) line when a software
facility (line) loopback is active for an MXPP_MR_2.5G, MXP_MR_2.5G, TXPP_MR_2.5G, and
TXP_MR_2.5G card client PPM (SFP) provisioned at the FC1G, FC2G, FICON1G, or FICON 2G line
speed.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Note For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provisioning Tranponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKFACILITY (FC) Condition

Step 1 Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.177 LPBKFACILITY (GE)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE
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A Loopback Facility condition for a Gigabit Ethernet (GE) port occurs when a software facility (line)
loopback is active for an MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G,
GE-XP, 10GE-XP, and ADM-10G card client PPM (SFP) provisioned at the ONE_GE port rate. For the
TXP_MR_10E and TXP_MR_10G cards, this condition occurs when there is a facility loopback on a
client PPM (SFP) provisioned at the TEN_GE port rate.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKFACILITY (GE) Condition

Step 1

Step 2

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.178 LPBKFACILITY (ISC)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: ISC

A Loopback Facility condition for an ISC port occurs when a software facility (line) loopback is active
for a TXPP_MR_2.5G or TXP_MR_2.5G client PPM (SFP) provisioned at the ISC port rate.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKFACILITY (ISC) Condition

Step 1

Step 2

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.179 LPBKFACILITY (TRUNK)

A

Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
Logical Object: TRUNK

A Loopback Facility condition on MXP, TXP, GE-XP, 10GE-XP, and ADM-10G card trunk ports
indicates that there is an active facility (line) loopback on the port. For this condition to be present, the
administrative state is OOS,MT (or Locked,maintenance).

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Caution

CTC permits loopbacks on an in-service (IS or Unlocked) circuit. Loopbacks are service-affecting.

Clear the LPBKFACILITY (TRUNK) Condition

Step 1

Step 2

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.180 LPBKTERMINAL (ESCON)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: ESCON

The LPBKTERMINAL (ESCON) condition occurs on a TXP_MR_2.5G or TXPP_MR_2.5G card PPM
(SFP) provisioned for FICON1G or FICON 2G line speed when there is a terminal loopback active on
the card.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Clear the LPBKTERMINAL (ESCON) Condition

Step 1

Step 2

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem (1-800-553-2447).

2.5.181 LPBKTERMINAL (FC)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Logical Object: FC

A Loopback Terminal condition for the FC payload occurs on an FC when a software terminal (inward)
loopback is active for an MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G,
GE-XP, and 10GE-XP card client PPM (SFP) provisioned at the FC1G, FC2G, FICON1G, or FICON2G
line speed.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the

Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provisioning Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKTERMINAL (FC) Condition

Step 1

Step 2

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.182 LPBKTERMINAL (GE)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE

A Loopback Terminal condition for a GE port occurs when a software terminal (inward) loopback is
active for an MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, and TXPP_MR_2.5G card client
PPM (SFP) provisioned at the ONE_GE port rate. For the TXP_MR_10E and TXP_MR_10G cards, this
condition occurs when there is a facility loopback on a client PPM (SFP) provisioned at the TEN_GE
port rate.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKTERMINAL (GE) Condition

Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.183 LPBKTERMINAL (ISC)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: ISC

A Loopback Terminal condition for an ISC port occurs when a software terminal (inward) loopback is
active for a TXPP_MR_2.5G or TXP_MR_2.5G client PPM (SFP) provisioned at the ISC port rate.

For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manualand “Provisioning Transponder and Muxponder Cards”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LPBKTERMINAL (ISC) Condition

Step 1

Step 2

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.184 LPBKTERMINAL (TRUNK)

Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
Logical Object: TRUNK

A Loopback Terminal condition on MXP or TXP trunk card indicates that there is an active terminal
(inward) loopback on the port.

For information about troubleshooting, refer to the “1.2 Troubleshooting MXP, TXP, XP, or ADM-10G
Circuit Paths With Loopbacks” section on page 1-7.

Clear the LPBKTERMINAL (TRUNK) Condition

Step 1

Step 2

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-245.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.185 LWBATVG

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR

The Low Voltage Battery alarm occurs in a —48 VDC environment when a battery lead input voltage falls
below the low power threshold. This threshold, with a default value of —44 VDC, is user-provisionable.
The alarm remains raised until the voltage remains above the threshold for 120 seconds. (For
information about changing this threshold, refer to the “Turn Up Node” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

Clear the LWBATVG Alarm

Step 1 The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

25.186 MAN-REQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Manual Switch Request condition occurs when a user initiates a Manual switch request on an
OC-N/STM-N port. Clearing the Manual switch clears the MAN-REQ condition. You do not need to
clear the switch if you want the Manual switch to remain.

Clear the MAN-REQ Condition

Step 1 Complete the “Initiate a 1+1 Manual Switch Command” procedure on page 2-237.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.187 MANRESET

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
A User-Initiated Manual Reset condition occurs when you right-click a card in CTC and choose Reset.

~

Note MANRESET is an informational condition and does not require troubleshooting.
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2.5.188 MANSWTOINT

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF

The Manual Switch To Internal Clock condition occurs when the NE timing source is manually switched
to an internal timing source.

MANSWTOINT is an informational condition and does not require troubleshooting.

2.5.189 MANSWTOPRI

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Primary Reference condition occurs when the NE timing source is manually
switched to the primary timing source.

MANSWTOPRI is an informational condition and does not require troubleshooting.

2.5.190 MANSWTOSEC

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Second Reference condition occurs when the NE timing source is manually
switched to a second timing source.

MANSWTOSEC is an informational condition and does not require troubleshooting.

2.5.191 MANSWTOTHIRD

S

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Manual Switch To Third Reference condition occurs when the NE timing source is manually
switched to a third timing source.

MANSWTOTHIRD is an informational condition and does not require troubleshooting.

2.5.192 MANUAL-REQ-SPAN (2R, ESCON, FC, GE, ISC, OCN/STMN, OTS)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, OTS

The Manual Switch Request on Ring condition for clients occurs when a user initiates a Manual Span
command on an MXP or TXP client for the above-listed client types to move traffic from a working span
to a protect span. This condition appears on the network view Alarms, Conditions, and History tabs. The
port where the MANUAL SPAN command was applied is marked with an “M” on the network view
detailed circuit map.

Note  For more information about protection schemes, refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

2.5.193 MANUAL-REQ-SPAN (TRUNK)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Manual Switch Request on Ring condition for the trunk occurs when a user initiates a Manual Span
command on an MXP or TXP trunk port in a splitter protection group to move traffic from a working
span to a protect span. This condition appears on the network view Alarms, Conditions, and History tabs.
The port where the MANUAL SPAN command was applied is marked with an “M” on the network view
detailed circuit map.

Note  For more information about protection schemes, refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

2.5.194 MEA (AIP)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: AIP

If the Mismatch of Equipment Attributes (MEA) alarm is reported against the AIP, the fuse in the AIP
board blew or is missing. The MEA alarm also occurs when an old AIP board with a 2-A fuse is installed
in a newer ANSI 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD).

Clear the MEA (AIP) Alarm

Step 1 Complete the “Replace the Alarm Interface Panel” procedure on page 2-250.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.195 MEA (EQPT)

Default Severity: Critical (CR), Service-Affecting (SA)
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Note

Logical Object: EQPT

The MEA alarm for equipment is reported against a card slot when the physical card inserted into a slot
does not match the card type that is provisioned for that slot in CTC. Removing the incompatible cards
clears the alarm. For more information about card compatibility, refer to the “Card Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual.

For more information about protection schemes, refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

Clear the MEA (EQPT) Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

A

Physically verify the type of card that is installed in the slot reporting the MEA alarm. In node view
(single-shelf mode) or shelf view (multishelf mode), click the Inventory tab and compare it to the actual
installed card.

Determine whether the ONS system shelf assembly is a newer 10-Gbps-compatible shelf assembly
(15454-SA-ANSI or 15454-SA-HD) or an earlier shelf assembly. Under the HW Part # column, if the
part number is 800-19857-XX or 800-19856-XX, then you have a 15454-SA-ANSI shelf. If the part
number is 800-24848-XX, then you have a 15454-SA-HD shelf. If the number is not one of those listed
here, then you are using an earlier shelf assembly.
S
Note  On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.

If you prefer the card type depicted by CTC, complete the “Physically Replace a Card” procedure on
page 2-244 for the reporting card.

If you prefer the card that physically occupies the slot but the card is not in service, does not have circuits
mapped to it, and is not part of a protection group, place the cursor over the provisioned card in CTC
and right-click to choose Delete Card.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.

S
Note Ifthe cardisin service, does have circuits mapped to it, is paired in a working protection scheme,

has DCC communications turned on, or is used as a timing reference, CTC does not allow you
to delete the card.

If any ports on the card are in service, place them out of service (OOS,MT or Locked,maintenance):

Caution

Before placing ports out of service, ensure that live traffic is not present.

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b. Click the Provisioning tab.

c. Click the administrative state of any in-service ports.
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d. Choose OOS,MT (or Locked,maintenance) to take the ports out of service.

If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-245.

Caution

Step 7

Step 8
Step 9

Step 10

Before deleting the circuit, ensure that live traffic is not present.

If the card is paired in a protection scheme, delete the protection group:

a. node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Protection
tabs.

b. Choose the protection group of the reporting card.
c. Click Delete.

Right-click the card reporting the alarm.

Choose Delete.

The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

25196 MEA (FAN)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: FAN

The MEA alarm is reported against the fan-tray assembly when a newer fan-tray assembly (15454-FTA3)
with a 5-A fuse is used with an older shelf assembly or when an older fan-tray assembly with a 2-A fuse
is used with a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) that
contains cards introduced in Release 3.1 or later. If a 10-Gbps-compatible shelf assembly contains only
cards introduced before Release 3.1, then an older fan-tray assembly (15454-FTA-2) can be used and
does not report an MEA alarm.

Clear the MEA (FAN) Alarm

Step 1

Step 2

Determine whether the shelf assembly is a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI
or 15454-SA-HD) or an earlier shelf assembly. In node view (single-shelf mode) or shelf view (multishelf
mode), click the Inventory tab.

Under the HW Part # column, if the part number is 800-19857-XX or 800-19856-XX, then you have a
15454-SA-ANSI shelf. If the part number is 800-24848-XX, you have a 15454-SA-HD shelf.

Under the HW Part # column, if the number is not one of those listed here, then you are using an earlier
shelf assembly.

If you have a 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD), the alarm
indicates that an older incompatible fan-tray assembly is installed in the shelf assembly. Obtain a newer
fan-tray assembly (15454-FTA3) with a 5-A fuse and complete the “Replace the Fan-Tray Assembly”
procedure on page 2-249.
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Step 3

Step 4

If you are using an earlier shelf assembly, the alarm indicates that you are using a newer fan-tray
assembly (15454-FTA3), which is incompatible with the earlier version of the shelf assembly. Obtain an
earlier version of the fan-tray assembly (15454-FTA2) and complete the “Replace the Fan-Tray
Assembly” procedure on page 2-249.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.197 MEA (PPM)

Note

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: PPM

The Missing Equipment Attributes alarm for the PPM (SFP) is raised on TXP, MXP, MRC-12 and
0C192-XFP/STM-64-XP cards when the PPM (SFP) is misprovisioned or unsupported. It can occur
when you provision the PPM (SFP) for a wavelength that is explicitly not the first tunable wavelength.

For general information about DWDM cards, refer to the “Card Reference” chapter in the

Cisco ONS 15454 DWDM Reference Manual. For PPM (SFP) specifications, refer to the “Hardware
Specifications” appendix in the same manual. For information about MRC-12 cards, refer to the “Optical
Cards” chapter in the Cisco ONS 15454 Reference Manual.

Clear the MEA (PPM) Alarm

Step 1

Step 2

To provision the PPM (SFP), you must first create it in CTC. To do this, complete the following steps:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b. Click the Provisioning > Pluggable Port Modules tabs. (If you already see the PPM [SFP] listed
in the Pluggable Port Modules Area, go to Step 2.)

c. Under the Pluggable Port Modules area, click Create.

d. In the Create PPM dialog box, choose the card PPM (SFP) number from the drop-down list (for
example, PPM 1).

e. Choose the PPM (SFP) type from the second drop-down list, for example PPM (1 Port).
f. Click OK.

~

Note  For more information about provisioning MXP or TXP PPMs (SFPs), refer to the “Turn Up
a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide. For information to
provision PPMs (SFPs) for the MRC-12 and OC192/STM64-XFP, refer to the “Optical
Cards” chapter in the Cisco ONS 15454 Reference Manual.

After you have created the PPM (SFP), or if you see it listed in the Pluggable Port Modules area but not
in the Selected PPM area, choose the port rate:

a. Under the Selected PPM area, click Create.
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b. In the Create Port dialog box, choose the port (for example, 1-1) from the drop-down list.

c. Choose the correct port type from the drop-down list. (For more information about selecting PPM
(SFP) port types, refer to the “Provision Transponder and Muxponder Cards” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.)

d. Click OK.

If you see the port listed in the Pluggable Port Modules area and the Selected PPM area, the MEA
indicates that the incorrect port rate was selected. Click the port in the Selected PPM area and click
Delete.

Complete Step 2 to correctly provision the port rate.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.198 MEA (SHELF)

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: SHELF

The MEA (Shelf) condition is raised when ANSI and ETSI shelves exist in the same node. For example,
an ANSI subtended shelf is configured on an ETSI node controller or an ETSI subtended shelf is
configured on an ANSI node controller.

Clear the MEA (SHELF) Condition

Step 1 Ensure that the shelves in the node are either ANSI only or ETSI only.

Step 2 If the condition does not clear, log onto http://www.cisco.com/tac for more information or call
TAC (1-800-553-2447).

2.5.199 MEM-GONE

Note

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Memory Gone alarm occurs when data generated by software operations exceeds the memory
capacity of the TCC2/TCC2P card. The TCC2/TCC2P cards which exceed the memory capacity reboot
to avoid failure of card operations.

The alarm does not require user intervention. The MEM-LOW alarm always preceeds the MEM-GONE
alarm.

25200 MEM-LOW

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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Logical Object: EQPT

The Free Memory of Card Almost Gone alarm occurs when data generated by software operations is
close to exceeding the memory capacity of the TCC2/TCC2P card. The alarm clears when additional
memory becomes available. If additional memory is not made available and the memory capacity of the
card is exceeded, CTC ceases to function.

The alarm does not require user intervention. If the alarm does not clear, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

25201 MFGMEM

Tip

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AICI-AEP, AICI-AIE, AIP, BPLANE, FAN, PPM

The Manufacturing Data Memory Failure alarm occurs when the EEPROM fails on a card or component,
or when the TCC2/TCC2P card cannot read this memory. EEPROM stores manufacturing data that a
system TCC2/TCC2P card uses to determine system compatibility and shelf inventory status.
Unavailability of this information can cause less-significant problems. The AIP EEPROM also stores the
system MAC address. If the MFGMEM alarm indicates EEPROM failure on these panels, IP
connectivity could be disrupted and the system icon is grayed out in CTC network view.

When you lose LAN connectivity with an ONS system due to an MFGMEM alarm on the AIP, you can
reestablish node management by disconnecting the Ethernet cable from the panel and connecting it to
the active TCC2/TCC2P card LAN port.

Clear the MFGMEM Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-241.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-242. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, complete the “Physically Replace a Card”
procedure on page 2-244.

If the MFGMEM alarm continues to report after replacing the TCC2/TCC2P cards, the problem lies with
the EEPROM.

If the MFGMEM is reported from the fan-tray assembly, obtain a fan-tray assembly and complete the
“Replace the Fan-Tray Assembly” procedure on page 2-249.

If the MFGMEM is reported from the AIP, the backplane, or the alarm persists after the fan-tray
assembly is replaced, log into the Technical Support Website at http://www.cisco.com/techsupport for
more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.
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2.5.202 MS-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STMI1E, STMN

The Multiplex Section (MS) AIS condition indicates that there is a defect in the multiplexing section
layer of the SONET overhead. The multiplex section refers to the segment between two SONET devices
in the circuit and is also known as a maintenance span. The multiplex section layer of the SONET
overhead deals with payload transport, and its functions include multiplexing and synchronization.

Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the MS-AIS Condition

Step 1
Step 2

Complete the “Clear the AIS Condition” procedure on page 2-27.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.203 MS-DEG

Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMIE

The Multiplex Section Signal Degrade condition is similar to the “SDBER-EXCEED-HO” alarm on
page 2-203, but applies only to the multiplex section overhead of the EQPT object.

Clear the MS-DEG Condition

Step 1
Step 2

Complete the “Clear the SDBER-EXCEED-HO Condition” procedure on page 2-203.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.204 MS-EOC

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: STMN
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The MS-DCC Termination Failure alarm occurs when the ONS 15454 loses its data communications
channel. The DCC is nine bytes, D4 through D 12, in the SONET overhead. The bytes convey
information about Operation, Administration, Maintenance, and Provisioning (OAM&P). The

ONS 15454 uses the DCC on the SONET section overhead to communicate network management
information.

Clear the MS-EQOC Alarm

Step 1 Complete the “Clear the RS-EOC Alarm” procedure on page 2-199.

Step2  If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.205 MS-EXC

Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STM1E

The Multiplex Section Signal Excessive BER condition is similar to the “SDBER-EXCEED-HO” alarm
on page 2-203, but applies only to the multiplex section overhead of the EQPT object.

Clear the MS-EXC Condition

Step 1 Complete the “Clear the SDBER-EXCEED-HO Condition” procedure on page 2-203.

Step2  If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.206 MS-RFI

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STM1E, STMN

The MS Remote Fault Indication (RFI) condition indicates that there is an RFI occurring at the SONET
overhead multiplexing section level.

An RFI occurs when the ONS 15454 detects an RFI in the SONET overhead because of a fault in another
node. Resolving the fault in the adjoining node clears the MS-RFI condition in the reporting node.
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Clear the MS-RFl Condition

Step1  Log into the far-end node of the reporting ONS 15454.
Step 2 Determine whether there are other alarms, especially the LOS(STM1E, STMN).
Step3  Clear the main alarm. See the appropriate alarm section in this chapter for the procedure.

Step4  If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.207 MT-0CHNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OTS

The MT-OCHNC condition occurs when the user provisions (tunes) a specific wavelength for
maintenance on a WXC card from an input port (EXP1-8, ADD-RX) to the output port (COM-TX).

Clear the MT-OCHNC Condition

Step1  Delete the provisioned wavelength that was specifically tuned for maintenance purposes on a WXC card.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.5.208 NON-CISCO-PPM

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: PPM

The Non-Cisco PPM Inserted condition occurs when a PPM that is plugged into a card’s port fails the
security code check. The check fails when the PPM used is not a Cisco PPM.

Clear the NON-CISCO-PPM Condition

Step1  Obtain the correct Cisco PPM and replace the existing PPM with the new one.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.209 NOT-AUTHENTICATED

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM

The NOT-AUTHENTICATED alarm is raised by CTC (not by the NE) when CTC fails to log into a node.
This alarm only appears in CTC where the login failure occurred. This alarm differs from the
“INTRUSION-PSWD” alarm, page 2-113, because INTRUSION-PSWD occurs when a user exceeds the
login failures threshold.

Note NOT-AUTHENTICATED is an informational alarm and is resolved when CTC successfully logs into the
node.

2.5.210 OCHNC-INC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OCHNC-CONN

The Optical Channel (OCH) Incomplete Cross-Connection condition is raised when an OCH cross
connection on a two-way circuit is deleted. For example, if you create an OCH circuit on a linear DWDM
structure with Nodes A, B and C—originating at Node A, traversing through Node B, and terminating
at Node C—then mistakenly delete a cross-connect (such as by TL1 command DLT-WLEN) on Nodes
B or C, this condition is raised on the source node (A). The condition is corrected by regenerating the
cross-connect. The alarm also follows these guidelines:

e Two-way circuit with Nodes A, B, and C (as described in the preceding example): Deleting a
cross-connection on Nodes B or C will raise OCHNC-INC on the Node A cross connection.

¢ Two-way circuit with Nodes A, B, and C: Deleting a cross connection on Node A will raise an
OCHNC-INC alarm on the Node C cross connection.

¢ One-way circuit with Nodes A, B and C: Deleting a cross connection on Nodes B or C will raise an
OCHNC-INC alarm on Node A cross connection.

e One-way circuit with Nodes A, B, and C: Deleting a cross connection on Node A will not raise an
OCHNC-INC alarm.

Note  If you delete one of the cross-connects, you might not be able to recreate this same circuit with CTC
because the wavelength is already being used on the other component nodes for add, drop, or express.

The OCHNC-INC alarm can also be raised if you restore one node’s database that is inconsistent with
other node databases, following the guidelines previously listed. (That is, an inconsistent database that
does not contain up-to-date circuit cross-connection information will cause the same problem as if you
had deleted the cross-connect.)

A

Caution It is important to create a backup version of the database for each node of a topology during a
known-stable situation. You should give the saved files names that indicate their version and date or any
other information needed to verify their consistency. For procedures to back up or restore database files,
refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.
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Clear the OCHNC-INC Alarm

Step 1

Step 2

Note

Step 3

To recreate the missing cross-connect itself, establish a Telnet connection with the node where it was
deleted and use the ENT-WLEN command with the Add port, Drop port, or Express port on the node.

For information about establishing a TL1 session connection, refer to the Cisco ONS SONET TL1
Reference Guide. For more information about ENT-WLEN and other TL1 commands, as well as their
syntax, refer to the Cisco ONS SONET TLI1 Command Guide.

If the alarm is not due to a deleted cross-connect but instead to an inconsistent database being restored
on a node, correct the problem by restoring the correct backup version to that node. For the restore
procedure, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

When you restore a database on a node, it replaces the database being used on both (ACT and SBY)
TCC2/TCC2P cards as the cards synchronize this version into their active flash memory. If the active
(ACT) TCC2/TCC2P card is reset, the standby (SBY) TCC2/TCC2P card will therefore use the same
database version from its active flash memory. In the case of a power-up, both TCC2/TCC2P cards boot
and choose which database to use from two criteria: (1) the most recent version compatible with the node
software, and (2) the most recently loaded version of that compatible database (with the highest sequence
number).

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.211 OCHTERM-INC

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: OCHTERM

The Optical Termination Incomplete condition is raised against an OCH termination of there is no peer
OCH termination at the other end of a span.

Clear the OCHTERM-INC Condition

Step 1

Step 2

Create an OCH termination at the other end of the span. For procedures to do this, refer to the “Create
Channels and Circuits” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.212 ODUK-1-AIS-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
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The ODUK-1-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-1-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.

A single ODUK-x-AIS-PM can occur when one far-end client signal is lost; multiple ODK-x-AIS-PMs
can occur (ODUK-1-AIS-PM, ODUK-2-AIS-PM, ODUK-3-AIS-PM, ODUK-4-AIS-PM) if more than
one far-end client is lost. If the entire trunk signal is lost, LOS (TRUNK) occurs and demotes any LOS
(2R) alarms.

Clear the ODUK-1-AlIS-PM Condition

Step 1 Look for and clear the LOS (2R) alarm on the far-end client. This should clear the ODUK-1-AIS-PM
condition on the trunk.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.213 ODUK-2-AIS-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The ODUK-2-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-2-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.

Clear the ODUK-2-AlIS-PM Condition

Step 1 Complete the “Clear the ODUK-1-AIS-PM Condition” procedure on page 2-168.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.214 ODUK-3-AIS-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The ODUK-3-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-3-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.

Clear the ODUK-3-AIS-PM Condition

Step 1 Complete the “Clear the “Clear the ODUK-1-AIS-PM Condition” procedure on page 2-168.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.215 ODUK-4-AIS-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The ODUK-4-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-4-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.

Clear the ODUK-4-AlIS-PM Condition

Step 1 Complete the “Clear the ODUK-1-AIS-PM Condition” procedure on page 2-168.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.216 ODUK-AIS-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Optical Data Unit (ODUK) AIS Path Monitoring (PM) condition applies to TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, ADM-10G, and OTU2_XP cards when ITU-T G.709 encapsulation is enabled for the
cards. ODUK-AIS-PM is a secondary condition that indicates a more serious condition such as the LOS
(OCN/STMN) alarm occurring downstream. (This is described in the “Alarm Troubleshooting” chapter
of the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide.)
The ODUK-AIS-PM condition is reported in the path monitoring area of the optical data unit wrapper
overhead. ODUK-AIS-PM is caused by the upstream 2.5.219 ODUK-OCI-PM, page 2-171.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP). For information about provisioning the
TXP card or MXP card to enable ITU-T G.709 encapsulation, refer to the “Provision Transponder and
Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

~

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
| 78-18378-02 .m



Chapter2  Alarm Troubleshooting |

W Trouble-Clearing Procedures

Clear the ODUK-AIS-PM Condition

Step1  Determine whether upstream nodes and equipment have alarms, especially the LOS (OCN/STMN)
alarm, or OOS (or Locked) ports.

Step2  Clear the upstream alarms using the “Clear the LOS (OCN/STMN) Procedure” located in the
Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.217 ODUK-BDI-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The ODUK Backward Defect Indicator (BDI) PM condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_I10E_C, TXP_MR_10E_L, MXP_2.5G_10G, ADM-10G,
and OTU2_XP cards when ITU-T G.709 encapsulation is enabled for the cards. It indicates that there is
a path termination error upstream in the data. The error is read as a BDI bit in the path monitoring area
of the digital wrapper overhead.

Note For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-BDI-PM Condition

Step 1 Complete the “Clear the OTUK-BDI Condition” procedure on page 2-180.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.218 ODUK-LCK-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The ODUK Locked Defect (LCK) PM condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, ADM-10G,
and OTU2_XP cards when ITU-T G.709 encapsulation is enabled for the cards. ODUK-LCK-PM
indicates that a signal is being sent downstream to indicate that the upstream connection is locked,
preventing the signal from being passed. The lock is indicated by the STAT bit in the path overhead
monitoring fields of the optical transport unit overhead of the digital wrapper.
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Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-LCK-PM Condition

Step 1 Unlock the upstream node signal.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.219 ODUK-OCI-PM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The ODUK Open Connection Indication (OCI) PM condition applies to TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_I10E_L,
MXP_2.5G_10G, ADM-10G, and OTU2_XP cards when ITU-T G.709 encapsulation is enabled for the
cards. It indicates that the upstream signal is not connected to a trail termination source. The error is read
as a STAT bit in the path monitoring area of the digital wrapper overhead. ODUK-OCI-PM causes a
downstream “ODUK-LCK-PM” alarm on page 2-170.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-OCI-PM Condition

Step 1 Verify the fiber connectivity at nodes upstream.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.220 ODUK-SD-PM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
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The ODUK Signal Degrade (SD) PM condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, ADM-10G,
and OTU2_XP cards when ITU-T G.709 encapsulation is enabled. ODUK-SD-PM indicates that
incoming signal quality is poor, but the incoming line BER has not passed the fail threshold. The BER
problem is indicated in the path monitoring area of the optical data unit frame overhead.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-SD-PM Condition

Step 1 Complete the “Clear the OTUK-SD Condition” procedure on page 2-183.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.221 ODUK-SF-PM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The ODUK Signal Fail (SF) PM condition (ODUK-SD-PM) applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_2.5G_10G, ADM-10G, and OTU2_XP cards when ITU-T G.709 encapsulation
is enabled. ODUK-SF-PM indicates that incoming signal quality is poor and the incoming line BER has
passed the fail threshold. The BER problem is indicated in the path monitoring area of the optical data
unit frame overhead.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-SF-PM Condition

Step1  Complete the “Clear the SF (DS1, DS3) Condition” procedure located in the “Alarm Troubleshooting”
chapter of the Cisco ONS 15454 Troubleshooting Guide.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.222 ODUK-TIM-PM

Note

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The ODUK-TIM- PM condition applies to the path monitoring area of the OTN overhead for
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L,MXP_2.5G_10G, ADM-10G, and OTU2_XP cards. The condition occurs when there
is a trace identifier mismatch in the data stream. ODUK-TIM-PM causes an 2.5.217 ODUK-BDI-PM,
page 2-170, downstream.

The ODUK-TIM-PM condition applies to TXP cards and MXP cards when ITU-T G.709 encapsulation
is enabled for the cards. It indicates that there is an error upstream in the optical transport unit overhead
of the digital wrapper.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP). For information about provisioning the
TXP card or MXP card to enable ITU-T G.709 encapsulation, refer to the “Provision Transponder and
Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-TIM-PM Condition

Step 1

Step 2

Complete the “Clear the TIM-P Condition” procedure located in the “Alarm Troubleshooting” chapter
of the Cisco ONS 15454 Troubleshooting Guide.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.223 OPEN-SLOT

Default Severity: Not Alarmed (NA), Minor (MN)
Logical Object: EQPT

The Open Slot condition indicates that there is an open slot in the system shelf. Slot covers assist with
airflow and cooling.

Clear the OPEN-SLOT Condition

Step 1

To install a slot cover and clear this condition, refer to the procedures located in the “Install Shelf and
Common Control Cards” chapter of the Cisco ONS 15454 DWDM Procedure Guide.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.5.224 OPTNTWMIS

Note

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: NE

The Optical Network Type Mismatch alarm is raised when DWDM nodes are not configured for the same
type of network, either MetroCore or MetroAccess. All DWDM nodes on the same network must be
configured for the same network type because APC and ANS behave differently on each of these network
types. For more information about APC and ANS, refer to the “Network Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual.

When the OPTNTWMIS alarm occurs, the “APC-DISABLED” alarm on page 2-29 could also be raised.

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the OPTNTWMIS Alarm

Step 1

Step 2
Step 3

In node view (single-shelf mode) or multishelf view (multishelf mode) of the alarmed node, click the
Provisioning > WDM-ANS > Provisioning tabs.

Choose the correct option from the Network Type list box, and click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.225 OPWR-HDEG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS

The Output Power High Degrade alarm occurs on all DWDM ports that use a power setpoint, including
the OPT-BST, OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C cards AOTS ports in control-power mode;
the 32DMX, 32DMX-0, 40DMX, 32MUX-0, 32WSS, 40WSS-C, and WXC card OCH ports; and the
OSC-CSM and OSCM OSC-TX ports.

The alarm generally indicates that an internal signal transmission problem prevents the signal output
power from maintaining its setpoint and the signal has crossed the high-degrade threshold. For 32DMX,
32DMX-0, 40DMX, 32MUX-0, 32WSS, 40WSS-C, WXC OCH ports and OSC-CSM and OSCM
OSC-TX ports, OPWR-HDEG indicates that the card has a VOA control circuit failure affecting its
attenuation capability. The alarmed card should be replaced at the next opportunity.
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For more information about provisioning gain setpoints and VOA setpoints, refer to the “Node
Reference” and “Network Reference” chapters, respectively, of the Cisco ONS 15454 DWDM Reference
Manual. The “Hardware Specifications” appendix in the same manual contains power level tables for
each card.

Clear the OPWR-HDEG Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Verify fiber continuity to the port by following site practices. Refer to the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

If the cabling is good, confirm that the LED is correctly illuminated on the physical card. A green
ACT/SBY LED indicates an active card. A red ACT/SBY LED indicates a failed card.

Verify that the power read by photodiode on the port is within the expected range as projected by
Cisco TransportPlanner. The application generates a spreadsheet of values containing this information.

If the optical power level is within specifications, check the opwrMin threshold. (These are listed in the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.) Refer to the
Cisco MetroPlanner DWDM Operations Guide and decide what value to use for modifying the power
level:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. Display the optical thresholds by clicking the following tabs:

e For the OPT-BST, OPT-AMP-C, or OPT-AMP-17-C cards, click the Provisioning > Opt. Ampli.
Line > Optics Thresholds tabs.

¢ For the OPT-PRE, OPT-AMP-C, or OPT-AMP-17-C cards, click the Provisioning > Opt. Ampli.
Line > Optics Thresholds tabs.

e For the WXC card, click the Provisioning > Optical Chn > Optics Thresholds tabs.
e For the AD-xC-xx.x card, click the Provisioning > Optical Chn > Optics Thresholds tabs.
e For the AD-xB-xx.x card, click the Provisioning > Optical Band > Optics Thresholds tabs.

e For the 32DMX, 32DMX-O, or 40DMX cards, click the Provisioning > Optical Chn > Optics
Thresholds tabs.

e For the 32MUX-O card, click the Provisioning > Optical Chn > Optics Thresholds tabs.

e For the 32WSS card, click the Provisioning > Optical Chn: Optical Connector x >
Optics Thresholds tabs.

e For the OSCM or OSC-CSM cards, click the Provisioning > Optical Line > Optics Thresholds
tabs.

If the received optical power level is within specifications, refer to the Cisco MetroPlanner DWDM
Operations Guide to determine the correct levels and check the opwrMin threshold. (These are listed in
the “Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.) If
necessary, modify the value as required.

If the optical power is outside of the expected range, verify that all involved optical signal sources,
namely the TXP or MXP trunk port or an ITU-T line card, are in IS or Unlocked administrative state by
clicking the correct tab:

¢ For the MXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning >
Line > SDH) tabs.
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Step 7

Step 8

Step 9
Step 10

Step 11

Step 12
Step 13

e For the MXP_2.5G_10E card, click the Provisioning > Line > Trunk tabs.

e For the MXP_2.5G_10G card, click the Provisioning > Line > SONET (or Provisioning >
Line > SDH) tabs.

e Forthe MXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.

e For the TXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning >
Line > SDH) tabs.

e For the TXP_MR_10E card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.

e For the TXP_MR_10G card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.

e For the TXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.

If it is not IS or Unlocked, choose IS (or Unlocked) from the administrative state drop-down list. This
creates the IS-NR or Unlocked,enabled service state.

If the port is in IS (or Unlocked) state but its output power is outside of the specifications, complete the
“Clear the LOS-P (OCH) Alarm” procedure on page 2-142. (These specifications are listed in the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.)

If the signal source is IS or Unlocked and within expected range, come back to the unit reporting
OPWR-HDEG and clean all connected fiber in the same line direction as the reported alarm according
to site practice. If no site practice exists, complete the procedure in the “Maintain the Node” chapter of
the Cisco ONS 15454 DWDM Procedure Guide.

~

Note  Unplugging fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer
to the procedures in the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-237. For more detailed protection switching information, refer to the “Manage the Node”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Repeat Steps 1 to 8 for any other port on the card reporting the OPWR-HDEG alarm.

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

If no other alarms exist that could be the source of the OPWR-HDEG, or if clearing an alarm did not
clear the alarm, place all of the card ports in OOS,DSBLD (or Locked,disabled) administrative state.

Complete the “Physically Replace a Card” procedure on page 2-244 for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.226 OPWR-HFAIL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OMS, OTS
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The Output Power Failure alarm occurs on an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C, or
OPT-AMP-17-C) AOTS and WXC card OCH port if the transmitted power exceeds the high fail
threshold. This alarm is raised only in control power working mode. The alarmed card should be replaced
at the next opportunity.

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the OPWR-HFAIL Alarm

Step 1
Step 2

Complete the “Clear the OPWR-HDEG Alarm” procedure on page 2-175.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.227 OPWR-LDEG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS

The Output Power Low Degrade alarm occurs on all DWDM ports that use a setpoint, including the an
amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C, or OPT-AMP-17-C) AOTS ports in control-power
mode; the 32DMX, 32DMX-0, 40DMX, 32MUX-0, 40MUX, 32WSS, and 40WSS-C card OCH ports;
and the OSC-CSM and OSCM card OSC-TX ports.

The alarm generally indicates that an internal signal transmission problem prevents the signal output
power from maintaining its setpoint and the signal has crossed the low degrade threshold. For the
32DMX, 32DMX-0, 40DMX, 32MUX-0, 40MUX, 32WSS, and 40WSS-C card OCH ports and the
OSC-CSM and OSCM card OSC-TX ports, the OPWR-HDEG alarm indicates that the card has a VOA
control circuit failure affecting its attenuation capability. The alarmed card should be replaced at the next
opportunity.

The OPWR-LDEG alarm may be raised on the WSS pass through ports of a ROADM configuration when
the attenuation is increased at the span level.

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For more information about provisioning VOA setpoints,
refer to the “Network Reference” chapter in the same manual.

Clear the OPWR-LDEG Alarm

Step 1

Complete the “Clear the OPWR-HDEG Alarm” procedure on page 2-175.
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Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.228 OPWR-LFAIL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS

The Output Power Failure alarm applies to an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C, or
OPT-AMP-17-C) AOTS ports. It also applies to AD-1B-xx.x, AD-4B-xx.x, AD-1C-xx.x, AD-2C-xx.x%,
AD-4C-xx.x, OPT-PRE, OPT-BST, OPT-AMP-C, or OPT-AMP-17-C, 32MUX-0O, 40MUX, 32DMX,
32DMX-0, 32DMX, 40DMX, 32WSS, 40WSS-C, and OSC-CSM transmit ports. The alarm is raised
when monitored input power crosses the low fail threshold.

For the AD-1B-xx.x, AD-4B-xx.x, AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x card OCH ports and the
32MUX-0, 40MUX, 32DMX, 32DMX-0, 32DMX, 40DMX, 32WSS, 40WSS-C, OSCM, and
OSC-CSM cards, OPWR-LFAIL indicates that the card has a VOA control circuit failure that affects its
attenuation capability.

Note  For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For more information about provisioning VOA setpoints,
refer to the “Network Reference” chapter in the same manual.

Clear the OPWR-LFAIL Alarm

Step 1 Complete the “Clear the OPWR-HDEG Alarm” procedure on page 2-175.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.229 OSRION

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OTS

The Optical Safety Remote Interlock On condition is raised an amplifier card (OPT-BST or OPT-PRE)
when OSRI is set to ON. The condition does not correlate with the “OPWR-LFAIL” alarm on
page 2-178, which is also reported on the same port.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
m. 78-18378-02 |



| Chapter2 Alarm Troubleshooting

Trouble-Clearing Procedures 1l

Clear the OSRION Condition

Step 1 Turn the OSRI off:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. Click the Maintenance > ALS tabs.
¢. In the OSRI column, choose OFF from the drop-down list.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.230 OTUK-AIS

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Optical Transport Unit (OTUK) AIS condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
MXP_2.5G_10E, ADM-10G, and OTU2_XP cards when ITU-T G.709 encapsulation is enabled for the
cards. OTUKk-ALIS is a generic AIS signal with a repeating AIS PN-11 sequence. This pattern is inserted
by the card in the ITU-T G.709 frame (Trunk) when a faulty condition is present on the client side.

The detection of an OTUK-AIS on the RX-Trunk port of a near-end TXP or MXP is a secondary
condition that indicates a more serious issue occurring on the far-end TXP/MXP card connected
upstream, most likely on the client side. OTUK-AIS is reported in the optical transport unit overhead of
the digital wrapper.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note  For information about MXP and TXP cards and their monitoring capabilities, refer to the “Card
Reference” and “Provision Transponder and Muxponder Cards” chapters in the Cisco ONS 15454
DWDM Procedure Guide.

Clear the OTUK-AIS Condition

Step 1 Complete the “Clear the AIS Condition” procedure on page 2-27.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.231 OTUK-BDI

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
| 78-18378-02 .m




Chapter2  Alarm Troubleshooting |

W Trouble-Clearing Procedures

Note

Note

The Section Monitoring Backward Defect Indication (OTUK BDI) condition applies to TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, MXP_2.5G_10E, ADM-10G, and OTU2_XP cards when ITU-T G.709 encapsulation
feature is enabled for the cards. The presence of OTUK-BDI is detected by ITU-T G.709 frame
section-monitoring overhead field. The BDI bit is a single bit defined to convey the signal fail status
detected in a section termination sink in the upstream direction.

If the near-end TXP detects an OTUK-BDI condition on its Trunk-RX port, this means that the far-end
TXP has inserted the BDI bit in the transmitted (Trunk-Tx) frame, because a failure such as LOS or SD
was detected on the Trunk-RX port. Troubleshoot the failure on the far-end side to clear this condition.
For information about various DWDM LOS alarms, refer to the appropriate sections in this chapter. For
an OC-N/STM-N LOS failure or an SD, refer to the “Alarm Troubleshooting” chapter of the

Cisco ONS 15454 Troubleshooting Guide.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-BDI Condition

Step 1

Step 2

Step 3

Step 4

Step 5

At the near-end node, use site practices to clean trunk transmitting fiber toward the far-end node and the
client receiving fiber. If no site practice exists, complete the procedure in the “Maintain the Node”
chapter of the Cisco ONS 15454 DWDM Procedure Guide.

At the far-end node, determine whether an “OTUK-AIS” condition, page 2-179, is present on the
Trunk-RX. If so, the root cause to be investigated is the Trunk-Tx side on the near-end card (the one
alarmed for OTUK-BDI) because that is the section where the AIS bit is inserted.

If there is no OTUK-AIS at the far-end node, continue to investigate performances of the Trunk-Rx:
Look for other OTU-related alarms, such as the “OTUK-LOF” condition on page 2-181 or “OTUK-SD”
condition on page 2-182 at the far-end Trunk-RX. If either is present, resolve the condition using the
appropriate procedure in this chapter.

If the OTUK-BDI alarm does not clear, use an OTN test set such as the Agilent OmniBerOTN tester to
to check near-end transmitting signal quality. (For specific procedures to use the test set equipment,
consult the manufacturer.)

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.232 OTUK-IAE

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK
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The OTUK Section-Monitoring Incoming Alignment Error (IAE) alarm occurs on TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_I10E_L,
MXP_2.5G_10G, MXP_2.5G_10E, ADM-10G, and OTU2_XP cards when ITU-T G.709 encapsulation
is enabled for the cards and the trunk connection is present. This alarm is raised on the near-end node to
indicate that the far-end node it has detected errors in the received OTUK frames, but they are not bad
enough to cause an “OTUK-LOF” alarm, page 2-181.

The TAE bit in the section overhead allows the ingress point (in this case, the far-end node) to inform its
corresponding egress (near-end) point that the alignment error is detected on the incoming signal OTUK
frame alignment errors from NE. The error is an out-of-frame (OOF) alignment, in which the optical
transport unit overhead frame alignment (FAS) area is errored for more than five frames.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-IAE Alarm

Step 1

Step 2

Step 3

Step 4

At the near-end and far-end node, use site practices to clean transmitting fiber on near-end node's
reporting port and receiving fiber on correspondent far-end port. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the OTUK-IAE alarm does not clear, look for other OTU-related alarm, such as the “OTUK-LOF”
alarm, page 2-181, at the far-end node and resolve it using the appropriate procedure in this guide.

If the OTUK-IAE alarm does not clear, use an OTN test set such as the Agilent OmniBerOTN tester to
to check near-end transmitting signal quality. For specific procedures to use the test set equipment,
consult the manufacturer.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.233 OTUK-LOF

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK

The OTUK-LOF alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, MXP_2.5G_10E, GE-XP, 10GE-XP,
ADM-10G, and OTU2_XP cards when ITU-T G.709 encapsulation is enabled for the cards. The alarm
indicates that the card has lost frame delineation on the input data. Loss of frame occurs when the optical
transport unit overhead frame alignment (FAS) area is errored for more than five frames and that the error
persists more than three milliseconds.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).
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Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-LOF Alarm

Step 1

A

Verify cabling continuity to the port reporting the alarm.

Caution

Step 2

Step 3

Step 4

Step 5

Step 6

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. To
verify cable continuity, follow site practices.

At the far-end node, verify the cabling of the Trunk-TX port of the TXP or MXP connected to alarmed
card in the near-end. Clean the fibers according with site practice.(If no site practice exists, refer to the
“Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide for procedures.)

At the far-end node, verify the ITU-T G.709 encapsulation configuration of the Trunk-TX of the
TXP/MXP connected to alarmed card in the near end.

Look for other OTU-related alarms at the far-end Trunk-TX and resolve them if necessary using the
appropriate procedure in this guide.

If the OTUK-LOF alarm does not clear on the near end, use an OTN test set such as the Agilent OmniBer
OTN tester to check far-end ITU-T G.709 transmitting signal quality. (For specific procedures to use the
test set equipment, consult the manufacturer.)

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.234 OTUK-SD

Default Severity: Not Alarmed (NA) Non-Service-Affecting (NSA)
Logical Object: TRUNK

The OTUK-SD condition applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_I0E_C, TXP_MR_I10E_L, MXP_2.5G_10G, MXP_2.5G_10E, ADM-10G, and OTU2_XP
cards when ITU-T G.709 encapsulation is enabled. The condition indicates that incoming signal quality
is poor, but the incoming line BER has not passed the fail threshold. The BER value is calculated on the
Trunk-Rx port’s incoming ITU-T G.709 encapsulation frame. If FEC or E-FEC feature is enabled, the
BER is a pre-FEC measurement.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).
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For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-SD Condition

Step 1

Step 2

Step 3
Step 4

Step 5
Step 6
Step 7
Step 8
Step 9

Step 10

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

If the optical power level is good, verify that optical receive levels are within the acceptable range.

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

If the condition does not clear, verify that single-mode fiber is used.

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.
Clean the fiber connectors at both ends for a signal degrade according to site practice.
Verify that a single-mode laser is used at the far end.

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-242.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.235 OTUK-SF

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The OTUK-SF condition applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_I0E_C, TXP_MR_I10E_L, MXP_2.5G_10G, MXP_2.5G_10E, ADM-10G, and OTU2_XP
cards when ITU-T G.709 encapsulation is enabled. The condition indicates that incoming signal quality
is poor and that the BER for the incoming line has passed the fail threshold. The BER value is calculated
on the Trunk-Rx port’s incoming ITU-T G.709 encapsulation frame. If FEC or E-FEC feature is enabled,
the BER is a pre-FEC measurement.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).
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Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-SF Condition

Step 1 Complete the “Clear the OTUK-SD Condition” procedure on page 2-183.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.236 OTUK-TIM

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK

The OTUK-TIM alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, MXP_2.5G_10E, ADM-10G, and OTU2_XP
cards when ITU-T G.709 encapsulation is enabled and section trace mode is set to manual. The alarm
indicates that the expected section-monitoring trail trace identifier (TT1) string does not match the
received TTI string and raises a Trace Identifier Mismatch (TIM) alarm. The TIM alarm in turn, triggers
an “OTUK-BDI” alarm, page 2-179.

ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-TIM Condition

Step 1 Complete the “Clear the TIM Alarm” procedure on page 2-222.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.237 OUT-OF-SYNC

Default Severity: Major (MJ), Service-Affecting (SA); Not Alarmed (NA),
Non-Service-Affecting (NSA) for ISC
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Logical Objects: FC, GE, ISC, TRUNK

The Ethernet Out of Synchronization condition occurs on TXP_MR_2.5, TXPP_MR_2.5, GE-XP,
10GE-XP, and ADM-10G cards when the PPM (SFP) port is not correctly configured for the Gigabit
Ethernet payload rate.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OUT-OF-SYNC Condition

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the alarmed card to open
the card view.

Click the Provisioning > Pluggable Port Modules tabs.

Delete the provisioning for the PPM (SFP) by completing the following steps:

a. Click the PPM (SFP) in the Selected PPM area.

b. Click Delete.

Recreate the PPM (SFP):

a. In the Pluggable Port Modules area, click Create.

b. In the Create PPM dialog box, choose the PPM (SFP) number you want to create.
c. Click OK.

After the PPM (SFP) is created, provision the port’s data rate:

a. In the Pluggable Ports area, click Create.

b. In Create Port dialog box, choose ONE_GE from the Port Type drop-down list.
c. Click OK.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.238 PARAM-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS

The Plug-in Module Range Settings Mismatch condition is raised an amplifier card (OPT-BST ,
OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C), optical add-drop multiplexer (OADM) card
(AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.Xx, AD-1B-xx.X, and AD-4B-xx.x), multiplexer card (32MUX-O,
32WSS, 40WSS-C, and 40WXC), or demultiplexer cards (32DMX-0, 32DMX, 40-DMX-C, and
40DMX-CE) when the parameter range values stored on the card are different from the parameters stored
in TCC2/TCC2P card database. The condition is not user-serviceable. Log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).
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>

Warning

>

Warning

>

Warning

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM

PDI-P is a set of application-specific codes indicating a signal label mismatch failure (SLMF) in the
ONS 15454 STS path overhead. The condition indicates to downstream equipment that there is a defect
in one or more of the directly mapped payloads contained in that STS synchronous payload envelope
(SPE). For example, the mismatch could occur in the overhead to the path selector in a downstream node
configured as part of a path protection. The PDI-P codes appear in the STS Signal Label (C2 byte).

An SLMF often occurs when the payload (for example, ATM) does not match what the signal label is
reporting. The “AIS” condition, page 2-26 often accompanies a PDI-P condition. If the PDI-P is the only
condition reported with the AIS, clearing PDI-P clears the AIS. PDI-P can also occur during an upgrade,
but usually clears itself and is not a valid condition.

A PDI-P condition reported on an OC-N port supporting a G-Series card circuit could result from the
end-to-end Ethernet link integrity feature of the G-Series card. If the link integrity is the cause of the
path defect, it is typically accompanied by the TPTFAIL (G1000) or the CARLOSS (G1000) reported
against one or both Ethernet ports terminating the circuit. If this is the case, clear the TPTFAIL and
CARLOSS alarms to resolve the PDI-P condition.

A PDI-P condition reported on an OC-N port supporting an ML-Series card circuit could result from the
end-to-end Ethernet link integrity feature of the ML-Series card. If the link integrity is the cause, it is
typically accompanied by the TPTFAIL (ML100T, ML1000, MLFX) reported against one or both POS
ports terminating the circuit. If TPTFAIL is reported against one or both of the POS ports,
troubleshooting the accompanying alarm clears the PDI-P condition. Refer to the Ethernet Card
Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327 for more information about ML-Series cards.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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Clear the PDI-P Condition

Step 1

Step 2

A

Verify that all circuits terminating in the reporting card are DISCOVERED:
a. Click the Circuits tab.
b. Verify that the Status column lists the circuit as active.

c. If the Status column lists the circuit as PARTIAL, wait 10 minutes for the ONS 15454 to initialize
fully. If the PARTIAL status does not change after full initialization, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447).

After determining that the circuit is DISCOVERED, ensure that the signal source to the card reporting
the alarm is working.

Caution

Step 3

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

If traffic is affected, complete the “Delete a Circuit” procedure on page 2-245.

Caution

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Deleting a circuit can affect existing traffic.

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.

If circuit deletion and re-creation does not clear the condition, verify that there is no problem stemming
from the far-end OC-N card providing STS payload to the reporting card.

If the condition does not clear, confirm the cross-connect between the OC-N card and the reporting card.

If the condition does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

If the condition does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for
the optical/electrical cards.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.240 PEER-NORESPONSE

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: EQPT

The switch agent raises a Peer Card Not Responding alarm if either traffic card in a protection group
does not receive a response to the peer status request message. PEER-NORESPONSE is a software
failure and occurs at the task level, as opposed to a communication failure, which is a hardware failure
between peer cards.
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Clear the PEER-NORESPONSE Alarm

Step 1
Step 2

Step 3

25241 PMI

Note

Complete the “Reset a Card in CTC” procedure on page 2-241 for the reporting card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical objects: OCH, OMS, OTS

The Payload Missing Indication (PMI) condition is part of MSTP network-level alarm correlation. It is
raised at the far end when OTS or OMS optical payload is missing due to an LOS, LOS-P, or
OPWR-LFAIL alarm root cause. A single PMI condition is sent when every channel on the aggregated
port is lost--that is, when there are no pass-through channels or active added channels in service.

An LOS, LOS-P, or OPWR-LFAIL alarm on an MSTP circuit causes multiple alarms for each channel.
R7.0 correlation simplifies troubleshooting by reporting a single alarm for multiple alarms having one
root cause, then demoting the root alarms so that they are only visible in the Conditions window (with
Not Reported [NR] severity.)

PMI clears when the optical channel is working on the aggregated or single-channel optical port.

Network-level alarm correlation is only supported for MSTP communication alarms. It is not supported
for equipment alarms.

Clear the PMI Condition

Step 1

Step 2

Clear the root-cause service-affecting alarm by using one of the following procedures, as appropriate:
e “Clear the LOS (OTS) Alarm” procedure on page 2-136
e “Clear the LOS (TRUNK) Alarm” procedure on page 2-137
e “Clear the LOS-P (OCH) Alarm” procedure on page 2-142
e “Clear the LOS-P (AOTS, OMS, OTS) Alarm” procedure on page 2-140
e “Clear the LOS-P (TRUNK) Alarm” procedure on page 2-146
e “Clear the OPWR-LFAIL Alarm” procedure on page 2-178

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.242 PORT-FAIL

Note

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OCH

The APC Port Failure alarm occurs when amplifier margins and VOA are saturated for a port, so APC
cannot apply any control. For example, it is raised if APC attempts to set an OPT-BST or OPT-AMP-x-C
port’s gain higher than 20 dBm (the maximum setpoint) or its attenuation on Express VOA lower than
0 dBm (the minimum setpoint).

For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual.

Clear the PORT-FAIL Alarm

Step 1

Step 2

Step 3

A

Warning

Step 4

If a maintenance operation such as fiber repair, adding a card, or replacing a card has just been performed
on the optical network (whether at the node raising the PORT-FAIL alarm or at any other node),
determine whether this operation has added extra loss. This can happen if the repair is imperfect or if a
patchcord is dirty. To test for signal loss, refer to procedures in the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

If there is loss added and fiber has been repaired or removed, first try cleaning the fiber by completing
the procedures in the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm does not clear and fiber has been repaired, perform the repair again with new fiber if
necessary. For fibering procedures, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454
DWDM Procedure Guide. If the alarm does not clear, go to Step 4.

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

a~

Note  Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

If a maintenance operation has not been recently executed on the network, the alarm indicates that the
network has consumed all of its allocated aging margins. In this case, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447)
in order to report a Service-Affecting (SA) problem.

2.5.243 PROTNA

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
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The Protection Unit Not Available alarm is caused by an OOS (or Locked) protection card when a
TCC2/TCC2P card or cross-connect card that has been provisioned as part of a protection group is not
available. The alarm clears if the device or facility is brought back in service.

Clear the PROTNA Alarm

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

If the PROTNA alarm occurs and does not clear, and if it is raised against a controller card, ensure that
there is a redundant TCC2/TCC2P card installed and provisioned in the chassis.

If the alarm is raised against a line card, verify that the ports have been taken out of service (OOS,MT
or Locked,maintenance):

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b. Click the Provisioning tab.

¢. Click the administrative state of any in-service (IS or Unlocked) ports.

d. Choose OOS,MT (or Locked,maintenance) to take the ports out of service.
Complete the “Reset a Card in CTC” procedure on page 2-241 for the reporting card.

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-243 for the reporting card.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.244 PROV-MISMATCH

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: PPM

The Provisioning Mismatch for a PPM alarm is raised against a PPM connector on MXP_2.5G_10E,
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10G, MXP_MR_2.5G, MXPP_MR_2.5G,
TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXPP_MR_2.5G, GE_XP,
10GE_XP, ADM-10G, and OTU2_XP under one of the following circumstances:

e The physical PPM’s range or wavelength does not match the provisioned value. PPMs have static
wavelength values which must match the wavelengths provisioned for the card in the case of
non-DWDM PPMs.

e The PPM’s reach (loss) value does not meet the reach value needed for the card.
e The reach of the inserted PPM does not match the physical PPM.
This alarm is raised on GE_XP and 10GE_XP cards, if the following settings are configured:
e Double Add and Translate Add selective modes
e CVLAN Ingress CoS
e MAC address learning on SVLAN
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Until this alarm is cleared, provisioning on the GE_XP and 10GE_XP cards is not possible.

Clear the PROV-MISMATCH Alarm

To clear the alarm when the physical PPM’s range or wavelength does not match the provisioned value,
perform the following steps:

Step 1 Determine what the PPM wavelength range should be by viewing the frequency provisioned for the card:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. Click the Maintenance > Info tabs.
¢. Record the value shown in the Value column.
Step2 Remove the incorrect PPM connector:
a. Unplug the PPM connector and fiber from the reporting card.
b. If the PPM connector has a latch securing the fiber cable, pull the latch upward to release the cable.
c. Pull the fiber cable straight out of the connector.
Step3  Replace the unit with the correct PPM connector:

a. Plug the fiber into a Cisco-supported PPM connector. For more information about supported PPMs,
refer to the “Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference
Manual.

b. If the new PPM connector has a latch, close the latch over the cable to secure it.

c. Plug the cabled PPM connector into the card port until it clicks.

To clear the alarm when the PPM’s reach (loss) value does not meet the reach value needed for the card,
perform the following steps:

Step1  Determine what the reach distance of the PPM should be by viewing the reach value provisioned for the
card:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b. Click the Provisioning > Line tabs.

Note In GE_XP cards, click Provisioning > Ether Ports tabs.

c¢. Record the value shown in the Reach column.

Step2  Check the reach value of the PPM:
a. In the node view (single-shelf mode), click the Inventory tab.
b. Check the reach distance in the Product ID column.

Step3  If there is a mismatch in the values recorded in steplc and step2b, change the PPM to match the
provisioned value or reprovision the card.
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Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

To clear the alarm on GE_XP or 10GE_XP cards with Double Add and Translate Add selective modes,
CVLAN Ingress CoS, or MAC address learning on SVLAN configuration, perform the following steps:

Step 1 Remove Double Add and Translate Add selective modes, CVLAN Ingress CoS, or MAC address
learning on SVLAN configuration.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.245 PTIM

Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: TRUNK, EQPT

The Payload Type Identifier Mismatch alarm occurs when there is a mismatch between the way the
ITU-T G.709 encapsulation option is configured on MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXPP_MR_2.5G, ADM-10G, or OTU2_XP card
at each end of the optical span.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the PTIM Alarm

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the alarmed
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, or TXPP_MR_2.5G, ADM-10G, or OTU2_XP card to open the card view.

Step2  Click the Provisioning > OTN > OTN Lines tabs.
Step3  Ensure that the G.709 OTN check box is checked. If not, check it and click Apply.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.246 PWR-FAIL-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
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The Equipment Power Failure at Connector A alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
TCC2/TCC2P, or 1/O cards.

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-A Alarm

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6
Step 7

If a single card has reported the alarm, take the following actions depending on the reporting card:

e Ifthe reporting card is an active traffic line portin a 1+1 protection group or part of a path protection
configuration, ensure that an APS traffic switch has occurred to move traffic to the protect port.

~

Note Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To
avoid this, perform an external switch if a switch has not already occurred. See the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-237 for
commonly used traffic-switching procedures.

e If the alarm is reported against a TCC2/TCC2P card, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-241.

e If the alarm is reported against an OC-N/STM-N card, complete the “Reset a Card in CTC”
procedure on page 2-241.

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-243.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
reporting card.

If the single card replacement does not clear the alarm, or if multiple cards report the alarm, verify the
office power. Refer to the “Install the Shelf and Common Control Cards” chapter in the

Cisco ONS 15454 DWDM Procedure Guide for procedures. See the “1.10 Power Supply Problems”
section on page 1-59 as necessary.

If the alarm does not clear, reseat the power cable connection to the connector.
If the alarm does not clear, physically replace the power cable connection to the connector.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.247 PWR-FAIL-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

| 78-18378-02
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The Equipment Power Failure at Connector B alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
TCC2/TCC2P, or 1/O cards.

>

Warning  The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-B Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-193.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.248 PWR-FAIL-RET-A

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Equipment Power Failure at Connector A alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA) or
TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-193.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.249 PWR-FAIL-RET-B

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Equipment Power Failure at Connector B alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA) or
TCC2/TCC2P.
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Clear the PWR-FAIL-RET-A Alarm

Step 1 Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-193.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.250 PWR-PROT-ON

Default Severity: Major (MJ), Service-Affecting (SA)
SONET Logical Objects: OTS

The Raman Power Protection On alarm occurs only on the OPT-RAMP-C card when the Raman
amplifier is used on fiber span that is too short for Raman power.

Clear the PWR-PROT-ON Alarm

Step1  To clear the alarm, check if the Raman amplifier is connected to the wrong span. If it is, check patch
cords setup and fix it.

Step2  Alternatively, review the network configuration to see Raman amplifier has been wrongly used. If is,
remove it.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.251 RFI

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Remote Failure Indication condition is raised against an MXP_2.5G_10G, TXP_MR_10G,
TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXPP_MR_2.5G, or ADM-10G
card when the card has the “AIS” condition, page 2-26. The MXP or TXP cards only raise AIS (or remote
failure indication [RFI]) when they are in line or section termination mode, that is, when the MXP or
TXP cards in line termination mode or section termination mode have improperly terminated overhead
bytes.

m For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.
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Clear the RFI Condition

Step1  Complete the “Delete a Circuit” procedure on page 2-245 and then recreate the circuit.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.252 RFI-L

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK

A RFI Line condition occurs when the ONS 15454 detects an RFI in OC-N card SONET overhead
because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-L condition
in the reporting node. RFI-L indicates that the condition is occurring at the line level.

Clear the RFI-L Condition

Step1  Log into the node at the far-end node of the reporting ONS 15454.
Step2  Identify and clear any alarms, particularly the LOS (OCN) alarm.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.253 RFI-P

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM

The RFI Path condition occurs when the ONS 15454 detects an RFI in the an STS-1 signal SONET
overhead because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-P
condition in the reporting node. RFI-P occurs in the terminating node in that path segment.

Clear the RFI-P Condition

Step1  Verify that the ports are enabled and in service (IS-NR or Unlocked,enabled) on the reporting
ONS 15454:

a. Confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b. To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c. Click the Provisioning > Line tabs.

d. Verify that the Admin State column lists the port as IS or Unlocked.
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e. If the Admin State column lists the port as OOS,MT or Locked,maintenance or Locked,disabled,
click the column and choose IS or Unlocked. Click Apply.

~

Note If ports managed into IS or Unlocked admin state are not receiving signals, the LOS alarm
is either raised or remains, and the port service state transitions to OOS-AU,FLT.

To find the path and node failure, verify the integrity of the SONET STS circuit path at each of the
intermediate SONET nodes.

Clear alarms in the node with the failure, especially the “UNEQ-P” alarm on page 2-226.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OTS

The Raman Laser Shutdown (RLS) condition is raised during the Raman link turn-up phase on
RAMAN-TX port of the OPT-RAMP-C card when excessive back reflection is detected. When the RLS
alarm is raised, the Raman pump laser inside the card is shut down automatically and the optical link
turn-up procedure is terminated. The RLS condition must be cleared before proceeding with further
provisioning.

Clear the RLS Condition

Step1  Disconnect the LINE-RX port cable.

Step2  Clean the optical connectors. To do this, refer to the "Install Hardware" chapter in the Cisco ONS 15454
Procedure Guide.

Step3  Reconnect the LINE-RX port cable. Wait five minutes for the Raman link restart procedure to be
completed on OPT-RAMP-C card.

Step4  If the RLS condition does not clear, replace the optical cable connected to the LINE-TX port. Repeat
Step 3.

Step5  If the RLS condition persists, call the Cisco TAC (1 800 553-2447) to open a Return Material

Authorization (RMA) case.

2.5.255 ROUTE-OVERFLOW

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: NE regardless of MSTP or MSPP

The ROUTE-OVERFLOW indicates the condition when the OSPF routing table exceeds 700 routes. The
symptoms for this condition are loss of visibility to a node or network, inability to access a node using
CTC, CTM, Telnet, Ping, and so on.

| 78-18378-02
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Clear the ROUTE-OVERFLOW Condition

Step 1

Reconfigure the OSPF network to less than 700 routes.

2.5.256 RS-EOC

>

Warning

Note

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SONET Data Communications Channel (DCC) Termination Failure alarm occurs when the
ONS 15454 loses its data communications channel. Although this alarm is primarily SONET, it can
apply to DWDM. For example, the OSCM card can raise this alarm on its STM-1 section overhead.

The RS-DCC consists of three bytes, D1 through D3, in the SONET overhead. The bytes convey
information about operation, administration, maintenance, and provisioning (OAM&P). The ONS 15454
uses the DCC on the SONET section overhead to communicate network management information.

Class 1 laser product. Statement 1008

Class 1M laser radiation when open. Do not view directly with optical instruments. Statement 1053

On the 0C192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is
off when the safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

If a circuit shows an incomplete state when this alarm is raised, the logical circuit is in place. The circuit
is able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.
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Clear the RS-EOC Alarm

Step 1

A

If the alarm does not clear on the reporting node, verify the physical connections between the cards and
that the fiber-optic cables are configured to carry RS-DCC traffic. If they are not, correct them. For more
information about OC-N fiber connections and terminations, refer to the “Install Cards and Fiber-Optic
Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Caution

Step 2

Step 3
Step 4

Step 5

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located lower-right edge of the shelf assembly.

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the
fiber span have unlocked ports. Verify that the ACT/SBY LED on each card is green.

When the LEDs on the cards are correctly illuminated, complete the “Verify or Create Node RS-DCC
Terminations” procedure on page 2-246 to verify that the DCC is provisioned for the ports at both ends
of the fiber span.

Repeat Step 2 at the adjacent nodes.

If DCC is provisioned for the ends of the span, verify that the port is active and in service by completing
the following steps:

a. Confirm that the card shows a green LED in CTC or on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.
b. To determine whether the port is in service, double-click the card in CTC to display the card view.

¢. Foran OC-N card, click the Provisioning > Line tabs. For the OSCM card, click the Provisioning >
STM-1 Line tabs.

d. Verify that the Admin State column lists the port as IS or Unlocked.

e. If the Admin State column lists the port as OOS,MT or Locked,maintenance or Locked,disabled,
click the column and click IS or Unlocked from the drop-down list. Click Apply.

~

Note If a port in the unlocked admin state does not receive a signal, the LOS alarm is raised and
the port service state transitions to Locked-disabled, automaticInService & failed.

For all nodes, if the card is in service, use an optical test set to determine whether signal failures are
present on fiber terminations. For specific procedures to use the test set equipment, consult the
manufacturer.

Caution

Step 6

Step 7

Using an optical test set disrupts service on an OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-237 for commonly used switching procedures.

If no signal failures exist on terminations, measure power levels to verify that the budget loss is within
the parameters of the receiver.

If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly
terminated. For more information refer to “Install Cards and Fiber-Optic Cables” chapter in the
Cisco ONS 15454 Procedure Guide.
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Step 8

Step 9

Step 10

Step 11
Step 12

If fiber connectors are properly fastened and terminated, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-241.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Resetting the active TCC2/TCC2P card switches control to the standby TCC2/TCC2P card. If the alarm
clears when the ONS 15454 node switches to the standby TCC2/TCC2P card, the user can assume that
the previously active card is the cause of the alarm.

If the TCC2/TCC2P card reset does not clear the alarm, delete the problematic RS-DCC termination by
completing the following steps:

a. From card view, click View > Go to Previous View if you have not already done so.
b. Click the Provisioning > Comm Channels > RS-DCC tabs.

c. Highlight the problematic DCC termination.

d. Click Delete.

e. Click Yes in the Confirmation Dialog box.

Recreate the RS-DCC termination. Refer to the “Turn Up Network™ chapter in the Cisco ONS 15454
Procedure Guide for procedures.

Verify that both ends of the DCC have been recreated at the optical ports.

If the alarm has not cleared, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country. If the Technical Support
technician tells you to reseat the card, complete the “Remove and Reinsert (Reseat) Any Card” procedure
on page 2-243. If the Technical Support technician tells you to remove the card and reinstall a new one,
follow the “Physically Replace a Card” procedure on page 2-244.

2.5.257 RS-TIM

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STMN

The Regenerator Section TIM alarm occurs when the expected JO path trace string does not match the
received string.

If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed or
someone entered a new incorrect value into the Current Transmit String field. Follow the procedure
below to clear either instance.

Clear the RS-TIM Alarm

Step 1
Step 2

Complete the “Clear the TIM Alarm” procedure on page 2-222 for the JO byte.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.
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2.5.258 SD (TRUNK)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

A Signal Degrade (SD) condition on the trunk occurs when the quality of an optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, GE-XP, 10GE-XP, and ADM-10G card has BER on the incoming
optical line that passes the signal degrade threshold. The alarm applies to the card ports and the trunk
carrying optical or electrical signals to the card.

Signal degrade is defined by Telcordia as a soft failure condition. SD and SF both monitor the incoming
BER and are similar, but SD is triggered at a lower BER than SF. The BER threshold on the ONS system
is user-provisionable and has a range for SD from 1E-9 dBm to 1E-5 dBm.

For more information about MXP and TXP cards and their thresholds, refer to the “Card Reference”
chapter and the “Hardware Specifications” appendix respectively in the Cisco ONS 15454 DWDM
Reference Manual.

Clear the SD (TRUNK) Condition

25259 SD-L

Step 1

Step 2

Step 3
Step 4

Step 5
Step 6
Step 7
Step 8
Step 9

Step 10

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

If the optical power level is good, verify that optical receive levels are within the acceptable range.

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

If the condition does not clear, verify that single-mode fiber is used.

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.
Clean the fiber connectors at both ends for a signal degrade according to site practice.
Verify that a single-mode laser is used at the far end.

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-242.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Note

Logical Object: STMN

An SD Line condition is similar to the “SD (TRUNK)” condition, page 2-201. It applies to the line level
of the SONET signal and travels on the B2 byte of the SONET overhead.

An SD-L on an Ethernet or OC-N card does not cause a protection switch. If the alarm is reported on a
card that has also undergone a protection switch, the SD BER count continues to accumulate. The
condition is superseded by higher-priority alarms such as the LOF and LOS alarms.

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the SD-L Condition

Step 1
Step 2

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.260 SD-L (TRUNK)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

A Signal Degrade (SD) condition on the trunk occurs when the quality of an optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_I10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, GE-XP, 10GE-XP, and ADM-10G card has bit error rate (BER) on
the incoming optical line that passes the signal degrade threshold. The alarm applies to the card ports
and the trunk carrying optical or electrical signals to the card.

Clear the SD-L (TRUNK) Condition

Step 1
Step 2

2.5.261 SD-P

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM

An SD Path condition is similar to the “SD (TRUNK)” condition, page 2-201, but it applies to the path
(STS) layer of the SONET overhead. A path or STS-level SD alarm travels on the B3 byte of the SONET
overhead.

For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD
from 1E-9 dBm to 1E-5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not
user-provisionable and the error rate is hard-coded to 1E-6 dBm.
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On path protection configurations, an SD-P condition causes a switch from the working card to the
protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-P condition does
not cause switching.

The BER increase that causes the condition is sometimes caused by a physical fiber problem such as a
poor fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The SD clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the SD-P Condition

Step 1

Step 2

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.262 SDBER-EXCEED-HO

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCTRM-HP

The Signal Degrade Threshold Exceeded for High Order condition indicates that the signal degrade BER
threshold has been exceeded for a high-order (VC-4) path on optical (traffic) cards.
SDBER-EXCEED-HO occurs when the signal BER falls within the degrade threshold (typically

1E-7 dBm) set on the node.

Class 1 laser product. Statement 1008

Class 1M laser radiation when open. Do not view directly with optical instruments. Statement 1053

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Clear the SDBER-EXCEED-HO Condition

Step 1

Step 2

Step 3

Determine the BER threshold. Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G
Card Loopback Circuit” procedure on page 2-245.

If adjustment is acceptable in site practices, adjust the threshold.

Using an optical test set, measure the input power level of the line and ensure that the level is within the
guidelines. For specific procedures to use the test set equipment, consult the manufacturer.

Verify the input fiber cable connections to the reporting card.
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Step 4

Clean the input fiber cable ends according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country. If the condition applies to VCMON-HP, it is
Service-Affecting (SA).

2.5.263 SF (TRUNK)

>

Warning

>

Warning

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

A Signal Fail (SF) condition for the trunk occurs when the quality of an optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_I10E, TXP_MR_10E_C,
TXP_MR_I10E_L, TXPP_MR_2.5G, GE-XP, 10GE-XP, or ADM-10G card has BER on the incoming
optical line that passes the signal fail threshold. The alarm applies to the card ports and the trunk carrying
optical or electrical signals to the card.

Signal fail is defined by Telcordia as a hard failure condition. SF monitors the incoming BER and is
triggered when the BER surpasses the default range.

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about MXP and TXP cards and their thresholds, refer to the “Card Reference”
chapter and the “Hardware Specifications” appendix respectively in the Cisco ONS 15454 DWDM
Reference Manual.

Clear the SF (TRUNK) Condition

Step 1

A

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

An SF Line condition is similar to the “SD (TRUNK)” condition, page 2-201, but it applies to the line
layer B2 overhead byte of the SONET signal. It can trigger a protection switch.

The SF-L condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

The condition is superseded by higher-priority alarms such as the LOF and LOS alarms.

Clear the SF-L Condition

Step 1
Step 2

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.265 SF-L (TRUNK)

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

A Signal Fail (SF) condition is raised on the trunk when the quality of an incoming optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_I10E_L, TXPP_MR_2.5G, or ADM-10G card has high BER due to bent or degraded fiber
connected to the trunk, on the incoming optical line that passes the signal fail threshold. The alarm
applies to the card ports and the trunk carrying optical or electrical signals to the card.

The SF-L condition monitors the incoming BER and is triggered when the BER surpasses the default
range.

Clear the SF-L (TRUNK) Condition

Step1  Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-201.
Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.

Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. For
detailed instructions on how to wear the ESD wristband, refer to the Cisco ONS Electrostatic Discharge
and Grounding Guide.
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Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.266 SF-P

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM

An SF Path condition is similar to the “SF (TRUNK)” condition, page 2-204, but it applies to the path
(STS) layer B3 byte of the SONET overhead. It can trigger a protection switch.

The SF-P condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

Clear the SF-P Condition

Step 1 Complete the “Clear the SF (TRUNK) Condition” procedure on page 2-204.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.267 SFTWDOWN

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
A Software Download in Progress alarm occurs when the TCC2/TCC2P card is downloading or

transferring software.

If the active and standby TCC2/TCC2P cards have the same versions of software, it takes approximately
three minutes for software to be updated on a standby TCC2/TCC2P card.

If the active and standby TCC2/TCC2P cards have different software versions, the transfer can take up
to 30 minutes. Software transfers occur when different software versions exist on the two cards. After
the transfer completes, the active TCC2/TCC2P card reboots and goes into standby mode after
approximately three minutes.

No action is necessary. Wait for the transfer or the software download to complete. If the alarm does not
clear, log into the Technical Support Website at http://www.cisco.com/techsupport for more information
or call Cisco TAC (1-800-553-2447).

~

Note SFTWDOWN is an informational alarm.

2.5.268 SHELF-COMM-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: SHELF
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The Shelf Communication Failure alarm applies to optical equipment when an NC shelf is unable to
communicate with an SS shelf. Typically this occurs when there is a fiber disconnection. But the alarm
can also occur if an SS shelf is resetting.

Clear the SHELF-COMM-FAIL Alarm

Step1  Determine whether an SS shelf controller is being reset. If it is being reset, you must wait for the shelf
to reset for this alarm to clear.

Step2  If the alarm does not clear or if no shelf is being reset, check the cabling between the TCC2/TCC2P and
the MS-ISC card. Correct it if necessary.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.269 SH-IL-VAR-DEG-HIGH

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS

The Switch Insertion Loss Variation Degrade High alarm occurs as the OSC-CSM card optical switch
ages and slowly increases its insertion loss. This alarm indicates that the insertion loss has crossed the
high degrade threshold. The card must eventually be replaced.

Note For more information about insertion loss, refer to the APC section of the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual.

Clear the SH-IL-VAR-DEG-HIGH Alarm

Step 1 For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-244 as appropriate.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25270 SH-IL-VAR-DEG-LOW

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS

The Switch Insertion Loss Variation Degrade Low alarm occurs as the OSC-CSM card optical switch
ages and slowly decreases its insertion loss. This alarm indicates that the insertion loss has crossed the
low degrade threshold. The card must eventually be replaced.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
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~
Note For more information about insertion loss, refer to the APC section in the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual.

Clear the SH-IL-VAR-DEG-LOW Alarm

Step 1 For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-244 as appropriate.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.271 SHUTTER-OPEN

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OTS

The SHUTTER-OPEN condition occurs if an OSC-CSM card laser shutter remains open after the “LOS
(OTS)” alarm on page 2-136 is detected. A laser shutter remains open if an optical safety issue is present
and closes when the OSC-CSM card LINE-RX port receives OSC power for three consecutive seconds.

Clear the SHUTTER-OPEN Condition

Step 1 Complete the “Clear the LOS (OTS) Alarm” procedure on page 2-136.

Step 2 If the SHUTTER-OPEN condition still does not clear, it indicates that the unit shutter is not working
properly. Complete the “Physically Replace a Card” procedure on page 2-244.

Step3  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.272 SIGLOSS

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Objects: FC, GE, ISC, TRUNK

The Signal Loss on Data Interface alarm is raised on XP and MXP cards FC and ISC client data ports
when there is a loss of signal. (Loss of Gigabit Ethernet client signal results in a CARLOSS [GE], not
SIGLOSS.) SIGLOSS can also be raised on the XP and MXP trunk port.

The Signal Loss on Data Interface alarm is raised on OTU2_XP card 10GE and 10G FC client data ports
when there is a loss of signal.

If the SYNCLOSS alarm was previously raised on the port, the SIGLOSS alarm will demote it.
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Clear the SIGLOSS Alarm
Step1  Ensure that the port connection at the near end of the SONET or SDH (ETSI) link is operational.
Step2  Verify fiber continuity to the port. To verify fiber continuity, follow site practices.
Step3  Check the physical port LED on the card. The port LED looks clear (that is, not lit green) if the link is
not connected.
Step4  If the alarm does not clear, log onto http://www.cisco.com/techsupport for more information or call

Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

25.273 SNTP-HOST

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: NE

The Simple Network Timing Protocol (SNTP) Host Failure alarm indicates that an ONS system serving
as an IP proxy for the other ONS system nodes in the ring is not forwarding SNTP information to the
other nodes in the network. The forwarding failure can result from two causes: either the IP network
attached to the ONS system proxy node is experiencing problems, or the ONS system proxy node itself
is not functioning properly.

Clear the SNTP-HOST Alarm

Step 1

Step 2

Step 3

Step 4

Step 5

Ping the SNTP host from a workstation in the same subnet to ensure that communication is possible
within the subnet by completing the “1.6.8 Verify PC Connection to the ONS 15454 (ping)” procedure
on page 1-42.

If the ping fails, contact the network administrator who manages the IP network that supplies the SNTP
information to the proxy and determine whether the network is experiencing problems, which could
affect the SNTP server/router connecting to the proxy ONS system.

If no network problems exist, ensure that the ONS system proxy is provisioned correctly:

a. In node view (single-shelf mode) or shelf view (multishelf mode), for the ONS system serving as the
proxy, click the Provisioning > General > General tabs.

b. Ensure that the Use NTP/SNTP Server check box is checked.
c. If the Use NTP/SNTP Server check box is not checked, click it.
d. Ensure that the Use NTP/SNTP Server field contains a valid IP address for the server.

If proxy is correctly provisioned, refer to the “Timing” chapter in the Cisco ONS 15454 Reference
Manual for more information on SNTP Host.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.274 SPANLEN-OUT-OF-RANGE

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS

The SPANLEN-OUT-OF-RANGE alarm is raised when span loss measured by CTC is higher than the
maximum expected span loss (or lower than the minimum expected span loss).

The TCC2/TCC2P automatically measures span loss every hour, or it calculates it when you perform the
“Calculate Span Loss” operation. (For procedures to perform this operation, refer to the “Manage the
Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.)

To create its span calculation, CTC compares far-end POSC power with the near-end OSC power to
create the span length measurement. The loss is recalculated in each MSTP node, since the OSC channel
is regenerated in each MSTP node.

Clear the SPANLEN-OUT-OF-RANGE Alarm

Step 1 Determine the maximum and minimum expected span loss values provided by Cisco TransportPlanner
and confirm that they are correctly entered in CTC.

Step2  Determine whether the measured span length falls between these two values.

~

Note  Cisco TransportPlanner determines the span length range according to span length and allocated
margins. If this value is set to zero in CTC, the SPANLEN-OUT-OF-RANGE alarm is never
raised.

Step3  If the value falls outside this range, check the following factors in the fibering:
e C(learance
e Integrity
e Connection

Step4  Determine whether any site variations are present which conflict with the Cisco TransportPlanner design
and correct them.

Step5  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.275 SPAN-NOT-MEASURED

SPAN-NOT-MEASURED is a transient condition. For more information about it, refer to Chapter 3,
“Transient Conditions.”

25.276 SQUELCHED

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, TRUNK
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The Client Signal Squelched condition is raised by a TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G_10E,
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_MR_2.5G, MXPP_MR_2.5G, GE-XP, 10GE-XP,
ADM-10G, and OTU2_XP card.

The condition can be raised in the following situations:

e An MXP or TXP client facility detects that an upstream receive facility has experienced a loss of
signal (such as an Ethernet CARLOSS, DWDM SIGLOSS, or optical LOS). In response, the
facility’s transmit is turned off (SQUELCHED). The upstream receive facilities are the trunk receive
on the same card as the client, as well as the client receive on the card at the other end of the trunk
span.

e The client will squelch if the upstream trunk receive (on the same card) experiences a SIGLOSS,
Ethernet CARLOSS, LOS, or LOS (TRUNK) alarm. In some transparent modes, the client is
squelched if the trunk detects an AIS condition or a TIM alarm.

¢ The client will squelch if the upstream client receive (on the card at the other end of the DWDM
span) experiences CARLOSS, SIGLOSS, or LOS.

In an example situation, an upstream MXP_2.5G_10G client port receive experiences a “loss of light,”
and this port raises CARLOSS, SIGLOSS, or LOS (determined by the payload type) locally.

The local client raises SQUELCHED if it also raises one of the following alarms for the client, all of
which are signalled by the upstream node:

e 2.5.212 ODUK-1-AIS-PM, page 2-167
e 2.5.213 ODUK-2-AIS-PM, page 2-168
e 2.5.214 ODUK-3-AIS-PM, page 2-168
e 2.5.215 ODUK-4-AIS-PM, page 2-169

On the MXP_MR_10G, the local client raises a SQUELCHED condition if the upstream client detects
one of the following alarms. Note that no corresponding local alarm is raised to indicate which of these
conditions is present upstream.

e LOS for the clients including the “LOS (2R)” alarm on page 2-133, the “LOS (ESCON)” alarm on
page 2-134, and the “LOS (ISC)” alarm on page 2-136

e CARLOSS for the clients including the “CARLOSS (FC)” alarm on page 2-53, the “CARLOSS
(GE)” alarm on page 2-53, and the “CARLOSS (ISC)” alarm on page 2-54

The local client raises a SQUELCHED condition if the local trunk raises one of the following alarms:
e 2.5.233 OTUK-LOF, page 2-181
e 25.230 OTUK-AIS, page 2-179
e 25.167 LOS (TRUNK), page 2-137
e 2.5.236 OTUK-TIM, page 2-184 (squelching enabled)
e 2.5.216 ODUK-AIS-PM, page 2-169
e 2.5.218 ODUK-LCK-PM, page 2-170
e 2.5.222 ODUK-TIM-PM, page 2-173 (squelching enabled)
e 2.5.302 TIM, page 2-222 (for the OCN/STMN, squelching enabled)

¢ LOF (OCN/STMN) alarm in the “Alarm Troubleshooting” chapter of the Cisco ONS 15454
Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide

e LOS (OCN/STMN) alarm the “Alarm Troubleshooting” chapter of the Cisco ONS 15454
Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide
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e 2.5.48 CARLOSS (TRUNK), page 2-55
e 2.5.323 WVL-MISMATCH, page 2-233 (client or trunk)

When troubleshooting the SQUELCHED condition locally, look for failures progressing upstream in the
following order. (If you are troubleshooting this alarm remotely, reverse the order of progress.)

e Local client alarms, as previously listed
e Local trunk alarms, as previously listed

e Remote (upstream) client receive alarms, as previously listed

~

Note If you see a SQUELCHED condition on the trunk, this can only be caused by a transponder (TXP) card.

Clear the SQUELCHED Condition

Step 1 If the object is reported against any object besides ESCON, determine whether the remote node and local
node reports and LOF or the LOS alarm (for the client trunk, as listed here). If it does, turn to the relevant
section in this chapter and complete the troubleshooting procedure.

Step2  If no LOF or LOS is reported, determine whether any other listed remote node or local node conditions
as listed here have occurred. If so, turn to the relevant section of this chapter and complete the
troubleshooting procedure.

Step3  If none of these alarms is reported, determine whether the local port reporting the SQUELCHED
condition is in loopback. (You will see LPBKFACILITY OR LPBKTERMINAL in the condition window
for this port.) If it is in loopback, complete the following steps:

a. Innode view (single-shelf mode) or shelf view (multishelf mode), double-click the client card to open
the card view.

b. Click the Maintenance > Loopback > Port tabs.

c. If the port Admin State column says OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the cell to highlight it and choose IS , or Unlocked, from the drop-down list.
Changing the state to IS (or Unlocked) also clears any loopback provisioned on the port.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.277 SSM-DUS

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Synchronization Status (SSM) Message Quality Changed to Do Not Use (DUS) condition occurs on
ADM-10G and MXP trunk ports when the synchronization status message (SSM) quality level degrades
to DUS or is manually changed to DUS.

The signal is often manually changed to DUS to prevent timing loops from occurring. Sending a DUS
prevents the timing from being reused in a loop. The DUS signal can also be sent for line maintenance
testing.
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~

Note  SSM-DUS is an informational condition and does not require troubleshooting.

2.5.278 SSM-FAIL

Single Failure Default Se verity: Minor (MN), Non-Service-Affecting (NSA); Double Failure
Default Severity: Major (MJ), Service-Affecting (SA)

Logical Object: TRUNK

The SSM Failed alarm occurs on ADM-10G and MXP trunk ports when the synchronization status
messaging received by the system fails. The problem is external to the ONS system. This alarm indicates
that although the ONS system is set up to receive SSM, the timing source is not delivering valid SSM
messages.

Clear the SSM-FAIL Alarm

Step 1 Verify that SSM is enabled on the external timing source.

Step2  Iftimingis enabled, use an optical test set to determine that the external timing source is delivering SSM.
For specific procedures to use the test set equipment, consult the manufacturer.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25279 SSM-LNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Local Node Clock (LNC) Traceable condition occurs on ADM-10G and MXP trunk ports when
the SSM (S1) byte of the SONET overhead multiplexing section has been changed to signify that the line
or BITS timing source is the LNC.

~

Note  SSM-LNC is an informational condition and does not require troubleshooting.

2.5.280 SSM-OFF

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Off condition applies to references used for timing related to the ADM-10G and MXP trunk
ports. It occurs when the SSM for the reference has been turned off. The node is set up to receive SSM,
but the timing source is not delivering SSM messages.
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Clear the SSM-OFF Condition

Step 1
Step 2

Complete the “Clear the SSM-FAIL Alarm” procedure on page 2-213.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.281 SSM-PRC

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Primary Reference Clock (PRC) Traceable condition occurs when the SONET transmission
level for ADM-10G and MXP trunk ports is PRC.

SSM-PRC is an informational condition and does not require troubleshooting.

2.5.282 SSM-PRS

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Primary Reference Source (PRS) Traceable condition occurs when the SSM transmission level
for ADM-10G and MXP trunk ports is Stratum 1 Traceable.

SSM-PRS is an informational condition and does not require troubleshooting.

2.5.283 SSM-RES

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Reserved (RES) For Network Synchronization Use condition occurs when the synchronization
message quality level for ADM-10G and MXP trunk ports is RES.

SSM-RES is an informational condition and does not require troubleshooting.

2.5.284 SSM-SMC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
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The SSM SONET Minimum Clock (SMC) Traceable condition occurs when the synchronization
message quality level for ADM-10G and MXP trunk ports is SMC. The login node does not use the clock
because the node cannot use any reference beneath its internal level, which is ST3.

S

Note  SSM-SMC is an informational condition and does not require troubleshooting.

2.5.285 SSM-ST2

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Stratum 2 (ST2) Traceable condition occurs when the synchronization message quality level
for ADM-10G and MXP trunk ports is ST2.

~

Note  SSM-ST?2 is an informational condition and does not require troubleshooting.

2.5.286 SSM-ST3

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Stratum 3 (ST3) Traceable condition occurs when the synchronization message quality level
for ADM-10G and MXP trunk ports is ST3.

~

Note  SSM-ST3 is an informational condition and does not require troubleshooting.

2.5.287 SSM-ST3E

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Stratum 3E (ST3E) Traceable condition indicates that the synchronization message quality
level for ADM-10G and MXP trunk ports is ST3E. SSM-ST3E is a Generation 2 SSM and is used for
Generation 1.

~

Note  SSM-ST3E is an informational condition and does not require troubleshooting.

2.5.288 SSM-ST4

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Stratum 4 (ST4) Traceable condition occurs when the synchronization message quality level
is ST4 for ADM-10G and MXP trunk ports. The message quality is not used because it is below ST3.
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~

Note  SSM-ST4 is an informational condition and does not require troubleshooting.

2.5.289 SSM-STU

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Synchronization Traceability Unknown (STU) condition occurs when the reporting node is
timed to a reference that does not support SSM, but the ONS system has SSM support enabled (for the
ADM-10G and MXP trunk ports). SSM-STU can also occur if the timing source is sending out SSM
messages but SSM is not enabled on the ONS system.

Clear the SSM-STU Condition

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing > BITS
Facilities tabs.

Step2  Complete one of the following depending upon the status of the Sync Messaging Enabled check box:
e If the Sync. Messaging Enabled check box for the BITS source is checked, uncheck the box.
e If the Sync. Messaging Enabled check box for the BITS source is not checked, check the box.
Step3  Click Apply.

Step4  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

25290 SSM-TNC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The SSM Transit Node Clock (TNC) Traceable condition occurs when the synchronization message
quality level is TNC for ADM-10G and MXP trunk ports.

~

Note  SSM-TNC is an informational condition and does not require troubleshooting.

25291 SW-MISMATCH

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT

The Software Mismatch condition occurs during software upgrade when there is a mismatch between
software versions. The card connecting to the TCC2/TCC2P card is running an older version than the
TCC2/TCC2P card is.
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Clear the SW-MISMATCH Condition

Step 1 Complete the “Reset a Card in CTC” procedure on page 2-241 for the errored card.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.292 SWTOPRI

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Primary Reference condition occurs when the ONS system switches to
the primary timing source (reference 1). The ONS system uses three ranked timing references. The
timing references are typically two BITS-level or line-level sources and an internal reference.

~

Note SWTOPRI is an informational condition and does not require troubleshooting.

2.5.293 SWTOSEC

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Secondary Reference condition occurs when the ONS system has
switched to a secondary timing source (reference 2).

Clear the SWTOSEC Condition

Step 1 To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-219.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

25294 SWTOTHIRD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

The Synchronization Switch to Third Reference condition occurs when the ONS system has switched to
a third timing source (reference 3).
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Clear the SWTOTHIRD Condition

Step 1 To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-219 or the “SYNCSEC” alarm on page 2-220.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.295 SYNC-FREQ

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Synchronization Reference Frequency Out of Bounds condition is reported against any reference
that is out of the bounds for valid references. The login node fails the reference and chooses another
internal or external reference to use.

Clear the SYNC-FREQ Condition

Step1  Use an optical test set to verify the timing frequency of the line or BITS timing source and ensure that
it falls within the proper frequency. For specific procedures to use the test set equipment, consult the
manufacturer.

For BITS, the proper timing frequency range is approximately —15 PPM to 15 PPM. For optical line
timing, the proper frequency range is approximately —16 PPM to 16 PPM.

Step2  If the reference source frequency is not outside of bounds, complete the “Physically Replace a Card”
procedure on page 2-244 for the TCC2/TCC2P card.

~

Note It takes up to 30 minutes for the TCC2/TCC2P card to transfer the system software to the newly
installed TCC2/TCC2P card. Software transfer occurs in instances where different software
versions exist on the two cards. When the transfer completes, the active TCC2/TCC2P card
reboots and goes into standby mode after approximately three minutes.

Step3  If the SYNC-FREQ condition continues to report after replacing the TCC2/TCC2P card, log into the
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

25.296 SYNCLOSS

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Objects: FC, GE, ISC, TRUNK, EQPT
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The Loss of Synchronization on Data Interface alarm is raised on MXP card client and trunk ports when
there is a loss of signal synchronization on the port. The SYNCLOSS alarm is raised on OTU2_XP card
10GE and 10G FC client data ports when there is a loss of signal synchronization on the port. This alarm
is demoted by the SIGLOSS alarm.

Clear the SYNCLOSS Alarm

Step 1
Step 2
Step 3

Step 4

Ensure that the data port connection at the near end of the SONET or SDH (ETSI) link is operational.
Verify fiber continuity to the port. To do this, follow site practices.
View the physical port LED to determine whether the alarm has cleared.
e If the LED is green, the alarm has cleared.
e Ifthe port LED is clear (that is, not lit green), the link is not connected and the alarm has not cleared.
e If the LED is red, this indicates that the fiber is pulled.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a service-affecting problem.

2.5.297 SYNCPRI

Default Severity:

Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF; Major (MJ), Service-Affecting (SA)
for NE-SREF (For SONET)

Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF; Major (MJ), Non-Service-Affecting
(NSA) for NE-SREF (For SDH)

Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Primary Reference alarm occurs when the ONS system loses the primary timing
source (reference 1). The ONS system uses three ranked timing references. The timing references are

typically two BITS-level or line-level sources and an internal reference. If SYNCPRI occurs, the ONS
system should switch to its secondary timing source (reference 2). Switching to the secondary timing

source also triggers the “SWTOSEC” alarm, page 2-217.

Clear the SYNCPRI Alarm
Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.
Step2  Verify the current configuration for REF-1 of the NE Reference.
Step3  If the primary timing reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure
on page 2-134.
Step4  If the primary reference clock is an incoming port on the ONS system, complete the “Clear the LOS

(OCN/STMN) Alarm” procedure located in the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide.
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Step5  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.298 SYNCSEC

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Secondary Reference alarm occurs when the ONS system loses the secondary
timing source (reference 2). If SYNCSEC occurs, the ONS system should switch to a third timing source
(reference 3) to obtain valid timing for the ONS system. Switching to a third timing source also triggers
the “SWTOTHIRD” alarm, page 2-217.

Clear the SYNCSEC Alarm

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.

Step2  Verify the current configuration of REF-2 for the NE Reference.

Step3  If the secondary reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-134.

Step4  Verify that the BITS clock is operating properly.

Step5  If the secondary timing source is an incoming port on the ONS system, complete the “Clear the LOS
(OCN/STMN) Alarm” procedure located in the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide.

Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.299 SYNCTHIRD

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF

A Loss of Timing on Third Reference alarm occurs when the ONS system loses the third timing source
(reference 3). If SYNCTHIRD occurs and the ONS system uses an internal reference for source three,
the TCC2/TCC2P card could have failed. The ONS system often reports either the “FRNGSYNC”

condition on page 2-88 or the “HLDOVRSYNC” condition on page 2-102 after a SYNCTHIRD alarm.

Clear the SYNCTHIRD Alarm

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.
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Step2  Verify that the current configuration of REF-3 for the NE Reference. For more information about
references, refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual.

Step3  If the third timing source is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-134.

Step4  If the third timing source is an incoming port on the ONS system, complete the “Clear the LOS
(OCN/STMN) Alarm” procedure located in the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide.

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step5  If the third timing source uses the internal ONS system timing, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-241.

Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 6 If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-242. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Card”
procedure on page 2-244.

2.5.300 SYSBOOT

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: NE

The System Reboot alarm indicates that new software is booting on the TCC2/TCC2P card. No action
is required. The alarm clears when all cards finish rebooting the new software. The reboot takes up to
30 minutes.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

~

Note  SYSBOOT is an informational alarm. It only requires troubleshooting if it does not clear.

2.5.301 TEMP-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE

Temperature Reading Mismatch Between Control Cards is raised when the temperature readings on the
two TCC2/TCC2P cards are out of range of each other by more than some predefined difference (such
as 5 degrees C). A message containing power monitoring and temperature information is exchanged
between the two TCC2/TCC2P cards, allowing the values to be compared. The temperature of each
TCC2/TCC2P card is read from a system variable.
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This condition can be caused by a clogged fan filter or by fan tray stoppage.
Clear the TEMP-MISM Condition

Step 1 Complete the “Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-247.
Step2  If the condition does not clear, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-248.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25302 TIM

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK

The Section TIM alarm occurs when the expected JO section trace string does not match the received
section trace string. This occurs because the data being received is not correct, and the receiving port
could not be connected to the correct transmitter port.

If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed due to
a fibering misconnection, a TL1 routing change, or to someone entering an incorrect value in the Current
Transmit String field.

TIM occurs on a port that has previously been operating without alarms if someone switches optical
fibers that connect the ports. TIM is usually accompanied by other alarms, such as the LOS
(OCN/STMN) or UNEQ-P (or HP-UNEQ) alarms. (For instructions to clear these alarms, refer to the
“Alarm Troubleshooting” chapter of the Cisco ONS 15454 Troubleshooting Guide and the

Cisco ONS 15454SDH Troubleshooting Guide.) If these alarms accompany a TIM alarm, reattach or
replace the original cables/fibers to clear the alarms. If a Transmit or Expected String was changed,
restore the original string.

Clear the TIM Alarm

Step 1 Ensure that the physical fibers are correctly configured and attached. To do this, consult site documents.
For more information about cabling an ONS system DWDM node, refer to the “Turn Up a Node” chapter
in the Cisco ONS 15454 DWDM Procedure Guide.

Step2  If the alarm does not clear, you can compare the JO expected and transmitted strings and, if necessary,
change them:

a. Log into the circuit source node and click the Circuits tab.
b. Select the circuit reporting the condition, then click Edit.
c. In the Edit Circuit window, check the Show Detailed Circuit Map check box and click Apply.

d. On the detailed circuit map, right-click the source circuit port and choose Edit JO Path Trace (port)
from the shortcut menu.

e. Compare the Current Transmit String and the Current Expected String entries in the Edit JO Path
Trace dialog box.
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f. If the strings differ, correct the Transmit or Expected strings and click Apply.
g. Click Close.

Step3  If the alarm does not clear, ensure that the signal has not been incorrectly routed. (Although the ONS
system routes circuits automatically, the circuit route could have been changed using TL1.) If necessary,
manually correct the routing using TL1. For instructions, refer to the Cisco ONS SONET TLI Reference
Guide and the Cisco ONS SONET TLI Command Guide.

Step4  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem if necessary.

2.5.303 TIM-MON

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The TIM Section Monitor TIM alarm is similar to the “TIM” alarm on page 2-222, but it applies to
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_I10E, TXP_MR_I10E_C,
TXP_MR_10E_L, and MXP_2.5G_10G cards when they are configured in transparent mode. (In
transparent termination mode, all SONET overhead bytes are passed through from client ports to the
trunk ports or from trunk ports to client ports.)

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the TIM-MON Alarm

Step 1 Complete the “Clear the TIM Alarm” procedure on page 2-222.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

25.304 TIM-P

Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Default Severity:
Minor (MN), Non-Service-Affecting (NSA) for STSMON

Logical Object: STSMON, STSTRM

The TIM Path alarm occurs when the expected path trace string does not match the received path trace
string. Path Trace Mode must be set to Manual or Auto for the TIM-P alarm to occur.

In manual mode at the Path Trace window, the user types the expected string into the Current Expected
String field for the receiving port. The string must match the string typed into the Transmit String field
for the sending port. If these fields do not match, the login node raises the TIM-P alarm. In Auto mode
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on the receiving port, the card sets the expected string to the value of the received string. If the alarm
occurs on a port that has been operating with no alarms, the circuit path has changed or someone entered
a new incorrect value into the Current Transmit String field. Complete the following procedure to clear
either instance.

Clear the TIM-P Alarm

Step 1

Step 2

2.5.305 TIM-S

Note

Complete the “Clear the TIM Alarm” procedure on page 2-222. (The option will say “Edit J1 Path Trace”
rather than “Edit JO Path Trace.”)

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447). If the alarm applies to the STSTRM object,
it is Service-Affecting (SA).

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OCN

The TIM for Section Overhead alarm occurs when there is a mismatch between the expected and
received JO section overhead strings in either Manual or Auto mode.

In manual mode at the DS3/EC1-48 card Section Trace window, the user enters the expected string into
the Current Expected String field for the receiving port. The string must match the string typed into the
Transmit String field for the sending port. If these fields do not match, the login node raises the TIM-S
alarm.

In Auto mode on the receiving port, the card sets the expected string to the value of the received string.
If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed or
someone entered a new incorrect value into the Current Transmit String field. Complete the following
procedure to clear either problem.

TIM-S also occurs on a port that has previously been operating without alarms if someone switches the
cables or optical fibers that connect the ports. If TIM-S is enabled on the port, the “AIS-L” alarm on
page 2-27 can be raised downstream and the “RFI-L” alarm on page 2-196 can be raised upstream.

AIS-L and RFI-L are disabled or enabled in the Provisioning > EC1 > Section Trace tab Disable
AIS/RDI on TIM-S? check box.

Clear the TIM-S Alarm

Step 1
Step 2
Step 3
Step 4
Step 5

Double-click the DS3/EC1-48 card to open the card view.

Click the Provisioning > EC1 > Section Trace tabs.

Choose the port from the Port pull-down.

In the Expected area, enter the correct string into the Current Expected String field.

Click Apply.
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Step6  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447). If the alarm applies to the STSTRM object,
it is Service-Affecting (SA).

2.5.306 TRAIL-SIGNAL-FAIL

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: OCH, TRUNK

The Trail Signal Fail condition is raised on a DWDM trunk port or OCH port to correlate with the
“LOS-P (TRUNK)” alarm on page 2-145 when the trunk port’s administrative state is set to
OO0S,DSBLD (or Locked,disabled).

Clear the TRAIL-SIGNAL-FAIL Condition

Step 1 Switch the OCHNC administrative state of the errored OCH or trunk port to IS , or Unlocked.:

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.307 UNC-WORD

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Uncorrected FEC Word condition indicates that the FEC capability could not sufficiently correct the
frame.

Note  For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the UNC-WORD Condition

Step 1 Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Step2  Ensure that the ports on the far end and near end nodes have the same port rates and FEC settings. For
more information about port rates and FEC settings, refer to the “Provision Transponder and Muxponder
Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.
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Step 3

Step 4
Step 5

Step 6
Step 7
Step 8
Step 9
Step 10

Step 11

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

If the optical power level is good, verify that optical receive levels are within the acceptable range.

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

If the condition does not clear, verify that single-mode fiber is used.

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.
Clean the fiber connectors at both ends for a signal degrade according to site practice.
Verify that a single-mode laser is used at the far end.

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-242.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.308 UNEQ-P

Note

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STSMON, STSTRM

An SLMF UNEQ Path alarm occurs when the path does not have a valid sender. The UNEQ-P indicator
is carried in the C2 signal path byte in the SONET overhead. The source of the problem is the node that
is transmitting the signal into the node reporting the UNEQ-P.

The alarm could result from a PARTIAL circuit or an empty VT tunnel. UNEQ-P occurs in the node that
terminates a path.

If a newly created circuit has no signal, a UNEQ-P alarm is reported on the OC-N cards and the AIS-P
condition is reported on the terminating cards. These alarms clear when the circuit carries a signal.

Clear the UNEQ-P Alarm

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

In node view, choose Go to Network View from the View menu.
Right-click the alarm to display the Select Affected Circuits shortcut menu.
Click Select Affected Circuits.

When the affected circuits appear, look in the Type column for VTT, which indicates a VT tunnel circuit.
A VT tunnel with no VTs assigned could be the cause of an UNEQ-P alarm.

If the Type column does not contain VTT, there are no VT tunnels connected with the alarm. Go to
Step 7.

If the Type column does contain VTT, attempt to delete these rows:
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Step 11
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~

Note  The node does not allow you to delete a valid VT tunnel or one with a valid VT circuit inside.

a. Click the VT tunnel circuit row to highlight it. Complete the “Delete a Circuit” procedure on
page 2-245.

b. If an error message dialog box appears, the VT tunnel is valid and not the cause of the alarm.

c. If any other rows contain VTT, repeat Step 6.

If all nodes in the ring appear in the CTC network view, determine whether the circuits are complete:
a. Click the Circuits tab.

b. Verify that PARTIAL is not listed in the Status column of any circuits.

If you find circuits listed as PARTIAL, use an optical test set to verify that these circuits are not working
circuits that continue to pass traffic. For specific procedures to use the test set equipment, consult the
manufacturer.

If the PARTIAL circuits are not needed or are not passing traffic, delete the PARTIAL circuits.
Complete the “Delete a Circuit” procedure on page 2-245.

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide.

Log back in and verify that all circuits terminating in the reporting card are active:
a. Click the Circuits tab.
b. Verify that the Status column lists all circuits as active.

If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

On the 0C-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Step 13 If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-244 for the
OC-N and electrical cards.
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Step 14  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.309 UNQUAL-PPM

Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Objects: PPM

The Unqualified PPM Inserted condition occurs when a PPM with a nonqualified product ID is plugged
into the card’s port; that is, the PPM passes the security code check as a Cisco PPM but is not qualified
for use on the particular card.

Clear the UNQUAL-PPM Condition

Step 1 Obtain the correct Cisco PPM and replace the existing PPM with the new one.

Step2  If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.310 UNREACHABLE-TARGET-POWER

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCH

The Unreachable Port Target Power alarm occurs on WSS32 cards during startup as the card laser attains
its correct power level. The condition disappears when the card successfully boots.

Note  Card power levels are listed in the "Hardware Specifications" appendix of the Cisco ONS 15454 DWDM
Reference Manual.

Note  UNREACHABLE-TARGET-POWER is an informational condition. It only requires troubleshooting if
it does not clear.

2.5.311 UT-COMM-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The Universal Transponder (UT) Module Communication Failure alarm is raised on MXP_2.5G_10E
and TXP_MR_10E cards when there is a universal transponder communication failure because the
universal transponder (UT) has stopped responding to the TCC2/TCC2P card.
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Clear the UT-COMM-FAIL Alarm

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the card
view.

Step2  Request a laser restart:
a. Click the Maintenance > ALS tabs.
b. Check the Request Laser Restart check box.
c. Click Apply.

Step3  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.312 UT-FAIL

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The Universal Transponder Module Hardware Failure alarm is raised against MXP_2.5G_10E and
TXP_MR_I10E cards when a UT-COMM-FAIL alarm persists despite being reset.

Clear the UT-FAIL Alarm

Step 1 Complete the “Physically Replace a Card” procedure on page 2-244 for the alarmed card.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.313 VOA-DISABLED

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT

The VOA Disabled alarm indicates that the VOA control loop is disabled due to excessive
counter-propagation light. This alarm is raised when there is a mis-cabling of interface cards, that is,
when the interface trunk TX port is connected to DMX drop-TX port through the patch-panel.

Clear the VOA-DISABLED Condition

Step 1 To clear the alarm, check and ensure that the patchcords connection to and from the interfaces trunk ports
are proper.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447).
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2.5.314 VOA-HDEG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS

The VOA High Degrade alarm is raised on DWDM cards when an equipped VOA exceeds the setpoint
due to an internal problem. The alarm indicates that the attenuation has crossed the high degrade
threshold. The alarmed card should be replaced at the next opportunity.

Note  For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-HDEG Alarm

Step1  Complete the “Physically Replace a Card” procedure on page 2-244 for the alarmed card.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.315 VOA-HFAIL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OMS, OTS

The VOA High Fail alarm is raised on DWDM cards when an equipped VOA exceeds the setpoint due
to an internal problem. The alarm indicates that the attenuation has crossed the high fail threshold. The
card must be replaced.

Note  For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-HFAIL Alarm

Step1  Complete the “Physically Replace a Card” procedure on page 2-244 for the alarmed card.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.
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2.5.316 VOA-LDEG

Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS

The VOA Low Degrade alarm is raised on DWDM cards when an equipped VOA does not reach the
setpoint due to an internal problem. The alarm indicates that the attenuation has crossed the low degrade
threshold. The alarmed card should be replaced at the next opportunity.

Note  For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-LDEG Alarm

Step1  Complete the “Physically Replace a Card” procedure on page 2-244 for the alarmed card.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.317 VOA-LFAIL

Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OMS, OTS

The VOA Low Fail alarm is raised on DWDM cards when an equipped VOA does not reach the setpoint
due to an internal problem. The alarm indicates that the attenuation has crossed the low fail threshold.
The card must be replaced.

Note  For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-LFAIL Alarm

Step1  Complete the “Physically Replace a Card” procedure on page 2-244 for the alarmed card.

Step2  If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.
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25318 VOLT-MISM

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: PWR

The Power Monitoring Mismatch Between Control Cards alarm is raised against the shelf when the
power voltages of both TCC2/TCC2P cards are out of range of each other by more than 5 VDC.

Clear the VOLT-MISM Condition

Step 1

Step 2
Step 3

Check the incoming voltage level to the shelf using a voltmeter. Follow site practices or refer to the
“Install the Shelf and Common Control Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide for power installation procedures.

Correct any incoming voltage issues.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.319 WKSWPR (2R, EQPT, ESCON, FC, GE, ISC, OTS)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OTS

This condition is raised when you use the FORCE SPAN, FORCE RING, or MANUAL SPAN command
at for a Y-Cable-protected MXP or TXP client port (set for one the above-listed client configurations).
WKSWPR is visible on the network view Alarms, Conditions, and History tabs.

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

2.5.320 WKSWPR (TRUNK)

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

This condition is raised when you use the FORCE SPAN, FORCE RING, or MANUAL SPAN command
at for a splitter-protection enabled MXP or TXP trunk port. WKSWPR is visible on the network view
Alarms, Conditions, and History tabs.

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.
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2.5.321 WTR (2R, ESCON, FC, GE, ISC)

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC

The Wait To Restore condition occurs for client ports in the above-listed types of configuration in a
Y-cable protection group when the “WKSWPR (TRUNK)” condition, page 2-232, is raised. The
condition occurs when the wait-to-restore time has not expired, meaning that the active protect path
cannot revert to the working path. The condition clears when the timer expires and traffic switches back
to the working path.

WTR is an informational condition and does not require troubleshooting.

2.5.322 WTR (TRUNK)

~

Note

Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK

The Wait To Restore condition occurs when the “WKSWPR (TRUNK)” condition, page 2-232, is raised
for MXP or TXP splitter protection scheme ports. The condition occurs when the wait-to-restore time
has not expired, meaning that the active protect path cannot revert to the working path. The condition
clears when the timer expires and traffic switches back to the working path.

WTR is an informational condition and does not require troubleshooting.

2.5.323 WVL-MISMATCH

Note

Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK

The Equipment Wavelength Mismatch alarm applies to the following cards: TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_I10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_MR_2.5G, MXPP_MR_2.5G,
MXP_MR_10DME_C, MXPP_MR_10DME_C, ADM-10G, and OTU2_XP cards. It occurs when you
provision the card in CTC with a wavelength that the card does not support.

For more information about supported card wavelengths, refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual.

Clear the WVL-MISMATCH alarm

Step 1

Step 2
Step 3

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP or MXP card to
open the card view.

Click the Provisioning > Line > Wavelength Trunk Provisioning tabs.

In the Wavelength field, view the provisioned card wavelength.

| 78-18378-02

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0 g



Chapter2  Alarm Troubleshooting |

I DWDM Card LED Activity

Step 4

Step 5

Step 6
Step 7
Step 8

Step 9

If you have access to the site, compare the wavelength listed on the card faceplate with the provisioned
wavelength. If you are remote, compare this wavelength with the card identification in the inventory:

a. In node view (single-shelf mode) or shelf view (multishelf mode), click the Inventory tab.
b. Locate the slot where the TXP or MXP card is installed and view the card wavelength in the name.

If the card was provisioned for the wrong wavelength, double-click the card in node view (single-shelf
mode) or shelf view (multishelf mode) to open the card view.

Click the Provisioning > Line > Wavelength Trunk Provisioning tabs.
In the Wavelength field, click the drop-down list and choose the correct wavelength.
Click Apply.

If the wavelength does not appear because the wavelength band of the card, either C or L, differs from
the band that was provisioned in CTC, complete the following steps:

a. In the Wavelength field, click the drop-down list and choose First Tunable Wavelength.
b. Click Apply.

c. In the Wavelength field, click the drop-down list and choose the correct wavelength.

d. Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.6 DWDM Card LED Activity

The following sections list the DWDM card LED sequences during card insertion and reset.

2.6.1 DWDM Card LED Activity After Insertion

When an DWDM card is inserted in the shelf, the following LED activities occur:

1. The FAIL LED illuminates for approximately 35 seconds.
The FAIL LED blinks for approximately 40 seconds.
All LEDs illuminate and then turn off within 5 seconds.

If new software is being downloaded to the card, the ACT and SF LEDs blink for 20 seconds to
3.5 minutes, depending on the card type.

5. The ACT LED illuminates.

> W DN

6. The SF LED stays illuminated until all card ports connect to their far-end counterparts and a signal
is present.

2.6.2 DWDM Card LED Activity During Reset

When an DWDM card resets (by software or hardware), the following LED activities occur:

1. The FAIL LED switches on for few seconds.
2. The FAIL LED on the physical card blinks and turns off.
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3. The white LED with the letters “LDG” appears on the reset card in CTC.
4. The green ACT LED appears in CTC.

2.7 Traffic Card LED Activity

ONS system traffic card LED behavior patterns are listed in the following sections. These sections give
behavior for card insertion, reset, and side-switch.

2.1.1 Typical Traffic Card LED Activity After Insertion

When a non-DWDM card is inserted, the following LED activities occur:

1. The red FAIL LED turns on and remains illuminated for 20 to 30 seconds.
The red FAIL LED blinks for 35 to 45 seconds.

All LEDs blink once and turn off for 5 to 10 seconds.

The ACT or ACT/SBY LED turns on. The SF LED can persist until all card ports connect to their
far-end counterparts and a signal is present.

& @ D

2.1.2 Typical Traffic Card LED Activity During Reset

While a non-DWDM card resets, the following LED activities occur:

1. The FAIL LED on the physical card blinks and turns off.

2. The white LED with the letters “LDG” appears on the reset card in CTC.
3. The green ACT LED appears in CTC.

2.1.3 Typical Card LED State After Successful Reset

When a non-DWDM card successfully resets, the following LED states are present:
e If you are looking at the physical ONS system, the ACT/SBY LED is illuminated.

e Ifyouare looking at node view (single-shelf mode) or shelf view (multishelf mode) of the ONS system,
the current standby card has an amber LED depiction with the initials “SBY,” and this has replaced
the white “LDG” depiction on the card in CTC.

e Ifyouare looking at node view (single-shelf mode) or shelf view (multishelf mode) of the ONS system,
the current active card has a green LED depiction with the initials “ACT,” and this has replaced the
white “LDG” depiction on the card in CTC.

Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
| 78-18378-02 .m



Chapter2  Alarm Troubleshooting |

| Frequently Used Alarm Troubleshooting Procedures

2.8 Frequently Used Alarm Troubleshooting Procedures

This section gives common procedures that are frequently used when troubleshooting alarms. Most of
these procedures are summarized versions of fuller procedures existing elsewhere in the ONS system
documentation. They are included in this chapter for the user’s convenience. For further information,
please refer to the Cisco ONS 15454 DWDM Procedure Guide or the Cisco ONS 15454 DWDM
Reference Manual as appropriate to your purpose

2.8.1 Node and Ring Identification, Change, Visibility, and Termination

The following procedures relate how to identify or change BLSR names and node IDs, and how to verify
visibility from other nodes.

Identify a BLSR Ring Name or Node ID Number

Step1  Log into a node on the network.
Step 2 In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BL.SR tabs.

Stepd  From the Ring Name column, record the ring name, or in the Nodes column, record the Node IDs in the
BLSR. The Node IDs are the numbers in parentheses next to the node name.

Change a BLSR Ring Name

Step 1 Log into a node on the network.

Step 2 In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BL.SR tabs.

Step4  Highlight the ring and click Edit.

Step 5 In the BLSR window, enter the new name in the Ring Name field.
Step6  Click Apply.

Step7  Click Yes in the Changing Ring Name dialog box.

Change a BLSR Node ID Number

Step 1 Log into a node on the network.

Step 2 In node view, choose Go to Network View from the View menu.
Step3  Click the Provisioning > BL.SR tabs.

Step4  Highlight the ring and click Edit.

Step5 In the BLSR window, right-click the node on the ring map.
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Step6  Select Set Node ID from the shortcut menu.

Step7 In the Edit Node ID dialog box, enter the new ID. The Node ID is the number in parentheses after the
Node Name.

Step8  Click OK.

Verify Node Visibility for Other Nodes

Step 1 Log into a node on the network.

Step2  In node view, click the Provisioning > BLSR tabs.
Step3  Highlight a BLSR.

Step4  Click Ring Map.

Step5 In the BLSR Ring Map window, verify that each node in the ring appears on the ring map with a node
ID and IP address.

Step6  Click Close.

2.8.2 Protection Switching, Lock Initiation, and Clearing

The following sections give instructions for port, ring, and span switching and switch-clearing
commands, as well as lock-ons and lockouts.

Initiate a 1+1 Protection Port Force Switch Command

The following sections give instructions for port switching and switch-clearing commands.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step2  In the Protection Groups area, select the protection group with the port you want to switch.

Step3  In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
Protect/Standby port, click this port.

Step 4 In the Switch Commands area, click Force.
Step5  Click Yes in the Confirm Force Operation dialog box.

Step6  If the switch is successful, the group says “Force to working” in the Selected Groups area.

Initiate a 1+1 Manual Switch Command

This procedure switches 1+1 protection group traffic from one port in the group to the other using a
Manual switch.
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~

Note
Step 1
Step 2

Step 3

Step 4
Step 5
Step 6

A Manual command switches traffic if the path has an error rate less than the signal degrade. A Manual
switch is preempted by a Force switch.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

In the Protection Groups area, select the protection group with the port you want to switch.

In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
protect/standby port, click this port.

In the Switch Commands area, click Manual.
Click Yes in the Confirm Force Operation dialog box.

If the switch is successful, the group now says “Manual to working” in the Selected Groups area.

Initiate a 1:1 Card Switch Command

~

Note

Step 1
Step 2
Step 3
Step 4

The Switch command only works on the active card, whether this card is working or protect. It does not
work on the standby card.

In node view, click the Maintenance > Protection tabs.

Click the protection group that contains the card you want to switch.
Under Selected Group, click the active card.

Next to Switch Commands, click Switch.

The working slot should change to Working/Active and the protect slot should change to
Protect/Standby.

Clear a 1+1 Force or Manual Switch Command

~

Note

Note

If the 1+1 protection group is configured as revertive, clearing a Force switch to protect (or working)
moves traffic back to the working port. In revertive operation, the traffic always switches back to
working. There is no revert to the protect. If ports are not configured as revertive, clearing a Force switch
to protect does not move traffic back.

If the Force Switch was user-initiated, the reversion occurs immediately when the clear command is
issued. The five-minute WTR period is not needed in this case. If the Force was system-initiated, allow
the five-minute waiting period (during WTR) before the reversion occurs.
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In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

In the Protection Groups area, choose the protection group containing the port you want to clear.
In the Selected Group area, choose the port you want to clear.

In the Switching Commands area, click Clear.

Click Yes in the Confirmation Dialog box.

The Force switch is cleared. Traffic immediately reverts to the working port if the group was configured
for revertive switching.

Initiate a Lock-On Command

~

Note

Step 1

Step 2
Step 3

Step 4
Step 5
Step 6

For 1:1 and 1:N electrical protection groups, working or protect cards can be placed in the Lock On state.
For a 1+1 optical protection group, only the working port can be placed in the Lock On state.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

In the Protection Groups list, click the protection group where you want to apply a lock-on.

If you determine that the protect card is in standby mode and you want to apply the lock-on to the protect
card, make the protect card active if necessary:

a. In the Selected Group list, click the protect card.

b. In the Switch Commands area, click Force.

In the Selected Group list, click the active card where you want to lock traffic.
In the Inhibit Switching area, click Lock On.

Click Yes in the confirmation dialog box.

Initiate a Card or Port Lockout Command

~

Note

Step 1

Step 2
Step 3
Step 4
Step 5

For 1:1 or 1:N electrical protection groups, working or protect cards can be placed in the Lock Out state.
For a 1+1 optical protection group, only the protect port can be placed in the Lock Out state.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

In the Protection Groups list, click the protection group that contains the card you want to lockout.
In the Selected Group list, click the card where you want to lock out traffic.
In the Inhibit Switching area, click Lock Out.

Click Yes in the confirmation dialog box.
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The lockout has been applied and traffic is switched to the opposite card.

Clear a Lock-On or Lockout Command

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step2  In the Protection Groups list, click the protection group that contains the card you want to clear.
Step3  In the Selected Group list, click the card you want to clear.

Step 4 In the Inhibit Switching area, click Unlock.

Step5  Click Yes in the confirmation dialog box.

The lock-on or lockout is cleared.
Initiate a Lockout on a BLSR Protect Span

Step 1 From the View menu choose Go to Network View.
Step2  Click the Provisioning > BLSR tabs.
Step3  Choose the BLSR and click Edit.

Step4  Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).

Step5 In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Lockout Protect Span from the drop-down list.

Step6  Click OK.
Step7  Click Yes in the two Confirm BLSR Operation dialog boxes.

Clear a BLSR External Switching Command

Step 1 Log into a node on the network.

Step2  From the View menu, choose Go to Network View.
Step3  Click the Provisioning > BLSR tabs.

Step4  Click the BLSR you want to clear.

Step5  Right-click the west port of the BLSR node where you invoked the switch and choose Set West
Protection Operation.

Step6  In the Set West Protection Operation dialog box, choose Clear from the drop-down list.
Step7  Click OK.
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Click Yes in the Confirm BLSR Operation dialog box.

2.8.3 CTC Card Resetting and Switching

A

This section gives instructions for resetting traffic cards and TCC2/TCC2P cards.

Caution

A

For TXP and MXP cards placed in a Y-cable protection group, do not perform a software reset on both
cards simultaneously. Doing so will cause a traffic hit of more than one minute. For more information
about Y-cable protection groups, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM
Reference Manual.

Caution

Resetting the active card in a Y-cable group will cause a traffic outage if the standby card is down for
any reason.

When an AIC-I card is rest in CTC, any subsequent user client operations (such as CTC or TL1 activity)
is paused for approximately 5-10 seconds. The reset does not cause any conditions to be raised.

For more information about MXP and TXP cards, refer to the “Card Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.
Reset a Card in CTC

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), position the cursor over the optical or
electrical traffic card slot reporting the alarm.

Step3  Right-click the card. Choose Reset Card from the shortcut menu.

Step4  Click Yes in the Resetting Card dialog box.

Reset an Active TCC2/TCC2P Card and Activate the Standby Card

A

Caution

~

Note

Resetting an active TCC2/TCC2P card can be service-affecting.

Before you reset the TCC2/TCC2P card, you should wait at least 60 seconds after the last provisioning
change you made to avoid losing any changes to the database.
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Step1  Log into a node on the network. If you are already logged in, continue with Step 2.
Step2  Identify the active TCC2/TCC2P card:

If you are looking at the physical ONS system shelf, the ACT/SBY LED of the active card is green. The
ACT/STBLY LED of the standby card is amber.

Step 3 In node view (single-shelf mode) or shelf view (multishelf mode), right-click the active TCC2/TCC2P card
in CTC.

Step4  Choose Reset Card from the shortcut menu.
Step5  Click Yes in the Confirmation Dialog box.

The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.

Step6  Verify that the reset is complete and error-free and that no new related alarms appear in CTC. For LED
appearance, see the “2.7.3 Typical Card LED State After Successful Reset” section on page 2-235.

Step7  Double-click the node and ensure that the reset TCC2/TCC2P card is in standby mode and that the other
TCC2/TCC2P card is active. Verify the following:

e If you are looking at the physical ONS system shelf, the ACT/SBY LED of the active card is green.
The ACT/STBLY LED of the standby card is amber.

e No new alarms appear in the Alarms window in CTC.

2.8.4 Physical Card Reseating, Resetting, and Replacement

This section gives instructions for physically reseating and replacing TCC2/TCC2P cards and traffic
cards.

A

Caution Do not physically replace a card without first making provisions to switch or move traffic to a different
card or circuit. General procedures for this are located in the “2.8.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-237.

Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card
A

Warning  Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool hefore touching any other part of it or
before placing it in an antistatic bag. Statement 201

A

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

A

Caution Do not perform this action without the supervision and direction of Cisco TAC (1-800-553-2447).
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Caution

Step 1

Step 2

Step 3
Step 4

The TCC2/TCC2P card reseat could be service-affecting. Refer to the “2.8.2 Protection Switching,
Lock Initiation, and Clearing” section on page 2-237 for traffic-switching procedures.

Before you reset the TCC2/TCC2P card, you should wait at least 60 seconds after the last provisioning
change you made to avoid losing any changes to the database.

When a standby TCC2/TCC2P card is removed and reinserted (reseated), all three fan lights could
momentarily turn on, indicating that the fans have also reset.

Log into a node on the network.

Ensure that the TCC2/TCC2P card you want to reseat is in standby mode. A standby card has an amber
ACT/SBY (Active/Standby) LED illuminated.

When the TCC2/TCC2P card is in standby mode, unlatch both the top and bottom ejectors on the
TCC2/TCC2P card.

Physically pull the card at least partly out of the slot until the lighted LEDs turn off.
Wait 30 seconds. Reinsert the card and close the ejectors.

>
Note  The TCC2/TCC2P card requires several minutes to reboot and display the amber standby LED

after rebooting. Refer to the xxx Cisco ONS 15454 DWDM Reference Manual for more
information about LED behavior during a card reboot.

Remove and Reinsert (Reseat) Any Card

A

Warning

A

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
hefore placing it in an antistatic bag. Statement 201

Caution  Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
Step 1 Open the card ejectors.
Step2  Slide the card halfway out of the slot along the guide rails.
Step3  Slide the card all the way back into the slot along the guide rails.
Stepd  Close the ejectors.
Cisco ONS 15454 DWDM Troubleshooting Guide, R9.0
[ 78-18378-02 .m



Chapter2  Alarm Troubleshooting |

| Frequently Used Alarm Troubleshooting Procedures

Physically Replace a Card

A

Warning

A

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
hefore placing it in an antistatic bag. Statement 201

Caution

A

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

Step 1
Step 2
Step 3
Step 4
Step 5

Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has
not already occurred. See the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-237 for commonly used traffic-switching procedures.

When you replace a card with the identical type of card, you do not need to make any changes to the
database.

Open the card ejectors.

Slide the card out of the slot.

Open the ejectors on the replacement card.

Slide the replacement card into the slot along the guide rails.

Close the ejectors.

2.8.5 Generic Signal and Circuit Procedures

This section gives instructions for verify BER thresholds, deleting circuits, provisioning SDCC (or
MS DCC) terminations, and clearing loopbacks.

Verify the Signal BER Threshold Level

Step 1
Step 2

Step 3
Step 4

Step 5
Step 6

This procedure is used for MXP or TXP cards.

Log into a node on the network.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card reporting the alarm
to open the card view.

Click the Provisioning > Line > SONET (or SDH) tabs.

Under the SD BER (or SF BER) column in the Provisioning window, verify that the cell entry is
consistent with the originally provisioned threshold. The default setting is 1E-7.

If the entry is consistent with the original provisioning, go back to your original procedure.

If the entry is not consistent with what the system was originally provisioned for, click the cell to reveal
the range of choices and click the original entry.
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Step7  Click Apply.

Delete a Circuit

Step1  Log into a node on the network.

Step2  In node view (single-shelf mode) or shelf view (multishelf mode), click the Circuits tab.
Step3  Click the circuit row to highlight it and click Delete.

Step4  Click Yes in the Delete Circuits dialog box.

Verify or Create Node Section DCC Terminations

Step1  Log into a node on the network.

Step2  In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > Comm
Channels > SDCC (or Provisioning > Comm Channels > MS DCC) tab.

Step3  View the Port column entries to see where terminations are present for a node. If terminations are
missing, proceed to Step 4.

Step 4 If necessary, create a DCC termination:
a. Click Create.

b. In the Create SDCC Terminations (or Create MS DCC Terminations) dialog box, click the ports
where you want to create the DCC termination. To select more than one port, press the Shift key.

c. In the port state area, click the Set to IS or Unlocked (or Set to Unlocked) radio button.
d. Verify that the Disable OSPF on Link check box is unchecked.
e. Click OK.

Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit

Step1  Log into a node on the network.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card in CTC
to open the card view.

Step3  Click the Maintenance > Loopback tabs.
Step4  In the Loopback Type column, determine whether any port row shows a state other than None.

Step5  If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

Step6  In the Admin State column, determine whether any port row shows an administrative state other than IS
or Unlocked, for example, OOS,MT or Locked,maintenance.

Step7  If arow shows an administrative state other than IS or Unlocked, click in the column cell to display the
drop-down list and select IS , or Unlocked.
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Note If ports managed into IS (or Unlocked) administrative state are not receiving signals, the LOS
alarm is either raised or remains, and the port service state transitions to OOS-AU,FLT (or
Locked-disabled, automaticInService & failed).

Step8  Click Apply.

Verify or Create Node RS-DCC Terminations
~

Note  Portions of this procedure are different for ONS 15454 DWDM nodes.

Step1  Log into a node on the network. If you are already logged in, continue with Step 2.
Step2 In node view, click the Provisioning > Comm Channels > RS-DCC tab.

Step3  View the Port column entries to see where terminations are present for a node. If terminations are
missing, proceed to Step 4.

Stepd  If necessary, create a DCC termination by completing the following steps:
a. Click Create.

b. In the Create RS-DCC Terminations dialog box, click the ports where you want to create the DCC
termination. To select more than one port, press the Shift key.

c. In the port state area, click the Set to Unlocked radio button.
d. Verify that the Disable OSPF on Link check box is unchecked.
e. Click OK.

Clear an STM-N Card XC Loopback Circuit

Step 1 Log into a node on the network. If you are already logged in, continue with Step 2.
Step2  Double-click the reporting card in CTC to display the card view.

Step3  Click the Maintenance > Loopback > VC4 tabs.

Stepd  Click Apply.

2.8.6 Air Filter and Fan Procedures

This section gives instructions for cleaning or replacing the air filter and reseating or replacing the fan
tray assembly.
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Inspect, Clean, and Replace the Reusable Air Filter

A

Warning

A

To complete this task, you need a vacuum cleaner or detergent and water faucet, a spare filter, and a
pinned hex key.

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Although the filter works if it is installed with either side facing up, Cisco recommends that you install
it with the metal bracing facing up to preserve the surface of the filter.

Caution

Step 1

Step 2

Step 3
Step 4

Step 5
Step 6

Step 7
Step 8

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell,
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later
versions of the ONS system use a reusable air filter.

If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being
careful not to dislodge any dust that could have collected on the filter. If the filter is installed beneath
the fan tray and not in the external filter brackets, open and remove the front door assembly by
completing the following steps:

a. Open the front door of the shelf assembly by completing the following substeps.(If it is already open
or if the shelf assembly does not have a front door, continue with Step 3.)

e Open the front door lock.
e Press the door button to release the latch.
e Swing the door open.

b. Remove the front door by completing the following substeps (optional):
e Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.
¢ Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.
e Secure the dangling end of the ground strap to the door or chassis with tape.

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that could have
collected on the filter.

Visually inspect the air filter material for dirt and dust.

If the reusable air filter has a concentration of dirt and dust, either vacuum or wash the air filter. Prior to
washing the air filter, replace the dirty air filter with a clean air filter and also reinsert the fan-tray
assembly. Wash the dirty air filter under a faucet with a light detergent.

Spare ONS system filters should be kept in stock for this purpose.
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Step 9

A

~

Note  Cleaning should take place outside the operating environment to avoid releasing dirt and dust
near the equipment.

If you washed the filter, allow it to completely air dry for at least eight hours.

Caution

Step 10

Step 11

A

Do not put a damp filter back in the ONS system.

If the air filter should be installed in the external filter brackets, slide the air filter all the way to the back
of the brackets to complete the procedure.

If the filter should be installed beneath the fan-tray assembly, remove the fan-tray assembly and slide the
air filter into the recessed compartment at the bottom of the shelf assembly. Put the front edge of the air
filter flush against the front edge of the recessed compartment. Push the fan tray back into the shelf
assembly.

Caution

Step 12

Step 13
Step 14

If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and
readjust the position of the reusable filter until the fan tray fits correctly.

~

Note  On a powered-up ONS system, the fans start immediately after the fan-tray assembly is correctly
inserted.

To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray
assembly is activated and displays node information.

Rotate the retractable handles back into their compartments.

Replace the door and reattach the ground strap.

Remove and Reinsert a Fan-Tray Assembly

Step 1

Step 2
Step 3

Use the retractable handles embedded in the front of the fan-tray assembly to pull it forward several
inches.

Push the fan-tray assembly firmly back into the ONS system.

Close the retractable handles.
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Replace the Fan-Tray Assembly

A

Caution

A

The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 system R3.1 and later shelf
assemblies (15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). It includes a pin that
does not allow it to be installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution

A

Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or
the connectors on the backplane.

Caution

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6
Step 7

Step 8

Step 9

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities.

Open the front door of the shelf assembly by completing the following steps. If the shelf assembly does
not have a front door, continue with Step 3.

a. Open the front door lock.

b. Press the door button to release the latch.

¢. Swing the door open.

Remove the front door (optional):

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.
b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.
¢. Secure the dangling end of the ground strap to the door or chassis with tape.

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Fold out the retractable handles at the outside edges of the fan tray.

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.

If you are replacing the fan-tray air filter and it is installed in the external bottom bracket, you can slide
the existing air filter out of the bracket and replace it at anytime. For more information on the fan-tray
air filter, see the “Inspect, Clean, and Replace the Reusable Air Filter” section on page 2-247.

Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into
the corresponding receptacle on the backplane.

To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is
activated.
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Step 10

If you replace the door, be sure to reattach the ground strap.

2.8.7 Interface Procedures

This section includes instructions for replacing an AIP.

Replace the Alarm Interface Panel

A

Caution

A

Do not use a 2A AIP with a 5A fan-tray assembly; doing so causes a blown fuse on the AIP.

Caution

~

Note

A

If any nodes in an Ethernet circuit are not using Software R4.0 or later, there is a risk of Ethernet traffic
disruptions. Contact Cisco TAC at 1 800 553-2447 when prompted to do so in the procedure.

Perform this procedure during a maintenance window. Resetting the active TCC2/TCC2P card can cause
a service disruption of less then 50 ms to OC-N or DS-N traffic. Resetting the active TCC2/TCC2P card
can cause a service disruption of 3 to 5 minutes on all Ethernet traffic due to spanning tree reconvergence
if any nodes in the Ethernet circuit are not using Software R4.0 or later.

Caution

A

Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and
result in a loss of data. For assistance with AIP replacement contact Cisco TAC (1-800-553-2447).

Caution

Step 1

Step 2

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

This procedure replaces an existing AIP with a new AIP on an in-service node without affecting traffic.
Ethernet circuits that traverse nodes with a software release prior to R4.0 is affected.

You need a #2 Phillips screwdriver.

Ensure that all nodes in the affected network are running the same software version before replacing the
AIP and repairing circuits:

a. In network view, click the Maintenance > Software tabs. The working software version for each
node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade
document for procedures. No hardware should be changed or circuit repair performed until after the
software upgrade is complete. If you do not need to upgrade software or have completed the software
upgrade, proceed to Step 2.

Record the MAC address of the old AIP:

a. Log into the node where you are replacing the AIP. For login procedures, refer to the “Connect the
PC and Log into the GUI” chapter in the Cisco ONS 15454 Procedure Guide.
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b. In node view, click the Provisioning > Network > General tabs.

¢. Record the MAC address.

Step3  Call Cisco TAC (1-800-553-2447) for assistance in replacing the AIP and maintaining the original MAC
address.
Step4  Unscrew the five screws that hold the lower backplane cover in place.
Step5  Grip the lower backplane cover and gently pull it away from the backplane.
Step6  Unscrew the two screws that hold the AIP cover in place.
Step7  Grip the cover and gently pull away from the backplane.
~
Note  On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.
Step8  Grip the AIP and gently pull it away from the backplane.
Step9  Disconnect the fan-tray assembly power cable from the AIP.
Step10  Set the old AIP aside for return to Cisco.
Cau%] The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The

A

15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP,
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149)
shelves and earlier use the 2A AIP (P/N: 73-5262-01).

Caution Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD

(P/N: 800-24848) shelf; doing so causes a blown fuse on the AIP.

Step 11 Attach the fan-tray assembly power cable to the new AIP.
Step12 Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.
Step13  Replace the AIP cover over the AIP and secure the cover with the two screws.
Step14 Replace the lower backplane cover and secure the cover with the five screws.
Step15 In node view, click the Provisioning > Network tabs.
Caution  Cisco recommends TCC2/TCC2P card resets be performed in a maintenance window to avoid any
potential service disruptions.
Step16 Reset the standby TCC2/TCC2P card:

a. Right-click the standby TCC2/TCC2P card and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears
on the card in CTC.The reset takes approximately five minutes. Do not perform any other steps until
the reset is complete.

Step17 Reset the active TCC2/TCC2P card:
a. Right click the active TCC2/TCC2P card and choose Reset Card.
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Step 18
Step 19

Step 20

Step 21
Step 22

Step 23

Step 24

Step 25

Step 26
Step 27

b. Click Yes in the Resetting Card dialog box. As the card resets, a Ldg indication appears on the card
in CTC. The reset takes approximately five minutes and CTC loses its connection with the node.

From the File drop-down list, choose Exit to exit the CTC session.

Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down
list.

Record the new MAC address:

a. In node view, click the Provisioning > Network > General tabs.

b. Record the MAC address.

In node view, click the Circuits tab. Note that all circuits listed are PARTIAL.

In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box
appears.

Read the instructions in the Circuit Repair dialog box. If all the steps in the dialog box have been
completed, click Next. Ensure that you have the old and new MAC addresses.

The Node MAC Addresses dialog box appears. Complete the following steps:

a. From the Node drop-down list, choose the name of the node where you replaced the AIP.

b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 2.

c. Click Next.

The Repair Circuits dialog box appears. Read the information in the dialog box and click Finish.

The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes or more
depending on the number of circuits provisioned on it.

When the circuit repair is complete, the Circuits Repaired dialog box appears.
Click OK.

In the node view of the new node, click the Circuits tab. Note that all circuits listed are DISCOVERED.
If all circuits listed do not have a DISCOVERED status, call the Cisco TAC (1-800-553-2447) to open a
Return Material Authorization (RMA).
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	2.5.206 MS-RFI
	Clear the MS-RFI Condition
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	2.5.222 ODUK-TIM-PM
	Clear the ODUK-TIM-PM Condition
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	Clear the OUT-OF-SYNC Condition

	2.5.238 PARAM-MISM
	2.5.239 PDI-P
	Clear the PDI-P Condition

	2.5.240 PEER-NORESPONSE
	Clear the PEER-NORESPONSE Alarm

	2.5.241 PMI
	Clear the PMI Condition

	2.5.242 PORT-FAIL
	Clear the PORT-FAIL Alarm

	2.5.243 PROTNA
	Clear the PROTNA Alarm

	2.5.244 PROV-MISMATCH
	Clear the PROV-MISMATCH Alarm

	2.5.245 PTIM
	Clear the PTIM Alarm

	2.5.246 PWR-FAIL-A
	Clear the PWR-FAIL-A Alarm

	2.5.247 PWR-FAIL-B
	Clear the PWR-FAIL-B Alarm

	2.5.248 PWR-FAIL-RET-A
	Clear the PWR-FAIL-RET-A Alarm

	2.5.249 PWR-FAIL-RET-B
	Clear the PWR-FAIL-RET-A Alarm

	2.5.250 PWR-PROT-ON
	Clear the PWR-PROT-ON Alarm

	2.5.251 RFI
	Clear the RFI Condition

	2.5.252 RFI-L
	Clear the RFI-L Condition

	2.5.253 RFI-P
	Clear the RFI-P Condition

	2.5.254 RLS
	Clear the RLS Condition

	2.5.255 ROUTE-OVERFLOW
	Clear the ROUTE-OVERFLOW Condition

	2.5.256 RS-EOC
	Clear the RS-EOC Alarm

	2.5.257 RS-TIM
	Clear the RS-TIM Alarm

	2.5.258 SD (TRUNK)
	Clear the SD (TRUNK) Condition

	2.5.259 SD-L
	Clear the SD-L Condition

	2.5.260 SD-L (TRUNK)
	Clear the SD-L (TRUNK) Condition

	2.5.261 SD-P
	Clear the SD-P Condition

	2.5.262 SDBER-EXCEED-HO
	Clear the SDBER-EXCEED-HO Condition

	2.5.263 SF (TRUNK)
	Clear the SF (TRUNK) Condition

	2.5.264 SF-L
	Clear the SF-L Condition

	2.5.265 SF-L (TRUNK)
	Clear the SF-L (TRUNK) Condition

	2.5.266 SF-P
	Clear the SF-P Condition

	2.5.267 SFTWDOWN
	2.5.268 SHELF-COMM-FAIL
	Clear the SHELF-COMM-FAIL Alarm

	2.5.269 SH-IL-VAR-DEG-HIGH
	Clear the SH-IL-VAR-DEG-HIGH Alarm

	2.5.270 SH-IL-VAR-DEG-LOW
	Clear the SH-IL-VAR-DEG-LOW Alarm

	2.5.271 SHUTTER-OPEN
	Clear the SHUTTER-OPEN Condition

	2.5.272 SIGLOSS
	Clear the SIGLOSS Alarm

	2.5.273 SNTP-HOST
	Clear the SNTP-HOST Alarm

	2.5.274 SPANLEN-OUT-OF-RANGE
	Clear the SPANLEN-OUT-OF-RANGE Alarm

	2.5.275 SPAN-NOT-MEASURED
	2.5.276 SQUELCHED
	Clear the SQUELCHED Condition

	2.5.277 SSM-DUS
	2.5.278 SSM-FAIL
	Clear the SSM-FAIL Alarm

	2.5.279 SSM-LNC
	2.5.280 SSM-OFF
	Clear the SSM-OFF Condition

	2.5.281 SSM-PRC
	2.5.282 SSM-PRS
	2.5.283 SSM-RES
	2.5.284 SSM-SMC
	2.5.285 SSM-ST2
	2.5.286 SSM-ST3
	2.5.287 SSM-ST3E
	2.5.288 SSM-ST4
	2.5.289 SSM-STU
	Clear the SSM-STU Condition

	2.5.290 SSM-TNC
	2.5.291 SW-MISMATCH
	Clear the SW-MISMATCH Condition

	2.5.292 SWTOPRI
	2.5.293 SWTOSEC
	Clear the SWTOSEC Condition

	2.5.294 SWTOTHIRD
	Clear the SWTOTHIRD Condition

	2.5.295 SYNC-FREQ
	Clear the SYNC-FREQ Condition

	2.5.296 SYNCLOSS
	Clear the SYNCLOSS Alarm

	2.5.297 SYNCPRI
	Clear the SYNCPRI Alarm

	2.5.298 SYNCSEC
	Clear the SYNCSEC Alarm

	2.5.299 SYNCTHIRD
	Clear the SYNCTHIRD Alarm

	2.5.300 SYSBOOT
	2.5.301 TEMP-MISM
	Clear the TEMP-MISM Condition

	2.5.302 TIM
	Clear the TIM Alarm

	2.5.303 TIM-MON
	Clear the TIM-MON Alarm

	2.5.304 TIM-P
	Clear the TIM-P Alarm

	2.5.305 TIM-S
	Clear the TIM-S Alarm

	2.5.306 TRAIL-SIGNAL-FAIL
	Clear the TRAIL-SIGNAL-FAIL Condition

	2.5.307 UNC-WORD
	Clear the UNC-WORD Condition

	2.5.308 UNEQ-P
	Clear the UNEQ-P Alarm

	2.5.309 UNQUAL-PPM
	Clear the UNQUAL-PPM Condition

	2.5.310 UNREACHABLE-TARGET-POWER
	2.5.311 UT-COMM-FAIL
	Clear the UT-COMM-FAIL Alarm

	2.5.312 UT-FAIL
	Clear the UT-FAIL Alarm

	2.5.313 VOA-DISABLED
	Clear the VOA-DISABLED Condition

	2.5.314 VOA-HDEG
	Clear the VOA-HDEG Alarm

	2.5.315 VOA-HFAIL
	Clear the VOA-HFAIL Alarm

	2.5.316 VOA-LDEG
	Clear the VOA-LDEG Alarm

	2.5.317 VOA-LFAIL
	Clear the VOA-LFAIL Alarm

	2.5.318 VOLT-MISM
	Clear the VOLT-MISM Condition

	2.5.319 WKSWPR (2R, EQPT, ESCON, FC, GE, ISC, OTS)
	2.5.320 WKSWPR (TRUNK)
	2.5.321 WTR (2R, ESCON, FC, GE, ISC)
	2.5.322 WTR (TRUNK)
	2.5.323 WVL-MISMATCH
	Clear the WVL-MISMATCH alarm


	2.6 DWDM Card LED Activity
	2.6.1 DWDM Card LED Activity After Insertion
	2.6.2 DWDM Card LED Activity During Reset

	2.7 Traffic Card LED Activity
	2.7.1 Typical Traffic Card LED Activity After Insertion
	2.7.2 Typical Traffic Card LED Activity During Reset
	2.7.3 Typical Card LED State After Successful Reset

	2.8 Frequently Used Alarm Troubleshooting Procedures
	2.8.1 Node and Ring Identification, Change, Visibility, and Termination
	Identify a BLSR Ring Name or Node ID Number
	Change a BLSR Ring Name
	Change a BLSR Node ID Number
	Verify Node Visibility for Other Nodes

	2.8.2 Protection Switching, Lock Initiation, and Clearing
	Initiate a 1+1 Protection Port Force Switch Command
	Initiate a 1+1 Manual Switch Command
	Initiate a 1:1 Card Switch Command
	Clear a 1+1 Force or Manual Switch Command
	Initiate a Lock-On Command
	Initiate a Card or Port Lockout Command
	Clear a Lock-On or Lockout Command
	Initiate a Lockout on a BLSR Protect Span
	Clear a BLSR External Switching Command

	2.8.3 CTC Card Resetting and Switching
	Reset a Card in CTC
	Reset an Active TCC2/TCC2P Card and Activate the Standby Card

	2.8.4 Physical Card Reseating, Resetting, and Replacement
	Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card
	Remove and Reinsert (Reseat) Any Card
	Physically Replace a Card

	2.8.5 Generic Signal and Circuit Procedures
	Verify the Signal BER Threshold Level
	Delete a Circuit
	Verify or Create Node Section DCC Terminations
	Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit
	Verify or Create Node RS-DCC Terminations
	Clear an STM-N Card XC Loopback Circuit

	2.8.6 Air Filter and Fan Procedures
	Inspect, Clean, and Replace the Reusable Air Filter
	Remove and Reinsert a Fan-Tray Assembly
	Replace the Fan-Tray Assembly

	2.8.7 Interface Procedures
	Replace the Alarm Interface Panel




